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5.2	Addons

This	page	list	Third-party	Addons	written	by	users	and	developers	to	work	only	with
Gramps	version	5.2.

Please	use	carefully	on	data	that	is	backed	up.
Help	make	these	Third-party	Addons	better	by	reporting	any	comments	or	problems	to	the	author,	or
issues	and	Feature	requests	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	these	plugin	by	following	 these
instructions
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
These	Third-party	Addons	unless	stated	are	not	officially	part	of	Gramps.
This	Addon/Plugin	system	is	controlled	by	the	Addon	Manager	and	Plugin	Manager.

Gramps	comes	with	a	core	set	of	plugins	which	provide	all	of	the	critical	features.

However,	you	can	extend	this	functionality	with	additional	Third-party	Addons.	These	addons	provide	reports,	filters,	View	modes,	Gramplets,	and
more.

From	Gramps	 Addon	Manager...>	Scheduled	update	checks 	section,	you	can	check	for	available	extra	(or	updated)	addons	and	select
which	to	download.	Then,	they	will	be	retrieved	from	the	internet	from	the	Gramps-Project	file	server	and	installed	locally	on	your	computer.

Once	installed,	an	addon	is	found	in	the	same	place	as	a	built-in	feature	of	the	same	Type.	That	is,	Tool	addons	become	new	menu	items	on	the
Tools	menu...	while	addon	Gramplets	become	new	choices	in	the	appropriate	Category	View	sidebar,	bottombar	or	Dashboard	options.

Installed	addons	can	be	enabled	or	disabled	via	the	Plugin	Manager.

Can	not	find	it?

The	Plugin	Manager	and	Preferences	are	good	places	to	search	when	a	feature	is	being	elusive.

Addons	are	not	typically	cross-referenced	in	the	wiki	and	might	not	be	where	you	would	expect	in	the
interface.

What	you	recalled	as	a	Report	might	actually	be	a	Quick	View...	and	those	are	found	in	entirely	different
menus.	Or	you	might	have	installed	an	Addon	for	a	different	machine	or	in	another	version	of	Gramps.

So	looking	through	the	addons	available	for	download	and	among	those	installed	can	help	you
rediscover	the	feature.

Installing	Addons	in	Gramps

Fig.	.1	"Addon	Manager..."	window	showing	default	"Settings..."	for	Gramps	5.2

You	can	have	Gramps	manage	the	process	of	checking	and	downloading	Addon	updates	by	changing	your	settings	to	match	the	highlighted	section
in	the	screenshot	to	the	right	or	read	the	following.

To	configure	Gramps	for	Addons:

1.	 Start	Gramps
2.	 Select	Menu	Edit	->	Addon	Manager...
3.	 Go	to	the	 Settings 	tab
4.	 In	the	 Scheduled	update	checks 	section:
5.	 Change	 Check	for	addon	updates: 	so	when	you	start	Gramps,	it	checks	for	updated	Addons:
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1.	 Once	a	week 	-	checks	for	updates	when	you	start	Gramps	once	a	week	(This	is	the	recommended	setting	but	you	can	choose	any
of	the	other	time	periods.)

6.	 Change	 What	to	check 	so	when	you	check	for	updates,	it	checks	for:
1.	 New	and	updated	addons 	-	checks	for	all	new	and	updated	addons	(This	is	the	recommended	setting)

7.	 Change	the	 Do	not	ask	about	previously	notified	addons	checkbox	to:
1.	 	Unchecked	as	it	means	that	new/updated	addons	are	always	shown	to	you	(This	is	the	recommended	setting)

8.	 If	needed	you	can	verify	that	in	the	 Project's	tab	>	Where	to	check 	option	has	the	correct	URL.	To	locate	the	list	of	addons	for
your	current	language	and	version,	it	should	be	set	to:
https://raw.githubusercontent.com/gramps-project/addons/master/gramps52	if	not;	select	the	 Restore	project	defaults
button.	(Also	see	the	Discourse	forum	discussion	for	the	URL	of	the	5.2	beta	repository	of	Isotammi	addons.)

9.	 Assuming	you	have	an	Internet	connection.	You	can	now	optionally	select	the	 Check	for	updated	addons	now 	button	to	force	a
check	for	Addons	using	the	updated	settings.

10.	 From	the	 Available	Gramps	Updates	for	Addons 	window	you	will	be	shown	a	list	broken	down	by	Type	that	you	can	view	by
selecting	the	"Select"	column	expand	out	each	"Type".

11.	 You	can	then	select	the	check	box	of	those	Addons	you	want	to	install.
12.	 Then	select	the	 Install	Selected	Addons 	button	to	download	those	Addons	from	the	Internet.
13.	 Once	downloaded	from	the	 Done	downloading	and	installing	addons 	dialog	select	the	 Close 	button
14.	 From	the	 Preferences 	dialog	select	 Close 	button.
15.	 To	use	the	Addons	you	need	to	Family	Trees>Quit	and	restart	Gramps.

"Available	Gramps	Updates	for	Addons"	window	showing	example	listing	output	for	Gramps	5.2

Addon	List
Addons	are	listed	inside	of	Gramps	through	the	interface	described	above.	The	Plug-in	Manager	list	includes	the	 built-in	Gramplets	as	well	as	any
downloaded	third	party	addons...	such	as	those	in	the	following	list.

See	Addon	list	legend

for	details	of	on	each	columns.

Plugin	/
Documentation Type Image Description Use

Rating
(out	of

4)
Contact Download
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http://www.gramps-project.org/wiki/index.php/Gramps_5.2_Wiki_Manual_-_Navigation#Projects
https://raw.githubusercontent.com/gramps-project/addons/master/gramps52/listings/addons-en.json
https://gramps.discourse.group/t/gramps-5-2-after-beta1-isotammi-plugins-available/4067
http://www.gramps-project.org/wiki/index.php/Gramps_5.2_Wiki_Manual_-_Settings#Available_Gramps_Updates_for_Addons
http://www.gramps-project.org/wiki/index.php/File:AvailableGrampsUpdatesforAddons-example-listing-52.png
http://www.gramps-project.org/wiki/index.php/Gramps_5.2_Wiki_Manual_-_Gramplets#Built-in_Gramplet_List
http://www.gramps-project.org/wiki/index.php/File:Tango-Dialog-information.png
http://www.gramps-project.org/wiki/index.php/Addon_list_legend


All	Names	of	All
People Quickview Shows	all	names	for

all	people All 4
Gramps
Bugtracker
Doug	Blank

AllNamesQuickview.addon.tgz

Ancestors	map View

A	Geography
category	View
Mode	which	maps
Event	Places	related
to	the	Ancestors	of
the	Home	Person.

All 1
Gramps
Bugtracker
Serge	Noiraud

GeoAncestor.addon.tgz

Attach	Source Tool
A	tool	to	attach	a
source	to	a	group	of
people.

All 1
Gramps
Bugtracker
Doug	Blank

AttachSourceTool.addon.tgz

Avatar	Generator
Tool Tool

A	tool	that	allows
you	to	add	and
remove	one	or
several	images	for	a
selected	set	of
filtered	people.

All 4 Matthias
Kemmer AvatarGenerator.addon.tgz

DNA	Segment
Map Gramplet

Gramplet	showing	a
matching	DNA
segment	map
(attribute)

All 4

Gramps
Bugtracker
Nick	Hall,
Gary	Griffin

DNA.addon.tgz

Event	Description
Editor Tool

A	tool	that	allows
you	to	find	and
replace	a	text	string
in	the	event
description	of
multiple	events.

All 4 Matthias
Kemmer EventDescriptionEditor.addon.tgz

Biography Quickview

Shows	a	text
biography	based	on
the	events	of	the
selected	Person

All 4 A.	Guinane BiographyQuickview.addon.tgz

Number	of
ancestors Quickview

A	quickview	similar
to	the	Number	of
Ancestors	text
report.

All 4 Matthias
Kemmer NumberOfAncestorsQuickview.addon.tgz

Family
Relationship	Tool Tool N/A

A	tool	that	allows
editing	family
relationships	of
multiple	families.

All 4 Matthias
Kemmer FamilyRelationshipTool.addon.tgz

Heatmap Report Create	a	heatmap
web	report. All 4 Matthias

Kemmer Heatmap.addon.tgz

Media	Report Report

A	text	report	for
images,	which
allows	custom
headings	and
custom	notes	as	well
as	image	data	like
notes,	citations,
tags,	attributes	and
people	references.

All 4 Matthias
Kemmer MediaReport.addon.tgz
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http://www.gramps-project.org/wiki/index.php/File:EventDescriptionEditor-defaults-51.png
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http://www.gramps-project.org/wiki/index.php/File:Biography-Quickview-addon-example-51.png
https://github.com/gramps-project/addons/blob/master/gramps52/download/BiographyQuickview.addon.tgz?raw=true
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Double	Cousin Report N/A

Double	Cousin	is	a
text	report	which
lists	special
multiplicities	of
cousins	like	double
cousins.

All 4 Matthias
Kemmer DoubleCousins.addon.tgz

Set	Privacy	Tool Tool

The	Set	Privacy
Tool	allows	you	to
manage	privacy
status	of	people,
events	and	media

All 4 Matthias
Kemmer SetPrivacyTool.addon.tgz

Birthdays Gramplet Display	the
upcoming	birthdays All 1 Peter	Potrowl BirthdaysGramplet.addon.tgz

Sort	Children	in
Birth	order Tool

Sort	children	in
families	in	their
birth	order

All 3 Paul	Culley BirthOrder.addon.tgz

Media	Browser Gramplet

Display	shows
details	of	a	person
linked	media
objects.

All 4 Gramps
Bugtracker MediaBrowser.addon.tgz

Clock Gramplet A	sample	Cairo
clock	gramplet. Developer 1

Gramps
Bugtracker
Doug	Blank

ClockGramplet.addon.tgz

Calculate
Estimated	Dates Tool

A	tool	to	set
estimated	birth	and
death	dates.

All 2
Gramps
Bugtracker
Doug	Blank

CalculateEstimatedDates.addon.tgz

Check
Associations	data Tool Associations

state	tool 	dialog

Will	check	the	data
on	Association	for
people.
menu	Tools	->
Utilities	->	Check
Associations	data...

All

Gramps
Bugtracker
Jerome
Rapinat

AssociationsTool.addon.tgz

Combined View

A	Relationships
category	View
Mode	showing
relationships	and
events	for	a	person.
Like	the	built-in
Relationships	View
but	on	steroids.

All 1
Gramps
Bugtracker
Nick	Hall

CombinedView.addon.tgz
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Collections
Clipboard Gramplet

Allows	one	to	group
items	together	for
quick	access.

All 2
Gramps
Bugtracker
Doug	Blank

ClipboardGramplet.addon.tgz

Command	Line
Merge Tool N/A

Merge	primary
object	via	the
command	line.
(Note:	Used	by
Gramps	project	to
test	its	code	you	can
see	an	example	of
how	it	used
programmatically
here)

Developer 3

Gramps
Bugtracker
Michiel	D.
Nauta

CliMerge.addon.tgz

D3	Ancestral	and
Descendant
Charts

Web	Report

Create
ancestral/descendant
web	based
interactive	D3
charts.

All 3 Matt	Keenan D3Charts.addon.tgz

Database
Differences
Report

Report

Allows	a	mostly
complete
comparison	between
the	current	database
and	a	Gramps	XML
file

All 2 Gramps
Bugtracker Differences.addon.tgz

Data	Entry
Gramplet Gramplet Quick	Data	Entry

for	People	data Expert	user 4 Gramps
Bugtracker DataEntryGramplet.addon.tgz

Date	Calculator Gramplet Allows	you	to	do
date	math. Normal	user 3 Gramps

Bugtracker DateCalculator.addon.tgz

Deep	Connections
Gramplet Gramplet

Finds	deep
relationships
between	home	and
active	people

All 3 Gramps
Bugtracker DeepConnectionsGramplet.addon.tgz

DenominoViso Web	report

Creates	interactive
graphical
ancestor/descendant
tree	on	a	webpage.

All 3
Gramps
Bugtracker
Michiel	Nauta

DenominoViso.addon.tgz
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Descendant	Book
and
Detailed
Descendant	Book

Report

Create	a	book	of
descendant	or
detailed	descendant
reports	using	a	filter.

All 4
Matt	Keenan
Giansalvo
Gusinu

DescendantBooks.addon.tgz

Detailed
Descendant
Report	With	All
Images

Report

Produces	a	detailed
descendant	report
with	all	images	and
optional	todo	list.

All 4 Jon	Schewe DetDescendantReport-images.addon.tgz

Descendant	Count Gramplet	andQuickview

Gives	a	count	of
descendants	for	each
person

All 4
Gramps
Bugtracker
Doug	Blank

DescendantCount.addon.tgz

Descendants
Lines Report

Generates	a
graphical
descendants	tree
using	orthogonal
edges	and	routing
("square	edges").

All 3

Gramps
Bugtracker
User:Lcc
Adam
Sampson
Giansalvo
Gusinu

DescendantsLines.addon.tgz

Download	media
files	from	the
internet

Tool Download	media
from	web	pages All 1 Gramps

Bugtracker DownloadMedia.addon.tgz

Dynamic	Web
Report Report

Exports	the	Family
Tree	as	Web	pages
that	are	generated
dynamically	by
client-side
Javascript(no	server
required).

All 3

Gramps
Bugtracker
Pierre
Bélissent

DynamicWeb.addon.tgz

Export	Raw Exporter

A	Gramps	exporter
that	will	dump	your
BSDDB	database
into	a	flat	text
version	(.raw)	of	the
Python	objects.

Developer 4
Gramps
Bugtracker
Doug	Blank

ExportRaw.addon.tgz

Extract	Place	Data
from	a	Place	Title Tool

Attempts	to	extract
city	and
state/province	from
a	place	title

All 3 Gramps
Bugtracker ExtractCity.addon.tgz

Family	Sheet Report

Generates	a	form
with	all	information
about	a	person,	its
spouses	and	its
children.	(Requires:
PIL	(Python
Imaging	Library).)

All 4

Gramps
Bugtracker
Reinhard
Müller

FamilySheet.addon.tgz

Family	Tree Report

Generates	a
graphical	tree	of	a
family	with	its
ancestors	and/or
descendants.

All 3

Gramps
Bugtracker
Reinhard
Müller

FamilyTree.addon.tgz

Fix	Capitalization
of	Given	Names Tool Fix	Capitalization	of

Given	Names All 2

Gramps
Bugtracker
Donald	N.
Allingham
Doug	Blank

ChangeGivenNames.addon.tgz
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Forms	Gramplet Gramplet

Forms	gramplet	that
allows	users	to
create	and	edit
structured	source
data	in	a	single
form,	such	as	birth,
marriage	and	death
certificates	and
parish	register
entries.

All 1 Nick	Hall Form.addon.tgz

Export	GEDCOM
Extensions
(GED2)

Exporter

Collection	of
unofficial
GEDCOM
extensions	which
extend	Gramps
GedcomWriter	to
include	common
non-compliant
GEDCOM
additions..

Expert	user 2
Gramps
Bugtracker
Doug	Blank

GedcomExtensions.addon.tgz

Tree	Reports:

Ancestor
Tree
Descendant
Tree
Grandparent
Tree
Sandclock
Tree
Sandclock
Tree	for	a
Family

Report

A	group	of	5	Tree
reports	that	use
LaTeX
genealogytree	(the
Pedigree	and
genealogical	tree
diagrams	package)
to	create
professional	looking
trees	for	the	active
person.	Four	report
are	available.
Requires:
texlive/texlive-
pictures	and
texlive-fontsextra

Developer
Expert	user
Intermediate
user

3
Gramps
Bugtracker
Nick	Hall

GenealogyTree.addon.tgz

Geneanet	import
for	Gramps Tool

A	tool	that	allows
you	to	import
Geneanet	ascendants
and	descendants	of	a
selected	person	into
Gramps.	Requires
both	the	Request
and	lxml
prerequisites	to
work.

All 3 Bruno	Cornec GeneanetForGramps.addon.tgz

GetGOV Gramplet

Download	places
from	the	GOV
genealogical
gazetteer.

Expert	user 2 Gary	Griffin GetGOV.addon.tgz

GoogleEarth Mapservice Show	places	with
GoogleEarth.. All 3 Peter	Landgren GoogleEarthWriteKML.addon.tgz

SQLite	Export
SQLite	Import Exporter/Importer

A	Gramps	exporter
and	importer	that
will	export/import
your	Family	Tree	as
a	fully-relational
SQLite	database.

Expert	users 3
Gramps
Bugtracker
Doug	Blank

Sqlite.addon.tgz

Graph	View View

A	Graph	category
View	Mode	that	can
display	the	active
persons	ancestor
tree	and	descendant
tree.	Requires
PyGoocanvas	and
Goocanvas.

All 3
Gramps
Bugtracker
Gary	Burton

GraphView.addon.tgz
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Edit	Image	Exif
Metadata Gramplet

Gramplet	to	view,
edit,	and	save	image
Exif	metadata.

All 3
Rob	G.
Healey,	Paul
Culley

editexifmetadata.py

Headline	News Gramplet
Shows	Gramps
breaking	news,	once
a	day.

All 4 Gramps
Bugtracker HeadlineNewsGramplet.addon.tgz

House	Timeline Gramplet
Lists	the	Residents
of	an	Address	by
Timeline

All 4 Gramps
Bugtracker HouseTimelineGramplet.addon.tgz

H-Tree	Pedigree View

A	Graph	category
View	Mode	with	an
H-tree	based	layout
that	can	be	used	to
display	ancestral
trees.

All 3 Gramps
Bugtracker HtreePedigreeView.addon.tgz

Import	Text Gramplet

Interface	to	import
text	directly	in	the
following	formats:
CSV	(spreadsheet
input),	Gramps
XML,	VCard.

Developers 2
Gramps
Bugtracker
Doug	Blank

ImportGramplet.addon.tgz

Import	and	Merge
tool Tool

Compares	a	Gramps
XML	database	with
the	current	one,	and
allows	merging	of
the	differences.

All 4 Paul	Culley ImportMerge.addon.tgz

Information	Graph Report N/A

Generate	detailed
GraphViz	graphs	by
spidering	over	the
database.

All 0 Bob	Ham GVInformationGraph.py

Interactive	Family
Tree Tool

Opens	an	interactive
tree	in	the	browser.
This	tool	uses	the
Topola	Genealogy
Viewer	to	display
the	family	tree.

All 4 GitHub	issue
tracker Topola.addon.tgz

Last	Change Gramplet	and
Report

A	gramplet	and
report	to	display	the
last	ten	records
changed	in	the	open
family	tree.	The
gramplet	only
displays	persons,
while	the	report	can
display	changed
families,	places,	and
events	too.

All 1 Jakim	Friant LastChange.addon.tgz
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Generic	DB
Access	lib Library

The	Generic	DB
Access	lib	(AKA
libaccess)	is	an
experimental	library
that	provides
generic	access	to	the
database	and	the
gen.lib	interface.

Developer 1
Gramps
Bugtracker
Doug	Blank

libaccess.addon.tgz

Life	Line
Ancestor	Chart
Life	Line
Descendant	Chart

View

A	Graph	category
View	Mode	which
shows	individuals	as
lines	in	an	ancestor
or	descendant	chart
along	a	time	span.

All 3
Gramps
Bugtracker
CWSchulze

Lines	of
Descendency
Report

Report

Prints	out	all
descendency	lines
from	a	given
ancestor	to	a	given
descendant	in	text.

All 2.5 User:Lcc	(e-
mail) LinesOfDescendency.addon.tgz

Merge	Media Tool

Searches	for	Media
entries	that	point	to
the	same	media	file
and	merges	them
together.

All 4 Paul	Culley MediaMerge.addon.tgz

Media	Verify Tool

Verify	a	one-to-one
relationship	between
media	objects	and
files	in	the	media
directory.	The	main
purpose	of	the	tool
is	to	locate	files	that
have	been	moved
and	fix	the	paths.

All 4 Gramps
Bugtracker MediaVerify.addon.tgz

MongoDB Database N/A

MongoDB	database
backend	support.
For	Experts	only!
This	is	an
Experimental
Unreleased	addon.

Developer 2 Gramps
Bugtracker MongoDB.addon.tgz

Network	Chart Website

Generate	a	single
graph	showing
connectivity
between	individuals

Expert	user 3 Mark	B. NetworkChart.addon.tgz

Note	Gramplet Gramplet A	data	entry
gramplet	for	notes. All 3

Gramps
Bugtracker
Doug	Blank

NoteGramplet.addon.tgz

Note	Cleanup Tool

A	tool	to	clean	up
html	and	convert	to
Styled	Text	in	notes.
Also	converts	Web
links	to	Styled	text.

All 3 Paul	Culley NoteCleanup.addon.tgz

Number	of
descendants Quickview

Shows	the	number
of	descendants	of
the	current	active
person

All 4

Gramps
Bugtracker
Reinhard
Müller

NumberOfDescendantsQuickview.addon.tgz
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Participants Gramplet
Display	the
participants	in	an
event.

All 4 Gramps
Bugtracker Participants.addon.tgz

Pedigree	Chart Report

A	version	of	the
classic	pedigree
chart	that	is	suitable
for	printing.	(Can
optionally	use	-
numpy	if	installed)

All 1 Jakim	Friant PedigreeChart.addon.tgz

PersonEverything
Report Report

Show	absolutely
everything	about
one	person,
including	all	events,
notes,	citations,
sources,	attributes,
media	and	the
family	information
about	the	families
they	are	involved	in.

All 4 Gramps
Bugtracker PersonEverything.addon.tgz

Photo	Tagging Gramplet

Enables	tagging
people	in
photographs,	i.e.
associating	regions
of	images	with
Gramps	persons.
(Requires:
OpenCV(for
automatic	face
detection)&	Numpy
)

All 4 Gramps
Bugtracker PhotoTaggingGramplet.addon.tgz

Place	and
Coordinates

Place	Coordinate
Gramplet	view

Gramplet

View
	

Gramplet	simplifies
setting	the
coordinates	of	a
place	and	also
provides	an
additional
Geography	category
View	Mode	.

All 3 Christian
Schulze PlaceCoordinateGeoView.py

Place	Cleanup Gramplet

Place	Cleanup
Gramplet	assists	in
merging	places,	as
well	as	completing
places	from	the
GeoNames	web
database.

All 3 Paul	Culley PlaceCleanup.addon.tgz

PlaceCompletion Tool A	tool	to	fill	in
places. All 3 Gramps

Bugtracker PlaceCompletion.addon.tgz
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PlaceUpdate Gramplet
Gramplet	to
manipulate	multiple
places.

All 3
Kari	Kujansuu
Gramps
Bugtracker

PlaceUpdate.addon.tgz

PostgreSQL Database N/A
PostgreSQL
database	backend
support.

Expert	User 2 Gramps
Bugtracker PostgreSQL.addon.tgz

Prerequisites
Checker Gramplet

Diagnostic	tool	to
help	work	out	if
users	have	the
required
prerequisites
installed	as	well	as
the	latest	version	of
Gramps.

Expert	user 1 Gramps
Bugtracker PrerequisitesCheckerGramplet.addon.tgz

Python	Shell Gramplet Interactive	Python
Shell Developer 4 Gramps

Bugtracker PythonGramplet.addon.tgz

Plugin	Manager
Enhanced

Plugin	lib	and
Gramplet

A	Plugin	manager
with	additional
capabilities

All 4 Paul	Culley PluginManager.addon.tgz

Sources	and
Citations	Report Report

A	text	report	for
source	and	citations
with	notes.

All 4 Gramps
Bugtracker SourcesCitationsReport.addon.tgz

Sync	Associations Tool N/A
Add	reciprocal
Associations	if
missing.

All 2 Gary	Griffin SyncAssociations.addon.tgz

Tiny	Tafel
(Liste	éclair) Report

Provides	a	compact
way	of	describing
the	main	surnames
found	in	a	family
genealogy,	which
can	be	read	by
humans	and
matched	by
computers	using	a
Tafel	Matching
System.

All 4
Gramps
Bugtracker
Eric	doutreleau

ListeEclair.addon.tgz

Query	Gramplet Gramplet	and
Report

A	SQL-like	query
system. All 1

Gramps
Bugtracker
Doug	Blank

Query.addon.tgz

Quilt	Chart View

A	Graph	category
View	Mode	that
presents	your	family
tree	in	the	form	of	a
grid.

Expert	users 3

Gramps
Bugtracker
Serge	Noiraud,
Nick	Hall

QuiltView.addon.tgz
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Related	Relatives Gramplet

Display	all	persons
in	the	database	with
a	relation	to	a
relative.

All 1 Heinz	Brinker RelatedRelativesGramplet.addon.tgz

Add/Remove	Tag
Tool Tool

The	Add/Remove
Tag	Tool	allows	you
to	add	or	remove
one	tag	from	a
selected	set	of
filtered	objects	e.g.
people.

All 4 Matthias
Kemmer RemoveTagTool.addon.tgz

Repositories
Report Report

A	set	of	Text	reports
to	list	repositories
and	their	related
sources	information,
useful	when	going
to	a	repository	(like
an	archive).

All 3

Gramps
Bugtracker
Jérôme
Rapinat

RepositoriesReport.addon.tgz

Set	Attribute Tool
A	tool	for	setting
attributes	and	their
values	on	people.

All 2
Gramps
Bugtracker
Doug	Blank

SetAttributeTool.addon.tgz

Theme
preferences Settings

An	addition	to
Preferences	for
simple	Theme	and
Font	adjustment.
Especially	useful	for
Windows	users.

All 3 Paul	Culley Themes.addon.tgz

This	Day	in
Family	History Gramplet

Display	the
upcoming	a	concise
report	of	the	user
defined	list	of
events	that
happened	on	this
day	and	month.

All 1 Stephen
Adams ThisDayInFamilyHistory.addon.tgz

Thumbnail
Generator Tool

Generates
thumbnails	for
media	files.

All 3 Nick	Hall ThumbnailGenerator.addon.tgz

Type	Cleanup Tool
A	tool	to	Remove
unneeded	custom
Types.

All 4 Paul	Culley TypeCleanup.addon.tgz

Timeline Quickview

Shows	timeline	of
events	in	immediate
family	members'
lives

All 4
Gramps
Bugtracker
Doug	Blank

TimelineQuickview.addon.tgz

Timeline	Pedigree View

A	Graph	category
View	Mode
showing	Pedigree
timeline	and
relationships.

All 3
Gramps
Bugtracker
Doug	Blank

TimelinePedigreeView.addon.tgz

Todo	Report Report

Tag	notes	as	ToDo
(or	anything	else)
and	you	can
generate	a	report
with	the	notes	and
the	records	they	are
attached	to.	Another
way	of	maintaining
a	to-do	list	within
Gramps.

All 1 Jakim	Friant ToDoReport.addon.tgz
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Web	Connect
Pack
DE	Web	Connect
Pack
FR	Web	Connect
Pack
NL	Web	Connect
Pack
RU	Web	Connect
Pack
SV	Web	Connect
Pack
UK	Web	Connect
Pack
US	Web	Connect
Pack

Library

Collection	of	Web
sites	for	various
countries
(DE/FR/SV/UK/US)
Only	install	the
country	you	need.	(*
Requires
libwebconnect)

All 4 Gramps
Bugtracker

libwebconnect.addon.tgz
DEWebConnectPack.addon.tgz
FRWebConnectPack.addon.tgz
SVWebConnectPack.addon.tgz
UKWebConnectPack.addon.tgz
USWebConnectPack.addon.tgz

Gramps	Web
Sync Tool

Gramps	Web	Sync
is	an	addon	for
Gramps	that	allows
to	synchronize	your
Gramps	database	on
your	desktop
computer	with
Gramps	Web,
including	media
files.

Intermediate
user 3

DavidMStraub/
gramps-web-
sync	issues

GrampsWebSync.addon.tgz

Manually	installed	Addons
A	few	addons	have	to	be	installed	manually.	Some	are	scripts	and	need	to	be	installed	as	described	in	the	documentation	provided	with	that	addon.
Some	are	still	in	the	exploratory	stage	and	have	not	yet	been	published	to	the	list	used	by	the	Addon	Manager.

Addons	in	the	exploratory	stages	tend	to	be	initially	posted	to	the	GitHub	Gramps-Project	repositories	and	have	to	be	manually	installed.	Be	certain
to	backup	your	Tree	before	installing	anything.	There	is	a	potential	for	data	loss	with	such	preliminary	versions.

1.	 Download	the	compressed	file.	(Click	on	a	download	link	from	the	list	of	Addons	below;	or	for	unpublished	exploratory	addons,	select	the
Download	ZIP	option	from	the	 <>	Code 	button's	menu	in	their	GitHub	repository)

2.	 Open	the	compressed	file	(	*.ZIP	;	*.gz	;	*.tgz	/	etc	...using	7-ZIP)	and	extract	the	contents	to	in	your	Gramps	User	Directory,	in	the
gramps52/plugins	folder.

3.	 After	manually	installing	any	addons,	it	may	be	necessary	to	restart	Gramps	to	register	plug-ins	again.

Addon/Plugin	Errors

Any	addons/plugins	which	failed	to	load	can	be	identified	in	the	Help	>	Plugin	Manager.	View	the
Status	column	and	double-click	on	any	entry	that	shows	an	error.	Some	may	rely	on	prerequisite	modules
that	need	to	be	installed.
You	can	report	any	errors	to	the	plugin	contact.

Plugin	/
Documentation Type Image Description Use

Rating
(out	of

4)
Contact Download

InformationGraph Report N/A

Generate	detailed	GraphViz
graphs	by	spidering	over	the
database.	 The
InformationGraph
plugin	only	works	with
Gramps	3.2
For	a	similar	report
see	the:
Addon:PersonEverything
Report

All 1 Bob	Ham GVInformationGraph.py

Handle.bash External
utility

A	bash	script	which	makes	it
possible	to	work	with	multiple
databases	merging	select
branches	at	will	without
collisions.

All 3 User:Lcc	(e-mail) Handle.bash.tar.gz
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Isotammi	addons
Isotammi
project
addons

Gramplets:

Isotammi	configuration
Dates
Position	tool

Rules:

Events	with	an	invalid
date
Events	with	a	valid	date

Tool:

Generate	source
references	based	on
more	information

All ? http://wiki.isotammi.net/wiki/Gramps-
laajennukset

https://github.com/Taapeli/isotammi-
addons

Addons	for	other	versions	of	Gramps
Addons	for	other	versions	of	Gramps	can	be	found	on	the	following	pages

5.1	Addons
5.0	Addons
4.2	Addons
4.1	Addons
4.0	Addons
3.4	Addons
3.3	Addons
3.2	Addons
3.1	Addons
3.0	Addons
2.2	Addons

See	also
The	5.2	Addons	Offline	Manual	is	available	for	review	at	(English	18	MiB	PDF)

Gramps	5.2	Wiki	Manual	-	Command	Line
Plugins	Command	Line	(Needs	to	be	incorporated	into	user	manual)

Built-in	Gramplets	-	Gramplets
Rule	expansions	(3rd	party	addons	to	supplement	built-in	rules)
Inspect	the	current	updates	/listings/addons-en.json	file	in	the	 Where	to	check: 	https://raw.githubusercontent.com/gramps-
project/addons/master/gramps52	URL	in	the	Third	party	addons	management	in	the	 General 	tab	of	the	Edit	➡	Preferences
Discourse	forum	thread	discussing	how	the	addons.txt	(From	5.2	now	called	"addons-en.json"	)	entries	are	generated
The	Isotammi	project	addons	list.

Writing	an	Addon/Plugin

Addons	development
Writing	a	plugin	for	general	information	on	developing	addons
Report-writing	tutorial
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5.2	Addons

Rule	expansions

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Rule	Amendments

Changes	to	Rules	are	inconspicuous

New	built-in	Rules	appear	without	any	fanfare.	Plus	there	are	so	many	of	them,	grouped	in	so	many
subcategories	that	they	may	remain	concealed.
Addons	require	downloading	and	installation,	so	the	addon	Rules	have	more	visibility	than	the	builtins.
Plus	they	can	be	searched	as	a	category	in	the	Plugin	Manager.

Fig.	Addons	(Rules).1	Preferences:	Check	for	Updated	Addons
showing	Rules

Rules	are	the	basic	building	blocks	of	custom	Filters.	A	wide	variety	of	rules	have	been	built-in	for	creating	custom	filters	in	each	category.

The	following	of	add-on	Rule	collections	have	been	gathered	released	as	"Packs"	of	rules:

FilterRules	-	documentation,	GitHub	repository
FilterRules2	-	documentation,	GitHub	repository
Generic	rules	(SuperTool)	-	(separate	entries	under	each	object	category,	for	use	with	with	custom	rule	code	generated	by	SuperTool)	-
documentation,	GitHub	repository

With	the	release	of	Gramps	version	5.1,	the	first	addon	Rules	were	posted	as	examples	of	coding	a	Filter	Rule	addon.	Installing	similarly	to	any
other	addon,	a	New	Rule	appears	as	a	menu	item	within	Add	Rule	dialog	while	Defining	a	custom	Filter.

Filters	created	with	these	Rules	can	tested,	cloned	or	deleted	using	the	Filter	Editor.	The	dialog	is	invoked	from	the	Edit	menu	in	each	Category
view.

Locating	Filter	Rule	AddOns

Fig.	Addons	(Rules).2	Search	for	Rule	in	the	Enhanced	Plugin
Manager

The	Plugin	Manager	can	be	used	for	more	than	installing	and	updating	plug-in	modules.	It	can	help	you	discover	the	growing	capabilities	that	might
not	be	obvious.
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Open	the	Plugin	Manager	from	the	Help	menu	and	use	its	Search	box	to	filter	the	view	to	only	those	addons	which	have	a	row	or	filename	which
include	the	'Rule'	term.

Fig.	Addons	(Rules).3	Info	on	'People	related	to	<filter>'	addon	Rule

Addon	Rules	that	have	been	peer-reviewed	will	be	added	to	Gramps'	Update	Manager	system.	This	automates	the	installation	process

When	manually	installed,	each	addon	rule's	Python	source	code	(.py)	file	and	Gramps	Plugin	Registration	(.gpr.py)	file	will	be	located	in	the
\gramps5.2\plugins\FilterRules\	subdirectory	of	your	User	Directory

Looking	at	the	Info	on	any	currently	installed	Rule	will	verify	the	file	location	where	addon	rules	have	been	installed.	

Addon	Rules

Rules	are	added	in	sets/groups	via	the	Plugin	Manager.	All	the	Rules	in	a	set	are	added/removed	when	any	Rule	in	that	set	is	added/removed.

Each	set	supports	Multilingual	internationalization	services	through	.po	and	.pot	files	using	gettext.

In	the	few	months	that	addon	Rules	have	been	a	feature,	two	sets	of	rules	have	been	collected:

Individual	Rules

Active	Person

Fig.	Addons	(Rules).4
Searching	for	person	rules

General	filters	addon	rule	to	find	the	Active	Person.	Available	for	 Person,	 Relationships,	 Charts,	 Geography

This	is	a	useful	"basic"	rule	for	use	in	compound	filters.

Also	see:

the	Home	Person	filter	rule.

Isotammi	Add-on	Rules

Rather	than	distributing	through	the	Gramps	open	source	project,	the	 Taapeli	Project	(which	is	a	national	database	of	Finnish	Genealogical	Society)
curates	their	own	set	of	"Isotammi	lisäosia"	:	“Big	Oak	(the	mythological	World	Tree)	add-ons"	for	Gramps.	The	add-on	manager	installation	files
are	hosted	separately.

Besides	an	initial	experiment	distributing	a	rule,	they	created	the	SuperTool	for	directly	executing	queries	and	building	custom	query	rules	used	by	a
"Generic	<Object>	filter"	in	each	category	view.

Events	with	an	invalid/valid	date
Generic	<Object>	filter

FilterRules	:	Plugin	Manager	Rulebook	Collection

General	Filter	Rule	Addons

People	related	to	<filter>
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Fig.	Addons	(Rules).5	Searching	by	Rule	name

Person	•	General	filters	addon	rule	to	find	Person(s)	matching	a	specified	filter.	Matches	people	who	are	related	to	anybody	matched	by	a
person	filter.

isrelatedwithfiltermatch	provided	as	sample	.gpr.py	&	.py	code	for	writing	addon	filter	rules.	Demonstrates	piping	the	output	of	one
custom	Filter	into	another.

People	with	events	with	a	selected	role

Fig.	Addons	(Rules).6	Searching	for	Person	Rules	which	include	the
'role'	term.

Person	•	Event	filters	addon	rule	to	find	Person(s)	having	any	Event	with	a	specified	Event	Role.

This	rule	is	particularly	useful	to	search	for	people	with	Events	having	an	"Unknown"	event	role.	An	Unknown	role	always	a	placeholder	that
should	be	resolved	as	soon	as	possible.	

Families	with	Events	with	a	selected	role

Fig.	Addons	(Rules).7	Searching	by	Rule	name

Families	•	Event	filters	addon	rule	to	find	Families	having	any	Family	member	or	shared	Family	level	Event	with	a	specified	Event	Role.

hasrolerule	provided	as	sample	.gpr.py	&	.py	code	for	writing	addon	filter	rules.	Demonstrates	including	category	variants	of	a	rule	in	the
same	addon.
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Source	matching	parameters

Fig.	Addons	(Rules).8	Searching	by	Rule	name

Sources	•	General	filters	addon	rule	to	find	Sources	based	on	the	following	parameters:	Title,	Author,	Abbreviation,	Publication.

This	addon	rule	has	similar	options	to	the	standard	Filter	Gramplet	for	the	Source	Category	View.	It	can	be	used	to	save	complex	filter	parameters.

hassourcefilter	provided	as	sample	.gpr.py	&	.py	code	for	writing	addon	filter	rules.	Demonstrates	text	based	filtering	with	RegEx	options.

People	Separated	less	than	<N>	degrees	of	<Home	person>

Fig.	Addons	(Rules).9	Searching	for	Person	Rules	which	include	the
'degrees'	term.

Person	•	Relationship	filters	addon	rule	to	find	Person(s)	having	a	relationship	to	the	Home	Person	within	a	specified	degree	of	Consanguinity
and	Affinity.

The	Home	person	is	point	of	reference	for	calculating	(<N>)	Degrees.	For	N,	Minimum	value	is	1,	Maximum	is	value	32.

Degree	1:	person/spouse	+	children	(	<zero	N>	ancestors,	because	the	selected	person	is	generation	1	+	1N	descendants)
Degree	2:	person	plus	person’s	parents,	siblings,	niece/nephew,	children,	grandchildren,	etc.	(=	1N	ancestors	+	2N	descendants)
Degree	3:	persons	grandparents	and	3	generations	down.	(=	2N	ancestors	+	3N	descendants).

The	ancestors	and	descendants	generations	have	an	offset	of	1	to	mimic	the	built-in	filter	rule	behavior.	Early	versions	of	this	rule	optionally
included	partners	and	non-primary	parents.	Those	relatives	are	now	always	included.

This	Rule	may	need	to	manually	downloaded	and	installed:	see	the	source	code	files	on	the	GitHub	Repository	

People	Separated	less	than	<N>	degrees	of	<person>
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Fig.	Addons	(Rules).10	Searching	Person	rules	by	'degrees'	term;	roll-
over	hint	for	ID.

Person	•	Relationship	filters	addon	rule	to	find	Person(s)	having	a	relationship	to	a	specified	Person	within	a	specified	degree	of	Consanguinity
and	Affinity.

The	Person	corresponding	to	the	ID	is	the	focal	point	of	reference	for	calculating	(<N>)	Degrees.	For	N,	Minimum	value	is	1,	Maximum	is	value
32.

Degree	1:	person/spouse	+	children	(	<zero	N>	ancestors,	because	the	selected	person	is	generation	1	+	1N	descendants)
Degree	2:	person	plus	person’s	parents,	siblings,	niece/nephew,	children,	grandchildren,	etc.	(=	1N	ancestors	+	2N	descendants)
Degree	3:	persons	grandparents	and	3	generations	down.	(=	2N	ancestors	+	3N	descendants).

The	ancestors	and	descendants	generations	have	an	offset	of	1	to	mimic	the	built-in	filter	rule	behavior.	Early	versions	of	this	rule	optionally
included	partners	and	non-primary	parents.	Those	relatives	are	now	always	included.

Early	versions	of	this	rule	optionally	included	partners	and	non-primary	parents.	Those	relatives	are	now	always	included.	See	the	GitHub
Repository	files

Events	of	families	matching	a	<family	filter>

Events	of	families	matching	a	<family	filter>

Families	matching	<event	filter>

Matches	families	that	are	matched	by	an	event	filter

People	who	are	part	of	families	matching	<filter>

People	who	are	part	of	families	matching	<filter>

Filter	people	by	their	age	at	death

Match	associations	of	<person	filter>

People	with	multiple	parent	records

Person	•	Family	filters	addon	rule	that	matches	people	who	have	more	than	one	set	of	parents.

FilterRules2	:	Plugin	Manager	Rulebook	Collection

Genetic	Genealogy	Filter	Rule	Addons

The	following	rules	are	based	on	the	logical	rules	of	genetics,	not	on	comparing	DNA	data.

Matrilineal	progenitrix	of	<person>

Matches	the	earliest	recorded	matrilineal	ancestor	mother.

Mitochondrial	inheritance	of	<filter>

Matches	recorded	descendants	of	a	filter	result	following	mitochondrial	inheritance	patterns.

Mitochondrial	inheritance	of	<person>

Matches	recorded	descendants	of	person	following	mitochondrial	inheritance	patterns.

Patrilineal	progenitor	of	<person>

Matches	the	earliest	recorded	patrilineal	ancestor	father.

X-chromosomal	ancestors	of	<person>

Matches	ancestors	of	<person>	following	a	X-chromosomal	inheritance	pattern.

X-chromosomal	descendants	of	<person>

Matches	descendants	of	<person>	following	a	X-chromosomal	inheritance	pattern.

Y-chromosomal	inheritance	of	<person	filter>

Matches	recorded	descendants	of	a	filter	result	following	Y-chromosomal	inheritance	patterns.

Y-chromosomal	inheritance	of	<person>
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Matches	recorded	descendants	of	person	following	Y-chromosomal	inheritance	patterns.	

Pre-Release	Rules

Descendants	of	<person>	sharing	yDNA	with	each	other

Matches	descendants	of	a	<person>	sharing	yDNA

The	Evolution	of	of	Rules	as	AddOns

Gramps	5.1.1	(Sept.	2019)

Fix	bug	0011114:	resolve	crashes	in	withinarea	filter	rule:

Avoid	bad	coordinates	in	the	ref	place
Avoid	alphabetic	characters	in	filter	rules
Could	not	convert	string	to	float	by	using	withinarea	filter	rule
Difference	between	sidebar	filter	and	filter	rule
Fix	Bug	0011293	Fix	internationalization	issue	where	untranslated	English	GUI	items	appear	in	Event	filter

Gramps	5.1.0	(Aug.	2019)

New	feature	:	Filter	Rules	can	now	be	expanded	through	the	addons	interface.
Filter	Rule	editor,	save	pane	position
Fix	Bugs	0007950	and	0011430:	Name	Filter	rule	now	supports	multiple	attribute:	Check	all	values	of	an	attribute	type	and	not	only	the	first
one
filters	rule	have	children	person	filter:	Check	all	families	of	a	person	for	children	and	not	only	the	first
Person	Sidebarfilter:

Fix	Person	Sidebarfilter	when	using	‘Event’	and	Reg	expressions
In	personsidebarfilter,	search	on	each	part	of	name	Instead	of	requiring	that	the	entire	search	string	matches	a	single	one	of	the	Person’s
names,	the	function	will	require	that	each	word	in	the	search	string	matches	any	of	the	Person’s	name	fields.

Fix	exception	when	merging	with	active	sidebar	filter

Gramps	5.0.2	(Aug.	2019)

Fix	bug	0010509:	resolves	silent	fail	-	relationship	path	between	filter	rule	when	parent	is	missing
Fix	crash	when	using	sidebar	filter	and	merging	in	another	view
Fix	Place	Tree	view	when	using	enclosed	by	sidebar	filter
Fix	Relationship	Graph;	extra	people	when	using	filters	&	subgraphs

Gramps	5.0.1	(Dec.	2018)

Fix	bug	0010685:	resolves	crash	in	IsDuplicatedAncestorOf	filter	rule	on	tree	loop
Fix	Person	Sidebarfilter	when	using	‘Event’	and	Reg	expressions
Fix	FilterParser	for	much	older	3.x	custom_filters.xml	files
Fix	crash	when	a	filter	with	loop	in	definition	is	defined
Fix	view	so	column	widths	are	preserved	when	using	filters

Gramps	5.0.0	(Jul.	2018)

Fix	Custom	filter	update	when	created	via	sidebar.

Developing	New	Rule	AddOns
Beginning	with	version	5.0,	Gramps	implemented	an	database	API	(application	programming	interface)	infrastructure	supporting	user	selectable
backends.	This	new	exploration	of	database	support	lead	developer	to	extend	the	addon	(plug-in)	framework	to	support	expanding	Filter	Rules	via
the	Plugin	Manager.

The	5.1	release	changed	the	default	database	backend	from	BSDDB	(Berkeley	database)	to	SQLite.	With	the	broader	group	of	user	familiar	with
optimizing	searches,	it	made	sense	to	open	Gramps	to	the	specialized	knowledge.

Resources

Develop	an	Add-on	Rule
Sample	addon	Filter	code

See	also

Built-in	rules	by	category
Git	introduction
Built-in	Rules	Source	code	(Git)
Addon	Rules	Source	code	(Git)
Gtk+	widget	gallery	-	Gnome	development	sample	code
downloadable	.tgz	files	(Git)
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Addons	Development
Writing	a	Plugin
Policy	for	Committing	code	contributions
[Gramps-devel]:	Filter	rules	as	plugins?
[Gramps-users]:	A	question	on	writing	filters
[Gramps-devel]:	New	filter	rules	on	Names
[Gramps-devel]:	Sequencing	of	filter	rules?
[Gramps-devel]:	filter	rules
[Gramps-users]:	Gramplet	writing	-	newbie	help	needed

based	on	the	Gramps-users	archived	threads:

The	Group	As	name	override
unify	similar	surmanes	thread
threads	with	"Group	As	name"
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5.2	Addons

AddRemoveTagTool

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

The	Remove	Tag	Tool	was	enhanced	to	also	Add	tag's	and	renamed	to	the	Add/Remove
Tag	Tool

Add/Remove	Tag	Tool	-	General	options	dialog

The	 Add/Remove	Tag	Tool 	allows	you	to	add	or	remove	one	tag	from	a	selected	set	of	filtered	objects	e.g.	people,	events,	etc.

Usage
Once	this	addon	has	been	installed:

Verify	the	target	Tag	exists	(or	is	created)	before	using	the	Tool.	Use	the	Edit	➡	Tags	▶	Organize	Tags...	menu	command	to	invoke	a	dialog	(to
create	at	tag,	choose	a	tag	color	and	re-order	the	tags)	so	that	the	new	tag	will	be	higher	priority.

Select	Menu	Tools	➡	Family	Tree	Processing	▶	Add/Remove	Tag	Tool...

Undo	history	warning

Proceeding	with	this	tool	will	erase	the	undo	history	for	this	session.	In	particular,	you	will	not	be	able	to
revert	the	changes	made	by	this	tool	or	any	changes	made	prior	to	it.	If	you	think	you	may	want	to	revert
running	this	tool,	please	stop	here	and	backup	your	database.

From	the	Undo	history	warning	dialogue	you	can	choose	 Stop 	or	 Proceed	with	the	tool .

Once	you	have	made	your	choices	which	tag	should	be	removed	from	which	objects,	you	can	either	choose	 Close 	or	 Execute 	to	apply
the	change.

Tabs

General	options	tab
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Add/Remove	Tag	Tool	-	General	options	dialog

The	 General	options 	tab	is	displayed	with	the	following:
Add/Remove	Filter: 	Select	if	you	want	to	add	or	remove	a	tag.
Category	Filter: 	The	category	from	where	you	want	to	add/remove	a	tag	from	e.g.	people.
Tag	Filter: 	The	name	of	the	tag	you	choose	to	add/remove.

Filter	options	tab

Add/Remove	Tag	Tool	-	Filter	options	dialog

The	 Filter	options 	tab	is	displayed	with	the	following	(Each	filter	is	only	select-able	when	the	corresponding	category	is	selected	on
the	General	options	tab):

Person	Filter: 	All	persons	or	a	custom	filter	to	restrict	the	amount	of	persons	where	you	want	to	remove	the	tag	from.
Family	Filter: 	All	families	or	a	custom	filter	to	restrict	the	amount	of	families	where	you	want	to	remove	the	tag	from.
Event	Filter: 	All	events	or	a	custom	filter	to	restrict	the	amount	of	events	where	you	want	to	remove	the	tag	from.
Place	Filter: 	All	places	or	a	custom	filter	to	restrict	the	amount	of	places	where	you	want	to	remove	the	tag	from.
Source	Filter: 	All	sources	or	a	custom	filter	to	restrict	the	amount	of	sources	where	you	want	to	remove	the	tag	from.
Citation	Filter: 	All	citations	or	a	custom	filter	to	restrict	the	amount	of	citations	where	you	want	to	remove	the	tag	from.
Repository	Filter: 	All	repositories	or	a	custom	filter	to	restrict	the	amount	of	repositories	where	you	want	to	remove	the	tag
from.
Media	Filter: 	All	media	or	a	custom	filter	to	restrict	the	amount	of	media	where	you	want	to	remove	the	tag	from.
Note	Filter: 	All	notes	or	a	custom	filter	to	restrict	the	amount	of	notes	where	you	want	to	remove	the	tag	from.

Issues
No	help	link	to	this	page.

See	also
Tagging
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5.2	Addons

All	Names	Quickview

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

All	Names	of	All	People	-	Quickview	-	results	window

The	 All	Names	of	All	People 	-	Quickview	shows:

All	names	of	all	people
The	associated	primary	name
The	type	of	name

These	events	are	sorted	by	name,	but	can	be	sorted	by	any	column	by	clicking	the	column	header.

You	can	activate	the	Quickview	by	right-clicking	on	a	person's	name	in	the	 People	Category	View,	and	selecting	"Quick	View",	and	"All	Names	of
All	People".

Gramplet
You	can	also	use	the	Quickview	as	a	Gramplet:

1.	 select	the	Dashboard	Category	View
2.	 right-click	in	an	open	area,	and	select	"Add	a	gramplet"
3.	 left-click	on	"Quick	View"	Gramplet"
4.	 Select	"Configure	the	active	view"	from	the	toolbar	and	then	select	the	"Quick	View"	tab
5.	 Select	View	Type:	"Person",	and	select	the	appropriate	Quick	View,	and	press	"Save"
6.	 Close	the	"Configure	the	active	view"	dialog

Functionality
Double-click	a	row	in	the	Quickview	to	bring	up	a	dialog	showing	the	person	associated	with	the	name.

Issues
Quickview	dashboard	link	does	not	work.
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5.2	Addons

AncestorsMap

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

View	does	not	display	places	without	coordinates

Note	that,	like	all	 Geography	View	modes,	ONLY	the	Places	with	a	defined	Longitude	&	Latitude	will
be	plotted.

Ancestors	Map	Geography	view

This	 Geography	Category	addon	view	mode	plots	tagged	pins	on	a	Map	at	the	Places	associated	with	Ancestors	of	the	Home	Person.

Ancestors	Map	is	an	interactive	 	 Geography 	category	view	addon	that	overlays	pins	for	certain	known	Places	on	downloaded	Map	tiles.

Usage
Navigate	the	Active	Person	selection	before	changing	to	the	Geography	Category	view	to	map	the	Event	Places	associated	with	a	different	Person's
Ancestors.

An	interaction	in	the	1.0.3	version	of	the	Addon	with	the	Relationship	view	may	cause	the	Map	to	fail	to	focus	on	a	new	Active	Person.	Use	the
Person	View	or	Bookmarks	to	navigate	this	selection	to	a	different	person.

There	are	4	pin	types:
Still	looking	for	correct	pins.	This	map	use	left-handed	versions	of	the	normally	right-handed	magnifying	glass.

Pin Description Place	types

Zoom-in	Magnifying	glass Places	with	Birth	Events

Zoom-out	Magnifying	glass Places	with	Death	Events

Magnifying	glass	pins	with	an	X Places	with	Marriage	Events

Green	Push	pins Places	with	multiple	Event	types

Right-click	on	a	map	pin	to	reveal	a	pop-up	menu	listing	the	Events	&	People	at	that	Place.

⚙	Configuration	Options
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Fig.	.1	Configure	Geography	-	"The	map"	tab

The	Ancestors	Map	has	the	standard	Map	configuration	options.

See	the	Geography	view	introduction	to	using	maps.	

Troubleshooting
Places	of	Ancestor	Events	that	do	not	appear	as	pins	on	the	map	are	probably	missing	the	correct	GPS	longitude	and/or	longitude.	Determining
which	Places	are	missing	and	need	correction	can	be	finicky	work.	This	is	most	easily	done	with	custom	filters...	but	it	takes	multiple	stages.

The	objective	is	to	find	the	Places	of	Events	of	Ancestors	of	the	Home	Person.	That's	4	stages	of	filtering.

You	can	set	up	a	multi-stage	of	filter	that	shows	only	Places	for	Ancestors	&	configure	the	Places	Category	view	to	show	the	Longitude	&	Latitude
columns.	This	will	tell	you	how	many	of	Ancestor	related	Places	will	be	omitted	from	being	plotted	on	the	map.

For	this	multi-stage	custom	filter,	create	the	following	Cascade	of	custom	filters:

1.	 Create	a	Person	custom	Filter	"ActivePerson"	using	the	"Active	Person"	addon	Person	General	rule.
2.	 Person	custom	Filter	"ActiveAncestors"	using	Ancestral	filter	"Ancestors	of	<filter>	match";	filter=ActivePerson	

You	might	add	a	2nd	rule	to	include	the	Active	Person	and	then	select	the	"At	least	one	rule	must	apply"	option.	Otherwise,	the	Events	&
Places	of	the	Active	Person	might	be	omitted

3.	 Events	custom	Filter	"ActiveAncestorEvents"	using	Events	General	filter	"Events	of	persons	matching	the	<person	filter>";	person
filter=ActiveAncestors

4.	 Places	custom	Filter	"ActiveAncestorEventPlaces"	using	Places	General	filter	"Places	of	events	matching	the	<event	filter>";	event
filter=ActiveAncestorEvents

Making	Filters	that	are	more	reusable

You	could	built	this	using	a	Person	custom	filter	set	to	the	built-in	Default	Person	(a.k.a.	Home	Person)
General	rule.	That	would	more	directly	correspond	to	this	addon	Geography	view	mode.

But	a	custom	Filter	using	the	"Active	Person"	addon	Person	General	rule	is	much	more	flexible.	It	stays
synchronized	to	the	Person	being	edited	instead	of	continually	resetting	the	Home	Person	designation	or
editing	a	rule	that	had	been	preset	to	a	specific	PersonID.

Download	and	use	the	incredibly	useful	addon	Person	General	Rule	that	was	created	in	early	2020.	It
replaces	the	awkward	PersonID	based	rules	and	makes	Custom	Filters	MUCH	more	dynamic.	Thanks
Paul!

Credits
Shared	by	Serge	Noiraud

Errata
Bug	Report	0011681:	[Ancestors	Map]	view	mode	re-initializing	incorrectly	(1.0.3	Addon	version)
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5.2	Addons

AttachSourceTool

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Attach	Source	Tool	-	Options	(defaults)	-	dialog

The	 Attach	Source 	Tool	allows	you	to	add	a	new	or	existing	sources	to	the	entire	database	or	selected	set	of	filtered	people.

Usage
Once	this	addon	has	been	installed
Select	Menu	Tools	>	Family	Tree	Processing	->	Attach	Source...

Undo	history	warning

Proceeding	with	this	tool	will	erase	the	undo	history	for	this	session.	In	particular,	you	will	not	be	able	to
revert	the	changes	made	by	this	tool	or	any	changes	made	prior	to	it.	If	you	think	you	may	want	to	revert
running	this	tool,	please	stop	here	and	backup	your	database.

From	the	Undo	history	warning	dialog	you	can	choose	 Stop 	or	 Proceed	with	the	tool .

The	 Options 	tab	is	displayed	with	the	following:
Person	Filter: 	Entire	Database(default)
Filter	Person: 	defaults	to	the	Active	Person.
Source	type: 	New	source(default),	or	Existing	source.
New	Source	Title: 	Empty	textbox	by	default,	that	you	can	type	your	source	details	into.
Existing	Source	ID: 	Empty	textbox	by	default,	that	you	can	type	in	the	number	of	an	existing	source.

Once	you	have	made	your	choices	for	the	source	to	be	attached	you	can	either	choose	 Close 	or	 Execute 	to	apply	the	change.

After	the	change	has	been	made	the	 Results 	tab	will	become	available	where	you	can	change	and	examine	the	final	results.

Once	finished	select	 Close .	

Issues
Missing	a	Help	button	pointing	to	this	page	???
Fixed	"Results"	tab	that	does	not	expand	as	dialog	is	maximized.???
Selecting	"Execute"	a	second	time	with	no	changes	creates	a	duplicate	source	for	"New	Source"	,	probably	should	give	a	warning.	???

Future	plans

Add	attach	source	to	multiple	events	using	the	AttachSourceTool	4257
Add	sources	to	types	of	objects	other	than	people	(media,	events,	etc)	???
Be	able	to	reverse/undo	a	run	or	provide	a	dry	run	option	that	shows	the	results	of	what	would	be	changed	???
Add	a	method	to	select	the	source	ID	from	a	popup	dialog	???
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5.2	Addons

AvatarGenerator

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Before	and	After	Example	from	Addon:Graph	View	after	using
Avatar	Generator	Tool

The	 Avatar	Generator	Tool 	allows	you	to	add	and	remove	one	or	several	images	for	a	selected	set	of	filtered	people.	

Usage
Once	this	addon	has	been	installed:

Select	Menu	Tools	>	Family	Tree	Processing	->	Avatar	Generator	Tool...

Undo	history	warning

Proceeding	with	this	tool	will	erase	the	undo	history	for	this	session.	In	particular,	you	will	not	be	able	to
revert	the	changes	made	by	this	tool	or	any	changes	made	prior	to	it.	If	you	think	you	may	want	to	revert
running	this	tool,	please	stop	here	and	backup	your	database.

From	the	Undo	history	warning	dialogue	you	can	choose	 Stop 	or	 Proceed	with	the	tool .

Avatar	Generator	Tool	-	Options	dialogue

The	 Options 	tab	is	displayed	with	the	following:
Category: 	-	Filter	single	image	mode	or	male/female/unknown
Unknown: 	-	Image	selection	used	for	all	people	with	option	single	image	mode	or	people	with	unknown	gender	with	option
male/female/unknown
Male: 	-	Image	selection	for	males	(only	used	with	option	male/female/unknown)
Female: 	-	Image	selection	for	females	(only	used	with	option	male/female/unknown)
Person	Filter: 	-	Entire	Database(default)
Center	Person: 	defaults	to	the	Active	Person.

[	]	Remove	images	from	people: 	False	(default)	checkbox.

Once	you	have	made	your	choices	the	image	or	images	that	should	be	attached	as	avatar	images,	you	can	either	choose	 Close 	or	 Execute 	to
apply	the	change.
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Tips
Predefined	person	filters	like	'whole	database'	or	'ancestors	of	person	X'	as	well	as	custom	person	filters	like	'persons	with	tag	Y'	are	used	for
filtering.	By	filtering	different	person	groups	or	ancestor	lines	via	person	filters,	it	is	possible	to	add	different	images	to	different	lines	of	your
ancestor	tree.	Please	note	that	the	Avatar	Generator	Tool	only	adds	images	to	persons	without	media	references	within	a	selected	group	of	people.
Persons	who	already	have	media	references	are	ignored.

Furthermore,	it	is	possible	to	remove	images	from	a	group	of	filtered	persons.	In	order	to	do	so,	the	Avatar	Generator	Tool	searches	through	the
selected	list	of	filtered	people	and	removes	the	chosen	image	or	images.

See	also
[GraphView]	add	custom	avatars	#459
Themed	avatar	discussion
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5.2	Addons

Biography	Quickview

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Biography	quickview

The	 Biography	Quickview 	shows	a	basic	Biography	based	on	the	Events	of	the	first	selected	Person	in	your	Family	Tree.

The	name,	date,	and	place	formats	are	controlled	from	the	Display	tab	of	the	Preferences.

The	biography	text	is	is	based	on	the	parents	plus	the	dates	and	places	of	the	following	events	with	their	sources:

Birth
Baptism
Christening
Marriage
Death
Burial

Example

Biography	for	Garner	von	Zieliński,	Lewis	Anderson	Sr

Anderson	was	born	on	21	Jun	1855	in	Great	Falls,	MT,	USA.
Anderson	was	the	son	of	Garner,	Robert	W.	and	Zieliński,	Phoebe	Emily.

He	married	Martel,	Luella	Jacques	on	1	Apr	1875	in	Paragould,	Greene,	AR,	USA.

He	died	on	28	Jun	1911	in	Twin	Falls,	Twin	Falls,	ID,	USA	at	the	age	of	56	years,	7	days.	
He	was	buried	on	1	Jul	1911	in	Twin	Falls,	Twin	Falls,	ID,	USA.

Sources

Priests	of	Great	Falls	Church	1850	-	1867,	Baptize	registry	1850	-	1867	Great	Falls	Church	
-
All	possible	citations	-	page	17

Usage
You	can	activate	the	Quick	View	by	right-clicking	on	a	person's	name	in	the	 People	Category	View.	Then	select	Quick	View	>	Biography.

Tips
Quick	Views	can	also	be	used	within	the	Quick	View	shell	Gramplet.

Biography	Quickview 41

http://www.gramps-project.org/wiki/index.php/File:Gramps-notes.png
http://www.gramps-project.org/wiki/index.php/Third-party_Addons
http://www.gramps-project.org/wiki/index.php/How_to_make_a_backup
http://www.gramps-project.org/wiki/index.php/Using_the_bug_tracker
https://github.com/gramps-project/gramps/blob/master/README.md#the-following-packages-are-optional
http://www.gramps-project.org/wiki/index.php/Gramps_5.2_Wiki_Manual_-_Plugin_Manager
http://www.gramps-project.org/wiki/index.php/File:Biography-Quickview-addon-example-51.png
http://www.gramps-project.org/wiki/index.php/Gramps_5.2_Wiki_Manual_-_Settings#Display_Name_Editor
http://www.gramps-project.org/wiki/index.php/Gramps_5.2_Wiki_Manual_-_Settings#Place_Format_Editor
http://www.gramps-project.org/wiki/index.php/Gramps_5.1_Wiki_Manual_-_Settings#Display
http://www.gramps-project.org/wiki/index.php/File:Tango-Dialog-information.png
http://www.gramps-project.org/wiki/index.php/Gramps_5.2_Wiki_Manual_-_Categories#People_Category
http://www.gramps-project.org/wiki/index.php/Gramps_5.2_Wiki_Manual_-_Gramplets#Quick_View


5.2	Addons

BirthOrderTool

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Sort	Children	in	Birth	order	-	Tool	-	example	window

The	 Sort	Children	in	Birth	order 	tool	searches	your	database	for	families	that	have	children	which	are	not	listed	in	the	order	of	their
births	and	assists	in	ordering	them.	Allows	bulk	updates	of	the	children	order.

Usage
Once	this	addon	has	been	installed
Select	Menu	Tools	->	Family	Tree	Processing	->	Sort	Children	in	Birth	order...

Warning

Proceeding	with	this	tool	may	make	unexpected	changes	to	your	data.	While	it	is	possible	to	Undo	the
changes	made	by	this	tool,	it	may	be	easier	to	recover	from	a	backup.

When	the	tool	starts,	it	scans	you	data	for	families	that	need	sorting.	A	progress	bar	appears	so	that	with	large	databases	Gramps	doesn't	seem
to	be	frozen.	This	does	not	make	any	changes	to	your	data,	and	only	performs	the	search	and	fills	the	panes	if	unsorted	families	are	found.
Families	with	children	in	birth	order	are	not	shown.	If	some	children	in	a	family	don't	have	valid	birth	dates,	but	others	are	in	order,	the	family
is	not	shown.
At	this	point	the	tool	window	with	three	main	panes	and	some	buttons	should	be	visible.

The	top	pane	will	contain	a	list	of	the	results	of	the	search.	If	nothing	appears	here,	then	none	of	your	families	have	unsorted	children.
Selecting	a	family	from	this	list	updates	the	data	in	the	lower	panes.	It	is	also	possible	to	sort	this	list	for	ID,	Father,	or	Mother,	using
the	header	of	the	list.
The	 Current	Sort 	pane	(lower	left	side)	will	show	the	original	unmodified	list	of	children	with	their	birth	dates,	if	any.	This	cannot
be	changed.
The	 Proposed	Sort 	pane	(lower	right	side)	will	show	the	proposed	changes	to	the	children	sort.	If	the	user	wants	to	make
additional	changes,	they	can	be	made	directly	in	the	pane.	Adjusting	the	sort	manually	can	be	done	by	selecting	a	child	and	using	either
the	 Up 	or	 Down 	buttons	below	the	pane.	When	you	are	satisfied	with	the	changes,	if	any,	you	can	use	the	 Accept 	button	to	save
the	proposed	sort	order	to	the	database.

Many	times,	the	user	will	not	feel	a	need	to	make	manual	changes,	the	proposed	sort	order	if	acceptable.	The	tool	offers	two	buttons	that
allow	the	user	to	accept	some	or	all	of	the	listed	families.

The	 Accept	All	* 	button	will	accept	all	the	families	that	have	a	'*'	(Asterisk)	next	to	them.	In	these	families	all	the	children	have
valid	birth	dates	so	that	sorting	can	be	done	unambiguously.	When	this	button	is	used,	a	progress	bar	appears	so	that	with	large
databases	Gramps	doesn't	seem	to	be	frozen.
The	 Accept	All 	button	will	accept	all	the	families,	even	those	with	some	missing	or	invalid	birth	dates.	In	these	cases,	the	sorted
results	is	the	same	as	shown	in	the	lower	right	'Proposed	sort'	pane.	That	is,	children	with	invalid	or	missing	birth	dates	will	be	sorted
first,	followed	by	those	with	valid	dates.	When	this	button	is	used,	a	progress	bar	appears	so	that	with	large	databases	Gramps	doesn't
seem	to	be	frozen.

If	you	do	not	want	any	changes	to	be	made	to	your	data,	or	you	are	done	with	the	tool,	you	can	simply	press	the	 Done 	button.
The	 Help 	button	will	bring	up	this	page.
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Some	Notes
When	changes	are	accepted,	they	appear	in	the	'Undo'	list	Edit	->	Undo	History...	where	they	can	be	undone.	They	can	also	be	undone
individually	via	Edit	->	Undo.	Changes	from	the	 Accept 	button	are	listed	individually	as	'Edit	Family',	those	from	the	 Accept	All 	or
Accept	All	* 	buttons	are	listed	as	'Edit	families'	in	the	undo	list.

See	also
How	do	I	change	the	order	of	children?	Use:

The	Family	Editor	Children	tab	to	change	the	order	of	children	in	the	family.
This	third	party	addon	Birth	Order	Tool	which	allows	bulk	updates	of	the	children	order.

Issues
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5.2	Addons

BirthdaysGramplet

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Birthdays	Gramplet	-	results	window	(with	Configure	dialog	tab
showing)	-	detached	view

This	 Birthdays 	Gramplet	displays	the	upcoming	birthdays	based	around	the	current	date.

Only	the	people	who	are	calculated	by	Gramps	as	 probably	alive	are	displayed.

You	may	also	configure	the	Gramplet	to	either,	ignore	or	show	one	selected	Tag.
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5.2	Addons

Calculate	Estimated	Dates

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Calculate	Estimated	Dates	-	Help(	tab	)	Initial
window	on	start.

The	 Calculate	Estimated	Dates 	tool	Addon	is	used	to	add	and	remove	birth	and	death	events	for	people	that	are	missing	these	events.

Usage
You	can	select	the	tool	via	the	menu	Tools->Family	Tree	Processing-->Calculate	Estimated	Dates...	this	brings	up	a	 Undo	history
warning 	window:

Undo	history

Proceeding	with	this	tool	will	erase	the	undo	history	for	this	session.	In	particular,	you	will	not	be	able	to
revert	the	changes	made	by	this	tool	or	any	changes	made	prior	to	it.	If	you	think	you	may	want	to	revert
running	this	tool,	please	stop	here	and	backup	your	database.

You	then	choose	 Stop 	or	 Proceed	with	the	tool .

Help

Calculate	Estimated	Dates	-	Help(	tab	)	Initial	window	on	start.

You	will	be	presented	with	the	Calculate	Estimated	Dates	tool	window.	This	window	initially	has	two	tabs:

Options 	tab	and	the
Help 	tab	that	is	displayed	with	the	following	instructions.

To	use
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1.	 Go	to	the	 Options 	tab
2.	 Check	the	[	]	Remove	option	to	remove	previous	estimates
3.	 Select	the	Add	date	options	to	date	events	with	or	without	dates
4.	 Click	on	 Execute
5.	 Select 	the	people	with	which	to	add	events
6.	 Click	on	 Add	Selected	Events 	button	to	create

Note

If	you	decide	to	make	an	event	permanent,	remove	it	from	the	Source.	Otherwise,	it	will	get	removed	the
next	time	you	automatically	remove	these	events.

Note

You	may	have	to	run	the	tool	repeatedly	(without	removing	previous	events)	to	add	all	of	the	events
possible.

Select

Calculate	Estimated	Dates	-	Select(	tab	-	showing	processed	results)

On	the	 Select 	tab	you	will	see	the	processed	results	if	any.

You	can	individually	select	the	checkbox(s)	beside	the	people	or	 Select	All 	and	then	click	on	 Add	Selected	Events 	button	to	create	the
new	events	shown.

Options

Select	the	Options	tab

Calculate	Estimated	Dates	-	Options(	tab	-	defaults)

Filter: 	in	the	drop	down	menu	you	can	select	which	portion	of	the	database	will	be	processed:	you	can	also	select	the
Entire	database(default)
Descendants	of	the	Active	Person
Descendant	families	of	the	Active	Person
Ancestors	of	the	Active	Person
People	with	common	ancestor	with	the	Active	Person
or	any	custom	filter	(see	custom	made	filters).

Filter	Person: 	the	Active	Person	is	listed	in	this	field,	and	is	changeable	for	all	filters	except	the	Entire	databasefilter.	To	change	the
Filter	person	click	on	the	 Select	a	different	person 	icon	to	bring	up	a	 Select	a	person	for	the	report 	window.
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The	Select	a	person	for	the	report	window	shows	a	list	of	people	you	can	choose	from.	Use	the	 down 	arrow	or	the	 > 	arrow	to	expand
and	collapse	the	nodes.	In	the	table	you	will	see	for	which	persons	no	birth	or	death	date	is	available.	On	the	lower	left	hand	side	corner	there
is	a	 Show	all 	tick	box,	that	when	selected	will	show	all	people	in	the	database.

Source	text: 	in	this	 text	field 	you	can	fill	in	the	text	that	will	be	used	in	the	source	reference.	Default	value	is:	Calculated	Date
Estimates.

Remove	previously	added	events,	notes,	and	source:	Check	box	(unchecked	by	default)
Birth: 	drop	down	list.

Do	not	add	birth	events	(default)
Add	birth	events	without	dates
Add	birth	events	with	dates

Death:
Do	not	add	death	events	(default)
Add	death	events	without	dates
Add	death	events	with	dates

Maximum	age: 	110(default)
Maximum	sibling	age	difference: 	20(default)
Average	years	between	generations: 	20(default)
Estimated	Dates:

Approximate(about):(default)
Extremes(after	and	before)

See	also
Gramps_5.2_Wiki_Manual_-_Settings#Limits	for	Date	settings	used	for	calculation	operations	to	determine	if	a	person	is	probably	alive.
I	don't	know	the	exact	date	to	enter	into	Family	Tree	-	If	you	do	not	know	an	exact	date,	you	can	either	enter	as	much	of	the	date	as	you	know
or	estimate	a	year	based	on	other	information.,	-	FamilySearch.org
Estimating	dates	and	ages	in	genealogical	writing,	New	York	Genealogical	&	Biographical	Society

Issues
No	 Help 	button.
2241	Calculate	Estimated	Dates	function	needs	improvement	in	selecting	which	dates	fields	to	estimate
2243	Calculate	Estimated	Dates	keyed	on	birth	and	Life	Expectancy	Table	lookup
7448	Calculation	of	estimated	ranges	-	not	very	good
7898	Crash	during	"Calculated	Estimated	Dates"	gramplet
9147	Add	Option	to	not	Calculate	Estimated	Dates	for	baptisms	and	burials

Note	that	 Calculate	Estimated	Dates 	was	originally	builtin/part	of	Gramps	3.1

see	Gramps_3.1_Wiki_Manual_-_Tools#Calculate_Estimated_Dates
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5.2	Addons

Collections	Clipboard	Gramplet

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Collections	Clipboard	Gramplet	-	detached	-	example

The	 Collections	Clipboard	Gramplet 	is	similar	to	the	built-in	Clipboard	except	that	it	provides	a	way	to	create	collections	of	objects
which	are	persistent	over	time.

You	can	watch	an	older	version	of	the	Clipboard	Gramplet	in	action(Created:2010/07/29).

Usage
You	can	select	multiple	items	from	any	of	the	Category	list	views	and	drag	and	drop	them	onto	the	Collections	Clipboard	Gramplet.

To	delete	entries,	select	them	and	press	the	delete	key.

Double-click	selections	to	bring	up	the	object	editor.

Select	one	(or	more)	items,	and	then	right-click	gives	the	following	context	popup	menu	options:

See	Item	details 	-	will	show	the	first	selected	item	in	an	editor
Make	Item	active 	-	will	make	the	first	selected	item	active	in	the	item	view
Create	Filter	from	selected	Items 	-	will	turn	all	of	the	selected	items	(which	are	of	the	same	type	as	the	first	selected	item)	into	a
filter

Collections	Clipboards	will	remain	persistent	between	sessions,	and	you	can	mix	items	from	different	databases.	However,	you	can't	drag
and	drop	items	from	one	database	into	another.

There	are	several	Collections	Clipboard	objects	that	are	entirely	self-contained.	These	may	be	dropped	indiscriminately	into	any	database:

Text
URL	-	Internet	addresses.	Including:	eMail,	ftp,	website
Address	-	full	postal	addresses	with	phone	numbers
Attribute	-	custom	attributes

You	can	sort	the	columns	(type,	title,	and	value)	of	the	gramplet.

Multiple	Collections	Clipboards
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Collections	Clipboard	Dashboard	Gramplet	-	renaming	and	detaching

You	can	add	as	many	Collections	Clipboards	gramplets	as	desired	to	the	Dashboard.	A	single	instance	can	be	attached	to	each	of	the	Gramplet
splitbars	(sidebar	and	bottombar	in	the	View	menu)	in	the	other	view	Categories.	Each	instance	will	have	a	separate	collection	of	associated	objects.

Clicking	on	the	title	of	a	docked	Dashboard	gramplet	allows	renaming	the	instance	to	something	more	meaningful.	(Gramplets	in	Sidebars	and
bottombars	cannot	be	renamed.)	The	names	of	undocked	gramplets	will	be	shown	in	the	Windows	menu.

See	also
Using	the	Clipboard	-	The	built	in	Clipboard	whose	storage	is	persistent	only	within	a	single	Gramps	session.	Closing	the	window	will	not
lose	the	stored	records.	However,	exiting	Gramps	will.
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This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

5.2	Addons

CombinedView

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Combined	View	-	addon	-	In	action	showing

The	Combined	View	is	a	 Relationships 	category	view	addon	that	shows	relationships	and	events	for	a	person.	It	is	similar	to	the	built-in
Relationships	View	that	gives	an	overview	of	how	records	relate	to	each	other	within	the	context	of	a	specific	person	...	but	on	steroids.

This	view	is	intentionally	'read	only'	with	no	editing	controls.

Usage

From	the	 	 Relationships 	category	view	select	the	Combined	icon	(Identical	icon	to	the	Relationships	view	unfortunately!)	or	select	View	>
Combined	from	the	menu.

Relationships	tab
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Relationships	(Default)	tab	

Events	tab

Album	tab

Shows	gallery	of	associated	images.

Timeline	tab
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Associations	tab

Configure	Options

Layout	tab

Person	tab

See	also
New	experimental	combined	view	2020-04-15	-	initial	announcement	by	Nick	Hall
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Issues
See	issues	tagged	CombinedView
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5.2	Addons

D3	Ancestral	and	Descendant	Charts

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

The	D3	Ancestral	and	Descendant	Charts	addon	consists	of	three(3)	Web	based	reports:

Ancestral	Collapsible	Tree
Ancestral	Fan	Chart
Descendant	Indented	Tree .

Each	chart	used	the	D3.js	library	for	its	layout	which	are	SVG	based	and	provide	some	really	nice	inter-activeness	and	animation.

Note	the	filtering	is	based	off	the	text	based	Ancestry	and	Descendant	Reports.

All	of	the	reports	generate	JSON	for	ancestry/descendant's	and	could	be	easily	customized	for	other	usage.

Usage

Ancestral	Collapsible	Tree

Ancestral	Collapsible	Tree	-	example	output

This	report	is	available	under	the	menu	Reports	>	Web	Pages	>	Ancestral	Collapsible	Tree...

A	graphical	representation	of	ancestry	for	a	given	individual.

By	default	up	to	Great	Grandparents	are	displayed.

Clicking	on	an	ancestor	whom	has	further	ancestors	will	either	collapse	or	expand	all	ancestors	for	that	person.

Specific	customizable	colors	indicate	whether	there	are	further	ancestors	for	a	given	person,	and	can	be	specified	for	maternal	and	paternal	lines.

Ancestral	Fan	Chart
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Ancestral	Fan	Chart	-	example	output

This	report	is	available	under	the	menu	Reports	>	Web	Pages	>	Ancestral	Fan	Chart...

The	Ancestral	Fan	Chart	report	illustrates	an	individuals	ancestry	by	means	of	a	full	circle	fan	chart.

The	initial	display	shows	the	filtered	individual	at	the	center	of	the	fan	chart.

Selecting	individuals	on	the	fan	chart	will	result	in	that	individual	becoming	the	center	person	and	a	new	fan	chart	is	drawn	dynamically	indicating
that	persons	ancestry.

Continuous	selection	of	the	center	of	the	fan	chart	will	eventually	return	you	to	the	original	filter	person,	a	page	reload	will	also	do	this.

Custom	colors	can	be	provided	for	paternal	and	maternal	sides	of	the	filtered	person.

Descendant	Indented	Tree

Descendant	Indented	Tree	-	example	output

This	report	is	available	under	the	menu	Reports	>	Web	Pages	>	Descendant	Indented	Tree...

The	Descendant	Indented	Tree	report	is	a	graphical	representation	of	the	text	based	Descendant	Report.

When	clicking	on	a	person	if	that	person	has	further	descendants,	then	the	tree	will	dynamically	expand	or	collapse	depending	on	its	current	state.

As	with	the	other	reports	some	customizable	colors	can	be	specified	at	generation	time.	In	this	report	they	pertain	to	whether	there	are	more
descendants	to	view	or	not.

Issues
Charts	appear	without	content	-	related	to	a	security	vulnerability	update	to	Browsers.	(i.e.	local	HTML	files	ought	not	to	be	authorized	to
open	files	from	different	sub-directories)	This	shouldn't	be	a	problem	once	the	files	are	uploaded	to	a	server.	It	is	just	local	mode	that	is
affected.	Workarounds	for	local	mode	available	for:

set	Firefox	in	about:config
before	Firefox	95	:	privacy.file_unique_origin	flag	to	false
starting	with	Firefox	95	:	security.fileuri.strict_origin_policy	to	false

Chrome	launch	flags:

C:\Program	Files	(x86)\Google\Chrome\Application\chrome.exe"	--allow-file-access-from-files	--allow-file-access	--allow-cross-origin-auth-prompt

Help	buttons	URL's	on	report	dialogs	do	not	lead	here.
9602:	Descendant	Indented	Tree	doesn't	work	with	Chromium	browser
11800:	D3	Chart	update	of	d3.js	and	jquery	libraries	to	newer	versions
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Uses	D3.js	version	3.4.5	(and	not	the	current	release)
Uses	jquery	v1.10.2	and	2.0.3	which	are	no	longer	supported	or	patched
Uses	jquery-ui	v1.10.4	which	is	also	outdated

Does	not	work	with	MS-IE	11?[1]

If	anyone	is	still	facing	the	problem	[with	MS-IE	11]	here	is	the	solution:

Add	this	2	lines	to	your	html	file.

<meta	http-equiv="X-UA-Compatible"	content="IE=edge"	/>

If	not	IE	doesn't	understand	the	property	CSSStyleDeclaration	in	your	d3.js	file.

See	Also
Web	Solutions	for	Gramps
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5.2	Addons

DNASegmentMapGramplet

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Undocked	 DNA	Segment	Map	Gramplet 	with	the	HighContrast
theme

The	 DNA	Segment	Map	Gramplet 	shows	a	graph.

Usage
The	purpose	of	this	gramplet	is	to	view	DNA	segment	data	for	the	active	user	and	a	set	of	associated	users.	Once	the	user	has	done	an	autosomal
DNA	test	and	uploaded	their	data	to	one	of	the	vendors	(GEDmatch	or	FamilyTreeDNA,	for	example),	the	vendor	can	calculate	the	shared	DNA
segments	with	others	in	their	system.	These	list	of	people	with	their	shared	segments	are	input	to	this	gramplet	for	visualization.

Each	person	with	shared	segments	will	be	a	separate	Association.	The	Notes	in	the	Association	should	contain	the	shared	segment	info	as	calculated
by	the	vendor.

There	are	two	views	for	this	gramplet.	The	default	view	is	all	of	the	chromosomes	with	all	of	the	segments,	painted	in	the	order	of	the	Association.
The	second	view	is	a	detailed	view	of	a	single	chromosome,	with	each	associated	person	having	a	separate	row.	The	user	clicks	on	the	chromosome
label	(y-axis)	to	switch	to	the	detailed	view	and	clicks	on	the	background	to	return	to	the	default	view.

You	can	install	the	 DNA	Segment	Map	Gramplet 	on	the	bottombar	of	one	of	the	people	or	relationship	category	list	views.

Create	a	DNA	Association

To	specify	shared	DNA	segments	between	2	people,

Create	an	Association	for	one	person	(Person	A)	with	another	Person	(Person	B)	of	the	type	DNA.
Add	a	Citation	to	the	Association	to	reference	the	vendor	which	provided	the	segment	info.	This	is	not	used	by	the	gramplet,	but	is	useful
since	different	vendors	will	produce	slightly	different	segment	info.	And	some	Associated	Persons	might	have	data	from	multiple	vendors.	In
these	cases,	having	a	second	Association	is	useful.
Create	a	Note	in	the	Association	or	attached	to	a	Citation	in	the	Association	with	the	shared	DNA	segment	data.

The	format	of	the	Note	is	a	comma	separated	list	or	a	tab	separated	list	in	the	order:	Chromosome	Number,	Start	Segment,	End
Segment,	shared	length	in	centiMorgans	(cMs),	SNP	(optional),	M	or	P	or	U	(unknown)	to	override	the	Maternal
Paternal	chromosome	as	determined	by	the	closest	genetic	connection	in	the	tree	(optional).	.
For	Example:	3,56950055,64247327,10.9,1404	Which	means;	Chromosome	Number:	3,	Start	Segment:	56950055,	End	Segment:
64247327,	shared	length	in	cMs:	10.9,	matching	SNPs:	1404
Valid	entries	for	each	are:

Chromosome	Number
number	between	1-22	or	X

Start	Segment
The	starting	number	for	the	segment	location.

End	Segment
The	ending	number	for	the	segment	location.

Shared	length	in	cMs
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The	Genetic	Distance	(otherwise	known	as	the	number	of	centiMorgans)	in	the	segment.

SNP
optional	field	of	the	matching	SNPs	(Single	Nucleotide	Polymorphism)	in	the	segment.

M/P	flag
optional	field	to	override	the	Maternal	or	Paternal	or	Unknown	chromosome.	Valid	entries	are	M	or	P	or	U.	Any	other	data	is	ignored

Getting	the	chromosome	data

Sites	like	GEDmatch	make	this	shared	chromosome	data	available.	Direct	copy	from	the	GEDmatch	results	page	(with	header	and	tab	separators)
will	work.	There	can	be	additional	Associations	between	Person	A	and	Person	C	(et	cetera)	as	known.

DNApainter	provides	a	description	of	how	to	get	the	chromosome	data	from	many	of	the	common	sites.

Add	the	kit	number	or	other	unique	info	as	an	Attribute	to	the	Associated	Person.	For	example,	create	an	Attribute	'GEDmatch	kit'	to	contain	the
GEDmatch	kit	number.	Or	'DNAkit'	for	the	FTDNA	kit	number.	These	are	not	used	by	the	gramplet	but	good	for	reference.

The	sites	that	have	DNA	segment	data	and	formats	are	covered	below.

FamilyTreeDNA

FamilyTreeDNA	provides	a	download	CSV	file.	Sample	format	starting	at	field	2	is	set	for	copy	into	this	gramplet.

Match	Name,Chromosome,Start	Location,End	Location,Centimorgans,Matching	SNPs
MATCH	NAME,	1,191870504,201977600,9.505878,2391

GEDmatch

GEDmatch	provides	a	cut-paste	option	for	data.	The	format	is	set	for	copy	into	this	gramplet.	The	gramplet	will	accept	either	comma	or	period	as
the	thousands	separator.

Chr B37	Start	Pos'n B37	End	Pos'n Centimorgans	(cM) SNPs Segment	threshold Bunch	limit SNP	Density	Ratio
6 67,249,077 91,039,808 15.6 978 191 114 0.1

MyHeritage

MyHeritage	provides	a	download	CSV.	The	fields	need	to	be	adjusted	(remove	the	1st,	2nd,	6th	and	7th	fields).

<U+FEFF>Name,Match	Name,Chromosome,Start	Location,End	Location,Start	RSID,End	RSID,Centimorgans,SNPs
User	Name,Match	Name,2,172775482,208500311,rs116868713,rs9288384,29.8,16512

Geneanet

Geneanet	provides	a	download	CSV	that	needs	to	be	adjusted.	Fields	4	(Number	of	SNPs)	and	5	(Length	in	centimorgan)	need	switched	and	field	6
removed.	Semicolon	delimeter	needs	replaced	with	comma.

Chromosome;Start	of	segment;Length	of	segment;Number	of	SNPs;Length	in	centimorgan	(cM);Type	of	segment
9;14037831;73101159;6804;38.64;half-identical

Legend

Legend	with	rollover	tooltip

For	each	Chromosome:	the	top	portion	is	the	Paternal	side	and	the	bottom	portion	is	the	Maternal	side.
The	chromosome	segment	side	(Paternal	or	Maternal)	is	determined	from	the	Most	Recent	Common	Ancestor.	If	there	is	no	common
ancestor,	both	sides	are	used.
The	color	code	for	each	associated	person	in	the	DNA	segment	map	is	consistent	but	not	user-specified.	The	first	Association	will	always	be
the	same	color.
To	change	the	location	of	the	Legend,	edit	the	config	file	parameters:

legend-single-chromosome-y-offset=25
legend-swatch-offset-y=0

Navigation

The	Legend	on	the	right	side	lists	each	associated	person	who	has	a	mapped	segment.	Hovering	over	the	legend	items	will	show	a	tooltip	for
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possible	action.	Primary	button	click	will	change	the	active	person.	Secondary	button	click	will	open	the	Person	Editor	for	the	associated
person.
Hovering	over	the	Y-axis	chromosome	labels	will	show	a	tooltip	for	possible	action.	Primary	button	click	will	switch	view	to	single
chromosome	of	the	label	clicked.	To	return	to	full	view,	click	on	the	background	in	the	single	chromosome	view.
Hovering	over	a	segment	provides	detail	on	the	segments	at	that	location.	If	there	are	multiple	segments	overlapping,	all	will	have	details.

Configuration

The	config	file	for	this	gramplet	has	the	following	options.	Remove	the	comment	(double	semi-colon)	and	edit	as	needed.	Changes	are	not	reflected
until	the	next	time	the	gramps	is	started.

[map]
;;chromosome-build=37
;;legend-single-chromosome-y-offset=25
;;legend-swatch-offset-y=0
;;maternal-background=(0.833,	0.845,	0.92,	1.0)
;;paternal-background=(0.926,	0.825,	0.92,	1.0)
;;show-centromere=0
;;show_associate_id=1

Chromosome	Build:	choose	the	specific	build	for	the	chromosomes.	Options	are	36,	37,	38.
Legend	Single	Chromosome	Y	offset:	Adjust	the	height	of	the	legend	for	the	single	chromosome	view.	This	may	be	needed	if	more	than	12
people	share	the	chromosome.
Legend	Swatch	Offset:	Offset	for	the	color	swatch	in	the	legend.	Should	be	5	for	Windows	systems.	0	works	for	Linux	and	Mac
Maternal	Background	Color:	RGB	values	for	the	background	of	the	Maternal	Chromosome
Paternal	Background	Color:	RGB	values	for	the	background	of	the	Paternal	Chromosome
Show	Centromere:	If	1,	do	not	paint	the	background	area	for	the	centromere.	This	area	is	dependent	on	the	Build.
Show	Associate	ID:	To	remove	the	ID	on	the	legend	and	tooltip,	set	to	0.	Otherwise	leave	as	1	to	print	the	Associate	ID.

Single	Chromosome	View

To	view	just	a	single	chromosome,	click	on	the	chromosome	number.	This	view	has	each	association	as	a	different	row,	helping	to	see	overlapping
areas.	To	return	to	the	standard	view,	click	on	the	background	area.

DNA	Example	data

To	reproduce	the	illustration	with	the	Example.gramps	dataset,	create	two	records	in	the	Associations	tab	in	the	Person	Editor	for	Luther
Robinson(I0656).

The	first	record	is	DNA	type,	adding	an	association	with	Robert	F.	Garner	(I1123).
The	Note	under	this	association	contains	the	following	text.	The	last	two	fields	with	the	names	are	ignored.

Chromosome,Start	Location,End	Location,Centimorgans,Matching	SNPs,Name,Match	Name
3,56950055,64247327,10.9,375,Luther	Robinson,	Robert	F.	Garner
11,25878681,35508918,9.9,396
12,129481599,133491098,12.4,304
15,35444614,64710827,33.3,1212
1,48053426,68837810,24.6,3413
1,72956037,87857969,13.4,2035
3,69656569,74563488,9.0,974
6,6179882,15400114,18.5,1994		

The	second	record	is	also	DNA	type,	adding	an	association	with	Maude	Garner	(I0651).
The	Note	under	this	association	contains	the	following	text:

1,30578594,38686908,11.2,334
1,236520701,249210707,29.7,685
3,14446545,24339734,12.3,458
3,128688499,140766208,11.4,447
4,76585823,114118650,33.7,1317
4,163973796,190915650,49.1,1422
6,4737179,9181572,10.3,279
6,39128976,49586285,15.8,510
6,150564916,156389148,10.2,415
7,18915133,37547290,25.8,1038
7,93557588,116296896,20.2,821
7,141636563,156148608,30.9,787
8,2808265,6919748,10.7,436
8,12568161,42652859,38.7,1556
8,49039681,71454529,20.3,742
8,71990280,99554231,21.9,917
9,78958599,122204804,55.7,2014
10,5608202,10769007,10.4,333
10,19365648,38434090,19.6,775
11,26722523,37020611,11.8,447
12,66412457,94422155,24.4,1035
13,19234747,23899627,8.7,270
13,74422984,91183468,14.2,506
14,23902753,33048583,15.5,392
14,88816167,106020366,37.8,947
15,23727655,27246462,8.2,229
16,22836249,32137965,12.6,413
16,46644903,54620503,11.7,360
17,13905,6613192,18.9,419
17,25567080,44187492,19.7,694
17,44790203,72115774,39.7,1223
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18,18714991,47726830,27.9,1071
18,69454453,77894844,23.5,481
19,1993444,11174625,28.1,567
19,54545531,59087479,12.7,335
20,9879166,26225145,24.3,788
20,30221104,43975451,13.5,489
21,14670124,18743733,10.8,201

DNA	match	row	data	must	be	in	a	specific	CSV	order

The	data	may	include	a	header	but	the	Gramplet	does	not	require	one.	Headers	are	to	make	the	rows
more	readable	by	humans.	The	rows	do	not	need	to	be	sequentially	ordered	by	the	chromosome	identifier
(1	to	22	and	X).

Sample	GEDmatch	output	(see	screenshot)	that	can	be	cut	and	paste	into	the	Note.	The	fields	are	the	same	-	Chromosome,	Start,	End,	cM,	and
SNPs.	This	can	be	cut/paste	from	the	GEDmatch	output	directly	into	the	Note	for	the	Association.	The	header	line	will	be	ignored.	

Example

Create	an	Association	of	type	DNA	as	described	in	the	Association	page	to	Person	A.	Add	a	Note	with	the	DNA	shared	segment	data.	Set	the	Note
private	if	you	do	not	want	the	data	printed	in	reports.	
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Save	the	Association.	

Add	more	associations	as	known.	Each	would	be	associated	to	a	different	person	and	have	a	different	Note.	Since	the	Associations	are	drawn	in
order,	it	is	generally	better	to	have	them	in	order	of	closest	relative	to	furthest	relative	to	avoid	obscuring	a	distant	relative	(smaller	segment)	by	a
close	relative	(larger	segment).	Use	the	up-arrow	and	down-arrow	to	change	the	order	of	the	Association.	

Add	the	DNA	gramplet	to	the	Person	view.	Select	the	DNA	tab.	The	segment	map	will	be	color	coded	by	associated	person.	For	each	Chromosome
the	top	portion	is	the	P	(Paternal)	side	and	the	M	(Maternal)	side	is	the	bottom	portion.	If	the	chromosome	segment	side	(Paternal	or	Maternal)	is
unknown,	the	segment	will	cover	both	the	top	and	bottom	portions	of	the	chromosome	and	be	50%	transparent.	
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Hovering	the	cursor	over	a	known	segment	will	pop	up	the	name	of	the	associated	person	and	the	length	(in	cMs)	of	the	shared	segment.	

Clicking	on	the	Y-axis	label	for	the	6th	chromosome,	a	detailed	view	is	shown.	Click	on	the	background	to	return	to	the	complete	view.	

Reference	Info

Untested	Areas

There	are	areas	in	the	DNA	test	that	are	generally	not	tested	as	they	are	not	reliable	indicators	of	a	match.	If	you	want	to	visualize	these	areas,	create
a	dummy	person	and	add	an	association	with	the	following	DNA	segments.

13,1,19020094,0,0
14,1,19067948,0,0
15,1,20004965,0,0
21,1,9922017,0,0
22,1,16055121,0,0

Centromere	Areas

Machines	have	difficulties	to	read	the	area	around	the	centromere.	There	are	less	SNPs	to	read,	therefore	there	is	higher	probability	of	false	positive
matches.	For	example,	if	you	have	a	match	exactly	around	the	centromere,	then	it	is	most	probably	a	false	positive	match.	If	you	want	to	visualize
these	areas,	edit	the	config	file	as	described	above	and	set	show-centromere	to	1.	The	area	of	the	centromere	id	dependent	on	the	Build	(36,	37,	or
38).	For	example,	the	list	for	Build	37	(the	most	common)	is

1	121500000	128900000
2	90500000	96800000
3	87900000	93900000
4	48200000	52700000
5	46100000	50700000
6	58700000	63300000
7	58000000	61700000
8	43100000	48100000
9	47300000	50700000
10	38000000	42300000
11	51600000	55700000
12	33300000	38200000
13	16300000	19500000
14	16100000	19100000
15	15800000	20700000
16	34600000	38600000
17	22200000	25800000
18	15400000	19000000
19	24400000	28600000
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20	25600000	29400000
21	10900000	14300000
22	12200000	17900000
X	58100000	63000000

To	view	the	centromere	for	all	chromosomes,	edit	the	config	file	to	change	this	option:

show-centromere=1

To	Do

Issues
If	the	Chromosome	Number	is	not	in	the	range	(1,	2,	...,	22,	X)	it	is	ignored.
If	there	are	multiple	paths	to	a	common	ancestor,	the	closest	found	is	used.
To	create	a	segment	map	for	Person	A,	you	need	to	add	associations	to	Person	A.	There	is	no	reciprocal	relationship	for	Person	B	-	that	is,
there	is	no	segment	map	for	Person	B,	only	for	Person	A.	You	can	execute	the	Addon:SyncAssociation	addon	to	create	any	missing
reciprocal	relationships.
Color	code	for	each	associated	person	in	the	map	is	consistent	but	not	user-specified.	The	first	Association	will	always	be	the	same	color.
If	there	are	overlapping	segments	within	a	maternal/paternal	view	of	a	chromosome,	only	the	front	(last	drawn)	will	be	pickable.	The	tooltip
will	still	provide	the	details	of	the	hidden	segments.	Changing	the	order	of	Associations	(using	the	up-arrow	and	down-arrow)	to	have	the
closer	relatives	before	further	relatives	will	fix	this.	To	see	overlapping	segments,	select	a	single	chromosome.

See	also
DNA	Segment	Map	gramplet	#550	(GitHub	pre-release	[1])
Addon:SyncAssociation	-	For	every	Association,	if	there	is	not	a	reciprocal	Association	then	it	will	be	created.	That	is,	where	Person	John
Smith	has	a	DNA	Association	(with	an	Association	Note)	to	Person	Jane	Jones,	then	if	Jane	Jones	does	not	have	a	corresponding	DNA
Association	to	John	Smith,	it	will	be	created	which	shares	the	Note.
Add	Types	to	the	SyncAssociation	Gramplet
Discourse	forum	discussion	on	the	DNAgramplet
Introduction	to	Associations	in	Gramps
Roles,	Relationships	&	Associations
Genetics
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5.2	Addons

DataEntryGramplet

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Data	Entry	Gramplet	-	default	entry	dialog

The	 Data	Entry	Gramplet 	allows	an	easy	method	of	editing	previously	added	people,	and	adding	new	and	related	people	in	your	family	tree.

Usage
You	can	access	the	 Data	Entry	Gramplet 	by	adding	it	to	the	Gramplet	sidebars	or	bottombars	in	the	People,	Relationship	and	Chart	views.
This	gramplet	is	only	for	"Person"	category	views,	so	it	is	unavailable	in	the	Dashboard	or	Family	views...	or	any	other	views	that	focuses	on
something	other	than	the	Active	Person.	You	can	still	detach/undock	the	Gramplet	to	allow	use	while	referencing	other	Views.

The	 Data	Entry	Gramplet 	consists	of	two	separate	sections:	the	Active	person	and	New	person	sections.

Both	sections	have	a	number	of	text	fields,	just	displaying	that	type	of	data	for	different	people.	The	topmost	is	the	 Surname,	Given: 	entry
field	which	is	a	combined	entry	for	just	the	surname	followed	by	a	comma	and	the	given	names.	If	you	need	more	finely	grained	editing	on	the
name	(for	example,	the	person's	name	includes	a	suffix	or	prefix),	you	can	use	the	Edit	icon	once	the	new	person	has	been	created.

The	 Death: 	and	 Birth: 	lines	for	both	the	Active	person	and	New	person	are	also	a	combined	entry,	allowing	you	to	enter	a	date	and	place.
The	date	(if	one)	is	entered	first	in	any	format	available	to	your	Gramps	installation,	followed	by	the	word	in	(in	your	language)	and	the	location	(if
one).	For	example,	the	following	are	all	valid	entries	for	the	birth	or	death	entries:

Jan	1,	1867	in	Kingsport,	TN
about	1822	in	Sweden
in	London,	England,	UK
1756/12/31

If	a	location	has	been	previously	used,	then	it	will	share	that	location	with	the	others.	If	it	is	new,	it	will	be	created.

To	 Add 	a	New	person	as	a	relation	to	the	active	person	choose	a	relation	type	from	the	 Add	relation: 	drop	down	eg:	No	relation	to	the
active	person(default),	Add	as	a	Parent,	Add	as	a	Mother,	Add	as	a	Father,	Add	as	a	Spouse,	Add	as	a	Wife,	Add	as	a	Husband,	Add	as	a	Sibling,
Add	as	a	Child.	The	Gramplet	will	guess	at	the	best	place	to	add	the	person.	For	example,	it	will	add	the	new	person	to	the	first	family	available.
The	Gramplet	will	also	try	to	discern	gender	where	needed,	guessing	that	the	"father"	spouse	of	a	family	is	male,	and	the	"mother"	spouse	is	female.
If	these	guesses	are	incorrect,	you	should	add	your	new	person	via	the	normal	Gramps	data	entry	method.

Click	on	the	Edit	button	to	the	right	of	the	Active	person's	name	to	use	the	standard	 Edit	Person 	window.

Click	on	the	Edit	button	to	the	right	of	the	 Family: 	label	to	use	the	standard	 Edit	Family 	window.	This	will	bring	up	the	first/primary	family
(if	the	active	person	is	a	parent	in	a	family)	or	will	bring	up	the	active	person's	parent's	family,	if	it	is	known.

If	you	begin	an	edit	of	the	active	person,	then	the	active	person	data	won't	change	until	you	either	 Save 	or	 Abandon 	your	changes.
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Use	an	existing	person	as	a	Template

Understanding	the	precise	data	format	needed	to	avoid	creating	duplicate	place	and	sources	can	be
confusing.

Add	places	and	sources	to	your	active	person	before	pressing	the	 Copy	Active	Data 	button.

This	allows	the	same	source	to	be	applied	to	each	person	added	subsequently...	even	when	you	type	new
different	name,	birth	and	death	dates	in	each	of	the	left-hand	columns.

The	 Copy	Active	Data 	will	copy	the	entries	of	the	active	person	to	the	editable	entries	for	the	new	person.	This	is	particularly	useful	when
adding	an	entire	family	grouping	from	the	same	source	data.

To	undo	a	change,	use	the	menu	Edit	->Undo	History...	option.

Note	that	you	cannot	delete	existing	date	or	place	information	using	this	Gramplet

You	can	only	add	or	change	them.	For	example,	you	cannot	remove	a	place	by	just	deleting	the	text.	You
will	need	to	edit	the	person's	record	using	the	regular	edit	dialog	(by	clicking	the	edit	button	next	to	the
person's	name).

See	also
Forms	Gramplet	addon	-	allows	users	to	create	and	edit	structured	source	data	in	a	single	form.
Note	Gramplet	-	which	is	a	data	entry	gramplet,	that	allows	you	to	edit	the	first	note	of	type	Person	Note	for	the	active	person.

Issues
4170#c44496	If	you	select	a	gender	of	"Other"	the	Gramplet	will	crash.

Feature	Request

4170	:	Data	Entry	Gramplet:	genders
5420	:	Improvements	to	Data	Entry	Gramplet
8922	:	Citations	aware	Data	Entry	Gramplet
9774	:	Data	Entry	Gramplet:	Option	to	add	baptism
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5.2	Addons

Database	Differences	Report

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Database	Differences	Report	example	output

The	 Database	Differences	Report 	allows	a	mostly	complete	comparison	between	the	currently	opened	database	(Family	Tree)	and	a
Gramps	XML	file.

Usage

Database	Differences	Report	-	Report	Options	tab	example	defaults

Open	the	family	tree	you	want	to	compare	then

Select	Reports	>	Text	Reports	>	Database	Differences	Report...	from	the	menu.

On	the	Report	Options	tab	select	the	Family	Tree	file:	to	be	compared	against.

Check	or	Uncheck	the	options	you	want	to	test	for	in	the	report	eg:	All	are	checked	by	default

[x]	Show	items	that	different
[x]	Show	items	missing	from	file
[x]	Show	items	added	in	file

Limitations
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The	Database	Differences	Report	is	focused	on	the	principal	elements	of	the	Database.

There	are	a	number	of	other	types	of	'metadata'	that	are	not	examined	during	the	Database	Differences	Report.

researcher
custom	types
gender	name	maps
base	path	for	media
surname	mapping	for	the	"Group	As"	surname	feature
etc.

Some	of	these	'metadata'	are	not	'regular'	in	the	way	they	are	stored,	comparing	them	would	be	a	fair	amount	of	additional	code	work.

Also	note	that	some	of	the	'metadata'	would	be	difficult	to	compare	because	they	are	not	stored	in	the	backup	XML	files,	but	rather	in	the	Gramps
initialization	files.

According	to	the	author,	not	all	changes	are	pertinent.	For	example	an	object	that	just	has	an	updated	timestamp	is	ignored,	as	are	dates	that	may
have	irrelevant	differences.	Note	that	it	will	report	changed	order	of	list	items	as	two	different	changes.	It	doesn't	say	"tag	list	items	1	and	2	were
switched"	(which	would	be	nice)	but	rather	"tag	list,	#1	[ToDo]",	"tag	list,	#2	[Imported]"	for	item1	and	"tag	list,	#1	[Imported]",	"tag	list,	#2	[To
Do]"	for	item2.

Note	regarding	older	backup	files

In	the	past	Gramps	allowed	data	to	be	input	in	ways	that	are	no	longer	allowed.	When	you	import	an	older	backup	file,	many	of	these	issues	are
silently	corrected	for	you.	For	example,	Gramps	used	to	allow	leading	and	trailing	spaces	in	name	fields.	Gramps	now	removes	the	leading	and
trailing	white	space	when	the	data	is	entered.

The	Database	Differences	Report	performs	it's	work	by	creating	a	temporary	Database	and	importing	the	backup	file	that	you	specified.	A	side
effect	of	this	is	that	if	your	Gramps	Database	has	been	around	for	a	long	time,	it	may	still	contain	things	that	are	not	currently	allowed.	But	the
comparison	will	be	done	against	the	backup	file	that	has	all	of	those	issues	fixed.	Each	correction	has	the	potential	of	showing	up	as	a	difference,	but
on	examination	they	look	the	same.	It	is	quite	hard	to	see	those	leading/trailing	spaces.

There	are	2	solutions:

1.	 backup	your	database,	create	a	new	empty	Database	and	import	backup	you	just	made,	then	go	ahead	with	the	report.
2.	 run	the	Clean	input	data	tool	on	your	Database,	then	do	the	report.

See	also
1.	 GEPS_009:_Import_Export_Merge#Import_Export_Merge
2.	 2623:	Import	Export	Merge	(GEPS	009)	comment:	...A	Database	Differences	Report	has	been	added	to	gramps35/trunk	(marked	as

3.5):..One	can	now	see	the	raw	differences	between	an	exported	file	and	the	current	DB...
3.	 (Gramps-devel)Towards	database	syncing,	From:	Doug	Blank	-	2013-01-13	17:16:25,	...a	mostly	complete	comparison	between	the	current

database	and	a	Gramps	XML	file.
4.	 Addon	-	Import	and	merge	a	Gramps	XML	family	tree	derived	from	your	own	Gramps	XML	family	tree	backup	file.

Issues
help	button	does	not	come	here.
See	issues	and	features	tagged:	DatabaseDifferencesReport	on	the	bugtracker.

Database	Differences	Report 67

http://www.gramps-project.org/wiki/index.php/Gramps_5.2_Wiki_Manual_-_Tools#Clean_input_data
http://www.gramps-project.org/wiki/index.php/GEPS_009:_Import_Export_Merge#Import_Export_Merge
https://gramps-project.org/bugs/view.php?id=2623
https://gramps-project.org/bugs/view.php?id=2623#c25242
https://sourceforge.net/p/gramps/mailman/message/30345408/
http://www.gramps-project.org/wiki/index.php/Addon:Import_Merge_Tool
https://gramps-project.org/bugs/tag_view_page.php?tag_id=369


5.2	Addons

DateCalculator

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

The	 Date	Calculator	Gramplet 	allows	you	to	do	date	math.

Enter	at	least	one	valid	date	for	 Expression	1 	and	 Expression	2 	then	click	the	 Calculate 	button.

An	expression	can	be:

1.	 a	valid	Gramps	date
2.	 a	positive	or	negative	number	(represents	years)
3.	 a	positive	or	negative	tuple	(years,	months,	days)	 Note	that	only	a	single	leading	negative	sign	is	needed	to

indicate	a	negative	tuple.

Note	that	at	least	one	expression	must	be	a	date.
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Usage
Select	the	 Date	Calculator	Gramplet 	from	the	Gramplet	menu.

Enter	the	desired	expressions	and	press	the	 Calculate 	to	see	the	result.

Use	the	 Clear 	button	to	start	again.	

Example	usage

Assume	that	a	headstone	has	only	a	date	of	death	and	age	at	death.

RANEY

MOTHER
Hannah	M.

Wife	of
William	Raney

Died
Nov.	14,	1902

Aged

73Yrs.	4Mo.
&	3Ds.

Blessed	are	the	dead
who	die	in	the	Lord

Source:
Iowa	Gravestone
Photo	Project

FATHER
William	Raney

Died
Oct.	17,	1892

Aged

71	Yrs	2Mo
&	7Ds

I	will	behold	thy	face
in	righteousness	I	shall
be	satisfied	when

I	awake	with	thy	likeness

Enter	a	date	in	each	field	in	the	following	format	(	YYYY-MM-DD	).

Expression	1

Enter	a	starting	date	or	an	offset	value	(such	as	the	date	of	the	most	recent	birthday	on	a	marriage	license):

for	the	wife	in	the	example	gravestone,	enter	14	Nov	1902

Expression	2

an	offset	tuple	is	in	the	form	y,m,d
Example	for	"Aged	73Yrs.	4Mo.	&	3Ds.",	use	"-	73,	4,	3"
Note	that	only	a	single	leading	negative	sign	is	needed	to	indicate	a	negative	tuple.

Result

Pressing	the	 Calculate 	button	returns	1829-07-11.	When	storing	a	date	that's	been	calculated	from	a	reference	rather	than	a	historical	record,	it
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is	hard	to	be	certain	what	methodology	was	used.	So	the	results	are	an	estimate.	Annotate	this	by	preceding	the	value	with	"calc	abt"

Initially,	the	Result	field	will	contain	the	following	usage	hint:

Enter	an	expression	in	the	entries	above	and	click	Calculate.

An	expression	can	be:

1.	a	valid	Gramps	date
2.	a	positive	or	negative	number,	representing	years
3.	a	positive	or	negative	tuple,	representing	(years,	months,	days)

Note	that	at	least	one	expression	must	be	a	date.

See	also
Editing	dates
Formatting	Dates
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5.2	Addons

Deep	Connections	Gramplet

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Deep	Connections	Gramplet	-	example	results

The	 Deep	Connections 	Gramplet	shows	a	deep	relationship	between	active	person	and	home	person.	The	Deep	Connections	Gramplet	will	find
all	relationships	between	the	home	person	and	active	person,	if	one	exists.	Similar	to	the	built-in	Relationship	Calculator.

Usage
Add	the	 Deep	Connections 	Gramplet	to	one	of	the	following	Category	views:	People,	Relationships,	Charts	or	Geography.

Deep	Connections	Gramplet	-	No	Home
Person	set.	-	message

Make	sure	you	have	set	the	Home	Person	otherwise	you	will	receive	the	message:	 No	Home	Person	set. 	.

Select	another	person	from	the	People	list	view	to	make	them	active	then	change	to	the	 Deep	Connections 	Gramplet	to	see	the	result,	this	can
take	some	time,	as	it	thoroughly	searches	through	all	relationships.	The	 Deep	Connections 	Gramplet	reports	a	chain	of	people	that	form	a
related	connection	between	the	Active	Person	and	the	Home	Person.

You	can	 Pause 	the	Gramplet	or	 Copy 	the	person	to	the	Clipboard	or	even	have	the	Gramplet	 Continue 	to	attempt	to	find	additional
connections.

Context	menu	actions

Right-clicking	inside	the	gramplet	results	(but	not	on	a	hotlink)	will	show	a	pop-up	context	menu.	The	options	are:	Cut	(disabled),	Copy	(enabled
only	when	text	is	has	been	highlighted),	Paste	(disabled),	Delete	(disabled),	and	Select	All.

Right-clicking	on	the	titlebar	of	undocked	(detached,	torn	off)	Deep	Connections	Gramplet	will	show	a	pop-up	context	menu.	The	options	are:
Restore	(disabled),	Move,	Resize,	Minimize	(disabled),	Maximize	(disabled),	and	Close.

Hotlink	actions
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Right-clicking	on	a	hotlinked	Person	name	will	shift	the	Active	Person	focus	to	that	Person.	This	also	triggers	a	recalculation	of	the	Deep
Connections	of	the	new	Active	Person	to	the	Home	Person.

Left-clicking	on	a	hotlinked	Person	name	will	open	the	Person	Editor	for	that	Person.

See	also:
The	Relationship	Calculator
The	Relationship	to	home	person	Display	Preferences	option	for	the	Status	bar
Relation	to	Home	Person	quick	view.
The	Isotammi	Deep	Connection	Graph	-	local	server	dashboard	gramplet

Issues
When	view	expanded	the	display	area	does	not	fill	the	entire	window/dialog.
4458	Deep	Connections	Gramplet	does	not	find	all	possible	paths
6467	Deep	Connections	Gramplet:	Doubly	redundant	relations
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5.2	Addons

DenominoViso

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

DenominoViso	Web	Report	example	output

The	DenominoViso	Addon	for	Gramps	creates	an	interactive	graphical	representation	of	a	family	tree	on	a	web	page.

Usage
The	report	is	available	from	the	menu	Reports	>	Web	Pages	>	DenominoViso	

Options

You	can	change	how	the	report	is	created	by	changing	options	in	the	following	tabs.	

DenominoViso	Options	tab

DenominoViso	-	Web	Report	-	Addon	-	"DenominoViso	Options"	tab
defaults

Destination: 	~\user\document\outputlocation\DenominoViso.xhtml	The	destination	file	for	the	xhtml-content.
Folder 	-	Select	output	folder	location.

Central	Person: 	defaults	to	the	active	person
Select	Central	Person 	button	-	to	select	a	different	person.

Title	of	the	webpage 	empty	by	default	-	Any	string	you	wish
Display	mode: 	-	Either	plot	ancestors	or	descendants	graph

Ancestor(default)
Descendant
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This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

Display	type: 	-	The	type	of	graph	to	create.
Regular	(default)
Fan
Growth	Spiral
Mandelbrot	Tree
Pythagoras	Tree

Direction	of	time: 	-	Direction	in	which	times	increases.
right	to	left	(default)
left	to	right
top	to	bottom
bottom	to	top

Generations 	10	(default)	-	The	number	of	generations	to	include	in	the	tree
Max	chart	width	(%): 	50	(default)	-	Width	of	tree	as	fraction	of	the	browser	window
Max	chart	height	(px): 	1000	(default)	-	Height	of	the	tree	in	pixels.
Closing	remarks: 	Copyright...	(default)	-	List	of	strings,	free	text	added	at	the	bottom,	for	example	for	a	copyright	notice.

Include	Options	tab

[x]	Include	private	records
Include	Events:	[x]	-	Whether	to	include	a	person's	events

[x]	Include	birth	children
[	]	Include	death	relatives
[	]	Include	witness	note

Include	Attributes:	[x]	restricted	to:	.........	(text	box	empty)	-	Whether	to	include	a	person's	attributes
[	]	Include	Addresses
[	]	Include	Note
[	]	Include	URL
[	]	Include	URL	description
[	]	Include	Sources

Image	Options	tab

[	]	 Include	Photos/Images	from	Gallery
Copy	Image: 	[	]	*	 to	directory: 	file/path/to/media

Copy	the	images	to	the	designated	image	directory	button
Images	with	Attribute: 	____	equal	to	___	should	be	Included	(default)	or	Excluded

[	]	Include	Image	source	references
Source	reference	attribute:

Style	Options	tab

Color	of	active	person::
Color	of	found	persons::
Color	of	male	persons::
Color	of	female	persons::
Width	of	rectangle	(hrd)::
Height	of	rectangle	(hrd)::
Vertical	distance	of	rectangles	(hrd)::
Extra	style	settings::

Advanced	Options	tab

Mouse	event	handler: 	[x]	onclick	[	]	onmouseover
Birth	relationship	linestyle:
Source	confidence	color:
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This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

Event	format:
Source	format:

How	the	developer	uses	it
Some	examples	of	how	I	use	a	page	created	by	DenominoViso.

1.	 I	am	primarily	looking	for	information	on	ancestors.	The	large	overview	shown	by	a	page	created	by	DenominoViso,	helps	me	to	easily	find
which	ancestors	are	lagging	behind:	the	branch	is	tiny	compared	with	neighboring	branches.

2.	 Finding	death	records	is	harder	then	birth/baptism	and	marriage	records	in	Dutch	archives.	So	temporarily	I	typically	set	death	to	something
like	"after	xxxx".	I	can	now	enter	"after"	in	the	search	box	and	search	for	"death	events",	all	people	that	still	miss	their	real	death	event	show
up.

3.	 Some	sources	are	expected	to	contain	a	considerable	(geographic)	group	of	my	ancestors,	for	example	tax	records.	Because	in	Gramps	I	have
entered	the	details	of	that	tax	record	in	the	description	field	of	the	event,	I	can	search	on	this	in	the	page	created	by	DenominoViso.	Those
persons	not	showing	up	while	it	is	expected,	can	easily	be	identified	for	further	research.

Why
If	your	tree	of	ancestors/descendants	grows	a	bit	bigger,	traditional	graphical	representations	run	out	of	space	and	you	are	left	with	viewing	only	part
of	your	tree.	The	DenominoViso	plugin	mitigates	this	by	dropping	names	and	other	textual	details	from	the	boxes	that	make	up	a	tree	so	that	many
more	boxes,	thus	a	larger	section	of	the	tree,	can	be	put	in	view.

How
The	consequence	of	this	is	that	the	document	needs	to	be	interactive	to	determine	which	box	belongs	to	which	person,	thus	DenominoViso	creates	a
graphical	webpage	in	SVG/XHTML/javascript.	Such	a	document	can	be	displayed	with	standard	compliant	browsers	such	as	Firefox	or	Opera
(Internet	Explorer	will	not	do).

What	is	seen	on	the	webpage	is	typically	a	tree	structure	consisting	of	many	boxes.	Hovering	the	mouse	over	a	box	shows	the	name	of	that	person
on	the	statusbar	(browser	settings	must	allow	javascript	to	set	text	on	the	statusline,	something	which	is	at	present	typically	switched	off	by
browsers	in	their	standard	configuration).	Clicking	on	a	box	displays	the	known	details	about	that	person.

Features
1.	 Flat	access	to	the	data.	Gramps	is	very	hierarchical	opening	window	after	window.	This	is	good	for	data	entry,	but	not	so	for	data	display.	A
page	created	by	DenominoViso	shows	all	information	about	a	person	with	a	single	click	and	some	scrolling.

2.	 Easy	searching.	The	webpage	contains	a	text	entry	and	a	selection	field	which	make	it	easy	to	search	on	names	or	other	properties.
3.	 A	single	page	website.	Gramps	can	create	a	website,	but	it	is	too	bulky	for	my	taste.	DenominoViso	typically	puts	all	textual	information	in
one	big	file.

4.	 Mixing	family	and	person	events.	Gramps	displays	family	events	in	another	window	then	personal	event.	Birth	of	a	child	though,	would	be
considered	by	most	people	as	a	major	event	during	their	live.	DenominoViso	can	mix	family	events	with	personal	events	and	represents	them
in	chronological	order.

5.	 Fine	grained	control	over	what	gets	included.	DenominoViso	has	many	options	that	control	what	gets	included	in	the	webpage.	Some	can	be
included	by	setting	a	simple	checkbox,	others	however	are	very	advanced	and	should	only	be	used	by	people	with	some	experience.	For
example	the	confidence	level	of	the	source	of	an	event	can	be	indicated	by	a	color;	to	the	best	of	my	knowledge	their	is	no	other	report	that
can	display	this	information.

What's	in	a	name
The	name	DenominoViso	is	derived	from	a	use-case	I	had	not	realized	before	I	wrote	this	plugin.	It	means	something	like	"let's	have	a	look	at
namegiving".	It	turns	out	that	in	my	family	not	only	family	names	can	be	traced	back	over	centuries,	but	also	firstnames	where	children	are	typically
named	after	their	grandparents	or	great	grandparents	if	there	are	many	of	them.	Pages	created	with	the	DenominoViso	plugin	are	ideal	for	this,	just
enter	the	specific	part	of	the	name	in	the	search	field	and	search	for	"Name".

Version	History
Gramps	4	-	Update	of	Gramps	3	version,	to	support	GTK+3	and	python	3.	No	new	functionality	was	added.
Gramps	3	-	An	update	of	the	Gramps	2.x	version,	to	work	with	the	new	plugin-architecture.	No	new	functionality	was	added.

Issues
Help	URL	does	not	lead	here.
6486:	Duplication	in	graphical	reports	when	first	cousins	marry
??	Repository	information	is	at	present	not	included	in	the	page	created	by	DenominoViso.
Other	minor	issues	reported	on	github
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See	Also
Web	Solutions	for	Gramps
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5.2	Addons

Descendant	Count	Gramplet

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Descendant	Count	Gramplet	-	results	window	sorted	by	number
of	"Descendants"

The	 Descendant	Count	Gramplet 	shows	the	number	of	descendants	for	each	person	in	your	Family	Tree.

Usage
After	adding	the	gramplet	from	the	People	Category	area	sidebar	you	can:

Double-click	on	a	person	to	show	the	persons	edit	window.
Click	name	to	change	the	active	person.
Click	column	titles	"Person"	or	"Descendants"	to	sort	alphabetically	or	numerically	respectively.	(shows	a	little	arrow	(up	or	down)	to	indicate
which.	)

See	also
For	a	single	person	you	can	use	the	 Descendant	of	<filter>	match
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5.2	Addons

Descendant	and	Detailed	Descendant	Book	Reports

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Descendant	Book	-	Text	Reports	-	Addon	-	Report	Options	-	tab	-
defaults

The	"Descendant	Books"	addon	consists	of	two	book	type	addons:

Descendant	Book 	and
Detailed	Descendant	Book

Both	reports	are	based	directly	off	the	Descendant	Report	and	Detailed	Descendant	Report's,	the	main	difference	being	instead	of	just	producing	a
report	based	on	the	Center	Person,	it	allows	for	the	use	of	a	built	in	Query	or	Custom	query.	This	idea	is	to	produce	as	many	descendant	reports	as	is
required	to	satisfy	inclusion	of	all	individuals	within	the	given	query.

If	for	instance	"Entire	Database"	is	chosen	as	the	query	to	use.	Then	the	entire	database	is	traversed	and	a	unique	list	of	ancestors	is	determined	and
then	a	descendant	report	for	each	of	these	ancestors	is	produced.

As	there	is	a	potential	to	produce	more	than	one	report	the	best	place	to	include	these	reports	is	under	Books.	If	more	than	one	report	is	produced	a
table	of	contents	is	generated	to	show	how	many	reports	there	are.

If	one	only	report	is	produced,	no	table	of	contents	are	generated.

Usage

Descendant	Book	-	menu	Reports	>	Text	Reports	>	Descendant	Book
Detailed	Descendant	Book	-	menu	Reports	>	Text	Reports	>	Detailed	Descendant	Book

Common	uses

To	date	my	most	common	usage	is	:

Entire	Database

I	find	that	running	of	either	report	using	the	Entire	database	is	really	useful	for	highlighting	potential	people	in	my	database	that	I've	not	linked	up,
dangling	tree	elements	etc.

Ancestors	of	<person>

Again	really	useful	to	get	a	complete	accurate	picture	of	the	entire	family	tree	of	an	individual,	pretty	much	includes	all	cousins	of	this	person.	Up	to
now	to	print	this	you	would	first	have	to	determine	all	the	possible	ancestors	of	this	person,	and	then	manually	generate	a	descendant	report	for	each
of	these	ancestors.	By	running	this	report	we	get	all	these	reports	generated	in	one	go	and	a	table	of	contents	to	boot	!!
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Differences	to	Descendant	Reports
Some	of	these	differences	I	would	hope	end	up	in	Trunk/Core,	as	such	there	are	bug/feature	requests	logged	for	these.	If	the	bugs	are	marked
resolved	then	they've	been	integrated	and	you	can	ignore	the	reference	here,	or	better	still	ping	me	to	remove	this	reference	or	edit	this	page	your	self
and	remove	it.

Detailed	Descendant	Book	-	Text	Reports	-	Addon	-	Report	Options	-
tab	-	defaults

Descendant	Report,	Suppress	duplicate	families

Depending	on	the	filter	chosen,	a	number	of	Descendant	reports	may	be	produced	to	generate	the	book,	and	as	a	result	of	this	the	exact	same
dependent	family	tree	could	get	printed	in	more	than	one	report.	This	is	not	an	issue	if	only	running	one	report,	but	for	the	purpose	of	this	book	it
just	means	potential	wasting	of	paper,	and	potential	confusion.	With	this	in	mind,	any	report	contained	in	the	book	after	the	first	one	which	contains
a	family	that	has	already	been	printed	(including	any/all	descendants	of	that	family),	will	not	get	printed	in	subsequent	reports	but	instead	will	have	a
reference	to	the	exact	report	and	location	in	that	report.

Detailed	Descendant	Report,	Suppress	duplicate	individuals.

If	an	individual	has	been	printed	already	in	a	previous	report,	instead	of	printing	all	that	individuals	details	just	provide	a	reference	to	the	report	and
location	in	that	report	where	their	details	can	be	seen.	Kind	of	similar	to	the	"Same	as	person"	output	seen	at	the	moment,	except	it	spans	reports.

Detailed	Descendant	Report	-	Report	Reference	Section

If	an	individual	appears	in	more	than	one	report,	then	a	new	section	is	printed	under	that	person.	It	indicates	all	the	reports	in	which	this	person
appears.

Index	of	Names	(Detailed	Descendant	Report)

The	index	of	Names	is	the	list	of	all	Names	that	appear	in	the	Detailed	Descendant	Report	printed	in	alphabetical	order.	Next	to	each	name	there	are
all	references	to	find	the	person	in	the	single	reports.	The	user	can	decide	whether	or	not	print	this	index.

Index	of	Dates	(Detailed	Descendant	Report)

The	index	of	Dates	is	the	list	of	all	events'	dates	in	the	Detailed	Descendant	Report	printed	in	cronological	order	with	the	descriptions.	The	user	can
decide	whether	or	not	print	this	index.

Index	of	Places	(Detailed	Descendant	Report)

The	index	of	Places	is	the	list	of	all	events'	dates	and	description	in	the	Detailed	Descendant	Report	printed	in	cronological	order.	The	user	can
decide	whether	or	not	print	this	index.

Installation
Versions	for	Gramps	branches	3.4,	4.x	and	5.x	are	available	for	installation	via	Gramps	Addon	manager.

Gramps	5.x	Version:	via	the	Addon	manager
Gramps	4.x	Version:	via	the	Addon	manager

Download	and	manually	install:
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Gramps	3.4	Version	:	http://mattman.iflaf.com/familytree/gramps/DescendantBooks-1.0.1.tar.gz

Issues
Reports	don't	run	very	well	under	gramps	4.x	branch 	-	Matt	Keenan
8912	Gramps	crashes	when	DescendantBooks	report	runs

Feature	request

8905	detailed	descendant	report	-	added	index	of	names,	dates,	places

TODO

1.	 Addition	of	a	title	page
2.	 Addition	of	page	numbers	to	Table	of	Contents	(PDF/ODF	only)
3.	 If	2	can	be	done,	then	put	page	numbers	in	references	as	well.
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5.2	Addons

DescendantsLines

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Descendants	Lines	-	Galileo	Galilei's	Genealogy	example

The	 Descendants	Lines 	Graphical	Report	addon	generates	a	graphical	descendants	tree	using	orthogonal	edges	and	routing	("square	edges")	in
vertical	mode	only	in	which	children	in	a	family	are	ordered	from	left	to	right	following	the	Gramps	child	order;	and	families	are	ordered	right	to
left,	top	to	bottom,	following	the	Gramps	family	order.

Usage
Open	Gramps
Select	the	report	using	the	menu	option	Reports	->	Graphical	Reports	->	Descendants	Lines...
On	the	Report	Options	tab	choose	the	output	path	for	the	 Destination: 	$GRAMPSHOME/Descendants	Lines.png(default).

Note:	That	Document	Options	 Filename: 	option	will	contain	an	empty	file	or	file	with	a	list	of	people	after	the	report	is	run.
Note:	If	the	script	is	run	in	"debug	mode"	it	generates	copious	terminal	output	such	as	"Unknown	event	type:	..."	or	"Unknown	spouse:	...".
These	warnings	are	harmless.

Options

Descendants	Lines 	has	the	following	option	tabs	available	to	change:

Paper	Options

See	also	common	options	

Report	Options
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Report	Options

Center	Person:
Output	format: 	-	The	output	format	(PNG,	SVG,	PDF	or	PS)
Destination: 	$GRAMPSHOME/Descendants	Lines.png(default).	The	output	filename
Generations: 	-	Maximum	number	of	generations	to	include.	(0	for	unlimited)

[	]	Use	d'Aboville	descendant	numbering	System 	-	Whether	to	use	d'Aboville	descendant	numbering	system.
[	]	Include	an	image

Max	Image	height:
Max	Image	width:
Image	Location:

Report	Options(2)

Report	Options	(2)

[	]	Colour	Name	by	Gender 	-	Whether	to	use	colored	names	indicating	person	gender	in	the	output.
[	]	Use	alternate	events	if	primary	events	are	not	found	-	for	example,	if	there	is	no	Birth	event,	a	Baptism	or
Christening	event	may	be	substituted.	For	Death	Events,	a	Burial	may	be	substituted.
[	]	Sort	Events	by	Date
Text	Style: 	-	The	predefined	output	style
Maximum	Note	Length: 	-	limits	the	length	of	notes.

Display	Options
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Display	Options

[	]	Box	around	Person's	block
[	]	All	Person's	blocks	have	the	same	height
[	]	All	Person's	blocks	have	the	same	width
[	]	Colour	blocks	by	Generation
Descend	block	colour	intensity:
Spouse	block	colour	intensity:

Display	Formats

Display	Formats

Name	Display	Format: 	-	The	name	format.	See	Formatting	for	more	detail.

Descendant	Display	Format: 	-	the	default	settings	provide	for	several	event	types	and	their	dates	and	places.	By	changing	the
contents	of	this	box,	you	can	elect	to	include	Events	of	various	types,	and	include	the	dates	or	places	and	their	format.	See	Formatting	for
more	detail.
Spouse	Display	Format: 	-	the	default	settings	provide	for	several	event	types	and	their	dates	and	places.	By	changing	the	contents	of
this	box,	you	can	elect	to	include	Events	of	various	types,	and	include	the	dates	or	places	and	their	format.	See	Formatting	for	more	detail.

Replace	Options
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Replace	Options

Replace	Display	Format	'Replace	this'/'with	this': 	ie:	United	States	of	America/USA

Spouse	and	Family	Options

Spouse	and	Family	Options

Vertical	edge	descendant	to	spouse-bar
Vertical	edge	spouse-bar	to	spouse
Vertical	space	spouse-bar	to	other	spouse
Horizontal	space	descendant	to	spouse
Horizontal	space	family	to	family
Horizontal	distance	spouse	to	family	edge

Children	Options
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Children	Options

OL_PAD 	-	The	number	of	???	pad
Vertical	edge	spouse-bar	to	child-bar
Children	distance
Vertical	edge	child	to	child-bar
MIN_C_WIDTH
Space	around	text
Space	between	lines	of	text

Header	and	Footer	Options

Header	and	Footer	Options

Title	text
Footer	text
Title	and	footer	coefficient

Privacy	Options
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Privacy	Options

[	]	Protect	People,	Images	or	Events	that	are	marked	Private
Privacy	text: 	Private(default)

Examples

Lines	of	descendants	chart

DescendantsLines,	Left-aligned	text	style,	example	Gramps	data,
inc_marriages	and	inc_places.

Shakespeare	family	tree,	DescendantsLines,	inc_marriages

Shakespeare	family	tree,	DescendantsLines,	Left-aligned	text	style,
including	event	places

File:DescendantsLines-m-ep.pdf	--	DescendantsLines,	example	Gramps	data,	inc_marriages	and	inc_places,	PDF	output.
File:DescendantsLines-left.pdf	--	DescendantsLines,	Left-aligned	text	style,	example	Gramps	data,	use_colors,	inc_marriages	and	inc_places,
PDF	output.
File:Charlemagne-DescendantsLines.pdf	--	DescendantsLines	addon,	inc_marriages	and	inc_places,	PDF	output,	presenting	a	family	tree	of
Charlemagne	starting	from	Chloderic	King	of	Cologne.
File:PepinOfHerstal-DescendantsLines-left-dnum.pdf	--DescendantsLines	Gramps	addon,	Left-aligned	text	style,	d'Aboville	numbering
(inc_dnum),	descendants	of	Pepin	of	Herstal	or	Pepin	II,	PDF	output.	Data	from	Charlemagne	GEDCOM	at	[1]	[2]
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Tree	compression	and	or	modification

SVG	format	trees	can	be	compressed	and	or	modified	manually	using	the	program	Inkscape,	using	the	select	and	path	tools;	or	using	other	SVG
manipulating	program.	PNG	format	trees	can	be	compressed	manually	by	manipulating	the	image.

Development
There	is	an	in-development	migration	of	this	Gtk/cairo	code	to	a	draw	plugin	working	into	Gramps	(font,	style,	path,	canvas,	output	formats).	This
migration,	DescendantsLines,	does	not	use	the	Document	interface	of	Gramps.

Draft	version	is	available	on	Addons	repository.	addons-source/tree/master/DescendantsLines

The	idea	is	keeping	Gramps	XML	parsing,	but	with	a	copy	of	the	active	database	and	use	of	current	report	environment	(output	formats,	style,	path).

Ideas

Feel	free	to	contribute	or	improve	DescendantsLines.

This	addon	may	with	time	become	a	general	orthogonal	family	tree	drawing	resource	for	Gramps,	for	a	View,	etc.,	and	outside	Gramps	as
well.	The	PyCairo	code	can	be	connected	to	a	view.
Think	of	optional	tree	compression	algorithms.
Add	option	to	include	divorces.
Add	option	to	include	spouse	parents.
Add	option	to	include	spouse	ancestries.

Add	option	to	include	arbitrary	spouse	ancestries.
Add	option	to	include	arbitrary	ancestries.
Add	option	to	include	notes.
Add	option	to	include	sources.
Add	option	to	include	images.
Add	horizontal	mode.
Add	optional	text	wrap	width.
Add	optional	text	width	with	use	of	ellipses.
Cairo	provides	hyperlink	support.	Names	could	be	hyperlinks	to	html	complete	individual	reports	or	to	web	report	pages.
The	hardcoded	number	option	limits	can	be	altered	by	users,	by	altering	the	code.

Command	Line	Interface

Gramps	provides	a	cli	support	for	running	reports	and	tools	Gramps	5.2	Wiki	Manual	-	Command	Line.

4114:	Would	like	to	use	stdin	and	stdout	for	command	line	import/export.

Current	limitations

The	addon	DescendantsLines	does	not	use	the	Gramps	document	interface	(Document	Options).	(perhaps	the	Gramps	document	interface
options	should	be	hidden)
DestinationOption	does	not	have	the	usual	error	handling	and	user	checking	(e.g.	for	overwriting	files)
Partial	quoting	of	xml-syntax-like	data.	Data	which	resembles	xml	syntax	(tags,	etc)	may	cause	error.
Script	ignores	role	on	event	(was	added	in	2007)
Script	ignores	localized	date	handlers	(using	ISO	date	format,	date	quality	in	english)
Memory	limitation	with	a	large	database	(DOM	parsing)
The	last	pixel	column	of	each	secondary	line	of	each	entry	is	wrong	coloured	(red	instead	black)
Size	limit:	Cairo	surface	size	limit.	(32767	for	height	and	32767	for	width	[3])
Some	PDF	output	size	limit	(currently	crossing	this	limit	will	result	in	an	empty	PDF	file)

Needs

Pass	1:	generate	a	tmp	XML	with	only	data	needed	for	the	report,	to	load	it	as	input

1.	 Enable	Person	selection	(Gramps	ID)	-	done
2.	 Generate	a	temp	Gramps	XML	database	matching	'IsDescendantFamilyOf'	filter	rule	-	done
3.	 Input	path	-	done	(need	to	set	@prefix@:	path_to_SVN/src	on	const.py)
4.	 Clean-up	-	done

simple	Gramps	XML	template	with	events,	persons,	families	objects	(only	export	primary	event	role	reference).
'localized'	dates	(does	not	follow	last	DTD,	which	uses	english	and	ISO	format).

FINISHED	-	it	works	fine!

Pass	2:	use	draw	report	environment

1.	 Generate	a	plugins/docgen/PNGDrawDoc.py	file	4447
2.	 Move	Gtk	code	to	draw	report	(if	possible)
3.	 Move	cairo	code	to	draw	report	(if	possible)
4.	 Output	path
5.	 Clean-up,	pylint,	etc	...

Pass	2	(Alternate):	use	of	user-defined	(mega)-widgets
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1.	 Have	a	look	at	mega-widget	request	and	implementation	2393
2.	 Output	path	through	mega-widget
3.	 Clean-up,	pylint,	etc	...

Pass	2	(Alternate):	use	a	DestinationOption

1.	 Use	a	DestinationOption
2.	 Ignore	standard	Filename	option	5545

Development	History

2007:	Adam	Sampson	created	a	standalone	python	script	for	parsing	data.gramps	(Gramps	XML).	[4][5]
2010:	this	script	needs	some	updates	for	avoiding	minor	issues.

A	modified	script	is	available	from	the	sourceforge	addons	repository.	 [6]

Libraries

The	program	DescendantsLines,	as	the	script	in	which	it	is	based,	is	written	in	Python,	using	the	following	prerequistes	PyCairo	and	the	Python
XML	library.	Many	Gramps	modules	are	also	used.

Issues
See	Current	limitations

5545	Add	a	way	for	CATEGORY_DRAW	reports	to	turn	Gramps	Document	Interface	Options	off
5823	DescendentsLines	does	not	display	a	marriage	date	when	one	spouse	is	unknown
5965	report	produced	with	stale	name	from	previous	gramps	session
10390	Display	options	in	DescendantsLines	graphical	report	do	not	work	as	advertised

Help	button	does	not	link	here.

See:	Tag:	DescendantsLines	on	Bugtracker

inc_marriages	option?

This	page	mentions	a	"inc_marriages"	option	but	none	of	the	option	tabs	have	that	setting	,	was	it	removed?	Or	is	it	now	called	"Spouse	Display
Format"

There	are	option	and	tree	combinations	which	may	generate	overlapping	edges	and
nodes.

If	using	the	inc_marriages	option	the	S_DOWN	-	S_UP	difference	may	need	to	be	increased	by	5-15
units	depending	on	the	tree.

See	also
Addon:Family	Tree	-	generates	horizontal	orthogonal	graphical	trees.
Addon:TimelinePedigreeView	-	displays	horizontal	orthogonal	graphical	trees.
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5.2	Addons

Detailed	Descendant	Report	With	All	Images

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

The	" Detailed	Descendant	Report	with	all	images"	report	is	based	heavily	on	the	Addon:Descendant	and_Detailed_Descendant
Book	Reports.	This	report	adds	2	features.	The	first	is	that	it	tries	to	display	all	images.	The	second	is	that	it	allows	one	to	create	a	todo	list	of	all
todo	items	for	each	person	in	the	tree.

Usage
Menu	Reports	>	Text	Reports	>	Detailed	Descendant	Report	with	all	images...

Options

Detailed	Descendant	Report	With	All	Images	-	Report	Options	-	tab
(default)

Detailed	Descendant	Report	With	All	Images	-	Content	-	tab	(default)

Detailed	Descendant	Report	With	All	Images	-	Include	-	tab	(default)
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Detailed	Descendant	Report	With	All	Images	-	Missing	Information	-
tab	(default)

History
I	(Jon	Schewe)	created	this	report	because	I	wanted	to	print	out	as	much	information	as	possible	for	displaying	at	family	reunions.	The	original
detailed	descendant	report	displays	most	of	the	information	that	I	want,	however	it	doesn't	show	all	of	the	images	and	sometimes	these	are
important.	I	also	found	it	useful	to	list	my	todo	items	so	that	members	of	the	family	that	are	looking	at	the	book	may	be	able	to	help	with	the
answers.
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5.2	Addons

DoubleCousinReport

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Double	Cousin 	is	a	text	report	which	lists	special	multiplicities	of	cousins	like	double	cousins.

Usage
Once	this	addon	has	been	installed:

Select	Menu	Reports	>	Text	Reports	->	Double	Cousin...

The	 Report	Options 	tab	is	displayed	with	the	following:
[	]	Show	info	text: 	If	checked	the	reports	adds	an	info	text	about	double	cousins	at	the	beginning.
[	]	Show	Gramps	ID: 	If	checked	the	persons's	Gramps	IDs	will	be	added	to	the	report.

Once	you	have	made	your	choices,	you	can	either	choose	 Cancel 	or	 Ok 	to	apply	the	report	generation.
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5.2	Addons

DownloadMedia

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

"Download	media	tool"	-	addon	dialog

The	 Download	media	tool 	is	designed	to	download	pictures	from	websites.

If	the	Preferences	->	General	tabs	 Base	path	for	relative	media	paths:	is	set,	then	the	media	are	downloaded	there,	otherwise,	a
folder/directory	called	'mediadir'	is	created	in	the	user's	home	directory,	and	the	media	files	are	put	in	that	directory.

Example	of	use
This	example	shows	how	this	tool	would	be	used	with	the	Geni	website,	but	other	websites	would	be	similar.

1.	 Log	into	the	Geni	website	in	the	usual	way.
2.	 Create	and	export	a	GEDCOM	file.	In	the	case	of	Geni,	instructions	are	at	[1].	You	can	go	to	[2]	and	select	the	appropriate	download	option.
3.	 In	the	case	of	Geni,	the	GEDCOM	file	is	created	off-line,	and	you	get	an	email	to	say	that	the	file	is	available.
4.	 Download	the	GEDCOM	file.
5.	 Start	Gramps
6.	 It	is	strongly	recommended	that	you	create	a	new	Family	Tree 	rather	than	import	the	downloaded	GEDCOM	into	your	main	or	active
tree.

7.	 Import	the	Geni	family	tree	into	the	new	Family	Tree.
8.	 If	you	have	not	already	downloaded	the	addon,	download	it.
9.	 Click	on	Tools	->	Utilities	->	Download	media	files	from	the	internet...
10.	 The	 Download	media	tool 	dialog	warning	message	will	be	shown	asking	that	you	are	connected	to	the	internet	and	logged	into	the

website	where	the	images	are	held	appears.
11.	 OK 	the	 Download	media	tool 	dialog
12.	 The	 Media	downloaded 	dialog	will	report	the	total	number	of	media	files	downloaded.

Copy	the	media	files	that	you	are	interested	in	from	the	download	location	into	the	directory	where	you	hold	images	for	your	Family	Tree,	and	add
the	images	to	the	Family	Tree.

Note

That	some	of	the	media	references	are	actually	references	to	index	pages,	rather	than	direct	to	the	media
object,	and	these	are	not	downloaded.	Fortunately,	these	usually	duplicate	the	actual	media	files.

Report	Options
None,	no	user	option	are	available.

But	provision	has	been	made	in	the	source	code	to	enhance	the	addon	in	case	a	login	name	and	password	for	the	website	is	needed.

If	a	problem	is	encountered	in	this	respect,	please	raise	a	bug	tracker	report,	giving	details	of	the	website	and	data	that	are	causing	the	problem.

Issues
5248	Media	images	should	take	weburls

See	Also
Web	Solutions	for	Gramps
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5.2	Addons

DynamicWeb	report

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Warning:

DynamicWeb	may	have	performance	issues	for	Family	trees	with	more	than	5000	people.

See	Optimizations	for	big	databases	section	below.

DynamicWeb	report,	tree	view

DynamicWeb	report,	person	view

DynamicWeb	report,	persons	index
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DynamicWeb	report,	surnames	index

DynamicWeb	report,	tree	view

The	 Dynamic	Web	Report 	Addon	for	Gramps	creates	interactive	web	pages	of	the	family	tree	database,	and	provides	the	user	with	options	that
allow	a	wide	range	of	customization.

This	addon	is	based	on	the	Narrative	Web	Report	native	Gramps	report.

Usage
The	report	is	available	from	the	menu	Reports	>	Web	Pages	>	DynamicWeb

Features
Browsable	and	zoomable	bi-directional	family	tree	view.

This	graphical	family	tree	can	be	printed	using	the	SVG	format.
It	can	be	zoomed	(like	google	map)	in	order	to	print	20	generations	or	more.
It	can	show	descendants	or	ancestry	(or	both),	as	a	tree	or	as	concentric	circles.
Possibility	to	use	the	mouse	or	a	context	menu	for	navigation	in	the	tree.

A	search	form	allows	to	perform	a	textual	search	for	up	to	3,000	data	(individuals,	places,	sources,	media)	objects.	The	Search	is	not	shown
when	the	object	count	is	so	high	that	it	might	impact	the	server	performance.
Indexes	can	be	sorted	and	filtered.
Clickable	pictures:

The	clickable	regions	correspond	to	the	Gramps	database	media	references	regions.	See:	demo
Based	on	client-side	Javascript:

No	impact	on	server	resources.
The	web	pages	can	be	browsed	on	a	regular	web	site	or	from	your	local	computer.
The	generated	site	is	smaller,	and	contains	less	files	(compared	to	static	HTML	pages).

Demos
Example	using	the	default	style
Example	of	graphical	family	tree	-	example	bis	-	example	ter
Example	using	another	style	(‘Mainz’	style	of	the	narrative	web	report)
Example	of	clickable	picture
Indexes:

Surname	index:	Example	1	-	Example	2
Persons	index:	Example	1	-	Example	2
Places	index:	Example	1	-	Example	2
Media	index:	Example

Example	with	minimal	features	(without	private	data,	notes,	sources,	addresses,	gallery,	places,	families,	events)

Help	for	the	report	generation
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Configuration	before	the	report	generation

The	"Dynamic"	aspect	of	this	report	is	very	handy	when	coming	to	the	report	configuration.	Many	configuration	parameters	could	be	modified	after
the	report	generation,	directly	on	the	Web	site.	These	parameters,	accessible	to	any	user	of	the	Web	site,	are	detailed	in	the	section	Configuration	by
the	Web	site	users.

The	 Dynamic	Web	Report 	dialog	window	has	nine	tabs	each	are	reviewed	below.

Tab	 Report

Destination 	(~/yourhomedirectory/<Family	Tree	Name>_dynamicweb	by	default):
,	The	destination	directory	for	the	web	files.

Files	erased	and	overwritten

The	report	generation	does	not	erase	any	file	in	the	destination	directory
Only	the	files	that	need	to	be	regenerated	are	overwritten.

Store	web	pages	in	archive 	(Disabled	by	default):
This	option	could	be	used	for	2	purposes:

Generate	an	file	that	could	be	easily	downloaded	from	the	Web	site:

The	archive	could	be	be	in	formats:	.tar.gz	or	.zip

Simplify	the	upload	of	the	Web	site	to	your	internet	provider:

If	you	have	trouble	transferring	the	files	to	an	external	web	host,	you	can	create	a	single	gzip'd	tar	file	to	more	easily	upload	the
data.	The	large	number	of	files	and	directories	in	this	web	output	may	make	it	difficult	to	transfer	the	files	to	an	external	web
host.	Gramps	has	the	capability	of	saving	all	of	your	Narrative	Web	files	in	one	compressed	archive	using	the	gzip	and	tar
formats	(casually	known	as	a	‘tarball’).	This	single	file	can	quickly	be	transferred	to	your	server	and	uncompressed	on	the	website
host.	Unfortunately	not	all	web	servers	support	saving	web	files	in	this	way,	so	contact	your	hosting	provider	for	more
information.

Web	site	title 	(My	Family	Tree	default):
The	title	of	the	web	site.	You	can	enter	a	custom	site	title	in	this	option.	It	is	strongly	suggested	to	change	this	from	the	default
Filter :
Any	person	matching	this	filter	who	is	not	excluded	due	to	the	privacy	rules,	will	be	included	in	the	output.
Choose	between:

Entire	Database	(Default)
Descendants	of	active	person
Descendant	families	of	active	person
Ancestors	of	active	person
People	with	common	ancestor	with	active	person

Filter	Person 	(active	person	by	default):
The	center	person	for	the	report.
Name	format :
Select	the	format	to	display	the	names
Name	format	(short) :
Select	the	format	to	display	the	names,	in	the	graphical	tree	only.
Web	site	template :
The	report	provides	two	built-in	style	sheets	for	you	to	choose	from	to	determine	the	appearance	or	your	web	pages.	Choose	between
[Default],	or	[Mainz].
Copyright: 	(Standard	copyright	by	default):
When	creating	a	public	a	web	site	it	is	important	to	specify	the	copyright	conditions	under	which	you	are	publishing	your	data.	International
copyright	law	reserves	all	rights	of	your	data	to	your	discretion.	You	own	the	data	and	individuals	must	have	your	permission	if	they	wish	to
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reuse	that	data.	In	genealogical	research	sharing	data	with	other	researchers	is	a	common	practice.	Other	options	include	the	Creative
Commons	licenses,	offering	a	wide	range	of	use	restrictions	or	none	at	all.	Learn	more	about	the	Creative	Commons	at
http://creativecommons.org/

Tab	 Privacy

Please	note	that	compliance	with	privacy	laws	and	individuals'	privacy	concerns	is	as	a
researcher	your	responsibility.

The	Gramps	project	cannot	be	held	responsible	for	privacy	law	compliance	or	other	privacy	issues.

Privacy	of	personal	information	is	an	important	issue.	Gramps	provides	tools	and	settings	that	give	you	control	over	the	privacy	of	your	data.

Include	data	marked	private 	(disabled	by	default):
Whether	to	include	private	objects.	If	your	intention	is	to	provide	a	complete	record	of	your	research,	checking	this	box	will	include	all	entries
marked	private	along	with	the	rest	of	your	database.
Export	notes 	(Enabled	by	default):
Whether	to	include	notes.
Export	sources 	(Enabled	by	default):
Whether	to	include	sources.
Export	addresses 	(Enabled	by	default):
Whether	to	include	addresses.
Living	People :
How	to	handle	living	people.	You	can	control	the	display	of	sensitive	information	based	on	whether	or	not	an	individual	is	currently	alive.
However,	since	Gramps	is	a	research	tool,	it	is	likely	that	there	are	individuals	with	no	known	date	of	death	in	your	database.	To	deduce	if	an
individual	is	possibly	still	alive	Gramps	employs	an	algorithm	that	compares	death	dates,	birth	dates,	baptism/christening	dates,	death	dates	of
ancestors	and	birth	dates	of	ancestors.	The	algorithm	assumes	that	each	individual	is	possibly	still	alive	unless	the	cross-referenced	dates	make
the	individual's	possibility	of	being	alive	unlikely.

Exclude	(Default):	Excludes	all	information	of	all	individuals	who	are	possibly	still	alive
Include	Last	Name	Only
Include	Full	Name	Only
Include:	Include	all	information	of	all	individuals	even	if	they	are	possibly	still	alive

Years	from	death	to	consider	living 	(30	by	default):
This	option	is	inactive	if	the	"Living	People"	option	is	set	to	Include.

Some	countries	have	laws	that	specify	a	certain	number	of	years	after	death	before	an
individual's	information	can	be	published.	Here	you	can	specify	the	number	of	years
after	death	needed	to	comply	with	such	laws.

Tab	 Options

Include	repository	pages 	(disabled	by	default)
Include	images	and	media 	(enabled	by	default)
Images	and	media :
Three	possibilities	are	proposed	for	integrating	media	in	the	Web	site.
See	Media	files	organization	section	below.
Print	the	notes	type 	(enabled	by	default)

Print	place	pages 	(enabled	by	default)
Include	Place	map	on	Place	Pages 	(disabled	by	default):
Whether	to	include	a	place	map	on	the	Place	Pages,	where	Latitude/	Longitude	are	available.
Include	a	map	in	the	individuals	and	family	pages	(disabled	by	default)
Whether	to	include	a	place	map	on	the	pages,	where	Latitude/	Longitude	are	available.
Map	Service 	(Google	by	default):
Choose	your	choice	of	map	service	for	creating	the	Place	Map	Pages

Google	(default)
OpenStreetMap

Google	map	API	key :
The	access	to	the	Google	Maps	API	requires	an	application	key.
See	[Google	Maps	documentation]
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Tab	 Advanced

Character	set	encoding :	The	encoding	to	be	used	for	the	web	files
Unicode	UTF-8	(recommended)	(Default)
ISO-8859-1
ISO-8859-2
ISO-8859-3
ISO-8859-4
ISO-8859-5
ISO-8859-6
ISO-8859-7
ISO-8859-8
ISO-8859-9
ISO-8859-10
ISO-8859-13
ISO-8859-14
ISO-8859-15
koi8_r

Include	family	pages 	(disabled	by	default)
Include	GENDEX	file	(/gendex.txt) 	(disabled	by	default):
This	option	creates	a	GENDEX	file	placed	at	the	top	of	the	website.	You	can	see	sites	which	support	this	format	and	read	more	about	it	at	the
GENDEX	Wikipedia	article)(checkbox	unchecked	by	default)
Enable	page	configuration 	(enabled	by	default):
This	enables	the	configuration	after	report	generation,	see	configuration	by	the	Web	site	users	section	below.	This	configuration	is	accessed
with	the	cogwheel	button	on	the	pages	top-right.	It	allows	to	configure	the	layout	without	having	to	export	the	report	again.	It	is	very	helpful
to	find	the	convenient	layout	without	re-exporting	the	report	each	time.
Include	half	and/	or	step-siblings	on	the	individual	pages,	
Use	tabbed	panels	instead	of	sections ,	
Show	last	modification	time ,	
Insert	sources	author	in	the	sources	title ,	
Suppress	Gramps	ID :
See	the	help	for	the	configuration	by	the	Web	site	users	section	below.

Tab	 Indexes

For	the	options	below,	see	the	help	for	the	configuration	after	report	generation	section.

Default	format	for	the	surnames	index
Default	format	for	the	persons	index
Default	format	for	the	families	index
Default	format	for	the	sources	index
Default	format	for	the	places	index
Include	dates	columns	on	the	index	pages
Include	a	column	for	partners	on	the	index	pages
Include	a	column	for	parents	on	the	index	pages
Include	a	column	for	media	path	on	the	index	pages
Include	references	in	indexes

Default	number	of	entries	in	the	indexes 	(10	by	default):

The	number	of	entries	per	page	in	the	index	tables	is	memorized	by	the	browser	for	each	user	and	each	table.	This	value	is	the	initial	default	value
before	the	users	select	their	own	preference.

Tab	 Pages

Header	/	footer:
The	Gramps	notes	used	as	header	/	footer	could	include	special	features,	described	in	the	custom	pages	section	below.
Brand	name	/	icon:
The	gramps	note	used	could	embed	an	image	or	any	other	special	field	described	in	the	custom	pages	section	below.
When	no	brand	name/icon	is	used,	the	Gramps	icon	is	used.
Specify	an	empty	note	for	disabling	the	Gramps	icon.

Tab	 Trees

Most	of	these	configuration	parameters	could	also	be	tuned	after	report	generation,	see	configuration	by	the	Web	site	users	section.

Colors :

The	gradient	colors	are	used	for	all	gradients	(based	on	generation,	time	period,	or	age).
The	gender	colors	are	set	in	the	Gramps	Prefrences	(in	Edit	menu).
The	 Color	scheme	classic	view 	:	It	is	hardcoded	in	Gramps.	The	colors	are	those	used	in	the	Chart	view,	for	the	"Descendant
Fan",	when	configuring	background	to	Color	scheme	classic	view
The	 Color	scheme	classic	report :	Same	as	Color	scheme	classic	view.

Duplicates :
For	people	appearing	several	times	in	the	tree	(for	example,	when	both	parents	share	a	common	ancestor).
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Tab	 Custom	pages

It	is	possible	to	add	custom	pages	built	from	a	note.	These	pages	could	be	used	for:

A	customized	home	page
A	contact	page
A	download	page
Etc.

These	pages	have	the	following	options:

Title	for	the	custom	page
Menu	for	the	custom	page 	(enabled	by	default):	allows	to	have	a	page	without	any	menu.
Note	for	the	custom	page :	This	note	could	include

Text	formating
Links	to	other	Gramps	objects
External	HTTP	links
Relative	HTTP	links:	They	are	given	as	regular	HTTP	links,	but	in	the	form	relative://<relative	path>
Special	fields:
These	fields	are	given	as	text	in	the	note	and	are	replaced	in	the	generated	report.

Export	date:	__EXPORT_DATE__
GRAMPS	homepage:	__GRAMPS_HOMEPAGE__
GRAMPS	version:	__GRAMPS_VERSION__
Number	of	families:	__NB_FAMILIES__
Number	of	persons:	__NB_INDIVIDUALS__
Number	of	media	objects:	__NB_MEDIA__
Number	of	sources:	__NB_SOURCES__
Number	of	repositories:	__NB_REPOSITORIES__
Number	of	places:	__NB_PLACES__
Search	form:	__SEARCH_FORM__
Embedded	image:	__MEDIA_<Gramps	ID>__	(for	example:	__MEDIA_O0011__)
Embedded	image	thumbnail:	__THUMB_<Gramps	ID>__

Tab	 Pages	selection

Allows	to	enable,	disable	and	order	pages.

Media	files	organization

There	3	possibilities	for	using	the	media	files	in	the	report:

1.	 Copy,	rename	files	with	an	internal	Gramps	identifier:
The	media	files	are	copied	at	every	report	generation,	in	the	directory	"image",	and	their	names	and	changed	into	a	unique	obfuscated	name.
This	behavior	is	identical	to	the	Narrative	Web	Site	report.

Copy,	keep	file	names	unchanged:
The	media	files	are	copied	at	every	report	generation,	in	the	directory	"image",	but	their	names	kept	intact.	The	files	that	are	in	the	same
directory	are	copied	into	the	same	directory.	The	directory	names	are	replaced	by	unique	obfuscated	names.
Do	not	copy,	reference	existing	files:
The	media	files	are	not	copied.
The	relative	path	from	the	generated	report	to	the	media	files	is	used.
Therefore,	the	relative	path	from	Web	report	to	the	media	object	shall	stay	the	same	between	local	computer	and	the	web	server	where	the
web	site	is	uploaded.
On	Windows:	The	report	shall	be	generated	on	the	same	disk	drive	where	the	media	files	are	located.

For	example:

The	media	files	are	located	in	the	directory:	C:\Users\Mewtwo\genealogy\media\
The	report	is	generated	in	the	directory:	C:\Users\Mewtwo\genealogy\reports\DynamicWeb
Then	the	relative	path	is:	..\..\media
Therefore,	on	the	web	server,	the	media	files	and	report	shall	be	located	in	something	like:
http://my.web.site.com/path/to/report/media	and	http://my.web.site.com/path/to/report/reports/DynamicWeb

Optimizations	for	big	databases

The	report	was	tested	with	a	database	with	over	120,000	people	without	blocking	issue.

Nevertheless,	some	users	could	have	performance	issues.

The	technology	used	for	this	report	(client-side	Javascript)	is	not	designed	for	managing	big	amounts	of	data.

This	could	lead	to	performance	issues,	for	databases	over	5000	people,	when	the	configuration	is	not	properly	set.	The	following	tunings	could	be
used:

The	optional	index	columns	should	be	discarded
The	indexes	should	be	displayed	as	lists	and	not	as	tables

Another	possibility	is	to	use	only	a	portion	of	the	Family	Tree	database.	Generating	the	report	with	a	smaller	filter	enhances	the	performances	and
provides	a	smoother	experience	for	the	Web	site	users.
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Do	you	really	want	to	use	the	entire	Family	Tree	database	?

Be	aware	that	if	you	select	the	Entire	Database	filter	option	for	your	Family	Tree	database	that	very	big
files	will	be	generated	(depending	on	the	size	of	your	Family	Tree	database).	It	is	recommended	to	start
with	a	smaller	filter	(for	example:	ancestors	of	a	certain	person)	to	simplify	the	output	while	you	learn
about	the	Dynamic	Web	report.

Moreover,	when	rendering	large	datasets,	the	report	disables	some	fancy	features	for	better	performances.

Then	again,	exporting	a	portion	of	the	database	helps.

Help	for	the	Web	site	users

Configuration	by	the	Web	site	users

Some	configuration	parameters	are	accessible	after	the	report	generation,	using	the	cogwheel	button	at	the	top-right	of	the	pages.

This	cogwheel	button	is	enabled	in	the	 Advanced 	tab,	described	above.

Use	a	table	format	for	the	index,	for	the	 surnames ,	 persons ,	 families ,	 sources 	or	 places 	indexes:
When	enabled,	the	indexes	are	shown	as	tables.	These	tables	could	be	sorted	by	any	column,	and	filtered.
When	disabled,	the	indexes	are	shown	as	lists.	When	possible,	these	lists	are	indexed	alphabetically.	The	lists	could	also	be	sorted	by
name,	date,	etc.	depending	on	the	type	of	data	shown.

Include	columns	on	the	index	pages 	for	 dates ,	 partners ,	 parents ,	 media	path :
Includes	the	corresponding	columns	in	the	indexes,	when	the	indexes	are	shown	as	lists.

Include	references	in	indexes :
When	enabled,	the	references	between	objects	are	shown	in	the	indexes,	when	they	are	shown	as	lists..
For	example,	objects	citing	a	source	are	shown	in	the	sources	index.

Include	Place	map	on	Place	Pages :
Whether	to	include	a	place	map	on	the	Place	Pages,	where	Latitude/	Longitude	are	available.

Include	a	map	in	the	individuals	and	family	pages:
Whether	to	include	a	place	map	on	the	pages,	where	Latitude/	Longitude	are	available.

Include	half	and/	or	step-siblings	on	the	individual	pages
Insert	sources	author	in	the	sources	title :

The	source	author	is	always	shown	with	the	source	title.	This	covers	the	case	when	source	titles	are	too	generic,	like	 "baptize	registry"
for	example.

Use	tabbed	panels	instead	of	sections :
Changes	the	layout	of	the	pages.	With	tabbed	panels,	the	pages	are	more	compact.	With	sections,	all	the	data	is	visible	at	the	same	time
(no	need	to	switch	between	tabs).
Note:	the	sections	are	collapsible.

Show	last	modification	time :
Adds	a	modification	date/time	in	the	page	footer.

Suppress	Gramps	ID :
Allows	to	hide	the	Gramps	ID.	The	Gramps	ID	is	an	identifier	for	each	object	stored	in	the	Family	Tree	database.	It	could	be	used	to
precisely	identify	an	element	(person,	family,	source,	etc.).

Restore	default	settings :
Restores	the	settings	used	when	the	report	was	generated.
This	button	also	resets	the	user	preferences,	like	the	number	of	items	per	pages	in	the	index	tables.

Graphical	tree	options
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The	Graphical	aspect	of	the	tree	could	be	modified,	depending	on	users	preferences.

SVG	tree	graph	type
Ascending	tree :	Only	ancestors	of	the	chosen	person	are	shown
Descending	tree :	Only	descendants	of	the	chosen	person	are	shown
Descending	tree	with	spouses :	Descendants	of	the	chosen	person	are	shown,	along	with	their	spouses
Ascending	and	descending	tree :	Ancestors	and	descendants	of	the	chosen	person	are	shown
Ascending	and	descending	tree	with	spouses :	Ancestors	and	descendants	of	the	chosen	person	are	shown,	along	with
their	spouses

SVG	tree	graph	shape
Vertical	(↓) :	Ancestors	on	the	top	of	the	page,	descendants	on	the	bottom	of	the	page
Vertical	(↑) :	Ancestors	on	the	bottom	of	the	page,	descendants	on	the	top	of	the	page
Horizontal	(→) :	Ancestors	on	the	left	of	the	page,	descendants	on	the	right	of	the	page
Horizontal	(←) :	Ancestors	on	the	right	of	the	page,	descendants	on	the	left	of	the	page
Full	Circle :	Chosen	person	is	in	the	center	opf	the	page
Half	Circle :	Chosen	person	is	in	the	bottom-center	of	the	page.	This	graph	shape	is	not	available	when	displaying	both
ancestors	and	descendants.
Quadrant :	Chosen	person	is	in	the	bottom-left	of	the	page.	This	graph	shape	is	not	available	when	displaying	both	ancestors	and
descendants.

SVG	tree	parents	distribution ,	 SVG	tree	children	distribution
Size	proportional	to	number :	The	size	allocated	to	each	individual	depends	on	how	many	ancestors/descendants	there	are.
This	improves	the	readability.
Homogeneous	distribution :	The	size	is	allocated	homogeneously	to	each	individual.

Background
Ancestors :	Number	of	ancestors	generations.
Descendants :	Number	of	descendants	generations.
Show	duplicates :	Outlines	the	people	appearing	several	times	in	the	tree	(for	example,	when	both	parents	share	a	common	ancestor).
Restore	default	settings :Restores	the	settings	used	when	the	report	was	generated.

Graphical	tree	navigation

Tree	view	example

Use	the	mousewheel	to	zoom	in	and	out.
Use	the	mouse	drag	and	drop	to	move	the	graph.
Use	the	mouse	left-click	to	center	the	graph	on	a	person.
Use	the	mouse	right-click	to	open	a	context	menu.	This	menu	gives	access	to:

The	person	page,
The	persons	related	to	this	person	(parents,	children,	siblings,	souses).

Use	Shift	+	left-click	to	go	to	the	person	page	(same	as	using	the	context	menu	from	the	right-click).

Map	navigation
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Map	example

The	mouse	left-click	expands	the	map	full-screen	(or	restores	it	back).

Issues
Issues	and	features	requests	are	managed	in	the	Gramps	bug	tracking	system
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5.2	Addons

Edit	Image	Exif	Metadata

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Edit	Exif	Metadata

was	originally	included	in	Gramps	3.4.x	and	earlier

Edit	Exif	Metadata	Gramplet	-	detached	example

Edit	Exif	Metadata	Gramplet	-	Edit	dialog	example

The	 Edit	Exif	Metadata 	Gramplet	offers	an	easy	interface	to	add,	edit,	and	remove	Image	Exif	(Exchangeable	image	file	format)	Metadata
from	your	images	(*.jpg,	*.png.	*.tiff,	*.exv,	*.nef,	*.psd,	*.pgf).

See	also	the	built-in:

Image	Metadata	Gramplet	that	only	displays	the	Exif	information.

Usage

Add	the	gramplet
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Initially	needs	to	be	added	as	a	Gramplet	in	the	Media	List	View	category,	either	on	bottom	bar	or	on	the	side	bar.	Click	Views	from	the	Menu
bar,	and	select	Media	Views
Select	 Edit	Exif	Metadata 	Gramplet

General	usage

Select	an	image	from	the	 Media	List	View 	to	edit	its	Exif	Metadata.

The	interface

Summary	section

The	top	section	displays	a	summary	of	the	selected	media	object.	Typically	the	filename,	file	type	and	image	dimensions.

Buttons

Thumbnail 	-	will	produce	a	popup	showing	the	thumbnail.
<--	Image	Types	-->	V 	-	Select	from	a	drop-	down	box	the	image	file	type	that	you	would	like	to	convert	your	non-	Exiv2	compatible
media	object	to.
Convert 	-	If	your	image	is	not	of	an	image	type	that	can	have	Exif	metadata	read/written	to/from,	convert	it	to	a	type	that	can?
Help 	-	brings	your	to	this	page.
Edit 	-	This	will	open	up	a	new	window	to	allow	you	to	edit/modify	this	images's	Exif	metadata.	It	will	also	allow	you	to	be	able	to	Save
the	modified	metadata.

Save 	-	Will	write	the	metadata	to	the	image,	and	convert	latitude/longitude	if	it	is	in	decimal	format.
Clear 	-	Will	clear	all	data	fields
Copy
Close

Clear	GPS 	-	coordinates
Delete 	-	WARNING:	This	will	completely	erase	all	Exif	metadata	from	this	image!	Are	you	sure	you	want	to	do	this?

Data	Fields

Photographer
The	name	of	the	person	or	company	taking	the	image

Select	Date
Will	bring	up	a	calendar,	and	double-click	on	a	date.	The	time	will	be	filled	in	as	the	current	time

Date
The	Date/Time	needs	to	be	typed	in	as	a	very	specific	format:
Year	Mon	Day	24Hour:Minutes:Seconds
e.g.:	1826	Apr	12	14:06:00

Copyright
Can	be	anything	that	you	please...	
e.g.:	(C)	2010	Smith	and	Wesson	

Subject
Please	enter	keywords	that	describe	the	picture.	(Do	NOT	add	spaces	after	commas.)
e.g.:	Census,Milwaukee,Oregon

Latitude/Longitude
Latitude/Longitude	data	can	be	entered	in	one	of	two	ways:

1.	 Degrees	Minutes	Seconds
e.g.:	83	59	14

In	this	format,	you	will	need	to	select	cardinal	direction	Latitudinal	reference,	and	longitudinal	reference
If	the	Latitude	begins	with	a	negative	number,	select	'S'	(South)	as	Latitudinal	Reference	or	'N'	(North)	if	a	positive	number.	If
the	Longitude	begins	with	a	negative	number,	select	'W'	(West)	as	the	Longitudinal	Reference	or	'E'	(East)	if	a	positive	number.

2.	 Decimal
e.g.:	-34.15954

In	this	format,	the	Latitude	and	Longitude	reference	will	be	selected	for	you	after	you	click	Convert	GPS	Coordinates	or	press	the
Save	button.	For	foreign	countries	that	might	use	a	",	"	instead	of	a	".",	please	use	the	"."

Description
Type	in	something	about	the	image,	the	people	in	it	or	the	location	of	the	image.	Non-latin	characters	are	NOT	allowed.	ASCII	characters
only...

Prerequisites
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This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

Special	Note

Before	being	able	to	use	this	Gramplet/Addon,	you	will	need	to	download	and	install	gexiv2
or	install	gexiv2	from	your	local	Linux	repository.
MS-Windows	users,	this	is	depends	on	which	installer	you	used.
Ubuntu,	use	the	Universe	repository	to	find	gexiv2.
Also	see	GExiv2	for	Image	metadata

Once	you	have	installed	gexiv2,	see	above	for	directions	to	download	and	install	this	addon...

Special	Note:

Before	being	able	to	use	this	addon	gramplet,	you	will	need	to	download	and	install	pyexiv2	or	install
pyexiv2	from	your	local	Linux	repository.	Windows	user,	there	is	an	installer	for	you.	Ubuntu,	use	the
Universe	repository	to	find	python-pyexiv2.

Once	you	have	installed	pyexiv2,	see	above	for	directions	to	download	and	install	this	addon...

Pyexiv2	can	be	used	from	the	command	line	interface	(cli)	as	well,	and	from	within	a	python	script:

1.	 import	the	pyexiv2	library

from	pyexiv2	import	ImageMetadata,	ExifTag

2.	 specify	your	image

image	=	ImageMetadata("/home/user/image.jpg")

3.	 read	the	image

image.read()

Exif,	IPTC,	XMP	metadata	reference	tags	can	be	found	here.

Example:

image["Exif.Image.Artist"]	#	Artist
Smith	and	Johnson's	Photography	Studio

image["Exif.Image.DateTime"]	#	DateTime
1826	Apr	12	14:00:00

image["Exif.Image.DateTime"]	=	datetime.datetime.now()	#	Add	DateTime

image.write()	#	write	the	Metadata

Issues
6606	Gramplet	does	not	work	(	Needs	converting	from	pyexiv2	to	GExiv2.	(Was	originally	included	in	Gramps	3	and	earlier)	)

2018-04-02	10:33:07.872:	WARNING:	_manager.py:	line	295:	Plugin	error	(from	'editexifmetadata'):	No	module
named	'pyexiv2'

See	also
Image	Metadata	-	built-in	Gramplet	to	view	Exchangeable	Image	Format	(Exif)	Metadata
Media	Report	-	Gramps	"Report"	addon	by	Matthias	Kemmer
Photo	Tagging	-	Gramps	"Gramplet"	addon
Edit	Image	Exif	Metadata	-	Gramps	"Gramplet"	addon

gexiv2	-	GObject	wrapper	around	the	Exiv2	photo	metadata	library	(a	prerequisite	for	the	Image	Metadata	Gramplet)
Family	History	Metadata	Working	Group	(GitHub	repository,	Facebook,	LinkedIn	Website)

Metadata	Standards	v1.0	(Exec	Summary)
Metadata	Standards	v1.0	(Technical	Summary)
Metadata	Standards	v1.0	(Full	Normative	Specification)

NISO	Metadata	for	Images	in	XML	(NISO	MIX)
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5.2	Addons

EventDescriptionEditor

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

"Event	Description	Editor"	tool	-	defaults

The	 Event	Description	Editor 	tool	is	an	addon	that	allow	you	to	find	and	replace	a	text	string	in	the	event	description	of	multiple	events.

The	 Description: 	field	gives	you	the	opportunity	to	give	a	longer	description	what	this	event	is.

Usage
Once	this	plugin	has	been	installed:

Select	Menu	Tools	>	Family	Tree	Processing	->	Event	Description	Editor...

Undo	history	warning

Proceeding	with	this	tool	will	erase	the	undo	history	for	this	session.	In	particular,	you	will	not	be	able	to
revert	the	changes	made	by	this	tool	or	any	changes	made	prior	to	it.	If	you	think	you	may	want	to	revert
running	this	tool,	please	stop	here	and	backup	your	database.

From	the	Undo	history	warning	dialogue	you	can	choose	 Stop 	or	 Proceed	with	the	tool .

The	Options	tab	is	displayed	with	the	following:
Events: 	All	Events(default)	-	The	events	selected	by	a	custom	or	generic	filter.
Find: 	The	(sub)string	that	should	be	found	in	event	descriptions.
Replace: 	The	string	that	should	be	used	to	replace	the	event	description.

[	]	Replace	substring	only 	-	If	this	checkbox	is	ticked,	only	the	found	substring	will	be	replaced	with	the	replace
string.	If	True	only	the	substring	will	be	replaced,	otherwise	the	whole	description	will	be	deleted	and	replaced	by	the	new	one

You	can	select	 Close 	to	exit	with	no	change,	or	enter	the	options	you	need	changed	and	then	select	 Execute 	to	process	your	changes;	once
completed	the	tool	will	display	the	 INFO 	dialog	showing	the	total	number	of	change	made.
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5.2	Addons

ExportRaw

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

The	 [	]Raw	Export
option	checkbox	on	the
Choose	the	output
format 	page

Purpose
The	 Raw	Export 	adds	an	option	to	the	Export	Assistant	feature.	The	option	dumps	your	SQLite3	(default	database	engine	since	Gramps	5.1)	or
BSDDB	(Gramps	database;	into	a	raw	Python	object	representation	format	for	low-level	manipulation.

This	uses	the	object	string	conversion	representation	returned	from	Python's	repr()	built-in	function.	It	is	similar	to	the	str()	function	but	intended
for	internal	use	rather	than	display.	It	can	be	useful	for	printing	an	element	regardless	of	its	type.

Raw	output	has	been	used	for	byte-wise	comparisons	to	make	sure	that	different	import/export	functions	process	the	data	correctly.

Usage
Start	an	export	via	the	menu	Family	Trees	>	Export...	and	on	the	 Export	Assistant	dialog 	select	the	 Next 	button	to	get	to	the	 Choose
the	output	format 	page	where	you	can	select	the	 [	]Raw	Export 	option	checkbox.

Example	output
The	output	file	[filenamename].raw	can	be	opened	and	viewed	in	a	text	editor.	Here	is	a	sample	using	the	Example.gramps	family	tree:

note:	b39feeac1a202b44e76	('b39feeac1a202b44e76',	'N0012',	('How	did	he	die?	We	need	to	find	out!\n\nPerhaps	we	find	info	in	the	new	york	library',	[((5,	''),	'#ff0909',	[(16,	36)]),	((0,	''),	None,	[(62,	74)]),	((2,	''),	None,	[(0,	3)]),	((6,	''),	'#fbd50a',	[(62,	74)]),	((4,	''),	14,	[(16,	36)])]),	0,	(10,	''),	1234371783,	[],	False)
note:	ac380498bac48eedee8	('ac380498bac48eedee8',	'N0001',	('Names	can	notes,	too.	This	is	a	note	for	the	alternate	name	of	Louse	Garner	for	Lewis	Anderson	Garner.',	[((8,	''),	'gramps://Person/handle/GNUJQCL9MD64AM56OH',	[(80,	101)])]),	0,	(20,	''),	1185438865,	[],	False)
.....
citation:	e73a40d955f403d3fafddcfc646	('e73a40d955f403d3fafddcfc646',	'C2854',	(0,	0,	0,	(6,	6,	1841,	False),	'6	Jun	1841',	2393628,	0),	'House	of	Garner',	2,	'e73a3fdc8ce67c82dbf7485ba92',	[],	[],	[],	1588983638,	[],	False)
citation:	e73a41d73a065efcf7ce001e9a8	('e73a41d73a065efcf7ce001e9a8',	'C2855',	(0,	0,	0,	(6,	6,	1841,	False),	'6	Jun	1841',	2393628,	0),	'',	2,	'e73a3fdc8ce67c82dbf7485ba92',	[],	[],	[],	1588983742,	[],	False)
tag:	bb80c229eef1ee1a3ec	('bb80c229eef1ee1a3ec',	'complete',	'#076780873bf0',	1,	1288512479)
tag:	bb80c2b235b0a1b3f49	('bb80c2b235b0a1b3f49',	'ToDo',	'#efb60c280c28',	0,	1288512442)

See	also
Source	code:

ExportRaw	add-on
gramps/gen/lib	(see	type.py)

Gramps	data	model	diagram
Discourse	forum	thread:	"Does	anyone	have	a	list	of	the	Raw	Export	addon	event	type	codes?"
Developer	documentation:	gen_lib.html#module-gramps.gen.lib.eventtype
The	Supertool	(Isotammi	add-on	tool)	includes	the	ability	to	show	repr()	and	str()	data	interactively
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5.2	Addons

Extract	Place	Data	from	a	Place	Title

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Previously	Part	of	Gramps	4.2.x	and	earlier

And	now	no	longer	part	of	Gramps	you	can	download	this	tool	from	the	third	party	addons

Extract	Place	Data 	result	dialog	example	for	the	 Extract
Place	Data	from	a	Place	Title	tool

The	 Extract	Place	Data	from	a	Place	Title 	tool	attempts	to	extract	city,	state/province	and	zip	code	information	from	a	place	title.

The	tools	operates	on	places	where	all	fields	in	the	main	location	are	empty.

Usage
You	can	access	this	tool	via	the	menu	Tools->Family	Tree	Processing->Extract	Place	Data	from	a	Place	Title...

The	Undo	history	warning	will	be	shown	and	you	can	either	 Stop 	or	 Proceed	with	the	tool .

Once	the	report	finishes	the	 Extract	Place	data 	dialog	results	window	will	show	a	preview	list	of	Places	with	the	possible	data	that	can	be
extracted	from	the	place	title.	Un-select	the	places	you	don't	wish	the	tool	to	convert	and	select	the	 Accept	changes	and	close 	button	to
apply	the	changes.

You	can	use	the	mouse	or	keyboard	to	select	multiple	rows	at	once,	by	using	the	 CTRL 	or	 SHIFT 	keys	with	the	mouse	click,	or	with	the	space
key.	 CTRL	+	A 	will	select	all	rows.

The	 Toggle	selection 	button	will	toggle	the	selection	of	all	selected	rows	to	match	the	top	row.

You	can	sort	the	columns	with	a	click	of	the	column	header.

Apart	from	the	Place	title	column	you	can	also	manually	edit	the	other	column	values	if	necessary	by	clicking	on	them.

Notes

The	description	must	match	the	following	categories:

New	York,	NY	10000

Only	available	for	:

USA
Canada
Sweden

Stockholm	(A)
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France
Paris,	IDF	75000,	FRA	or	Paris,	ILE	DE	FRANCE	75000,	FRA

See	also
Places	in	Gramps
Gramps_5.2_Wiki_Manual_-_Entering_and_editing_data:_detailed_-_part_2#Place_Editor_dialog
Title	area	at	the	top	of	the	 Place	Editor	dialog 	displays	the	description	of	the	place	to	be	used	in	reports.	Gramps	will	construct	this
for	you.	See	Preferences	>	Display	>	Enable	automatic	place	title	generation
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5.2	Addons

FamilyRelationship

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

The	 Family	Relationship	Tool 	allows	you	to	change	the	relationship	type	for	a	selected	set	of	filtered	families.	

Usage
Once	this	addon	has	been	installed:

Select	Menu	Tools	>	Family	Tree	Processing	->	Family	Relationship	Tool...

Undo	history	warning

Proceeding	with	this	tool	will	erase	the	undo	history	for	this	session.	In	particular,	you	will	not	be	able	to
revert	the	changes	made	by	this	tool	or	any	changes	made	prior	to	it.	If	you	think	you	may	want	to	revert
running	this	tool,	please	stop	here	and	backup	your	database.

From	the	Undo	history	warning	dialogue	you	can	choose	 Stop 	or	 Proceed	with	the	tool .

The	 Options 	tab	is	displayed	with	the	following:
Family	Filter: 	-	Filter	All	families	or	a	custom	filter	to	restrict	the	amount	of	families	where	you	want	to	change	the	relationship
type.
Relationship	Type: 	-	Select	the	relationship	type	the	families	should	be	set	to.

Once	you	have	made	your	choices	the	image	or	images	that	should	be	attached	as	avatar	images,	you	can	either	choose	 Close 	or	 Execute 	to
apply	the	change.
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5.2	Addons

Family	Sheet

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Family	Sheet	-	Text	Report	-	Addon	-	example	output

The	 Family	Sheet 	text	report	creates	Family	Group	Sheet	which	contains	all	available	info	about	a	specific	person,	the	families	this	person	is	a
father	or	mother	in,	and	the	children	of	these	families.

The	intended	use	for	this	report	is	to	get	a	full	output/dump	of	the	database	in	well	formated	paper	form	that	is	suitable	to	file	in	a	folder.

Features
Each	Family	Sheet	contains	a	key	at	the	top	right	which	is	derived	from	the	relationship	from	the	central	person	in	the	database	and	the	person	for
which	the	sheet	is	printed.	For	direct	ascendants,	the	Family	Sheet	key	is	the	"Ahnentafel"	number	(also	known	as	Eytzinger,	Sosa,	Sosa-Stradonitz,
or	Kekule	number).	Each	child	is	assigned	a	letter	starting	from	"a",	and	the	Family	Sheet	key	of	the	child	is	the	Family	Sheet	key	of	the	parent	with
the	child's	letter	appended.

The	report	contains	full	information	(including	all	events,	attributes,	source	references,	and	notes)	for	the	key	person	and	all	its	spouses.	For
children	that	had	spouses,	only	a	short	section	(including	only	name	and	birth	event	info)	is	printed	along	with	a	reference	to	the	Family	Sheet	page
on	which	this	child	would	be	the	key	person,	while	for	children	that	had	no	spouses,	full	info	is	printed.

If	recursive	printing	is	selected	from	the	 Print	sheets	for: 	option,	each	Family	Sheet	is	followed	by	the	Family	Sheets	of	the	children	that
had	spouses.

Usage
Once	installed	you	can	choose	the	Family	Sheet	Report	with	Reports	->Text	Reports	->	Family	Sheet...

Report	Options
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"Family	Sheet"	"Report	Options"	tab	-	defaults

Center	person:
Select	a	different	person 	button

Print	sheets	for:
Center	person	only	(default)
Center	person	and	descendants	in	side	branches
Center	person	and	all	descendants

Use	call	name:
Don't	use	call	name	(default)
Replace	first	name	with	call	name
Underline	call	name	in	first	name	/	add	call	name	to	first	name

	 Print	placeholders	for	missing	information 	(checkbox	checked	by	default)
	 Include	sources 	(checkbox	checked	by	default)
	 Include	notes 	(checkbox	checked	by	default)

Prerequisites
For	this	report	to	work

PIL	(Python	Imaging	Library)	needs	to	be	installed.

Issues
Help	button	does	not	come	here.
Formatting	issue	with	a	single	person.
No	citations	available.
0005913:	[Family	Sheet	report]	missing	bottom	border	lines	in	LaTeX	output
0007818:	[Family	Sheet	report]	Enhance	RTF	/	Clean	up	formating
0011748:	Family	Sheet	text-report:	Reports	place	notes	and	locked	notes,	repeatedly

See	also
Family	Group	Report	-	builtin	report.
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5.2	Addons

Family	Tree

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Family	Tree	-	Graphical	Reports	-	Addon	-	example	of	results

The	 Family	Tree 	report	generates	a	graphical	tree	of	a	family	with	its	ancestors	and/or	descendants.	Similar	to	the	standard	built-in	Ancestor
Tree	and	Descendant	Tree	reports	but	with	the	following	differences:

Both	ancestors	and	descendants	are	combined	in	a	single	report
On	the	ancestors	side,	father	and	mother	are	combined	in	a	box
On	the	descendants	side,	spouses	are	included

Marriage	and	divorce	information	is	included
The	names	are	printed	in	a	bigger	font	than	the	dates	and	places	(birth	date,	death	date,	etc)
This	report	makes	better	use	of	the	available	space	for	printing	ancestors	and	the	whole	report	is	centered	on	the	page,	the	boxes	are	also
aligned	in	a	more	centered	than	top-aligned	way

Numerous	other	user	selectable	options	allowing	coloring,	and	how	various	family	information	is	display.

Usage
You	can	choose	the	Family	Tree	report	with	Reports	->Graphical	Reports	->	Family	Tree...

The	 Family	Tree 	report	starts	with	a	center	family	and	can	print	both	ancestors	(to	the	left)	and	descendants	(to	the	right).

Paper	Options

Printing	on	more	than	one	page	doesn't	work,

you	usually	want	to	use	the	default	 [x]	scale	to	fit	on	a	single	page	option.

See	also	common	options
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If	the	report	determines	that	the	paper	size	is	not	large	enough	you	will	see	the	warning
dialog

Paper	too	small:	Some	elements	may	not	appear	or
be	badly	rendered.

and	you	should	choose	a	larger	paper	size	or	reduce	the	number	of	generations	to	be	shown.

Tree	Options

Family	Tree	-	Graphical	Reports	-	Tree	Options	-	tab	default	options

Center	Family: 	you	can	choose	the	family	to	center	the	report	around.
Ancestor	Generations:
Descendant	Generations:
Kekule	number	of	husband:

[	]	Scale	to	fit	on	a	single	page
Colour:

[	]	Shuffle	colors

The	report	can	be	colored,	with	various	coloring	options	

Content	Options

Family	Tree	-	Graphical	Reports	-	Content	-	tab	default	options

You	have	the	option	to	print	occupation	and	residence.
There	are	3	predefined	ways	of	formatting	the	birth/death/marriage/divorce	data:	year	only,	full	date,	or	full	date	and	place

[	]	Include	Occupation
[	]	Include	Notes
[	]	Include	Residence
Print	event	data	(dead	person):
Print	event	data	(living	person):
[	]	Fall	back	to	baptism	if	birth	event	missing
[	]	Fall	back	to	burial	or	cremation	if	death	event	missing
[	]	Protect	private	items
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[	]	Print	fields	for	missing	information
[	]	Include	event	description

Tree	Options

Family	Tree	-	Graphical	Reports	-	Text	Options	-	tab	default	options

Title	text: 	-	if	left	blank	the	report	will	print	"Family	Tree	for	[Person	one]	and	[Person	two]".
Footer	text: 	-	if	left	blank	the	report	will	print	nothing

Callname	handling
This	report	has	an	some	experimental	options	to

use	the	call	name	instead	of	the	first	name,
or	to	underline	the	call	name	(only	works	with	PDF	output)

To	activate	callname	handling,	you	need	to	apply	the	patch	in	8003	uncomment	in	the	FamilyTree.py	the	line

#	menu.add_option(category_name,	"callname",	callname)

The	report	uses	<u>...</u>	to	underline	the	call	name	if	the	call	name	is	a	part	of	the	first	name.	This	only	works	with	CairoDoc	based	output
(direct	printing,	PDF	export)	and	HTML	output.

Issues
Help	button	wrong	page
7018	:	Family	Tree	report	no	longer	underlines	call	name	in	PDF	output

See	also
Addon:DescendantsLines	-	generates	vertical	orthogonal	graphical	trees.
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5.2	Addons

Fix	Capitalization	of	Given	Names

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Fix	Capitalization	of	Given	Names	-	Addon	-	example	of	results

Searches	the	entire	selected	Family	Tree	(database)	and	attempts	to	fix	capitalization	of	the	given	names.

Usage
You	can	use	this	tool	via	menu	Tools->Family	Tree	Processing->Fix	Capitalization	of	Given	Names....

This	tool	is	a	Addon	and	once	installed	works	almost	identically	to	the	built-in	 Fix	Capitalization	of	Family	Names 	tool.

Issues
Help	page	does	not	go	here
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5.2	Addons

Forms	Gramplet

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Census	or	Form?

Please	note	the	Form	Addons	are	an	upgrade	released	in	2015	to	expand	the	flexibility	of	the	original
Census	Addons.	The	Form	Addons	supersede	the	Census	Addons	from	Gramps	4.2.X

Forms	Gramplet	-	Shown	Undocked	from	Bottombar	Of	People
Category	View

The	Form	gramplet	allows	users	to	create	and	edit	structured	source	data	in	a	single	form.	It	makes	the	meticulous	process	of	recording	all	the
discrete	elements	far	less	fussy	and	error-prone.

The	 Form	gramplet 	has	been	enhanced	to	handle	other	 forms 	such	as	birth,	marriage	and	death	certificates	and	parish	register	entries	as	well
as	the	originally	supported	census	forms.

Using	a	Form	doesn't	mean	creating	data	that	can	only	be	accessed	with	the	Form	tool.	You	can	forego	using	the	Form	Gramplet	at	any	time	but	still
see	and	edit	the	data	that	was	entered.	The	Form	gramplet	merely	streamlines	creating	Events	with	the	Attributes	to	separately	store	elements	of	data
from	a	structured	source.	You	could	do	the	same	process	using	the	standard	Gramps	editors...	it	would	just	involve	a	lot	more	steps	per	Person	or
Event.

Forms	Gramplet

Before	using	the	forms	addons

You	need	to	define	the	form	that	describes	the	information	contained	within	a	source.
See:	Configuration

Adding	the	Forms	Gramplet
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Adding	Forms	Gramplet	to	bottombar	of	People	Category	(Tree)
View

The	Forms	gramplet	is	designed	to	be	added	for	the	bottombar	 People	Category	(Grouped	or	List)	view	modes	of	Gramps.	(After	installation,
this	gramplet	will	be	available	for	addition	in	all	these	locations:	the	sidebar/bottombar	option	for	the	following	views:	 People,	 Relationships,	
Charts,	and	 Geography.)

Select	the	 Forms 	menu	option	from	the	 Add	a	gramplet 	submenu	of	the	Gramplet	selection	menus.	Accessible	by	pressing	the	 ∨ 	(Down
Arrowhead	button)	in	the	view's	sidebar	or	bottombar.

The	blank	Forms	Gramplet	will	be	shown	docked	as	below.	

Forms	Gramplet	-	Shown	docked	In	Bottombar	Of	People	Category
View

Initial	Configuration	for	each	source

Before	using	the	forms	addons	you	need	to	define	the	form	that	describes	the	information	contained	within	a	source.	See:	Configuration

The	Forms	Gramplet	lists	all	the	events	for	the	active	person	that	can	be	edited	using	the	form	editor.	The	listing	displays	the	source,	date	and	place
of	the	event	together	with	the	role	the	active	person	performs	in	the	event.

A	new	event	can	be	created	by	clicking	the	 New 	button	at	the	bottom	of	the	 Forms	Gramplet 	which	will	show	you	the	 Select	Form
selector	dialog	where	you	can	choose	the	form	to	use.	Once	you	select	a	form	you	will	be	taken	to	the	 Form	Editor .
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Forms	Gramplet	-	Shown	Undocked	from	Bottombar	Of	People
Category	View

An	existing	event	can	be	edited	either	by	highlighting	a	row	and	clicking	the	 Edit 	button	or	by	double-clicking	on	a	row	to	bring	up	the	 Form
Editor .

If	the	 Forms	Gramplet 	is	undocked	you	can	use	the	 Help 	button	to	see	this	page.	

Form	Selector
The	form	selector	allows	the	user	to	select	a	source	that	has	been	associated	with	a	form.	The	sources	are	grouped	by	event	type.

If	the	 Form	Selector 	list	is	empty	then	you	need	to	define	the	form	that	describes	the	information	contained	within	a	source.	See:
Configuration	

Form	Editor
The	form	editor	is	designed	so	that	most	data	for	an	event	can	be	entered	into	a	single	form.

First	a	citation	reference	should	be	entered.	This	should	comprise	of	one	or	more	references	that	uniquely	identify	the	citation.	For	example,	in
the	case	of	a	UK	census	you	will	need	to	enter	the	PRO	reference,	Piece,	Folio	and	Page.

The	date	of	the	event	can	be	entered.	For	a	census,	the	date	is	populated	automatically.

A	place	can	be	selected	in	the	usual	Gramps	manner.
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Details	tab

The	" Details "	tab	provides	an	area	which	allows	the	user	to	enter	data	specific	to	individual	people	listed	in	the	source.	This	tab	can	be	divided
into	sections.	Each	section	consists	of	people	performing	the	same	role	in	the	event.

Person	Section

A	person	section	allows	information	about	a	single	person	to	be	entered.	A	new	person	can	be	created	and	selected	by	clicking	the	 + 	button.	A
person	already	in	Gramps	can	be	selected	by	clicking	the	second	button	( share ).	The	user	is	prevented	from	entering	data	until	a	person	is
selected.

Family	Section

A	family	section	allows	information	about	two	people	belonging	to	a	family	to	be	entered.	A	new	family	can	be	created	and	selected	by	clicking	the
+ 	button.	A	family	already	in	Gramps	can	be	selected	by	clicking	the	second	button	( share ).	The	user	is	prevented	from	entering	data	until	a
family	is	selected.

Multiple	Person	Section

A	multiple	person	section	allows	information	about	multiple	people	to	be	entered.	A	new	person	can	be	created	and	then	added	to	the	section	by
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clicking	the	 + 	button.	A	person	already	in	Gramps	can	be	added	to	the	section	by	clicking	the	second	button	( share ).	A	person	can	be	removed
from	the	section	by	clicking	the	 - 	button.	The	order	of	people	in	the	section	can	be	changed	by	highlighting	a	row	and	then	using	the	up	 ↑ 	and
down	 ↓ 	arrow	buttons.

Headings	tab

The	 Headings 	tab	provides	an	area	which	allows	the	user	to	enter	data	specific	to	the	event	listed	in	the	source.

Gallery	tab

The	 Gallery 	tab	provides	the	ability	to	add	media	to	the	event.	This	is	done	in	the	same	way	as	in	the	standard	Gramps	editors.

Configuration
Before	using	the	form	addons,	you	need	to	define	the	form	that	describes	the	information	contained	within	a	source.

To	do	this	you	need	to	edit	each	 Source 	and	add	an	entry	in	the	 "Attributes" 	tab.	The	entry	must	have	a	key	of	"Form"	and	a	value	which	is
a	 Code 	that	uniquely	identifies	the	form	to	be	used	eg:	UK1841

Translated	Gramps

If	you	are	using	Gramps	in	a	language	other	than	English,	enter	the	translated	version	of	the	key	(e.g.	In
French,	"Formulaire"	instead	of	"Form").

Supported	form	definitions

To	see	a	full	list	of	the	supported	 Code 's	for	definitions	included	with	the	addon	that	are	available,	See:	Addon:Form	Definitions

Writing	your	own	form	definitions

Note

Make	sure	that	your	definition	file	is	saved	using	UTF-8	encoding.
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If	a	form	you	require	is	not	in	the	list	of	supported	definitions	then	you	can	write	your	own.

Form	definitions	are	stored	in	XML	files.	These	are	located	in	the	Form	directory	beneath	your	user	plugins	directory.	The	file	called
form_xx.xml(where	xx	is	a	country	code),	is	provided	in	the	download,	and	contains	some	common	definitions.	Additional	files	called	custom.xml
and	test.xml	will	also	be	searched.

Definition	files	consist	of	an	XML	declaration	followed	by	a	forms	element.

<?xml	version="1.0"	encoding="UTF-8"	?>
<forms>
</forms>

The	forms	element	contains	a	number	of	form	elements,	each	representing	a	form	definition.	The	form	start-tag	contains	4	attributes:

id	:	A	unique	code	to	identify	the	form	definition.	You	will	use	this	code	in	the	"Form"	attribute	of	the	source.
type:	The	type	of	the	event	created	by	the	form	editor.	This	value	will	appear	in	the	"Type"	column	of	events	("EventType").	It	would	be	wise
to	avoid	standard	ones,	for	example,	to	add	death	information	you	could	specify	"Death.Info"	or	another	one	you	make	up	(Data	loss	is
possible	otherwise).
title	:	A	description	of	the	form.	It	should	be	possible	to	use	anything	here.
date	:	An	optional	date	in	a	Gramps	date	format.	This	is	only	useful	for	census	definitions	or	similar	events	that	happen	on	a	specific	date.

<form	id='UK1841'	type='Census'	title='1841	UK	Census'	date='6	Jun	1841'>

The	form	is	divided	into	sections	which	describe	the	information	that	needs	to	be	captured	for	people	performing	a	given	role	in	the	event.	Each
form	element	should	contain	at	least	one	section	element.	The	section	start-tag	can	specify	these	3	attributes:

role	:	The	role	that	people	in	this	section	perform	in	the	event.	This	value	will	appear	in	the	"Role"	column	of	events	("EventRoleType").
type	:	The	type	of	section.	This	defines	how	a	section	is	displayed	and	people	are	selected.	Allowed	values	are:	'person'	for	a	single	person,
'multi'	for	one	or	more	people,	or	'family'	for	two	people	selected	by	a	family.
title	:	This	is	used	when	displaying	the	section	on	the	form	and	provides	the	only	way	to	visually	tell	multiple	sections	apart.	In	a	marriage
you	would	have	a	"Husband",	a	"Wife"	and	possibly	others	such	as	"Witnesses".

<section	role='Primary'	type='person'	title='Child'>

Each	section	element	should	contain	a	column	element	for	each	column	in	the	section.	Column	elements	describe	information	that	may	be	recorded
for	each	person	in	the	section.

A	column	element	contains:

An	_attribute	element.	This	contains	the	key	used	to	store	column	information	in	the	attributes	of	event	reference	objects	within	the	Gramps
database	(The	"Type"	Attribute	of	the	reference	information	for	the	event.	If	you	use	"Name"	then	the	selected	person's	name	will	be	prefilled.
Once	defined	this	text	must	not	be	changed.
An	optional	_longname	element.	This	contains	a	fuller	description	of	the	column	and	is	only	used	for	tooltips	(when	you	hover	the	mouse	over
the	field	in	the	form).
A	size	element.	This	contains	the	size	of	the	column	in	the	census	report.	It	is	a	percentage	of	the	page	width.	The	sum	of	all	size	elements	in
a	definition	should	total	100%.

<column>
				<_attribute>At	Home</_attribute>
				<_longname>Working	at	Home</_longname>
				<size>6</size>
</column>

Note

The	underscore	is	important	and	indicates	that	the	text	should	be	translated	by	translators.

Each	form	element	may	optionally	contain	heading	elements.	Heading	elements	describe	information	that	is	recorded	once	for	each	form.

A	heading	element	contains:

An	_attribute	element.	This	contains	the	key	used	to	store	information	in	the	attributes	of	the	event	objects	within	the	Gramps	database.

<heading>
				<_attribute>City	or	Borough</_attribute>
</heading>

Although	you	can	add	your	definitions	to	the	pre-defined	entries	in	form_xx.xml,	it	is	recommended	you	create	a	separate	file	called	custom.xml	or
test.xml	for	this	purpose.

Tips	on	debugging	your	custom	form	definitions

After	creating	or	updating	a	form	(in	custom.xml	or	test.xml)	to	make	sure	your	Form	is	correctly	formatted	use	a	text	editor	that	includes	an
XML	mode	and	syntax	check,	(like	NotePad++	and	install	the	"XML	Tools"	plugin),	then	the	editor	will	be	able	to	tell	you	if	your	Form's	XML	code
is	formatted	correctly.

If	the	XML	form	check	worked	then	start	Gramps	to	test	it	and	if	the	 New 	and	 Edit 	buttons	don't	appear	in	the	 Forms	Gramplet 	then	there
is	a	good	chance	that	an	XML	syntax	(or	other)	error	has	occurred.	The	 Forms	Gramplet 	will	not	tell	you	where	the	error	is,	but	luckily	you
may	get	a	message	in	grampsXX.log	(in	the	root	of	gramps	user	directory)	that	may	look	like:

Traceback	(most	recent	call	last):
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		File	"C:\Program	Files\GrampsAIO64-5.1.2\gramps\gen\plug\_manager.py",	line	252,	in	load_plugin
				_module	=	self.import_plugin(pdata)
		...
		File	"C:\Users\<~username>\AppData\Roaming\gramps\gramps51\plugins\Form\form.py",	line	114,	in	__load_definitions
				dom	=	xml.dom.minidom.parse(definition_file)
		File	"AIO/xml/dom/minidom.py",	line	1958,	in	parse
		File	"AIO/xml/dom/expatbuilder.py",	line	911,	in	parse
		File	"AIO/xml/dom/expatbuilder.py",	line	207,	in	parseFile	xml.parsers.expat.ExpatError:	mismatched	tag:	line	12,	column	10

If	there	are	other	(non-syntax)	errors	in	the	file	then	when	you	use	the	 New 	button	and	select	the	form,	it	will	probably	fail	and	suggest	you	restart
Gramps,	if	you	open	the	details	first	you	will	see	some	information	which	may	give	you	a	clue	as	to	where	the	issue	is	(start	from	the	bottom	of	the
error	message),	the	following	is	an	example:

		25285:	ERROR:	grampsapp.py:	line	157:	Unhandled	exception	
		...
		File	"C:\Users\<~username>\AppData\Roaming\gramps\gramps51\plugins\Form\editform.py",	line	995,	in	__init__
				title1,	title2	=	title.split('/')
ValueError:	not	enough	values	to	unpack	(expected	2,	got	1)

For	the	example	error	above,	the	title	was	fine,	the	Forms	Gramplet	was	reporting	that	one	of	the	entries	in	the	custom	form	was	incorrectly	typed
and	should	be	exactly	like	the	supported	form	elements.

Submitting	your	form	definitions

Once	you	have	written	some	custom	form	definitions,	you	may	wish	to	share	them	with	the	Gramps	community.

A	Addon:Form	Testing	area	is	available	for	this	purpose.

See	existing	Addon:Form	Definitions	for	a	current	list.

Issues
See	issues	attached	to	the	Forms	tag.

See	also
Civil	registration	From	Wikipedia,	the	free	encyclopedia
Vital	records	From	Wikipedia,	the	free	encyclopedia
Census	From	Wikipedia,	the	free	encyclopedia

Data	Entry	Gramplet	addon	that	allows	an	easy	method	of	editing	previously	added	people,	and	adding	new	and	related	people	in	your	family
tree.

Form	Tutorials

Using	the	Form	Gramplet,	By	Tim	Graham,	Photo	Restorations	by	Tim	G.
Using	the	Form	Gramplet	-	Shows	an	older	version	of	the	Form	addon	(Published	on	Aug	4,	2016)	Note:	Video	says	it	can	be	installed
on	the	Dashboard	and	or	the	Charts	page	but	current	version	cannot.
Defining	Custom	Forms	for	the	Form	Gramplet	-	Shows	an	older	version	of	the	Form	addon	(Published	on	Aug	1,	2016)

Support	forum	threads

1950	US	Federal	Census	:	Includes	an	importable	sample	of	using	the	Forms	Gramplet
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5.2	Addons

GEDCOM	Extensions

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Available	for	Gramps	4.x	and	higher.

This	Addon	has	a	collection	of	unofficial	GEDCOM	extensions	which	extend	Gramps	GedcomWriter	to	include	common	non-compliant	GEDCOM
additions.

If	the	feature	you	want	is	not	listed	below,	then	you	can	either	add	it	yourself,	or	ask	a	developer	to	help	you.

Export	GEDCOM	Extensions
The	following	GEDCOM	Extensions	are	supported:

Exports	witnesses	associated	with	a	family	event
Include	media

Usage

To	run	the	exporter,	select	Family	Trees	>	Export..,	press	 Next ,	on	the	 Choose	the	output	format 	dialog	select	 "GEDCOM
Extensions	(GED2)" ,	press	 Next .	On	the	 Export	options 	dialog	select	the	relevant	GEDCOM	extension	option:

	 Include	witnesses 	-	(checked	by	default)	Exports	witnesses	associated	with	a	family	event
	 Include	media 	-	(checked	by	default)

Then	press	 Next ,	and	after	selecting	the	save	location	and	applying	the	export	the	data	should	be	exported	to	a	file	with	the	extension	".ged2".

Afterwards,	you	can	change	the	extension	from	".ged2"	to	".ged"	and	treat	as	a	normal	GEDCOM	file.

Warning

There	is	no	associated	.ged2	importer	in	Gramps,	so	the	export	is	one-way	only	(out	of	Gramps).	It
should	be	possible	for	someone	to	also	write	an	associated	GEDCOM	importer	to	handle	the	extensions
to	bring	them	into	Gramps	as	well.
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Import	GEDCOM	Extensions
There	are	no	import	extensions	currently	supported.

See	feature	request:

10550	Refactor	Gramps	GEDCOM	import	so	as	to	support	GEDCOM	extension	addons

See	also
The	source	code	is	available	from	addons-source/blob/master/GedcomExtensions/GedcomExtensions.py.

GEDCOM
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5.2	Addons

GenealogyTree

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Main	menu	showing	all	four	reports	for	Addon:GenealogyTree

The	GenealogyTree	addon	creates	professional	looking	trees	for	the	active	person	in	the	LaTeX	genealogytree	(the	Pedigree	and	genealogical	tree
diagrams	package)	file	format.	The	following	reports	are	available:

Ancestor	Tree
Descendant	Tree
Grandparent	Tree
Sandclock	Tree
Sandclock	Tree	for	a	Family

Usage
From	the	menu	select	Reports	>	Trees	>	[Xxxxx]	Tree...	where	[Xxxxx]	is	one	of	the	available	reports.

For	a	large	family	tree

Make	sure	to	select	a	large	enough	paper	size	in	the	 Paper	Options 	tab	as	the	reports	currently	do
not	scale	well.

Output	is	to	 LaTeX	File (*.tex)	by	default.	This	format	is	generally	intended	for	print	production	and	may	not	be	suitable	for	viewing	the
resulting	tree	chart.	Installing	an	additional	program	to	automatically	convert	to	a	.pdf	format	file	is	highly	recommended.

See	Common	options

Tree	examples
Example	output	for	each	tree	report.	

Ancestor	tree
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Ancestor	tree	-	example	for	Addon:GenealogyTree

Creates	a	tree	chart	showing	the	ancestors	of	the	active	person.	

Descendant	tree

Descendant	tree	-	example	for	Addon:GenealogyTree

Creates	a	tree	chart	showing	the	descendants	of	the	active	person.	

Grandparent	tree

Grandparent	tree	-	example	for	Addon:GenealogyTree

Creates	a	Grandparent	tree	for	the	selected	person.	

Sandclock	tree

Sandclock	tree	-	example	for	Addon:GenealogyTree

Creates	a	Sandclock	tree	for	the	selected	person.

A	sandclock	connects	ancestors	and	descendants	starting	from	a	single	proband	(active	person).	

Sandclock	Tree	for	a	Family

Sandclock	Tree	for	a	Family	-	example	for	Addon:GenealogyTree
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This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

Creates	a	Sandclock	tree	for	the	selected	family.	

Prerequisites
Output	is	only	to	 LaTex	File 	(*.tex)	which	by	default	is	displayed	as	plain	text	with	layout	annotation	in	the	preferred	Text	viewing	application
for	your	OS	unless	you	have	installed	a	LaTex	helper	application.	The	following	prerequisite	"helper"	applications	will	interpret	the	layout
annotation	to	view	the	fully	formatted	LaTex(*.tex)	file	or	automatically	convert	it	to	a	pdf	file:

texlive	including	the	textlive-pictures	package	which	contains	LaTeX	genealogytree	(the	Pedigree	and	genealogical	tree	diagrams
package)

The	texlive-pictures	package	contains	genealogytree.

The	texlive-fontsextra	package	is	required	for	non-latin	fonts.

See	specific	instructions	for	your	operating	system.

Linux
Apple	MacOS
Microsoft	Windows

Linux

Debian/Ubuntu

TeX	support,	at	least	'texlive-base',	'texlive-binaries',	'tex-common',	'luatex'	packages
for	internal	PDF	output	file	format	needs	LaTex	support	(e.g.,	'texlive-latex-base'	package)
for	genealogytree	needs	'texlive-pictures'	package

or	download	and	install	'genealogytree'	for	the	last	version:

$	mkdir	-p	~/texmf/tex/latex/genealogytree 	or	/var/lib/texmf,	/usr/local/share/texmf

$	cp	./genealogytree/*	~/texmf/tex/latex/genealogytree

$	texhash	~/texmf

Same	for	'tcolorbox',	and	maybe	for	fonts	:	'libertines',	'mweights,	etc	...

$	cp	~/texmf/tex/latex/libertine/map/libertine.map	~/.texmf-var/fonts/map/pdftex/updmap/pdftex.map

$	updmap	--enable	Map=~/texmf/tex/latex/libertine/map/libertine.map

$	sudo	mktexlsr

$	sudo	updmap-sys	--enable	Map=~/texmf/tex/latex/libertine/map/libertine.map

need	'texlive-latex-extra'	(for	xkeyval)	and	'latex-tools'	(for	shellesc)	or	install	the	base	[1]!
can	also	update	'pdftexcmds'	and	'pgf'

Apple	MacOS

Install	the	MacTeX	distribution.

https://www.tug.org/mactex/

Microsoft	Windows

You	can	enable	automatic	output	to	PDF	on	Microsoft	Windows	as	by	default	these	reports	only	output	to	the	LaTeX(".tex"	extension)	file	type
which	are	not	suitable	for	viewing.

For	our	Microsoft	Windows	TeX/LaTeX	environment	you	will	use	MiKTeX	we	only	need	to	download	the	basic	installer	from:

https://miktex.org/download/
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Start	the	MiKTeX	installer	and	during	install:

select	 [	]Install	MiKTeX	only	for	me(YOURUSERNAME)
and	change	 Install	missing	packages	on-the-fly 	to	Yes

after	successful	installation	of	MiKTeX	do	the	following	once	only:

Start	the	Microsoft	Windows	command	console	prompt	(cmd.exe)	and	type:

lualatex	--version

If	that	works	then	you	are	ready	to	have	MiKTex	install	the	additional	missing	packages,	start	Gramps	and	create	a	one	of	the	Reports	>	Trees	>
[Xxxxx]	Tree...	reports	and	for	the	LaTeX(".tex"	extension).	Now	in	the	Microsoft	Windows	command	console	prompt	(cmd.exe)	type:

lualatex	FILENAME

where	FILENAME	is	full	pathname	of	.tex	file	you	previously	create	in	Gramps.	The	MiKTeX	package	manager	will	then	automatically	download
the	missing	packages.	When	all	is	finished	pdf	file	will	be	created	in	directory	in	which	you	start	this	command,	along	with	two	other	files	of	the
same	name	but	with	different	extensions	(*.log)	and	(*.aux)	which	you	can	ignore.

If	everything	goes	well	you	will	now	have	an	additional	 Output	format: 	option	in	Gramps	to	output	the	reports	to	the	PDF(".pdf"	extension)
format	and	the	builtin	LaTex(*.tex)	format.

The	last	optional	step	is	from	the	Windows	StartMenu	run	the	 MiKTeX	Console 	and	in	 Settings 	change	 [	]Always	install	missing
packages	on-the-fly 	settings	to	 [	]Ask	me (recommended)	or	 [	]Never	install	missing	packages	on-the-fly .

PDF's	created	automatically	with	lualatex

are	output	to	the	PDF	Version	1.5	(Acrobat	6.0)format	which	has	a	maximum	PDF	page	size	of	200"	x
200"	inches	(508cm	x	508cm)	so	choose	your	custom	paper	sizes	accordingly	or	Gramps	will	show	the
Report	could	not	be	created 	dialog

See	also
Feature	request	10223	LaTeX	genealogytree	reports
https://github.com/gramps-project/gramps/blob/master/gramps/gen/plug/docgen/treedoc.py	(creates	the	*.tex	file	and	checks	for	the	presence
of	lualatex.exe	on	Windows	or	lualatex	on	Linux	)
Original	instructions	for	installing	PDF	output	support	for	Microsoft	Windows
LaTeX	genealogytree	(the	Pedigree	and	genealogical	tree	diagrams	package)	-	By	Prof.	Dr.	Dr.	Thomas	F.	Sturm,	 documentation	&	examples
(github)-	CTAN(Comprehensive	TeX	Archive	Network)	-	Pedigree	and	genealogical	tree	diagrams	are	proven	tools	to	visualize	genetic	and
relational	connections	between	individuals.	The	naming	(“tree”)	derives	from	historical	family	diagrams.	However,	even	the	smallest	family
entity	consisting	of	two	parents	and	several	children	is	hardly	a	‘mathematical’	tree	—	it	is	a	more	general	graph.	The	package	provides	a	set
of	tools	to	typeset	genealogical	trees	(i.e.,	to	typeset	a	set	of	special	graphs	for	the	description	of	family-like	structures).	The	package	uses	an
autolayout	algorithm	which	can	be	customized,	e.g.,	to	prioritize	certain	paths.
Questions	tagged	genealogytree	on	tex.stackexchange.com

Discussions	on	Gramps	community	support	forum	(Discourse)

rendering	of	cousins	marrying	and	Family	Tree	addon	report	as	an	alternative.

Issues
See	issues	tagged	with	GenealogyTree	on	the	bugtracker.

The	diagram	doesn't	scale	to	fit	the	page.	For	a	large	tree	you	will	have	to	select	a	large	paper	size.
Only	the	smallest	value	on	Paper	size	item	will	be	used
10512Sandclock	tree	generates	one	page	of	(possibly)	a	larger	report

10494	LaTeX	report	includes	full	images	uncropped
Help	button	url	does	not	come	here.
No	support	for	localized	month	names
If	you	install	only	one	of	the	reports	the	rest	are	installed	also!
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5.2	Addons

GeneanetForGramps

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Unreleased	addon

The	 GeneanetForGramps 	addon	allows	you	to	import	ancestors	and	descendants	for	a	selected	person	from	the	Geneanet	website.	

Usage
Once	this	addon	and	its	Prerequisite	has	been	installed:

Select	Menu	Tools	>	Family	Tree	Processing	->	Import	Geneanet	data	for	Gramps...

Undo	history	warning

Proceeding	with	this	tool	will	erase	the	undo	history	for	this	session.	In	particular,	you	will	not	be	able	to
revert	the	changes	made	by	this	tool	or	any	changes	made	prior	to	it.	If	you	think	you	may	want	to	revert
running	this	tool,	please	stop	here	and	backup	your	database.

From	the	Undo	history	warning	dialogue	you	can	choose	 Stop 	or	 Proceed	with	the	tool .

Import	from	Geneanet	into	Gramps

The	 Geneanet	Import	Options 	tab	is	displayed	with	the	following:
Center	Person: 	-	Person	to	process	in	Geneanet	(by	default	the	active	one)
Genanet	URL: 	-	The	URL	on	the	Geneanet'	site	corresponding	to	the	person	selected	in	Gramps	and	from	who	you	want	to	import
ancestors	and	descendants.	Note	that	in	Gramps	the	person	should	have	the	same	birth	and	death	date	so	it	works.
[	]	Import	ascendants: 	-	Check	that	box	if	you	want	to	import	ancestors	of	the	person	(False	by	default).
[	]	Import	descendants: 	-	Check	that	box	if	you	want	to	import	descendants	of	the	person	(False	by	default).
[	]	Import	spouses: 	-	Check	that	box	if	you	want	to	import	spouses	of	the	person	(False	by	default).
Level	of	import: 	Number	of	upper	or	lower	parsing	you'll	do	in	the	Geneanet	tree.	If	you	choose	2	(default),	you'll	get	parents
and	grandparents,	children	and	grandchildren.	Be	careful	by	using	large	numbers	as	the	parsing	can	then	take	a	long	time.
[	]	Force	import: 	Force	overwrite	of	existing	Gramps	fields	in	a	person	replaced	by	the	Geneanet	Filed	(False	by	default).
Verbosity: 	Increase	the	versbiosity	in	the	text	window	where	Gramps	has	been	launched	(from	0	to	4,	1	by	default)

Once	you	have	made	your	choices,	you	can	either	choose	 Close 	or	 Execute 	to	launch	the	import.

Note	that	for	the	parsing	to	work,	you	need	to	have	the	same	firstname/lastname	and	birth	date/death	date	for	the	person	in	both	Gramps	and
Geneanet.	Using	force	mmay	overwrite	this	security.

Tips
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Make	a	try	by	just	importing	ancestors	to	check	it's	working	correctly	for	you,	and	the	you	can	add	more	persons.	Limit	the	level	of	import	when
starting	at	2	before	increasing	once	you	verified	it's	working	for	you.	Note	that	the	plugin	can	also	be	called	from	the	CLI:

usage:	GeneanetForGramps.py	[-h]	[-v]	[-a]	[-d]	[-s]	[-l	LEVEL]
																												[-g	GRAMPSFILE]	[-i	ID]	[-f]
																												[searchedperson]

Import	Geneanet	subtrees	into	Gramps

positional	arguments:
		searchedperson								Url	of	the	person	to	search	in	Geneanet

optional	arguments:
		-h,	--help												show	this	help	message	and	exit
		-v,	--verbosity							Increase	verbosity
		-a,	--ascendants						Includes	ascendants	(off	by	default)
		-d,	--descendants					Includes	descendants	(off	by	default)
		-s,	--spouses									Includes	all	spouses	(off	by	default)
		-l	LEVEL,	--level	LEVEL
																								Number	of	level	to	explore	(2	by	default)
		-g	GRAMPSFILE,	--grampsfile	GRAMPSFILE
																								Full	path	of	the	Gramps	database	(under
																								$HOME/.gramps/grampsdb)
		-i	ID,	--id	ID								ID	of	the	person	to	start	from	in	Gramps
		-f,	--force											Force	processing

Prerequisites
For	the	addon	to	work	you	will	need	to	install	both	the	 Request 	and	 lxml 	Python	modules.

Requests
Install	the	python	module	 Requests 	otherwise	you	will	get	the	following	error:

2020-12-06	10:29:40.191:	WARNING:	_manager.py:	line	308:	Plugin	error	(from	'GeneanetForGramps'):	No	module	named
'requests'

lxml
Install	the	python	module	 lxml 	otherwise	you	will	get	the	following	error:

2020-12-07	00:22:41.100:	WARNING:	_manager.py:	line	308:	Plugin	error	(from	'GeneanetForGramps'):	No	module	named	'lxml'

SQLite	only	supported
Also	note	that	you	need	to	use	a	SQLite	DB	(based	on	API-DB)	and	NOT	a	BSDDB	for	the	plugin	to	work.	When	using	a	BSDDB	base	you'll	get
the	following	error:

File	"/users/gnucash/.gramps/gramps51/plugins/GeneanetForGramps/GeneanetForGramps.py",
line	1339,	in	find_grampsp
				ids	=	db.get_person_gramps_ids()
AttributeError:	'DbBsddb'	object	has	no	attribute	'get_person_gramps_ids'

You	can	Convert	a	BSDDB	Family	Tree	to	SQLite	and	then	export	from	the	previous	and	import	into	the	new.

See	also
Web	Solutions	for	Gramps
GitHub	-	bcornec/GeneanetForGramps	-	Gramplet/Script	to	import	into	Gramps	persons	from	Geneanet

GitHub	-	romjerome/GeneanetForGramps	(fork	and	some	modifications)
Geneanet	uses	GeneWeb	engine	:	Manage	Family	Trees	->	Export	->	GeneWeb	(.gw)
Web	Connect	Packs	-	adds	a	Geneanet	option	Web	Connection	pop-up	menu	search	in	People	View	(requires	an	account)
Gramps	on	Geneanet	dot	org	-	a	French	genealogy	site	with	over	4	million	members

Discourse	discussion	forum	threads

Export	to	Geneanet

Gramps-User	maillist	threads

2016-01-11	Gramps	importing	woes	-	Geneanet	GEDCOM	to	Gramps	4.2.1
2012-07-18	Geneanet	location	problème	-	GEDCOM	export	missing	some	place	enclosures

Gramps-Devel	maillist	threads

2020-12-06	Announce	of	the	GeneanetForGramps	plugin	-	an	import	tool	for	data	provided	by	Geneanet
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5.2	Addons

Generic	DB	Access	lib

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Experimental	library

Please	only	use	on	a	copy	of	your	Family	Tree

The	 Generic	DB	Access	lib 	(AKA	libaccess)	is	an	experimental	library	that	provides	generic	access	to	the	database	and	the	gen.lib
interface(AKA	The	core	library	of	Gramps	objects	).	It	was	designed	to	simplify	the	manner	in	which	developers	interact	with	Gramps.

Usage

Example

Consider	the	problem	of	finding	out	how	many	people	were	born	in	March.	Basically,	we	need	to	go	through	the	database,	get	the	reference	(if	one)
to	the	birth	event,	look	up	the	birth	event,	if	found,	get	the	date	from	it,	get	the	month	and	compare	it.	That	might	look	like	this:

count	=	0
for	p	in	db.iter_people():
				birth_ref	=	p.get_birth_ref()
				if	birth_ref:
								event	=	db.get_event_from_handle(birth_ref.ref)
								if	event:
												date	=	event.get_date_object()
												if	date.get_month()	==	3:
																count	+=	1

This	example	is	not	unusual;	you’d	have	to	do	something	like	this	whatever	it	is	that	you	are	doing.	And	this	is	a	simple	example.	It	can	get	much
more	complicated.	But	even	in	this	“simple”	example,	you	have	to	know	a	lot	about	the	gen.lib	objects	that	make	up	Gramps	(things	like	Person,
Event,	and	Date)	but	you	also	need	to	know	the	interface	to	the	database	(things	like	iter_people,	get_event_from_handle)	and	how	things	are	linked
together	(handles	and	refs).

Here	is	how	you	would	solve	the	above	using	this	experimental	Gramps	addon:

from	libaccess	import	*
init(dbstate.db)
len([p	for	p	in	Person.all()	if	p.birth.date.month	==	3])

That’s	it.	Now	there’s	quite	a	bit	going	on	here,	but	I	think	the	most	interesting	is	that	this	works	even	if	a	person	doesn’t	have	a	birth	event,	or	if	the
birth	event	happens	to	be	missing	(eg,	the	database	is	in	an	inconsistent	state).	By	allowing	this,	it	makes	chained	accessors	(item.item.item)	possible
to	use	to	get	to	the	endpoint	to	make	the	comparison	(month	==	3).	Also,	one	doesn’t	need	to	know	anything	about	the	database	or	gen.lib	objects
other	than	the	field	names	we’re	interested	in.

See	also
Alternative	Interfaces,	Date:	January	23rd,	2010,	by	Doug	Blank,	who	introduced	 libaccess 	in	Gramps	3.2.
Source	code	for	Gramps	master:	https://github.com/gramps-project/addons-source/tree/master/libaccess
GEPS	:	single-line	sql-like	filter	field	(libaccess	based	?),	Dec	11,	2012,	...I	don't	plan	on	developing	that	particular	prototype[libaccess]	any
further,...'	Doug	Blank
GEPS	017:	Flexible	gen.lib	Interface	-	Proposal	was	withdrawn	as	after	building	a	prototype,	it	was	found	to	be	too	slow	for	general	use.
Addon:Isotammi_addons#SuperTool	-	general	purpose	scripting	tool	that	can	be	used	to	do	"ad-hoc"	queries	against	a	Gramps	family
tree/database.
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5.2	Addons

GetGOV

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

GetGOV	gramplet

The	 GetGOV	Gramplet 	is	designed	to	download	place	information	from	the	GOV	gazetteer.	This	information	can	include

Geographical	location	(lat-lon	coordinates)
Foreign	and	former	names
Past	affiliation	or	hierarchy	of	enclosed-by	places.

Instead	of	the	default	Place	ID	Format	numbering	(Pxxxx)	for	the	imported	places,	the	GOV-id	will	be	used	as	the	Place	ID.	If	additional	imports
are	performed,	duplicate	places	(even	part	of	the	Enclosed	By)	will	be	automatically	merged.

Usage
It	is	designed	to	be	installed	as	a	gramplet	on	the	Places	Category	(List/Tree)	view.

Version	5.x

The	language	is	set	in	the	Edit	->	Preferences..	tabs	 Display 	and	is	described	in	the	Place	Format	Editor.	This	is	used	as	the	preferred	language
for	place	names	and	types	which	are	imported.	The	default	language	is	German.

Version	4.2

If	the	Preferences	->	Places	tabs	 Language 	is	set,	then	this	is	used	as	the	preferred	language	for	place	names	and	types	which	are	imported,
otherwise,	the	preference	is	German.

Example

This	example	shows	how	the	gramplet	would	be	used	with	the	GOV	gazetteer	website	to	import	the	place	Frommenhausen.
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Log	into	the	GOV	gazetteer	website.	

Find	the	appropriate	GOV-id	for	the	place	of	interest.	In	the	illustration,	the	search	for	the	city	Frommenhausen	was	used.	The	result	identifies	the
appropriate	GOV-id	as	FROSENJN48KK.	

To	see	what	data	will	be	imported,	you	can	drill	down	in	to	the	GOV-id.	
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Enter	the	GOV-id	into	the	GetGOV	gramplet	on	the	Places	view.	

The	resulting	places	with	Latitude	and	Longitude	are	loaded.	Note	that	the	Place	Type	is	in	the	same	language	as	the	Place.	Note	that	the	ID	is	the
GOV-id	and	not	the	default	Pxxxx	numbering.	If	you	use	the	Reorder	Gramps	IDs	tool,	it	will	change	the	ID	to	the	default	Pxxxx	numbering.	Later
use	of	this	gramplet	may	import	duplicate	items	(with	different	ID)	since	the	Gramps	ID	is	no	longer	the	GOV-id	and	duplicates	will	not	be
identified.	For	instance,	if	you	import	FROSENJN48KK	and	then	use	the	Reorder	Gramps	ID	tool	to	reset	the	Gramps	ID,	if	you	reimport
FROSENJN48KK	or	any	other	GOV	place	that	is	already	imported,	you	will	have	duplicate	places	for	every	item	imported.	

This	illustrates	that	multiple	alternate	names	will	be	loaded	if	they	are	in	the	GOV	database.	Deutschland	is	the	Primary	name	and	there	are	multiple
alternate	names	in	different	languages	in	this	illustration.	
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The	Place	hierarchy	is	also	loaded	as	defined	in	the	GOV	database.	This	includes	the	Enclosed	By	information	which	may	be	time-dependent	as
illustrated.	

Issues
If	you	use	the	Reorder	Gramps	IDs	tool,	it	will	change	the	ID	to	the	default	Pxxx	numbering.	Later	use	of	this	gramplet	will	import	duplicate
items	(with	different	ID)	since	the	Gramps	ID	is	no	longer	the	GOV-id	and	duplicates	will	not	be	identified.
11596	Place	format	Language	setting	is	not	honored	unless	it	is	in	lower	case
10980	Some	places	are	shown	as	"?"	if	imported	via	getGOV	third	party	addon
10773	Places	view	shows	all	alternate	names	-	even	those	with	different	languages
11680	GetGOV	crashes	Gramps	when	GOV	gazetteer	website	(	http://gov.genealogy.net	)	is	not	available

Other	open	issues	tagged	GetGOV	on	the	Gramps	Bug	Tracker.

See	also
Addon:GeoName	-	downloads	place	information	from	the	GeoNames	gazetteer.
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5.2	Addons

Gramps	Web	Sync

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Not	for	all	versions	of	Gramps

Released	for	Gramps	5.1.x	only.	This	documentation	is	derived	from	the	Synchronize	with	Gramps
section	of	the	Gramps	Web	User	Guide.	Their	page	should	be	considered	the	definitive	reference.

Gramps	Web	Sync

Gramps	Web	Sync	is	an	addon	for	Gramps	that	allows	to	synchronize	your	Gramps	database	on	your	desktop	computer	with	Gramps	Web,
including	media	files.

Purpose	of	this	tool
This	tool	was	specifically	written	to	harmonize	the	tree	data	between	a	Gramps	Web	instance	and	a	Gramps	Desktop	instance.

Make	no	mistake,	maintaining	synchronization	is	hard!	And	this	tool	is	not	magic,	it	does	not	make	the	process	simple	but	it	is	easier	than	the
alternatives.

Installation
The	addon	requires	a	Gramps	Web	account	with	owner	privileges,	Gramps	5.1	running	on	Python	3.7	or	newer.

The	tool	can	be	installed	like	any	other	version	5.1	Addon	tool;	see	 Installing	Addons	in	Gramps .	Specifically,	the
GrampsWebSync.addon.tgz	archive	download	is	available	for	manual	installation	or	via	the	Third	party	addons	management	section	of	the	Edit
➡	Preferences	of	the	Gramps	Desktop.

There	is	no	installation	(or	user	interface	options)	on	the	Gramps	Web	side	because	it	communicates	directly	with	that	webservice's	native	restful
API.

Usage
Once	installed,	it	is	run	by	using	the	Tools	->	Family	Tree	Processing	->	Gramps	Web	Sync....

Running	Gramps	Web	Sync

Batch	Tool	warning

The	tool	will	start	with	an	'Undo	history	warning'	that	suggest	that	you	back	up	your	work.
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You	are	then	presented	with	the	Synchronization	Assistant	dialog	will	the	stages	of	Synchronization.	The	first	tab	introduces	the	process.

See	the	Synchronize	with	Gramps'	page	on	the	Gramps	Web	User	Guide	for	further	instructions.

Account	Login	Settings

Notes

See	also
Gramps	Web	support	discourse	forum:	(About	the	category)

Category	search	for	sync
Category
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5.2	Addons

Graph	View

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Feature	is	slow	in	larger	Trees

The	larger	the	number	of	people	in	the	Family	Tree,	the	longer	the	chart	will	take	to	appear.
e.g.:	a	test	with	about	7000	people	took	10	minutes.
This	can	be	adjusted	by	changing	the	number	of	generations	to	be	shown.

Graph	View	-	addon	-	In	action	showing	both	ancestors	and
descendant	trees	(Gramps	5.1.x	version)

Graph	View	is	an	interactive	 	 Charts 	category	view	addon	that	presents	a	navigable	ancestors	and	descendant	tree	using	the	current	active
person	as	a	starting	point.	Clicking	another	person	in	the	family	tree	will	make	that	person	the	active	person	and	will	redraw	the	family	tree	based
on	them.

Usage

From	the	 	 Charts 	category	view	select	the	Graph	View	icon	or	select	View	>	Graph	View	from	the	menu.

In	general	the	Graph	View	is:

Interactive,	the	view	redraws	in	response	to	changes	made	to	a	person	or	family.
The	active	person	is	highlighted.
Clicking	on	another	person	will	redraw	the	family	tree	based	on	that	person.
Clicking	the	active	person	will	show	the	parent	family	of	the	active	person,	thereby	allowing	previous	generations	to	be	shown.
A	right	mouse	click	on	a	person	or	family	node	shows	the	person	or	family	editor	as	appropriate.
Able	to	show	both	ancestors	and	descendant	trees	(adjustable	from	the	Graph	View	toolbar).
Graph	view	can	be	panned	by	using	mouse	click	and	drag.	Select	the	background	of	the	tree	and	drag	the	mouse	to	pan	the	view.	Also	you	can
use	mouse	scroll	button	to	pan	view	in	any	place	of	view.

Graph	View	Toolbar
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Graph	View	has	a	smaller	toolbar	of	its	own	with	the	following	options	(from	left	to	right):

+(Zoom	in) 	button	-	Zoom	in	the	view.
-(Zoom	out) 	button	-	Zoom	out	the	view.
1(Zoom	to	original) 	button	to	reset	the	view	to	the	default	size.
☐(Zoom	to	best	fit) 	button	to	fit	the	current	family	tree	graph	in	the	display
⏎	(Go	to	active	person)
Go	to	bookmark 	button	-	Center	view	on	selected	bookmark	-	also	shows	"Bookmarks	for	current	graph:"	(who	are	being	display)	and
"Other	Bookmarks:"	(who	are	not	being	displayed)	-	along	with	two	buttons	to	"Add	active	person"	to	bookmarks	and	"Edit"	the	bookmarks.
�	Search... 	-	typing	shows	"Persons	from	current	graph:"	(who	are	being	display)	and	"Other	persons	from	the	database:"	(who	are	not
being	displayed)	as	well	as	any	saved	bookmarks.	You	can	use	 Ctrl	+	F 	to	make	search	entry	active.
Generations 	-	setting	to	change	the	generations	shown	for	Ancestor	3	generations	by	default	and	Descendants	10	generations	by	default.
Spacing 	-	changes	the	vertical(5	default)	and	horizontal(2	default)	spacing	between	the	generations.
All	connected 	-	Show	all	connected	persons	limited	by	generation	restrictions.	Works	slow,	so	don't	set	large	generation	values.	(
Limited	to	1000	persons,	if	your	family	tree	has	more	than	that	you	get	the	 Incomplete	graph 	warning	and	only	the	first	1000	connected
persons	are	drawn.)

On	main	Gramps	Toolbar

On	the	main	Gramps	Toolbar	you	also	have:

⎙(Print) 	button	that	does	not	print	but	instead	allows	you	to	save	the	currently	displayed	Graph	into	a	dot	format	file	for	a	later	printing.
This	will	save	a	.gv	file	and	a	svg	file.	You	must	select	a	.gv	file.	(Gramps	Print	-SVG	does	not	show	photo)
*	(Configure	Options) 	button	with	option	shown	in	the	next	section.

Configure	Options

Select	View	>	Configure...	from	the	menu	to	change	the	settings	on	the	following	four	tabs:

Layout
Show	images 	(checkbox	selected	by	default)
Show	avatars 	(checkbox	selected	by	default)
Highlight	the	home	person 	(checkbox	selected	by	default)
Show	full	dates 	(checkbox	unselected	by	default)
Show	places 	(checkbox	unselected	by	default)

Placeformat:
Default
Full

Show	tags 	(checkbox	unselected	by	default)
Time	Direction:

Vertical:	Top	to	Bottom
Vertical:	Bottom	to	Top
Horizontal:	Left	to	Right
Horizontal:	Right	to	Left

Themes
Person	theme:

Default
Image	on	right	side
Image	on	left	side

Path	color	to	home	person: 	#000000(default)
Font: 	-	shows	the	default	that	can	be	changed	by	selecting	from	the

Pick	a	Font 	dialog
Avatars	style:

Custom
Dark	Default
Light
Cartoon
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Graph	View	Avatars

Choose	the	Custom	 Avatars	style 	adds	2	more	popup	menus:

Male	avatar: 	File	selector
Female	avatar: 	File	selector

Active	person	border	size: 	3(default)
Person	border	size: 	1(default)

Animation
Show	animation 	(checkbox	selected	by	default)

Animation	speed	(1..5	and	5	is	the	slower):	(default	is	3)
Animation	count	(0..8	use	0	to	turn	off):	(default	is	4)

Search
Search	in	all	database (checkbox	selected	by	default)
Show	person	image (checkbox	selected	by	default)
Show	bookmarked	first (checkbox	selected	by	default)

Context	menus

Graph	view	has	three	context	menus	that	allow	the	following	

Empty	section

Right	click	menu	shown	when	selecting	an	empty
section	of	the	chart.

Right-click	an	empty	section	of	the	Graph	View	to	offer	the	following	display	options:

Show	images 	-	Display	thumbnails	or	avatars
Highlight	the	home	person 	-	set	the	background	of	the	Home	Person	to	green
Show	full	dates 	-	format	the	birth	and	death	date	as	only	the	year	or	as	the	complete	date
Show	places 	-	show	or	hide	birth	and	death	places
Show	tags 	-	show	color	markers	on	tagged	Persons	and	Families
Show	animation 	-	after	redraws,	wiggle	the	Active	Person	to	draw	focus

Lines	type 	-	choose	the	style	of	lines	connecting	People	and	Families
Direct
Curves
Ortho

About	Graph	View 	-	this	help	wiki	webpage

Person	node
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Right	click	menu	shown	when
selecting	a	Person	on	the	chart.

Right-click	a	person	(node)	to	show	a	context	menu	offering	the	following	options	for	the	indicated	person:

Edit
Copy
Delete

Tags
Spouses
Siblings
Children
Parents
Related	-	shows	people	sharing	an	event

Set	as	home	person
Show	path	to	home	person	-	changes	the	view	to	show	how	these	two	people	connect	to	their	common	ancestor
Add	to	bookmarks

Quick	View
Web	Connection

About	Graph	View

Family	node

Right	click	menu	shown	when
selecting	a	Family	(node)	on	the
chart.

Right	click	a	family	(node)	to	add	or	delete	a	spouse	or	child.

Edit
Remove

Tags
Spouse
Children
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About	Graph	View

Prerequisites
Before	Graph	View	can	be	used	you	will	need	the	following	installed:

Graphviz.	If	you	can	run	the	Gramps	Graph	reports	then	you	already	have	this	installed.
PyGoocanvas	(Gramps3)	or	Goocanvas2	or	gir1.2-goocanvas	(Gramps4)
Goocanvas

Windows

These	are	already	installed	if	you	are	using	the	Gramps	All	In	One	installer	eg:	GrampsAIOxxxxx.exe

Linux

All	of	these	should	be	available	in	common	Linux	distributions.

For	example,

Debian

Packages	Goocanvas/PyGoocanvas	as	libgoocanvas3	and	python-pygoocanvas.

Note:	As	of	May	2020	the	required	packages	for	Debian	Testing	are	gir1.2-goocanvas-2.0	and	libgoocanvas-2.0-9	from	the	official	repositories.

Please	make	sure	to	download	these	for	the	proper	architecture,	like	amd64	for	64-bit	PCs	(Intel	included).

Fedora

Try	package	goocanvas2-devel.

Opensuse

You	may	need	to	install	typelib-1_0-GooCanvas-2_0	as	mentioned	in	issue	8076.

Issues
You	can	see	related	issues	at	bug	tracker.

8054#c44291	-	print	options.
9806	-	Subprocess	on	[GraphView]	can	generate	a	memory	issue
8054	-	Better	label	positioning	in	Graphview
8964:	Enable	filter	on	GraphView	Feature	Request
[GraphView]	add	custom	avatars	#459
Themed	avatar	discussion

See	also
Addon:AvatarGenerator	-	allows	you	to	add	and	remove	one	or	several	images	for	a	selected	set	of	filtered	people.
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5.2	Addons

Handle.bash

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

The	script	handle.bash	(downloadable	here)	can	be	used	to	replace	all	database	handles	in	a	.gramps	file.	This	makes	it	possible	to	work	with
multiple	databases	in	Gramps,	merging	select	branches	manually	at	will.	Without	this	tool,	manual	merging	of	databases	derived	from	one	another,
or	with	a	common	base-database,	would	not	be	possible	because	of	handle	collision.

Usage

Linux

In	order	to	use	this	script,	you	must	create	a	directory	and	copy	the	script	file	to	it.	Then	you	export	the	database	you	wish	to	import	into	a	colliding
database	to	a	.gramps	file	inside	this	directory.	Then	you	run

$	bash	handle.bash	filename.gramps

where	filename.gramps	is	the	name	of	the	file	you	exported	into	the	new	directory.

The	script	will	create	the	files	file.gramps.zcat,	handle.old,	handle.new	and	file.gramps.	The	file	"file.gramps"	is	the	final	output,	the	original
"filename.gramps"	with	all	handles	replaced.

This	script	is	released	under	the	GNU	GPLv2,	author:	lcc.
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5.2	Addons

HeadlineNewsGramplet

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Internet	Access	required

The	Gramplet	reads	the	wiki	HeadlineNews	page	once	a	day.

Headline	News	Gramplet

The	 Headline	News	Gramplet 	reads	the	wiki	HeadlineNews	page	once	a	day.	The	links	from	the	wiki	will	appear	in	the	gramplet	and	clicking
them	will	open	the	associated	webpage	in	a	browser.	The	Gramplet	will	get	data	from:

Gramps	Wiki	Headline	News
Gramps	Blog	comments
Gramps	Blog	posts
Gramps	Wiki	changes
Gramps	Bugtracker	Issues
Gramps	Git	commits

Prerequisites
Because	the	Headline	News	Gramplet	gets	its	information	from	the	Gramps	wiki	(at	https://gramps-project.org/wiki/	)	and	other	places	you	need	to
have	a	internet	connection	for	this	to	work.	If	you	don't	have	an	internet	connection,	then	the	Headline	News	Gramplet	won't	show	any	information.

When	you	do	have	an	internet	connection,	the	Headline	News	Gramplet	will	show	you	the	latest	headline	news	about	Gramps.

Issues
8558#c41544	For	Gramps	4.2+:	Instead	of	parsing	Sourceforge	feeds	it	will	be	better	to	teach	him	how	to	parse	github	feed	eg:
https://github.com/gramps-project/gramps/commits/maintenance/gramps51.atom
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5.2	Addons

HeatmapWebReport

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Heatmap	report	(Stamen	Design	Terrain	map	tiles)

Heatmap 	is	a	web	report	which	creates	an	interactive	map	containing	a	heatmap	generated	from	Gramps	event	place	data.

Usage
Once	this	Report	addon	has	been	installed,	Heatmap	web	pages	can	be	generated	from	the	Graphical	User	Interface	or	the	Book	interface.	Report
only	looks	for	 Places	found	within	a	subset	of	the	 Events	related	to	a	group	of	 People.

The	webpage	contains	an	embedded	list	of	GPS	coordinates	for	places	with	the	number	of	Events	occurring	at	each	place.	The	list	is	set	up	for
output	to	the	Heatmapping	overlay	feature	of	a	selected	Web	map	service.

The	Graphical	User	Interface

Select	Menu	Reports	▼	Web	Pages	▶	Heatmap...

The	 General 	tab

Heatmap	Options	tab

This	tab	allows	the	following	options	to	be	selected:

Filter: 	defaults	to	restrict	 Person	results	to	match	the	"Ancestors	of	<selected	person>"	filter.	
Other	filters	include	the	"Descendants	of	<selected	person>"	or	any	of	the	custom	filter	for	the	Person	category.
Person: 	Sets	the	<selected	person>	for	the	filter.	
This	defaults	to	the	currently	Active	Person.	
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Heatmap	Select	Person	dialog
Select	Existing	button	allows	the	<selected	person>	to	be	re-designated.	

The	Share	list	is	initially	filtered	to	the	current	Active	Person,	Home	Person	and	any	bookmarked	persons.	
Show	all 	checkbox	allows	choosing	from	an	unfiltered	People	list.

Map	tiles: 	Changes	the	Map	Service	providing	the	HeatMap	overlay	processing	and	the	appearance	of	the	map	backdrop.

Map	Service	selections	include:
OpenStreetMap
Stamen	Terrain
Stamen	Toner
Stamen	Watercolor
CartoDB	Positron
CartoDB	DarkMatter

Filepath: 	The	file	directory	where	the	Web	Page	file	should	be	saved.
File	name: 	The	file	name.	(Only	allows	letters	A-Z,	a-z,	numbers	0-9	and	the	characters	space,	underline	and	hyphen)

The	 Advanced 	tab

Enable	custom	start	position 	If	selected,	the	map	centers	on	a	specific	location	and	zoom	scale.
Start	latitude: 	+90	(north	pole)	to	-90	(south	pole).	The	central	latitude	for	a	displayed	map.
Start	longitude: 	-180	to	0	for	the	western	hemisphere	and	0	to	+180	for	the	eastern	hemisphere.	The	central	longitude	for	a	displayed
map.
Start	zoom: 	1	to	18	[8	default].	1	shows	the	entire	planet	surface	in	about	5	inches	square.

The	 Limits 	tab

Enable	map	limits 	If	selected,	the	map	is	restricted	to	a	range	of	zoom	scales	and	a	viewing	window.
Min.	zoom: 	1	to	18	[1	default].	Limits	the	zoom	out	scale	that	a	map	rendering	will	accept.
Max.	zoom: 	1	to	18	[14	default].	Limits	the	zoom	in	scale	that	a	map	rendering	will	accept.
Upper	left	corner	latitude: 	+90	(north	pole)	to	-90	(south	pole).	The	upper	latitudinal	limit	for	scrolling	a	displayed	map.
Upper	left	corner	longitude: 	-180	to	0	for	the	western	hemisphere	and	0	to	+180	for	the	eastern	hemisphere.	The	leftmost
longitudinal	limit	for	scrolling	a	displayed	map.
Lower	right	corner	latitude: 	+90	(north	pole)	to	-90	(south	pole).	The	lower	latitudinal	limit	for	scrolling	a	displayed	map.
Lower	right	corner	longitude: 	-180	to	0	for	the	western	hemisphere	and	0	to	+180	for	the	eastern	hemisphere.	The	rightmost
longitudinal	limit	for	scrolling	a	displayed	map.

Render	custom	map	limit	border 	If	selected,	a	semi-transparent	blue	polygon	illustrates	the	limits	of	the	view	window	box.
(Shows	as	a	rectangle	for	standard	Mercator	Projection	of	the	globe.)

See	also
GitHub	pre-release:	New	web	report	(Heatmap)	#470
Discourse	forum	thread
Leaflet

Gramps	addons	by	Matthias	Kemmer
Addons	web	catalog
Heatmap	Web	Report
Avatar	Generator
Event	Description	Editor
Number	Of	Ancestors	Quick	View
Family	Relationship
Media	Report
Double	Cousin	Report
Set	Privacy	Tool
Add/Remove	Tag	Tool
FilterRules	:	Plugin	Manager	Rulebook	Collection	1

People	related	to	<filter>
People	with	events	with	a	selected	role
Families	with	Events	with	a	selected	role
Source	matching	parameters
People	Separated	less	than	<N>	degrees	of	<Home	person>
People	Separated	less	than	<N>	degrees	of	<person>
Events	of	families	matching	a	<family	filter>
Families	matching	<event	filter>
People	who	are	part	of	families	matching	<filter>

HeatmapWebReport 146

http://www.gramps-project.org/wiki/index.php/File:Gramplet_HeatmapSelectPerson.png
https://github.com/gramps-project/addons-source/pull/470
https://gramps.discourse.group/t/hotspot-heatmap-for-event-clusters/776
https://leafletjs.com/
https://mattkmmr.github.io/gramps-addons-listings/Gramps
http://www.gramps-project.org/wiki/index.php/Addon:AvatarGenerator
http://www.gramps-project.org/wiki/index.php/Addon:EventDescriptionEditor
http://www.gramps-project.org/wiki/index.php/Addon:NumberOfAncestorsQuickView
http://www.gramps-project.org/wiki/index.php/Addon:FamilyRelationship
http://www.gramps-project.org/wiki/index.php/Addon:MediaReport
http://www.gramps-project.org/wiki/index.php/Addon:DoubleCousinReport
http://www.gramps-project.org/wiki/index.php/Addon:SetPrivacyTool
http://www.gramps-project.org/wiki/index.php/Addon:AddRemoveTagTool
http://www.gramps-project.org/wiki/index.php/Rule_expansions#FilterRules_:_Plugin_Manager_Rulebook_Collection


Filter	people	by	their	age	at	death
Match	associations	of	<person	filter>
People	with	multiple	parent	records

FilterRules2	:	Plugin	Manager	Rulebook	Collection	2
Matrilineal	progenitrix	of	<person>
Mitochondrial	inheritance	of	<filter>
Mitochondrial	inheritance	of	<person>
Patrilineal	progenitor	of	<person>
X-chromosomal	ancestors	of	<person>
X-chromosomal	descendants	of	<person>
Y-chromosomal	inheritance	of	<person	filter>
Y-chromosomal	inheritance	of	<person>
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5.2	Addons

House	Timeline	Gramplet

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

House	Timeline	Gramplet

Ever	wondered	about	the	history	of	a	particular	address?	The	 House	Timeline 	Gramplet	lets	you	organize	residents	of	different	addresses	in	a
neat	timeline.	Besides	helping	you	understand	the	historical	context	of	a	property	and	how/when	certain	families	were	grouped	there.	The	 House
Timeline 	Gramplet	is	also	particularly	useful	for	cross-referencing	information	during	research.	If	you've	ever	come	across	potentially	related
family	records	with	family-nee	names	at	nearby	addresses,	this	Gramplet	lets	you	organize	a	person	to	a	specific	address	and	a	specific	time,	giving
you	a	clearer	picture	of	potential	relationships	that	may	have	formed	around	an	address/house.

Lists	residents	of	an	address	in	order	of	Date.
Lists	first	known	and	last	known	residents	at	an	address.
Calculates	the	length	of	time	an	address/property	has	been	occupied	by	family	members.
Calculates	the	total	number	of	known	residents	at	an	address.

Usage
You	can	add	the	 House	Timeline 	Gramplet	to	the	view	you	require	from	the	Add	a	gramplet	menu.

This	Gramplet	uses	Addresses	and	you	will	see	the	following	warning	message	displayed
by	the	Gramplet	if	you	have	none:

"There	are	no	individuals	with	Address	data.	Please	add	Address	data	to
people."

Configuration

House	Icon	Style:
Standard	(default)	-	Text	draw	house.
Small	-	Text	draw	house.
Unicode	-	Uses	a	text	character	for	the	house	eg:	⌂	.
None	-	no	house	is	shown.

See	Also
Addresses	-	Gramps	Wiki	Manual	-	Entering	and	editing	data:	detailed	-	part	3
Why	residence	event	and	not	Address?
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5.2	Addons

HtreePedigreeView

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

H-tree	Pedigree	View	-	example	showing	5	generations(31	people	total)

H-Tree	Pedigree	view	is	an	interactive	 	 Charts 	category	view	addon	that	presents	a	navigable	ancestors	tree	using	the	current	active	person	as
a	starting	point.	Clicking	another	person	in	the	family	tree	will	make	that	person	the	active	person	and	will	redraw	the	family	tree	based	on	them.

The	H-Tree	is	a	structured,	space-efficient	technique	for	pedigree	visualization	(to	display	ancestral	trees).

The	H-tree	based	layout	can	be	used	to	display	ancestral	trees.	This	layout	increases	the	number	of	displayable	generations,	via	a	symmetrically
arranged	structure,	provides	the	the	user	with	an	overview	that	allows	them	to	understand	and	navigate	through	the	data.

Usage

From	the	 	 Charts 	category	view	select	the	H-Tree	Pedigree	View	icon	or	select	View	>	H-Tree	Pedigree	View	from	the	menu.

Configure	the	active	view

H-tree	Pedigree	View	-	Layout	tab	-	default
configuration	options

You	can	configure	the	following	options	on	the	 Layout 	tab:

[x]Show	images
[x]Show	tags
Tree	size:	5(default)	range	2	to	6	generations.

H-tree	will	display	the	following	number	of	people	if	the	Tree	size	is	set	to:

2	generations	=	3	people	total
3	generations	=	7	people	total
4	generations	=	15	people	total
5	generations	=	31	people	total
6	generations	=	47	people	total
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This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

Context	menu

Depending	where	you	click	two	context	menus	are	available.

Blank	area

Context	menu(right	click)	Blank	area
example

Person	nodes

Context	menu(right	click)	Person	node
example

Issues
Drawing	issues	for	"Tree	Size"	6	(center	three	boxes	child	and	parents	are	too	large)
Add	connecting	lines	to	show	relationships	between	people	and	make	the	chart	clear	to	read
Add	ability	to	Print.
In	title	bar	of	Gramps	shows	"H-tree	Pedigree"	View	instead	of	"H-Tree	Pedigree"	View	(	issue	is	lower	case	"t"	in	"H-tree"	)

See	also
GEPS	030:	New	Visualization	Techniques	-	Gramps:	The	H-Tree
Based	on	the	Pedigree	View.
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5.2	Addons

ImportGramplet

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Import	Text	Gramplet	-	Addon	-	Showing	Gramps	XML	example

The	 Import	Text 	Gramplet	allows	you	to	paste	the	content	of	selected	file	formats	and	import	directly	into	Gramps	without	having	data	in	a	file.

Gramps	XML
CSV	(spreadsheet	input)
vCard	files	-	The	vCard	(Virtual	Contact	File	or	VCF)	import	and	export	currently	supports	only	the	version	3.0	format	with	property	types
for	the	name	(FN,	N,	NICKNAME,	SORT-STRING),	address	(ADR),	telephone	number	(TEL),	birthday	(BDAY),	occupation	(ROLE),	URL
(URL),	email	address	(EMAIL),	and	gender	(GENDER,	X-GENDER).	This	is	a	core	subset	of	the	dozens	of	property	types	available	in	the
vCard	format.

Usage
From	the	Dashboard	use	the	context	menu	(right-click)	to	add	the	 Import	Text 	Gramplet.

Example

Import	CSV	(spreadsheet	input)
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CSV	pasted	into	Import	Text	Gramplet

To	import	a	CSV	you	could:

Create	a	new	Family	Tree	to	test	the	following.
Add	the	 Import	Text 	Gramplet	to	your	Dashboard.
Copy	the	contents	of	the	CSV	example	from	User	manual
Paste	the	contents	directly	into	the	text	input	area	of	the	Gramplet.
Then	select	the	 Import 	button	only	once	unless	you	want	the	same	information	imported	multiple	times.
Then	empty	the	text	input	area	by	selecting	the	 Clear 	button.
View	the	imported	results	in	Gramps
If	you	want	to	reverse	the	imported	result	because	you	made	a	mistake	or	pressed	the	the	 Import 	button	multiple	times	you	can	select	Edit
>	Undo	CSV	import	from	the	Gramps	menu	as	many	times	as	you	need.

Troubleshooting	a	Place	list	Import

Every	text	parser	has	expectations	of	the	format.	So	it	is	important	to	do	that	testing	with	a	blank	Family	Tree.	Empty	Family	Trees	make	it	easier	to
find	where	each	piece	of	data	lands.

Generally,	CSV	files	that	contain	text	strings	simply	enclose	that	data	with	double-quotes	to	make	it	seem	as	a	single	block	of	text.	Experiments
with	this	parser	have	shown	that	any	extra	spaces	after	the	Comma	Separators	made	it	ignore	those	quotes	and	the	line	breaks	too.

Place,Name,Type,latitude,longitude
[P001],"Columbus,Franklin,OH,USA",City,,
[P002],"Las	Cruces,Dona	Ana,NM,USA",City,,
[P003],"Dunellen,Middlesex,NJ,USA",City,,
[P004],"New	York,New	York,NY,USA",City,,
[P005],"Metairie,Jefferson,LA,USA",City,,
[P006],"Hopkins,Hennepin,MN,USA",City,,
[P007],"Camarillo,Ventura,CA,USA",City,34.2164,-119.0376
[P008],"San	Antonio,Bexar,TX,USA",City,,
[P009],"Abilene,Dickinson,KS,USA",City,,
[P010],"Fairbanks,Fairbanks	North	Star,AK,USA",City,,
[P011],"Miami,Miami-Dade,FL,USA",City,,

Notice	that	the	sample	place	list	has	placeholder	commas	when	the	Latitude	and	Longitude	are	missing	for	10	of	the	11	rows.	And	this	test	data	has
the	Place	name	in	the	flat	form.	After	importing,	you	can	use	the	Generate	hierarchy	option	of	the	 Place	Update 	addon	Gramplet	to	convert	the
flat	form	into	a	hierarchy.	Then	filter	for	Unknown	types	and	use	the	Place	Type	option	to	set	the	State	and	County	types	to	an	extended	selection	of
the	enclosing	Places.

The	example	above	is	for	importing	non-hierarchical	Place	definitions.	You	would	still	have	to	reassemble	the	hierarchy.	The	following	example
assembles	a	country	enclosing	a	state	having	2	counties.	And	one	of	those	counties	has	a	city.

You'll	notice	that	the	last	line	does	not	specify	a	Place	ID.	This	lets	Gramps	use	the	next	automatically	generated	ID.	But,	the	drawback	is	that	if	you
were	to	run	this	import	twice,	The	Import	Text	addon	wouldn't	recognize	it	as	an	existing	place	and	would	create	a	duplicate	Place	of	the	same
name,	in	the	same	county.	This	addon	ONLY	compares	IDs	and	uses	matching	IDs	to	update/overwrite	records	rather	than	create	new	ones.
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Place,Enclosed_by,Name,Type,Latitude,Longitude
[P23],,USA,Country,38.9072,-77.0369
[P35],[P23],OH,State,39.9612,-82.9988
[P36],[P35],Franklin	county,County,40.0155,-82.9932
[P30],[P36],Columbus,City,39.9612,-82.9988
,[P35],Mahoning	county,County,40.9872,-80.7214

Issues
allow	import	from	pasted	GEDCOM	file	5436

See	also
CSV	Import	(the	CSV	foundation	for	the	interactive	Import	Gramplet	addon)
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5.2	Addons

Import	Merge	Tool

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Released	for	Gramps	5.0.x	or	greater	versions

Import	and	Merge	tool

The	Import	and	Merge	tool	will	 Import	and	merge	a	Gramps	XML 	family	tree	derived	from	your	own	Gramps	XML	family	tree	backup	file.

Purpose	of	this	tool
This	tool	was	specifically	written	to	make	importing	and	merging	a	Gramps	Tree	derived	from	your	own	Tree	easier.

Make	no	mistake,	merging	is	hard!	And	this	tool	is	not	magic,	it	does	not	make	the	process	simple	but	it	is	easier	than	the	alternatives.

Important	Note

This	tool	this	requires	that	the	Family	Tree	being	merged	must	be	a	Gramps	Family	Tree	derived	from	a
version	of	the	currently	loaded	Family	Tree.

A	situation	occurs	occasionally	after	giving	someone	a	copy	of	your	tree	in	our	native	Gramps	XML	format.	Then	each	person	makes	changes	to	the
copy	in	their	possession	using	Gramps	locally.	(You	can	verify	the	Trees	differ	and	log	those	revisions	with	the	Database	Differences	addon	report.)

Programmers	call	this	a	'fork.'	(As	in:	when	travelers	come	to	a	'fork	in	the	road'	and	each	chooses	different	paths.)	But	the	bottom	line	is	that	you
now	have	two	tree	variants	derived	from	a	common	Tree	and	you	want	share	your	updated	Tree.	You	can't	just	give	the	person	a	fresh	copy	of	your
Tree	because	then	their	changes	would	be	overwritten.

At	some	point,	you	may	want	to	merge	the	forks	into	a	common	tree...	without	losing	the	useful	changes	from	either	tree.	That	synchronization	is
what	this	tool	is	designed	to	facilitate.	It	depends	on	the	two	Trees	sharing	common	internal	handles	(not	just	the	user-editable	IDs)	to	simplify
ignoring	unchanged	records.	Then	the	tool	focuses	you	on	just	the	changes.

But	say	the	other	user	doesn't	use	Gramps,	so	you	exported	with	GEDCOM	(or	another	format)	and	got	it	back?	Sorry...	this	tool	won't	be	any	easier
than	a	manual	merge	after	a	standard	import.	You'd	still	need	to	hand	compare	every	record.

The	derived	trees	need	not	be	limited	to	those	edited	by	someone	else.	I	often	take	a	copy	of	my	tree	on	my	laptop	when	traveling	and	sometimes	I
make	updates	while	on	the	road.	But	then	I	may	forget	to	copy	it	back	to	my	home	desktop	computer	until	after	I've	made	more	updates.	This	tool
helps	to	merge	these	back	together.
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Warning:	Data	Corruption	Risk

Mass	changes	mean	more	potential	for	mangling	the	data.	Back	up	your	current	tree	BEFORE	using	this
tool	to	merge.
If	something	goes	wrong,	you	will	have	a	way	to	go	back	and	start	over.	See	make	a	Gramps	XML
backup.

Usage
The	tool	can	be	installed	like	any	other	Addon;	see	 Installing	Addons	in	Gramps

Once	installed,	it	is	run	by	using	the	Tools	->	Family	Tree	Processing	->	Import	and	Merge	tool....

Running	the	Import	Merge	tool

The	tool	will	start	with	an	'Undo	history	warning'	that	suggest	that	you	back	up	your	work.

You	are	then	presented	with	the	import	file	dialog,	which	shows	'.gramps'	files	from	your	import	location.

When	you	have	selected	a	file	to	import,	the	main	tool	window	comes	up	and	some	progress	meters	pop	up	indicating	the	import	and	comparison
process.	When	this	is	complete	you	end	up	with	a	three	part	window.	The	bottom	part	provides	control	and	'Action'	buttons	and	a	hint	that	changes
depending	on	what	you	are	doing.

Top	Pane

The	top	pane	is	a	scrollable	and	selectable	view	of	individual	items	that	were	found	to	be	different	in	your	import.	Items	that	were	the	same	(since
they	were	derived	from	the	common	Gramps	tree)	are	not	shown.

Import	and	Merge	tool

The	top	pane	shows	a	'Status'	which	is	one	of	Different,	Added,	or	Missing.	Different	items	were	found	in	both	the	current	and	imported	trees,	but
had	been	changed	in	some	way.	Added	items	are	found	only	in	your	imported	tree.	And	Missing	items	were	found	in	your	current	tree,	but	not	in	the
imported	tree.

The	top	pane	also	shows	the	Object	type	(Person,	Family,	Media	etc.),	its	Gramps	ID,	an	Object	Name	or	Description,	and	the	selected	Action
(more	later).

You	can	search	for	items	by	Name	by	just	typing	characters	to	match.	The	top	pane	must	be	active	for	this	to	work.	For	example	if	you	are	looking
for	'Smith,	Magnes'	in	the	'sample.gramps'	tree,	you	could	type	'smi'	which	would	jump	the	selection	to	the	first	of	the	lines	containing	these
characters,	and	then	use	cursor	up/down	keys	to	find	the	'Smith'	you	are	looking	for.	Or	type	'magn'	which	is	more	likely	to	land	on	the	right	place.

You	can	search	for	items	by	'ID'	field	by	typing	'#'	and	then	the	characters	to	match.	For	example	type	'#I0103'	to	search	for	the	individual	with	ID
I0103.

You	can	sort	the	top	pane	by	Status	(Object	will	be	a	sub-sort),	Object,	ID,	Object	Name/Description	(will	be	grouped	by	Object)	and	Action.	Click
on	the	column	header	to	change	the	sort.

Lower	Pane
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When	an	item	in	the	top	pane	is	selected,	the	lower	pane	shows	the	specific	differences.	If	no	Action	is	made	yet,	the	pane	will	show	the	'Original
>>'	and	'Imported	>>'	state	for	each	sub-object	and	item	that	has	a	difference.	If	an	Action	has	been	selected,	the	pane	also	includes	a	'Result	>>'	for
each	sub-object	and	item	that	has	a	difference.

Sometimes	it	may	be	difficult	to	determine	enough	about	the	difference	to	figure	out	what	is	going	on.	If	so,	you	can	check	the	 Show	more
details 	checkbox	to	see	more	about	the	difference.

The	lower	pane	tries	to	present	the	information	as	concisely	but	informatively	as	possible.	Apologies	if	the	information	seems	a	bit	hard	to	interpret
at	times.	One	area	that	might	be	confusing	is	when	there	are	differences	in	'lists'.	Many	of	Gramps	objects	have	lists	of	other	objects,	families	have
lists	of	children,	persons	have	lists	of	events	or	notes	etc.	When	a	list	has	changes,	the	left	side	will	have	a	list	position	number	preceded	by	'#'.	For
example:

Person,	Event	References	#1,	Event Original	>> your	tree	Event:	[E0012]	Death:	Smith	Gus
Imported	>> your	tree	Event:	[E0011]	Birth:	Smith	Gus

Person,	Event	References	#2,	Event Original	>> your	tree	Event:	[E0011]	Birth:	Smith	Gus
Imported	>> your	tree	Event:	[E0012]	Death:	Smith	Gus

In	this	example	list	of	event	references,	the	imported	tree	somehow	got	the	Birth	and	Death	events	swapped,	compared	to	the	original	tree.

Control	buttons

Help 	brings	up	this	wiki.

Edit	import 	allows	editing	of	the	selected	item.	Any	changes	are	temporarily	saved	in	your	imported	data,	and	will	be	kept	only	if	that	data	is
merged	into	your	current	tree.	If	your	editing	creates	new	items,	they	will	appear	in	the	top	pane	list	when	you	finish	editing.	Changes	here	cause
the	'Action'	to	be	cleared,	so	be	sure	to	choose	an	Action	when	finished.

Unmark 	clears	any	current	Action.	If	an	item	remains	unmarked	when	you	are	done,	it	will	be	treated	as	if	'Ignored',	that	is,	there	will	be	no
changes	to	your	tree	for	that	item.

Ignore 	sets	the	action	for	the	item	so	that	there	will	be	no	changes	to	your	tree	for	that	item.	This	is	the	same	as	leaving	the	item	unmarked,	but
makes	it	clear	that	you	have	looked	at	that	item.

Done 	tells	the	tool	that	you	are	finished	marking	the	various	actions.	The	tool	will	bring	up	a	confirmation	dialog,	allowing	you	to	save	your
work,	cancel	and	return	to	marking,	or	abandon	it.

The	remaining	buttons	are	considered	'Actions'	and	depend	on	the	Status	of	the	item.

Add 	appears	for	items	with	an	'Added'	status.	When	added,	the	imported	data	will	be	added	to	your	current	tree.

Delete 	appears	for	items	with	a	'Missing'	status.	When	selected,	the	data	in	your	tree	for	this	item	will	be	deleted.

Replace 	appears	for	items	with	a	'Different'	status.	When	replaced,	the	imported	data	for	the	item	will	completely	replace	the	same	data	in	your
current	tree.

Merge	Original 	appears	for	items	with	a	'Different'	status.	When	selected,	the	imported	data	for	the	item	will	be	merged	with	the	original	tree
and	the	IDs	of	the	original	item	are	retained.	The	portions	of	the	data	that	cannot	be	merged	will	remain	as	it	is	in	your	current	tree	data.

Merge	Import 	appears	for	items	with	a	'Different'	status.	When	selected,	the	imported	data	for	the	item	will	be	merged	with	the	original	tree	and
the	IDs	of	the	imported	item	are	used.	The	portions	of	the	data	that	cannot	be	merged	will	be	replaced	by	the	import	data.

When	you	select	an	'Action'	with	one	of	the	buttons,	a	hint	will	appear	that	states	the	action	in	more	detail.

You	can	change	the	'Action'	at	any	time	on	any	item,	it	may	be	instructive	to	see	the	results	of	choosing	the	various	choices	in	the	lower	pane.

In	general	I	recommend	that	you	start	marking	your	items	with	the	'Different'	items	first.	Within	these,	doing	Families	and	Persons	first	will	usually
minimize	the	amount	of	work	to	merge	your	tree.	This	tool	starts	up	with	the	sort	set	to	put	these	items	first,	so	starting	at	the	top	is	easy.

Automatic	Mark

This	tool	includes	the	ability	to	automatically	mark	those	items	that	are	'referred	to'	by	the	item	you	are	currently	marking.	For	Example,	if	you
Add 	a	person,	the	events,	notes,	media,	citations	and	families	that	the	person	refers	to	will	also	be	added.	The	same	process	is	applied	for	each	of
the	various	'Action'	buttons.

The	marks	that	are	automatically	generated	are	shown	in	the	top	pane	action	column	with	a	'*'	preceding	the	action.

Occasionally	you	may	mark	items	that	create	a	conflict	in	the	automatic	marking.	For	example	you	 Add 	a	person	that	refers	to	a	media,	and	then
later	 Ignore 	a	person	that	also	refers	to	the	same	media.	In	this	case,	the	media	item	will	be	marked	with	a	'?'	and	the	action	that	tends	to
conserve	more	data	will	be	used.	This	means	that	Adds	have	priority	over	Ignore,	Ignore	over	Delete	etc.

You	should	review	any	items	marked	this	way	to	make	sure	that	you	agree	with	the	program.

Note	that	families	and	persons	in	particular	usually	have	a	lot	of	references	to	other	families	or	persons.	In	fact	if	your	imported	file	contains	a	whole
new	branch	of	your	family	tree,	selecting	any	one	of	the	people	or	families	in	that	branch	will	automatically	mark	all	the	new	people	and	families	at
once.	This	is	usually	desirable,	but	not	always.

Automatic	mark	with	Families

This	tool	is	not	ideal	for	selecting	only	parts	of	a	tree	for	merging,	but	it	can	be	done.	If	you	wish	to	include	a	person,	but	not	his	family	(spouse	and
children)	then	you	can	uncheck	the	 Automark	Families 	checkbox.	This	applies	to	all	persons	found	via	the	Automark	as	well.	The	effect	is	that
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you	can	get	ancestors	(if	 Automark	Parent	Families 	is	checked)	included	but	not	all	the	descendants	of	those	ancestors.

If	you	wish	to	get	a	set	of	spouses	and	descendants	included	when	adding	a	person	but	not	all	the	ancestors	of	the	spouses,	then	you	can	uncheck	the
Automark	Parent	Families 	checkbox	and	leave	the	 Automark	Families 	unchecked.	If	you	don't	want	any	family	or	parent	families
automatically	included,	leave	both	 Automark	Parent	Families 	and	 Automark	Families 	unchecked.

Finishing	up

When	you	have	marked	up	as	many	items	as	you	want	and	reviewed	the	automatic	marks	to	make	sure	they	are	what	you	desire,	you	can	press	the
Done 	button.

The	tool	will	bring	up	a	confirmation	dialog,	allowing	you	to	save	your	work,	cancel	and	return	to	marking,	or	abandon	it.	If	you	abandon,	your
markings	are	lost	and	no	changes	are	made	to	your	current	tree.

If	you	decide	to	save	your	work,	the	tool	will	perform	a	series	of	checks	as	it	saves	your	work.	These	checks	make	sure	that	any	conflicts	that	may
have	been	created	will	not	result	in	errors	in	your	database.	For	example,	if	you	selected	a	person	to	add,	but	decided	to	ignore	a	note	attached	to	that
person,	the	tool	will	'clean	up'	the	reference	to	the	note	on	the	person	before	saving	it.

FAQ
Why	would	I	want	to	use	the	 Edit	import 	button?

If	you	had	an	item	with	a	difference,	where	both	the	current	tree	and	the	imported	tree	made	changes.	Because	of	some	limitations	of	Gramps
and	this	tool,	you	cannot	choose	between	current	and	imported	for	every	detail	within	an	object.	For	these	details,	you	can	only	choose	to	keep
your	current	data	with	 Ignore 	or	 Merge	Original ,	or	use	the	imported	data	with	 Replace 	or	 Merge	Import .	In	either	case
some	changes	will	be	lost.	For	example,	if	you	have	edited	a	Person	and	added	a	Nickname,	and	the	imported	tree	had	edited	the	same	person
to	add	a	LDS	Ordinance,	you	can	only	keep	the	information	for	one	side.	In	this	case	you	might	want	to	edit	the	imported	person	to	change	it
to	add	the	Nickname	so	that	data	will	not	be	lost.

Why	does	the	import	file	have	to	be	derived	from	the	same	original	source?
If	it	is	not,	then	the	matching	process	will	not	find	any	items	that	are	the	same	or	even	different.	Every	item	in	the	import	file	will	end	up
showing	as	'Added',	and	every	item	in	the	current	tree	will	show	as	'Missing'.	You	can	use	this	tool	to	add	in	part	or	all	of	the	imported	data,
but	it	is	not	ideal	for	this	purpose.	You	would	be	better	importing	the	data	into	a	new	tree,	using	all	the	Gramps	views	and	filters	to	find	what
you	do	or	don't	want,	make	any	deletions	or	edits	and	export	to	a	new	XML	before	importing	that	into	your	tree	the	usual	way.

When	would	it	make	sense	to	use	'Merge	Original'	vs	'Merge	Imported'?
The	difference	between	'Merge	Original'	or	'Merge	Imported'	is	which	Gramps	IDs	are	kept	as	the	final	object.	If	you	would	like	to	keep	your
starting	family	tree	the	way	you	have	set	it	up,	use	Merge	Original.	If	you	think	that	the	imported	tree	is	better,	has	better	IDs	etc,	then	use	the
Merge	Imported.

Why	can't	you	use	a	GEDCOM	file	as	the	import	source?
One	of	the	things	that	make	this	tool	work	is	that	every	'object'	in	the	Gramps	database	has	a	unique	ID	called	a	handle	(this	is	different	than
the	ID	shown	in	the	GUI	for	each	object).	The	tool	can	compare	objects	with	matching	handles	relatively	easily,	much	more	easily	than
guessing	if	John	Smith	in	your	tree	is	the	one	from	1722,	1854,	or	2012.
At	this	time	Gramps	GEDCOM	import	and	export	has	no	way	to	save	these	handles	to	make	this	sort	of	matching	possible.	A	few	of	the	other
family	tree	tools	can	import	and	export	the	so	called	'_UID'	GEDCOM	tag	(which	is	not	standardized)	which	might	be	usable	for	this,	but
most	tools	will	simply	discard	them	or	modify	them	to	be	unusable.	Even	if	these	were	available	and	not	lost	in	translation,	Gramps	data
model	does	not	always	match	with	GEDCOM	data	model.	So	a	GEDCOM	export/import,	even	without	any	changes	made	by	the	user,	would
have	a	lot	of	differences.

Notes
If	you	are	not	sure	exactly	what	an	imported	tree	contains,	you	should	use	Gramps	to	examine	it	before	using	this	tool.	Import	the	tree	into	a	new
family	tree,	and	look	it	over	with	the	various	charts	(I	like	the	relationship	chart	myself)	to	see	if	there	are	branches	that	you	don't	want.	It	is
frequently	easier	to	use	Gramps	filters	or	editing	tools	to	remove	items	than	to	use	the	tool	to	exclude	them,	although	the	tool	will	suffice	for	simpler
cases.	Even	then	you	should	take	notes	on	the	IDs	of	people	or	families	that	you	don't	want,	to	make	it	easier	to	find	them	with	this	tool.

This	is	a	new	tool	and	fairly	complex.	Please	report	any	issues	or	desired	enhancements	to	paulr2787	at	gmail.com

I	have	included	a	French	translation	of	the	tool,	mostly	as	a	test	of	the	internationalization	code.	Since	I	don't	speak	French	(USA	Texas	version	of
English	only),	please	excuse	my	French.

See	also
Database	Differences	Report	-	allows	a	mostly	complete	comparison	between	the	currently	opened	database	(Family	Tree)	and	a	Gramps
XML	file.
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This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

5.2	Addons

InformationGraph

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Note

The	InformationGraph	plugin	only	works	with	Gramps	3.2
For	a	similar	report	see	the:	Addon:PersonEverything	Report

InformationGraph	is	a	report	plugin	to	generate	detailed	Graphviz	graphs	of	a	database.	It	is	intended	to	allow	effectively	dumping	of	a	database
or	select	parts	of	the	database,	onto	dead	wood	(paper).

Installation
Download	and	Manually	install	the	Addon:

http://pkl.net/~node/software/GVInformationGraph.py	(Last	updated:	01-Aug-2009	)
Archived	copy	File:GVInformationGraph.zip

Features
Dump	as	much	information	as	possible	for	each	person	and	event	into	the	node:

Date	and	place	of	birth
Date	and	cause	of	death
All	other	events	(Residences,	Graduations,	etc)
Occupations
Notes
Date	and	place	of	marriage
Possibly	references	to	sources	of	information

Changing	the	date	stringification	to	print	a	more	human-friendly	date.	Eg,	"16th	December,	1842";	"June	quarter,	1912";	"about	1875"
Include	edges	for	non-primary	event	participants,	eg,	Witness,	Minister,	etc.
Add	labels	for	non-standard	child	relationship	edges,	or	modify	style	in	some	way	to	indicate	different	types,	eg,	Adopted,	Step	child,	etc.
Use	a	method	similar	to	the	FamilyLines	plugin	to	specify	a	list	of	people	to	start	spidering	over	the	database	from.	Also	include	a	list	of
people	not	to	spider	beyond.	This	will	allow	dumps	of	one	side	of	a	family	tree.

Features	to	be	implemented
Include	a	legend	for	edge	and	node	types
Have	the	ability	to	store	profiles	of	spider	settings.	Eg,	"Mum's	family",	"Dad's	family",	"Everyone".

See	also
For	a	similar	report	see	the:	Addon:PersonEverything	Report
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5.2	Addons

Interactive	Family	Tree

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

The	Interactive	Family	Tree	addon	does	not	send	any	data	out	of	your	computer.

It	is	processed	locally	on	your	computer.	Only	the	Topola	JavaScript	Genealogy	viewer	application	is
downloaded	so	that	it	can	run	locally.

Interactive	Family	Tree	addon	screenshot.

The	Interactive	Family	Tree	addon	allows	you	to	browse	the	family	tree	using	the	Topola	Genealogy	Viewer.

Usage
Select	Menu	Tools	>	Analysis	and	Exploration	->	Interactive	Family	Tree...	and	then	a	web	page	will	open	with	your	family	tree.

If	the	person	you	want	to	view	is	not	shown	you	can	search	for	them.

You	can	click	on	people	to	change	the	focus	of	the	tree.

You	can	choose	between	three	different	views;	Hourglass	chart,	All	relatives	and	Fancy	tree(experimental).

You	can	print	or	download	the	chart	in	various	formats.

You	can	 + 	zoom	in	or	 - 	zoom	out	on	the	chart.

Features
One	of	the	features	of	this	addon	is	that	 the	Interactive	Family	Tree	addon	does	not	send	any	data	out	of	your
computer.

This	is	something	that	is	not	obvious	because	what	you	see	in	the	browser	is	a	web	application.

Technical	details

Here	is	a	technical	description	of	how	the	addon	works.

On	the	Gramps	side,	the	addon	saves	a	temporary	file	in	GEDCOM	format	and	sets	up	a	temporary	local	HTTP	server	inside	Gramps	that	reads	the
GEDCOM	file.

Then,	the	addon	opens	your	browser	pointing	to	a	web	application	hosted	on	GitHub	pages.	That	web	application	contains	a	GEDCOM	parser	and
viewer	that	is	loaded	into	your	browser.	The	web	application	is	a	“single	page	application.”	Once	it	is	loaded	from	the	GitHub	server,	it	does	not
require	further	Internet	connections	to	work.	This	is	why	you	can	open	it	from	the	browser’s	cache	even	with	no	internet	connection.	(i.e.,	WiFi
turned	off)	After	the	web	application	is	loaded	from	cache,	it	reads	the	GEDCOM	file	from	simple	local	HTTP	server	temporarily	set	up	by
Gramps.	If	the	cached	file	expires	and	is	purged,	a	fresh	copy	will	need	to	be	downloaded	again.
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Genealogy	Data	is	not	uploaded.

The	data	is	only	loaded	locally	into	the	browser’s	memory	and	does	not	leave	your	computer.	It	is
processed	by	JavaScript	code	to	produce	a	visualization	of	the	data.

See	also
topola-viewer	issues	on	Github
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5.2	Addons

Isotammi	addons
The	Taapeli	Project	(which	is	a	national	database	of	Suomen	Sukututkimusseura	ry	:	the	Finnish	Genealogical	Society)	curates	their	own	set	of
"Isotammi	lisäosia"	:	“Big	Oak	(the	mythological	World	Tree)	add-ons”	for	Gramps.	The	Isotammi	Project	is	a	platform	that	coordinates	validated
merging	of	remote	researcher's	independent	work	into	a	collaborative	genealogical	collection.

This	group	of	addons	are	designed	to	help	Gramps	users	make	their	data	compliant	to	Isotammi	project.	(Their	server	also	contains	tools	for
cleaning	up	GEDCOM	dialects	from	other	software.)

Isotammi	users	can	import	data	as	.gramps	and	.gpkg	formats	and	browse	it.	Isotammi	software	is	built	on	Neo4j	(a	high-speed	graph	database),
Python	and	Flask	(a	lightweight	WSGI	web	application	framework),	and	increasingly	Vue	(a	progressive	JavaScript	Framework	for	building	user
interfaces).

The	main	challenge	now	is	auditing	and	merging	user’s	candidate	material	to	approved	data.	Future	plans	include	a	live	API	to	Isotammi.	The	API
would	allow	transferring	common	identifiers,	reference	places	and	sources	back	to	the	researchers’	Gramps	database.

The	reason	for	competing	with	world-wide	services	is	to	get	better	harmony	with	Scandinavian	name	formats	and	local	archives.	And,	in
compliance	with	regional	privacy	regulations,	to	keep	the	data	safely	in	Finland.

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Please	note	this	group	of	addons	require	an	additional	step	to	install.

Follow	the	installation	instructions	on	this	page.

Fig.	Isotammi.1	Isotammi	Tools	menu

Once	installed:

Gramplets	are	available	from	the:
Dashboards	add	a	gramplet	right	click	menu.	(Isotammi	configuration	/	Deep	Connections	Graph	/	PropertyEditor	)
Events	category	add	a	gramplet	drop	down	on	the	bottombar	(	Dates	)

Tools	are	available	under	the	Tools	>	Isotammi	tools	->	...	menu.
New	Rules	are	available	as	described	below.
Exporter	for	 Isotammi	XML	export

About	Isotammi
Isotammi.net	was	an	online	service	provided	by	the	Genealogical	Society	of	Finland	(Suomen	Sukututkimusseura,	abbreviated	SSS)	made	by
volunteers	that	took	into	account	the	special	characteristics	of	Finnish	genealogical	research.

The	SSS	name	is	composed	of	three	Finnish	words:

"Suomen"	-	This	is	the	genitive	case	of	the	word	"Suomi",	meaning	"Finland".
"Suku"	-	This	word	means	"family",	"kin",	or	"lineage".
"tutkimus"	-	This	word	means	"research"	or	"study".
"seura"	-	This	word	means	"society"	or	"association".

So,	the	full	name	"Suomen	Sukututkimusseura"	literally	translates	to	"Finland's	Family	Research	Society"	or	"The	Genealogical	Society	of	Finland".

The	service	contains	sourced	family	trees	compiled	by	users,	so	called	HisKi-trees	made	from	materials	in	HisKi	as	well	as	place	name	databases
compiled	from	communion	books.	Users	are	also	provided	with	quality	guidelines,	recommendations	and	tools.
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The	Isotammi	team	decided	to	end	the	Isotammi.net	service	on	May	31,	2024

The	publicly	announced	reasoning	was	that	the	costs	are	too	high	compared	to	the	use	and	that	further
development	of	the	application	would	have	required	resources	that	we	did	not	have	available.	The	team
states	that	they	have	reached	their	goal	of	promoting	good	research	practice	with	the	ease	of	references	to
original	sources	and	the	researcher's	own	quality	controls.	Isotammi,	instructions	and	Gramps	accessories
have	been	made	with	Finnish	development	work	in	the	era	of	transnational	giants.	

The	service's	software	is	still	available	as	open	source	code,	and	other	publication	channels	are	being
sought	for	its	databases	(location	information,	Hiskipuut,	common	family	trees).

The	Isotammi	Facebook	group	and	the	Gramps	Finland	focused	Google	group	still	serve.	The	Isotammi
team	(Jorma,	Juha,	Kari,	Pekka,	Timo)	thanks	the	users	and	their	partner	SSS	for	the	past	10	years.

The	Society	will	retain	and	archive	the	content	of	the	web	service,	genealogical	data	and	geographical
databases.	

Isotammi	extensions	developed	for	Gramps	will	not	be	affected	by	the	end	of	the	online	service.

The	Service	and	its	Aims

Isotammi	is	developed	domestically	in	Finland	and	this	is	where	it	begins	it	difference	from	commercial	services.	It	relies	on	open	source	software
and	its	own	programming.	The	service	is	wholly	non-commercial	and	all	its	public	information	is	owned	and	controlled	by	the	Society.	The
Society's	role	and	it	being	domestically	developed	means	that	the	service	supports	the	special	features	of	Finnish	genealogy.

The	user	can	also	edit	materials	to	Isotammi	and	browse	materials	uploaded	to	it	online	and	on	mobile	devices.	With	the	user's	permission	some
materials	are	also	public	for	all	users.	Registration	is	required	to	use	Isotammi.

The	aim	of	Isotammi	is	to	support	the	principles	of	good	research	practices	and	to	raise	the	quality	of	researchers'	genealogy	materials.	The
information	on	family	trees	should	be	supported	by	primary	sources.	References	to	them	should	be	to	as	precise	information	as	possible.	Changes	to
personal	names	are	managed	with	alternative	names.	The	location	of	events	are	specified	by	attaching	a	hierarchy	to	them,	i.e.	giving	information	as
to	what	larger	whole	it	to	which	it	belongs.	For	example,	farm-house-village-municipality.	Dozens	of	Place	Name	Databases	in	Isotammi	help	with
these	hierarchies.

Installation

Beware	the	false	"The	addon	repository	appears	to	be	unavailable.	Please	try	again
later."	message

Please	note	the	Isotammi	server	has	Finnish,	Swedish	&	English	lists.	Old	versions	of	the	Plugin
Manager	Enhanced	gave	a	false	failure	message	if	Gramps	is	running	in	any	other	language.

Update	the	Plugin	Manager	Enhanced	if	checking	the	Isotammi	server	for	updates	returns	the	message:
"The	addon	repository	appears	to	be	unavailable.	Please	try	again	later."

Fig.	Isotammi.2	General	Preferences	(Linux)

Isotammi	addons	installation	to	get	started	for	Gramps	5.1.x	go	to	Gramps	preferences	(Edit	>	Preferences)	and	replace	the	value	of	 Where	to
check: 	with:

https://raw.githubusercontent.com/Taapeli/isotammi-addons/master/addons/gramps52

Click	 Check	for	updated	addons	now 	and	install	all	shown	addons	or	at	least	the	 Isotammi	configuration 	Gramplet.

After	downloading	the	Isotammi	addons	restore	the	original	value	of	 Where	to	check: 	with:

https://raw.githubusercontent.com/gramps-project/addons/master/gramps52
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After	installation	go	to	Gramps	Dashboard	and	add	the	 Isotammi	configuration 	Gramplet	which	will	allow	you	to	select	which	source	to	use
for	installing	addons	in	the	future:	Gramps	default	or	Isotammi	addons	

Isotammi	addons

Fig.	Isotammi.3	Available	Isotammi	addons	(Gramps	5.1.3)

From	the	website

https://github.com/Taapeli/isotammi-addons

Follow	the	instructions	to	install	the	Gramps	Isotammi	addons	associated	with	the	Isotammi	project.

So	far,	the	following	three	gramplets,	two	rules,	and	one	tool	are	available:

Gramplets:

Isotammi_configuration
Dates	-	This	gramplet	helps	to	correct	invalid	dates...
Position	tool

Rules:

Events	with	an	invalid	date
Events	with	a	valid	date

Tool:

Generate	source	references	based	on	more	information

Here	are	brief	descriptions	of	the	above	extensions:

Gramplets

Isotammi	configuration

Deprecated	for	Gramps	5.2

The	Isotammi	Configuration	dashboard	gramplet	is	no	longer	needed.	The	Isotammi	URL	functionality
was	replaced	with	the	Projects	portion	of	the	Addon	Manager	in	the	Gramps	5.2	version.	The	API	key
feature	was	never	leveraged.

A	false	"The	addon	repository	appears	to	be	unavailable.	Please	try	again	later."	message	may	appear	when	using	obsolete	versions	of	the	Plugin
Manager	Enhanced	addon	in	an	unsupported	locale.	Please	note	the	Isotammi	server	supports	Finnish,	Swedish	and	English	lists.	A	false	failure
message	can	appear	if	Gramps	is	running	in	any	other	language.

Update	the	Plugin	Manager	Enhanced	if	checking	the	Isotammi	server	for	updates	returns	the	message:	"The	addon	repository	appears	to	be
unavailable.	Please	try	again	later."}}	 Isotammi	configuration 	Gramplet	can	be	added	to	the	Dashboard	to	allow	you	to	select	from	which
source	the	addons	are	installed	e.g.	from	the	default	location	of	Gramps	or	from	the	Isotammi	addons.
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Fig.	Isotammi.4	Isotammi	Configuration

The	Addon	source	radio	buttons	switches	the	Where	to	check	URL	of	the	Third	party	addons	management.

The	2	supported	Repositories	are:	the	Default	location	(the	Gramps-Project	repository	on	GitHub):

https://raw.githubusercontent.com/gramps-project/addons/master/gramps52

and	the	Isotammi	(the	Taapeli	repository	also	on	GitHub):

https://raw.githubusercontent.com/Taapeli/isotammi-addons/master/addons/gramps52

Fig.	Isotammi.5	General	Preferences	(Linux)

The	Gramps	preferences	button	opens	the	preferences,	allowing	the	selected	Addons	repository	to	be	manually	checked.	

Dates

Fig.	Isotammi.6	Dates	Gramplet	-	detached

The	 Dates	Gramplet 	is	installed	in	the	Events	list.	It	can	be	used	to	manipulate	event	date	information,	especially	to	correct	dates	in	the	wrong
format.	First	select	one	or	more	events	to	which	you	want	to	assign	the	function	and	the	desired	correction	function	and	press	 Execute .	This	can
be	used,	etc.,	with	the	rule	"Events	with	an	invalid	date"	so	that	it	first	generates	a	filter	that	looks	for	invalid	dates.	
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Place	tool

Fig.	Isotammi.7	PlaceTool	Gramplet	-	detached

The	 PlaceTool	Gramplet 	can	be	used	to	manipulate	multiple	location	data	at	once.	It	can	form	a	hierarchy	of	places	from	comma-separated
place	names,	the	type	of	places	can	be	changed,	it	can	be	used	to	move	places	(e.g.,	villages)	inside	the	right	keeper	and	to	correct	systematic	typos.
PlaceTool	can	be	added	to	the	bottombar	in	the	Places	category	list	view.	

Deep	Connections	Graph

Fig.	Isotammi.8	Deep	Connections
Graph	Dashboard	category	gramplet	-
detached

The	Deep	Relationship	Chart	graph	produces	a	graphical	diagram	of	the	relationships	between	two	people	-	The	chart	shows	not	only	the
relationships,	but	also,	for	example,	sponsorships	and	other	events	connections	through	Associations	and	through	links	in	Notes.

The	Deep	Connections	Graph	gramplet	for	the	Dashboard	category	is	the	control	for	controlling	a	locally	hosted,	browser	interface	to	charts	of	the
Deep	Connections	data.	It	allows	a	LocalHost	server	to	be	created,	the	current	Tree	data	to	be	posted.	The	server	has	a	Form	interface	to	select	two
Persons	and	options	for	diagramming	their	direct	or	indirect	connection.

Note	that	many	of	the	error	messages	(when	the	server	is	unable	to	generate	a	graph/chart)	are	in	Finnish.

Fig.	Isotammi.9	Deep	Connections	Graph	browser	interface
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PropertyEditor

Fig.	Isotammi.10	sample	Edit	Source	dialog

Fig.	Isotammi.11	Property	Editor	source	gramplet-	detached

The	Property	Editor	is	a	Source	category	gramplet	allowing	"Search	and	Replace"	mass	updates	to	selected	subsets	of	Source	records.

This	tool	was	designed	for	use	within	the	Isotammi	collaborative	Finnish	genealogy	project.	It	simplifies	harmonization	and	merging	of	Source
records.

See	also

Event	Description	Editor	addon	tool	-	Find	and	Replace	text	within	the	Description	of	Event	records.
Set	Attribute	addon	tool	-	Overwrite	text	within	the	Attribute	records	in	any	Category.
SuperTool	addon	tool	-	create	custom	mass	updates	when	at	specialized	tool	does	not	exist.

Add	Sources	Gramplet

This	gramplet	works	together	with	the	"Generate	citations	based	on	additional	information"	tool	(generatecitations).

This	gramplet	generates	the	necessary	additional	information	without	having	to	open	the	event.	All	you	have	to	do	is	select	the	desired	events	and
copy	the	additional	information	in	the	input	field	of	the	gramplet	and	press	the	button	'Add	to	selected	events'.	Co.	additional	information	can	be
obtained	from	the	digital	directory	or	sshy's	page	(in	the	case	of	sshy,	a	browser	extension	is	required	https://addons.mozilla.org/en-
US/firefox/addon/sshy-selainlaajennus/	or	https://chrome.google.com/webstore/detail/	sshy	browser	extension/caomdaijfcdopklkecajpkoaiamaegkb).

So	this	does	not	make	source	references	until	the	end,	but	"Create	source	references	based	on	additional	information"	must	be	run	at	the	end
anyway.

Direct	translation	from	AddSourcesGramplet/README.md

Multimerge	Gramplet

Excerpted	from	the	ReadMe.md	for	the	MultiMerge	addon	in	the	Isotammi	GitHub	Repository.

The	Multimerge	Gramplet	allows	the	merging	of	multiple	objects	in	a	single	step.	This	applies	to	the	following	object	views:

People
Families
Events
Places
Citations

Isotammi	addons 166

http://www.gramps-project.org/wiki/index.php/File:NewSource-editor-dialog-example-50.png
http://www.gramps-project.org/wiki/index.php/File:PropertyEditor-Gramplet-Isotammi-51.png
http://www.gramps-project.org/wiki/index.php/Addon:EventDescriptionEditor
http://www.gramps-project.org/wiki/index.php/Addon:SetAttributeTool
http://www.gramps-project.org/wiki/index.php/Addon:Isotammi_addons#SuperTool
https://addons.mozilla.org/en-US/firefox/addon/sshy-selainlaajennus/
https://chrome.google.com/webstore/detail/
https://github.com/Taapeli/isotammi-addons/tree/master/source/AddSourcesGramplet
https://github.com/Taapeli/isotammi-addons/blob/master/source/multimergegramplet/README.md


Sources
Repositories
Notes
Media

Add	the	MultiMergeGramplet	in	the	sidebar	or	bottombar	of	the	corresponding	view.

Usage

Fig.	Isotammi.12	Isotammi	MultiMerge	Gramplet	for	3
selected	People

Select	the	objects	to	be	merged	and	click	the	button	"Merge	selected	objects".

The	gramplet	will	ask	which	of	the	selected	objects	should	be	the	primary	object.The	gramplet	executes	the	standard	merge	function	pairwise	for
the	selected	objects.	The	user	can	select	the	primary	object	but	otherwise	the	merges	are	performed	using	the	defaults	for	each	case.

All	changes	are	done	under	a	single	transaction	and	they	can	be	undone	from	the	Gramps	menu	Edit	->	Undo.

Special	handling	for	families

Two	families	cannot	be	merged	if	the	primary	family	is	missing	a	parent	but	the	other	family	has	the	corresponding	parent.	The	gramplet	checks	for
this	situation	and	does	not	allow	selecting	such	family	as	the	primary	family.	If	there	is	no	suitable	primary	family	among	the	selected	families	then
the	gramplet	issues	the	error	"Impossible	to	merge"	and	stops.

Special	handling	for	notes:

By	default,	when	merging	notes	only	the	text	of	the	primary	note	is	preserved.	This	gramplet	allows	saving	text	from	all	merged	notes	by	appending
the	text	after	the	text	of	the	primary	note:	

Automerge

Fig.	Isotammi.13	After	using	automerge	for	all	Places	with	the	same
Title

There	is	also	an	"Automerge"	feature.	Automerge	is	accessible	from	its	own	tab	when	the	Multimerge	Gramplet	is	added	to	the	splitbars	of	the
Places,	Sources	and	Repositories	category	views.

This	will	automatically	merge	all	objects	with	the	same	name	(or	title	for	Source	and	Places).	As	instructed	by	the	Radio	Button	choice,	this	affects
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either:	only	the	selected	objects;	or,	all	objects.	After	the	operation,	a	list	of	merged	objects	will	be	displayed.	

Filter+

Fig.	Isotammi.14	Families	category's	Filter	gramplet	compared	to
the	Filter+	addon

It	is	often	desirable	to	use	the	Filter	gramplet	interactively	find	a	subset	of	records.	But	since	Tools,	Reports	and	Exports	do	not	have	the	option	to
restrict	themselves	to	that	filtered	data,	this	subset	either	had	to	be	manually	re-built	as	a	Custom	Filter	(which	meant	discovering	which	rules
corresponded	to	filter	fields)	or	to	Tag	the	view	contents	then	create	a	Custom	Filter	for	that	Tag.

Filter+	has	the	option	to	create	a	Custom	Filter	directly	from	the	Filter	parameters.

Filter+	gramplets	are	designed	to	look	very	similar	to	the	built-in	Filter	Gramplets.	But	Filter+	add-on	gramplets	are	slightly	enhanced	versions.
These	addons	do	NOT	upgrade	the	built-ins.	Just	add	the	Filter+	gramplets	to	the	sidebar	of	each	Category.	(It	is	advisable	to	remove	the	built-in
from	the	sidebar	as	the	addons	include	all	the	original	features.)

The	enhancements	are:

There	is	a	new	 Define	filter 	button	that	automatically	creates	a	custom	filter	based	on	the	given	criteria.	This	makes	it	easy	to	create
simple	custom	filters.
Selecting	the	Find	button	also	displays	the	elapsed	time	to	run	the	filter.
The	“Father”,	“Mother”	and	“Child”	allow	searching	for	multiple	partial	names	in	the	Families	Filter+	fields.	This	behaves	the	same	way	as
searching	Names	in	the	“People”	filter.	The	un-enhanced	filter	tried	to	match	the	entire	string	exactly.	(For	example,	“en	w”	matches	for	the
Father	in	example.gramps	will	find	34	families	including:	“Lawrence	Gill”	and	“Edward	Green”.	Adding	a	Child	“b	te”	reduces	the	list	to	4
families.)	This	5.1	enhancement	is	already	present	in	the	5.2	Family	category	Filter	Gramplet.
The	Citation	Filter+	uses	“Very	low”	as	the	default	confidence	level.	The	regular	filter	defaults	to	“Normal”	(which	might	miss	some
citations).

Fig.	Isotammi.15	A	Families	category	custom	filter
defined	by	Filter+	gramplet

Clicking	the	 Define	filter 	button	will	scrape	the	Gramplet	parameters	into	rules	for	a	Custom	Filter.	After	you	add	a	name	for	the	new
Custom	Filter,	the	 	OK	 	button	becomes	active.

The	Rules	used	to	simulate	the	Filter	Gramplet	in	each	category	(except	the	Dashboard)	are	illustrated	and	listed	in	the	Gramplets	section	of	the
wiki:
		 	People,	 	Relationships,	 	Families,	 	Charts,	 	Events,	 	Places,	
		 	Geography,	 	Sources,	 	Citations,	 	Repositories,	 	Media,	 	Notes
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Fig.	Isotammi.16	People
category	Filter+	gramplet
with	Death	Event
parameters

The	People	category	Filter+	Gramplet	is	expanded	to	include	parameters	for	searching	Death	Events.

Added	Rules:

The	Filter+	needed	some	addon	rules	to	support	the	same	parameter	filtering	as	the	Filter	gramplet.

HasEventBase+	:	HasEventBase+	-	used	by	Filter+
HasSourceBase+	:	HasSourceBase+	-	used	by	Filter+

Tools

Fig.	Isotammi.17	Isotammi	Tools	menu

Tools	are	available	under	the	Tools	>	Isotammi	tools	->	...	menu.

Tools	>	Isotammi	tools	->	Generate	source	citations	from	notes...
Tools	>	Isotammi	tools	->	Name	Editor	Tool...
Tools	>	Isotammi	tools	->	Name	Merge	Tool...
Tools	>	Isotammi	tools	->	SuperTool...
Tools	>	Isotammi	tools	->	ZipInstall...

Generate	source	citations	from	notes

The	 Generate	source	citations	from	notes 	tool	is	a	specialized	tool	that	can	interpret	a	source	reference	obtained	from	a	digital
directory	or	SSHY	page,	which	is	stored	in	Gramps,	eg	for	additional	information	about	an	event.	The	tool	then	forms	the	based	on	the	text
reference	to	the	source,	source,	and	archive	Gramps	and	deletes	the	original	additional	information.	The	additional	information	must	not	contain
other	text	and	the	source	reference	must	be	copied	there	as	it	is.	The	tool	processes	all	additional	information	in	this	format	at	the	same	time.	The
SSHY	source	reference	must	be	retrieved	using	a	special	SSHY	browser	extension	(https://addons.mozilla.org/en-US/firefox/addon/sshy-
selainlaajennus/	or	https://chrome.google.com/webstore/detail/sshy-selainlaajennus/caomdaijfcdopklkecajpkoaiamaegkb)	)

Name	Editor	Tool

Fig.	Isotammi.18	Name	editor	-	tool
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The	 Name	Editor 	Tool	standardizes	family	names	in	the	family	tree	to	eliminate	random	scribe	practices	and,	to	make	it	easier	to	find	duplicates
in	the	family	tree	and	to	merge.	For	example,	Gramps'	"MultiMerge"	and	"Family	Auto	Merge	Tool"	work	more	efficiently	the	more	consistent	the
nomenclature.	In	addition,	the	tool	maintains	the	primary	and	alternative	name	types	of	individuals.	

Usage

After	installing	the	add-on	in	Gramps,	the	tool	can	be	found	in	the	Tools	->	Isotammi	Tools	group

The	name	editing	tool	lists	the	people	in	the	family	by	line,	alphabetically	by	surname	and	first	name,	after	a	short	time.	At	the	top	left	of	the	list
window	is	a	line	of	text	for	filtering.	Its	value	targeting	can	be	refined	by	name	parts	and	gender	as	well	as	name	type.	Regular	expressions	(regex)
can	also	be	used.	At	the	top	right	of	the	list	window	are	the	editing	preferences,	which	are	described	in	more	detail	below.

In	the	list,	the	person	lines	are	alphabetically	by	last	name	and	first	name.	The	information	in	the	line	is	the	person's	ID	in	Gramps	(Id),	gender	(M
=	male,	F	=	female,?	=	Unknown),	surname	Prefix,	actual	Surname,	First	names,	Suffix	(contains	patro	/	matrimonial	information	according	to
Isotammi's	practice),	Title	(person's	Title)	and	Type	(birth,	marriage,	known,	etc.).

The	following	figure,	which	filters	people	with	the	letter	"r"	in	the	list,	provides	examples	of	the	need	to	edit.	The	situation	is	very	typical	when	the
family	tree	is	combined	with	material	from	several	sources,	in	which	case	there	is	no	uniform	practice.

the	matronymic	should	be	moved	to	the	Suffix

suffixes	(patronyms	and	matronyms	are	mixed	in	Finnish	and	Swedish

patronym	is	abbreviated	(Joh.sson)

the	surname	deviates	from	the	recommendation	of	how	to	mark	the	unknown	part	of	the	name

first	name	and	patronymic	are	the	same

Use

If	the	filter	text	targets	a	name	part,	uncheck	the	"All"	box	and	check	the	desired	part	(s).	If	gender	does	not	matter,	leave	the	"All"	option	on	it,
otherwise	the	sexual.	The	Regex	box	is	checked	when	the	corresponding	rule	is	in	the	"Filter"	text.	Filtering	is	started	with	the	"Search"	button	and
the	list	then	contains	only	the	person	lines	that	match	the	criteria.	The	"List	All"	button	returns	to	the	unfiltered	list.

Practically	worth	it

look	at	rows	filtered,	e.g.,	by	women’s	first	names,	because	then	changes	to	the	rows	may	not	be	appropriate	for	men	(e.g.,	“Christ:”	can	be
safely	interpreted	as	a	woman’s	name,	“Christina,”	but	for	men,	it	would	be	“Christer”	or	Christian).

first	take	care	of	the	abbreviations	of	the	name	parts.	For	their	initial	filtering,	write	"Filter"	in	the	text	"Filter",	for	example	";",	".",	";",
".sson"	or	other	string	used	by	scribes	to	abbreviate	parts	of	names	in	the	congregation.

targets	conversions	to	people	selected	from	the	list	bar.	The	selection	can	be	made	on	all	rows	at	once	or	by	picking	individual	rows.	The
latter	method	can	be	tedious	if	the	original	filter	selected	a	large	number	of	rows.	This	will	refine	the	filtering	text	(e.g.	":"	i.e.	select	all
people's	abbreviated	first	names	and	patronymics,	but	"men,	first	name,"	Henr:	"would	only	list	lines	where	the	first	name"	Henr:	"can	be
safely	decompressed	to"	Henric	".

Name	type

Gramps	has	a	number	of	standardized	name	types	(Birth	Name,	Avion	Name,	Known	Name,	Unknown),	in	addition	to	which	the	genealogist	can
define	his	own	types	(common	ones	include	Military	Name,	Taken	Name,	Noble	Name,	Artist	Name).	A	person	can	have	several	names,	one	of
which	is	selected	as	the	primary	and	appears	in	the	person	list,	and	the	others	are	set	as	alternate	names.	However,	each	must	have	a	first	name	and	a
patronymic	and	/	or	surname.	See	See	also	Quality	Guidelines	for	Genealogists	on	naming	conventions.

The	tool	loads	all	name	types	in	the	genealogy	from	the	selection	list	and	rows	can	be	filtered	and	edited	by	name	type.	In	the	person	line	of	the	list,
the	primary	name	type	is	in	bold.

Editing	rules

At	the	top	right	of	the	list	window	are	fields	and	buttons	for	editing.	In	basic	operation,	first	select	the	line	of	the	name	part	to	be	edited,	write	the
current	value	("Old	value")	and	the	desired	value	("New	value").	For	example,	in	men	"Joh."	in	the	first	name	filtered,	the	current	value	is	written
Joh.	and	the	new	value	Johan.

The	edit	only	affects	the	rows	that	are	selected	in	the	list.	Filtering	alone	does	not	select	rows!

All	rows	are	selected	at	once	with	the	key	combination	CTRL	+	A.

The	replacement	affects	part	of	the	text.	For	example,	if	the	first	name	is	"Lars	Sim:"	and	"Sim:"	is	to	be	converted	to	"Simon",	write	the	old	value
Sim:	and	the	new	value	Simon.	The	first	name	after	this	is	"Lars	Simon".

The	Regex	rule	is	available	by	ticking.

Editing	can	be	activated	with	"Special	Functions",	the	ticking	of	which	opens	up	possibilities	for	moving	parts	of	names	between	them.	(examples	of
use!)

The	editing	is	performed	with	the	"Replace"	button.	The	"Undo	previous	change"	button	cancels	the	last	corrections.	An	incorrect	conversion	can
also	be	undone	by	holding	the	selected	rows	and	performing	a	counter	conversion,	e.g.	Old	=	"Henricz">	New	=	"Henric".

Due	to	the	possibility	of	cancellation,	it	is	worth	learning	how	to	use	the	tool	by	boldly	trying	different	variants,	eg	for	one	or	a	few	names	at	a	time.
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Please	note

Clicking	on	the	list	bar	opens	the	respective	personal	editor.	Point-specific	changes	can	be	made	to	it,	i.e.	only	the	modification	necessary	for	the
person	concerned,	such	as	transfers	between	the	primary	and	alternative	names,	the	correction	of	a	very	rare	surname	clerical	error,	or	the	transfer	of
a	surname	that	has	crept	into	the	patronymic	to	the	surname.

Gender	is	an	integral	part	of	editing.	The	name	editing	tool	cannot	be	used	to	edit	genders,	but	the	"NameMerge"	and	"SetGender"	tools	are
available.	When	used	in	advance	or	interrupted	by	the	Name	Editor,	interrupting	the	gender	encoding	improves	the	impact	of	the	Name	Editor.	

Name	Merge	Tool

Fig.	Isotammi.19	Name	Merge	tool

The	 Name	Merge 	Tool	standardizes	family	names	by	combining	the	same	but	slightly	differently	spelled	first	or	last	name	names	so	that	the
names	of	the	people	are	in	the	genealogy	for	the	Genealogist's	own	use	or	for	the	recipients	of	the	genealogy,	either	as	printouts	or	gedcom	transfer
files.	The	merger	significantly	reduces	the	name	editing	work	with	the	Name	Update	Tool.	The	Gramps	MultiMerge	and	Family	Auto	Merge	Tool
also	work	more	efficiently	the	more	consistent	the	nomenclature.

Some	common	first	names	have	been	written	by	parish	scribes	in	dozens	of	different	forms,	based	on	Swedish	and	German	naming	practices	(e.g.
the	name	family	Heikki	<Henric,	Henrik,	Heinrich,	Hinnrich,	Hindrick,	Hen:,	...).	The	same	variegation	exists	in	other	parts	of	the	names	(e.g.,
v/w/fv	and	f/ph	spellings	have	been	used).	There	is	a	similarity	in	surnames,	especially	in	the	registration	of	long	foreign	surnames.

Usage

After	starting	Gramps,	the	tool	can	be	found	in	the	Isotammi	Tools	group	-	NameMerge	opens	after	a	short	time	after	thinking	about	the	list	of
names	of	all	people's	first	names,	with	their	personal	numbers	-	at	the	top	of	the	list	window	there	are	gender	selections,

The	list	shows	the	relevant	part	of	the	name	and	gender	in	alphabetical	order.	If	the	same	part	of	the	name	has	known	and	unknown	genders,	the
same	form	of	name	is	in	the	list	of	two,	followed	by	the	number	of	persons	in	the	cases	in	question.

At	the	top	is	the	"Set	gender"	checkbox,	which	automatically	updates	the	gender	in	the	merger	for	each	person	involved	in	the	merger,	if	there	is	a
single	case	of	gender	that	is	known	to	be	merged.

Use

To	merge	names	from	a	list,	follow	these	steps:

To	be	merged,	left-click	and	CTRL	+	left-click	the	last	name	in	successive	names.	Discontinuous	names	can	be	selected	and	canceled	with	the	left
mouse	click	of	SHIFT	+	-	you	can	remove	the	name	from	the	selected	ones	with	the	left	mouse	click	of	SHIFT	+	(a	good	way	if	there	are	non-
merged	names	among	the	ones	selected	in	succession)

The	merge	is	performed	with	the	MERGE	button	at	the	top.	The	merge	is	canceled	by	selecting	Gramps	Edit>	Cancel.	In	the	picture,	three	"Adolf"
name	spellings	are	selected	and	the	Merge	button	is	pressed.	The	tool	suggests	the	form	with	the	most	people	as	the	primary	one.

The	Merge	button	opens	a	new	window	Select	primary	name	".	Where	the	desired	name	format	is	selected	as	the	primary	(eg"	Adolf	"e	instead	of
Adolph"	in	the	figure).	When	you	double-click	the	merged	person	after	merging,	the	"Show	person"	window	opens,	listing	all	the	people	involved
in	the	merger.	When	you	select	a	person	from	the	list,	their	Personal	Edit	window	can	be	opened	with	the	Open	button.

In	the	main	Gramps	window,	the	cursor	moves	in	the	People	list.	to	the	selected	person,	in	which	case	you	can	open	the	person's	Relationships
window	(if	necessary,	remove	the	filter	from	the	list	and	the	transfer	will	take	place).	This	is	useful	if,	for	example,	the	person's	first	name	contains
information	about	his	or	her	parents.	In	this	case,	it	is	not	possible	to	form	family	relationships	automatically	when	forming	huskies.	Parents	can	be
corrected	in	the	Relationships	window.	Note	that	the	most	direct	way	to	add	parents	is	to	select	"add	a	child	to	an	existing	family"	using	the	father's
or	mother's	last	name	as	the	search	key.

After	merging,	only	the	selected	primary	name	format,	the	number	of	people	and	the	set	gender	remain	in	the	tool	list.

Tip

There	are	cases	at	the	end	of	surnames	that	require	other	means	than	merging	surnames.	The	following	image	shows	a	few	examples	of	these:

The	last	name	starts	with	a	lowercase	letter	(e.g.	"barck").	If	the	number	is	small,	the	fastest	way	is	to	select	the	last	name	from	the	list,	open
the	person	for	editing	with	a	right-click	and	correct	the	last	name	directly	in	the	person's	name.

The	part	of	the	prefix	left	in	the	surname	(eg	"d."	In	the	name	"d.	Pahlen")	is	corrected	as	above.

The	surname	contains	information	about	its	type	(e.g.	"eine	geborene",	"f.",	"Född").	The	first,	rare	situation	is	corrected	as	above.	There	are
usually	dozens	of	the	latter	cases.	The	correction	is	made	with	the	"Name	Editor"	tool	at	once,	replacing	the	text	"F."	Or	"Född"	with	the	last
names.	Note	that	the	text	to	be	replaced	includes	a	space	and	that	the	text	is	replaced	by	leaving	the	new	value	blank.

Family	Auto	Merge	Tool
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The	tool	is	intended	for	cleaning	the	parish's	Hiskipuut	stock.	The	tool	merges	the	children	of	the	parents	into	one	family	and	adds	a	Marriage	event
to	the	family.	Only	parents	whose	names	are	in	exactly	the	same	form	in	the	marriage	and	baptismal	events	of	Hezekiah	are	directly	interpreted	as
the	same	family.	The	tool	records	how	many	connected	families	it	formed.	The	efficiency	of	the	tool	can	be	improved	by	using	the	Name	Merge
Tool	and	Name	Editing	tools	mentioned	above.

The	next	step	is	the	researcher's	own	judgment.	Family	reunion	continues	in	Gramps	Families	view.	It	is	first	sorted	by	the	name	of	the	husband,
after	which	it	is	easy	to	identify	the	families	left	behind	by	the	tool	due	to	small	differences	in	the	name	of	the	wife	joining.	Merging	families	in	a
view	is	done	two	at	a	time	with	Gramps'	"Merge"	tool	or	"Multimerge"	tool	for	merging	multiple	families	at	once.

Once	the	men	have	been	dealt	with,	the	Families	list	is	further	sorted	by	wife's	name,	allowing	families	with	small	differences	in	husband's	names	to
be	combined	accordingly.

In	the	Gramps	interface,	you	should	add	the	"Kids"	tab	to	the	Bottom	bar	and	the	"Events"	tab	to	the	Sidebar.	They	can	be	used	to	check	that	there
are	no	visible	flaws	in	the	reunited	family,	e.g.,	the	children	have	too	long	a	time	interval	or	the	marriage	event	does	not	fit	the	children’s	time.
These	are	signs	that	unrelated	families	or	children	have	been	merged	into	the	same	family.

SuperTool

Fig.	Isotammi.20	SuperTool

From	SuperTool/README.md	on	GitHub

This	is	a	general	purpose	scripting	tool	that	can	be	used	to	do	"ad-hoc"	queries	against	a	Gramps	family	tree/database.	The	queries	are	expressed	in
the	Python	programming	language	so	the	tool	is	most	useful	for	programmers.	But	the	intent	is	also	that	the	tool	is	easy	enough	to	allow	regular
Gramps	users	to	make	use	of	it.

The	queries	can	be	saved	as	script	files	that	any	user	may	then	load	into	the	tool	—	without	necessarily	understanding	the	details.	The	queries	can
also	be	saved	as	Generic	rule-based	Custom	Filters	that	may	be	used	throughout	Gramps.

Table	of	contents

From	the	SuperTool	user	docs	on	GitHub

Introduction
User	interface
Basic	examples
Pre-defined	variables
Example
Accessing	Gramps	objects
General	variables
Help	feature
Options
Row	limit	-	1,000	Gtk	toolbox	Row	limit	mitigated	in	May	2024	—	⚡new	for	version	1.4.2	of	SuperTool
Editing	objects
Download/copy	as	CSV
Title	field
Initialization	statements
Statements	executed	for	every	object
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Supported	object	types
Parameterized	queries
Modifying	the	database
Deleting	objects
Saving	the	query	as	a	script	file
Saving	the	query	as	a	custom	filter
Using	predefined	custom	filters
Running	from	the	command	line
Proxy	objects
Date	arithmetic
Include	files
The	'result'	object
Settings
examples

Reference
Properties	supported	by	the	various	object	category	types.
global	variables	and	functions
Command	line	options
Sample	files

Direct	Access	to	Gramps	Functions

Initially,	the	higher	order	functions	of	certain	Python	Standard	Library	modules	(os,	sys,	re,	functools,	collections)	are	available	in	SuperTool	by
default.	And	the	Gramps	Primary	Object	matching	the	currently	active	view	(Person,	Family	etc)	are	implicitly	defined	when	the	tool	is	started.
Secondary	objects	(like	EventType,	PlaceName)	are	not	defined	and	the	script	has	to	explicitly	import	them	(in	the	"Initialization	Statements"
section)	if	they	are	needed.

This	tool	works	in	the	Gramps	versions	5.x	and	later.	It	will	be	installed	in	the	"Isotammi	tools"	submenu	under	the	Tools	menu.

The	tool	allows	arbitrary	Python	code	so	it	can	also	be	used	to	modify	the	database.

For	instructions	on	how	to	use	this	tool	please	visit	the	SuperTool	-	Instructions	on	Github.

Generic	Rules	for	Supertool

Fig.	Isotammi.21	Isotammi	Generic	Rule

SuperTool	simplifies	designing	a	new	database	query	and	provides	an	option	to	immediately	apply	that	query	design	to	the	Tree.	However,	to	use
that	query	design	as	a	limit	elsewhere	(in	a	View,	with	a	Tool,	on	a	Report,	or	when	Exporting	a	portion	of	your	Tree)	in	Gramps,	the	query
'initialization'	and	'statements'	specifications	must	be	inserted	into	a	Generic	Rule.	And	then	that	Titled	(named)	Rule	can	be	used	in	Custom	Filters.

Generic	person	filter
Generic	family	filter
Generic	event	filter
Generic	place	filter
Generic	source	filter
Generic	citation	filter
Generic	repository	filter
Generic	media	filter
Generic	note	filter

SuperTool	Scripts

If	you	create	library	folder	with	a	series	of	Scripts,	it	is	helpful	to	add	a	Bookmark	for	that	folder	to	the	GTK	File	Chooser.	This	simplifies
navigating	to	your	script	library	folder.

Discourse	support	forum	threads	(supertool-script	and	isotammi	category	searches)

Scripting	Tutorial:	mark	surname	origin	as	Patrilineal	if	matches	father	surname
Scripting	Tutorial:	mark	surname	origin	as	Taken	if	matches	spouse	surname
Scripting	Tutorial	adaptation:	Family	Nickname	propagation	to	descendants
Scripting	Tutorial	adaptation:	monogram	placeholders	for	sorting	(French)
Simple	Access	Tutorial:	Adapting	the	example	developer	snippets	in	the	Gramps	Simple	Class	to	SuperTool	(link	a	standard	Gramps	module)
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migrate	date	entered	in	wrong	field
Generating	a	Couverture	name	(the	"née"	form)	as	a	Primary	name
Creating	Media	filter	rules	with	SuperTool
Creating	Citations	filter	rules	with	SuperTool
Duplicating	Citations
Invalid	Date	re-Formatter	with	Localization	variants
make	selected	object	Private
Find	specific	Attributes	and	tag	as	Private
Set	selected	people	as	Private
gather	a	list	of	registered	Gramps	Plugins
Parse	URL	and	ID	numbers	from	Ancestry	CSV

The	SuperTool	scripts	of	Patrice	Legoux	(source	and	note	in	French.	Coming	soon!)	Recommended	reference	documents	for	SuperTool

On	Discourse:	Tweaking	the	Sort	Order	for	Names	override
On	Discourse:	Global	reset	the	Sort	Order	for	Names	override
On	Discourse:	generate	a	CSV	list	of	People,	dates	and	Places
On	Discourse:	Calculate	an	object's	creation	date	from	its	handle
On	Discourse:	find	Citations	for	tagged	persons
On	Discourse:	Set	citation	URL	attribute	(requires	correction)
On	Discourse:	The	boolean	at	the	end	of	dates	returned	with	obj.date.dateval
On	Discourse:	Merge	multiple	objects
On	Discourse:	create	a	Repository	research	plan
On	Discourse:	set	.jpg	media	paths
PLegoux	filter	library
Filtre	Supertool	automatisant	la	recherche	d’individus	ou	de	familles	dont	un	événement	n’a	pas	de	source	probante	[filter	for	unsourced
Events]
Import	Gedcom	to	find	points-in-common
Supertool	et	attributs	d'évèments	partagés	(updating	shared	event	attributes)

See	also:

Generic	DB	Access	lib	(AKA	libaccess)	addon	-	an	experimental	library	that	provides	generic	access	to	the	database	and	the	gen.lib
interface(AKA	The	core	library	of	Gramps	objects	).

FilterParams	tool

Fig.	Isotammi.22	Isotammi	FilterParams	dialog

The	FilterParams	dialog	flattens	the	number	of	steps	needed	to	adjust	parameters	in	a	custom	filter.

Currently	in	beta.

Example	illustrates	the	following	3	stage	custom	filter:

<?xml	version="1.0"	encoding="utf-8"?>
<filters>
		<object	type="Person">
				<filter	name="Some	Event	in	place	x"	function="and"	comment="People	filter	:	who	has	the	events">
						<rule	class="MatchesEventFilter"	use_regex="False">
								<arg	value="Event	in	place	x"/>
						</rule>
				</filter>
		</object>
		<object	type="Event">
				<filter	name="Event	in	place	x"	function="and"	comment="Event	filter	:	occurred	in	a	place">
						<rule	class="MatchesPlaceFilter"	use_regex="False">
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								<arg	value="In	place	X"/>
						</rule>
				</filter>
		</object>
		<object	type="Place">
				<filter	name="In	place	X"	function="and"	comment="Place	filter	:	enclosed	by	a	place">
						<rule	class="IsEnclosedBy"	use_regex="False">
								<arg	value="P0003"/>
								<arg	value="1"/>
						</rule>
				</filter>
		</object>
</filters>

ZipInstall

Fig.	Isotammi.23	Isotammi	ZIPInstall

Tool	to	install	an	addon	from	a	ZIP	or	a	.tgz	compressed	download	file.

This	is	very	efficient	when	downloading	GitHub	code	ZIP	files.	The	ZIPInstall	GtkFileChooser	dialog	has	a	button	to	change	to	the	"Downloads"
folder.	Sort	on	date	and	your	recent	download	is	on	the	first	line.	The	install	option	automatically	checks	the	Gramps	Registry	and	puts	the	updated
code	in	the	correct	plugin	subfolder.

The	ZIPinstall	will	confirm	that	you	want	to	overwrite	and	offer	the	option	to	backup	the	existing	addon.

Isotammi	ZipInstall	GitHub	folder.

Import	CSV	sources

The	"Import	CSV	sources"	Tool	is	a	specialized	tool	that	can	load	Gramps	sources	from	a	csv	(comma	separated	values)	file.	For	each	line	of	the
file,	the	tool	generates	an	Archive	(optional,	source,	Additional	source-related	Information	(optional)	and	Property	(optional)	for	Gramps.

The	tool	is	installed	in	the	Gramps	Tools>	Isotammi	tools	folder.

The	tool	is	fed	with	a	.csv	file	that	reads	the	information	under	the	following	column	headings:	-	title	(pakollinen)	-	author	-	abbrev	-	pubinfo	-
repository	-	....

Heading	titles	should	be	written	exactly	like	that,	in	lower	case.	The	order	of	the	columns	does	not	matter	and	not	every	one	needs	to	be	included.
Other	columns	are	ignored.

Each	line	creates	a	new	source	and	is	given	a	sequential	ID	numbering:	S0001,	S0002,	etc.	Therefore,	any	gramps-id	information	in	the	file	is	not
used.	If	there	are	already	sources	and	archives	in	the	database,	duplicate	ID	values	​​may	become	available	(but	they	can	be	renumbered	later	with
Tools	->	Family	Tree	Processing	->	"Rearrange	Gramps	IDs"	to	Select	Source	and	Archive	Items)

The	contents	of	the	columns	title,	author,	abbrev,	and	pubinfo	are	stored	as	is	in	the	source.

The	Repository	column	has	special	handling:

-	The	repository	can	be	empty,	so	the	source	is	not	attached	to	any	archive.

-	If	the	column	contains	an	id	in	square	brackets	(format	[Rxxxx]),	then	the	source	is	appended	to	the	corresponding	archive	if	it	is	already	in	the
database.	If.	archive	does	not	exist,	a	new	archive	named	"[Rxxxx]"	is	created	and	the	source	is	attached	to	it.

-	If	there	is	another	value	in	the	column,	it	is	interpreted	as	an	archive	name,	creating	a	new	archive	with	that	name	and	appending	the	source	to	it.
However,	if	the	same	name	is	used	multiple	times,	the	tool	only	creates	one	archive.	If	the	name	is	already	in	a	position	in	an	existing	archive,	the
tool	cannot	associate	the	new	name	with	it	(this	can	be	corrected	later	by	merging	the	archives	in	question).	

Convert	NARC	URLs

Convert	the	obsolete	URLs	of	the	Finnish	National	Archive's	digital	resources	found	in	the	Gramps	database	into	Astia	addresses.
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This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

Example:	Typically	converts	
http://digi.narc.fi/digi/view.ka?kuid=nnnnnnnn
		to	
https://astia.narc.fi/uusiastia/viewer/?fileId=xxxxxxxxx&aisenoId=yyyyyyyyyyy

Uses	the	conversion	service	of	the	National	Archives,	which	unfortunately	does	not	work	for	all	addresses.

Affects	the	addresses	in	Notes	and	on	the	people's	Internet	tab.

Make	a	backup	first.	Start	from	the	Tools	->	Isotammi	submenu.	The	conversion	starts	immediately,	it	can	be	interrupted	with	the	 Cancel
button.	The	changes	made	can	be	canceled	with	the	Edit	->	Undo	function	or	the	Family	Trees	->	Abandon	Changes	and	Quit.

Rules

Events	with	an	invalid/valid	date

Fig.	Isotammi.24	Events	with	Invalid	Date	Rule

Events	with	an	invalid	date/Events	with	a	valid	date 	are	rules	that	can	be	used	to	search	for	events	with	incorrect	dates.	These	are	not	exactly
opposites	of	each	other,	as	the	event	may	also	lack	date	information,	in	which	case	it	does	not	match	either	rule.	

Generic	<Object>	filter

Fig.	Isotammi.25	Isotammi	Generic	Rule

Generic	Rules	allow	a	Query	to	be	directly	saved	as	a	reusable	custom	Rule.	These	Generic	Rules	were	created	as	an	accessory	to	the	SuperTool
query	builder,	editor,	and	executing	shell.	Queries	in	the	SuperTool	have	a	compatible	syntax	and	segmentation	with	fields	of	the	Generic	Rule.

If	you	prefer	to	design	queries	manually,	a	simple	free-form	text	editor	and	query	execution	shell	in	the	Query	Gramplet	add-on.	However,	for	use	in
a	Generic	Rule	the	query	must	be	composed	in	the	exact	syntax	expected.	There	is	no	validation	nor	safety	nets	in	the	Generic	Filter	Rules.	For	this
reason,	it	is	recommended	that	syntax	be	tested	in	SuperTool.	Then	the	Custom	Filter	be	'Test	run'	with	the	FilterParams	add-on	tool...	which	is	the
only	custom	filter	tool	with	a	capability	to	abort	a	query	in	progress.

Generic	person	filter
Generic	family	filter
Generic	event	filter
Generic	place	filter
Generic	source	filter
Generic	citation	filter
Generic	repository	filter
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This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

Generic	media	filter
Generic	note	filter

Exporter

Isotammi	XML	export

Fig.	Isotammi.26	Isotammi	XML	export	-	Export	options	dialog.
(Options	Highlighted)

Exporter	for	 Isotammi	XML	export 	expands	the	options	available	compared	to	the	builtin	Gramps	XML	(family	tree)	export(er).

Choose	Menu	Family	Trees	->Export...	then	select	 Next 	and	select	 Isotammi	XML	export 	then	select	 Next 	and	choose	the	file	format
specific	export	options	you	want	to	use	and	then	select	 Next 	to	choose	your	filename	and	location	and	output	the	file.

File	format	specific	export	options

Listed	underneath	the	"Filters	and	privacy"	section	you	have	the	following	file	format	specific	export	options:

Use	Compression
Include	media
Description:	adds	a	user	description	to	the	output	file.
Material	type	-	describes	the	internal	annotation	in	the	header	of	the	export	file.	Used	by	the	Isotammi	project's	automated	processing	tools	to
correctly	route	the	data	into	their	master	database.

Family	tree
Place	Data
Hiski	Tree	-	HisKi	project	includes	lists	of	christenings,	marriages,	burials	and	moves	for	most	Finland	parishes	-	HisKi	is	a
portmanteau	of	the	finnish	term	"historiakirjat"	(in	english,	"historical	parish	books").	HisKi	Trees	are	isolated	branches	related	to	a
single	citation	processed	by	members	of	the	Genealogical	Society	of	Finland.	(In	their	project,	if	a	parish	book	has	separate	citation
worthy	entries	for	a	christening,	marriage	and	funeral;	then	there	might	be	3	duplicate	Persons	and	duplicates	for	each	unique
associated	person	in	the	citation.	Merging	is	processed	as	a	separate	operation	from	data	entry.)

Using	any	of	these	options	adds	the	following	unsupported	section	entries	to	Gramps	XML	output:

				<isotammi>
						<researcher-info>
						</researcher-info>
						<material_type>Family	Tree</material_type>
						<user_description>
This	is	my	family	tree	test	with	Isotammi	addons
						</user_description>
				</isotammi>

See	also
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Isotammi,	the	national	database	of	the	Finnish	Genealogical	Society.
stk-addons	-	Additional	modules	and	programs	for	the	genealogy	application	Gramps.
Search	Matt's	Gramps	Addon	List	for	Isotammi	contributions.
Inspect	the	current	updates	/listings/addons-en.txt	file	in	the	Isotammi	Where	to	check:	https://raw.githubusercontent.com/Taapeli/isotammi-
addons/master/addons/gramps51	URL	in	the	Third	party	addons	management	Preferences.	(See	the	main	addons	list	for	the	default	list.)
Feature	Request	12546:	Expand	Gramps	XML	to	support	"Description"	tag	from	Isotammi	XML	export(er)

Webpage	originally	duplicated	from	Isotammi	and	translated	to	English	and	expanded.

Collected	11	May	2021
http://wiki.isotammi.net/wiki/Gramps-laajennukset
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5.2	Addons

LastChange

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

This	addon	has	both	a	gramplet	and	a	report.	Both	list	the	last	ten	person	records	that	have	been	changed	in	the	open	tree,	starting	with	the	most
recent	change	and	the	report	allow	you	list	all	eight	categories	of	objects.

Usage

Latest	Changes	Gramplet

Latest	Changes	Gramplet	-	showing	context	menu

The	 Latest	Changes	Gramplet 	is	a	quick	way	to	list	the	last	ten	person	records	that	have	been	changed	in	the	open	tree,	starting	with	the
most	recent	change.	The	names	are	linked	back	to	the	records	they	come	from,	giving	you	an	easy	way	to	get	back	to	where	you	were	working	last.
You	can	also	copy	the	content	of	gramplet	using	the	context	menu.

Note	the	"Add	a	gramplet"	context	menu	shows	this	as	"Last	Change"!	

Last	Change	Report
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Last	Change	Report	Sample

The	 Last	Change	Report 	expands	the	types	of	records	you	can	list	all	eight	categories	of	objects	(People,	Families,	Places,	Events,	Media,
Sources,	Notes,	Citations)

You	can	create	the	report	via	the	menu	Reports	>	Text	Reports	>	Last	Change...

By	default	only	People	objects	are	shown	on	the	report.

Command	Line(CLI)	Usage

For	Command	Line(CLI)	use,	the	following	is	an	example	command	that	runs	the	report	on	'Family	Tree	1'	to	file	'c:\output.txt'	of	type	'txt'	with	all
types	except	media	included	in	the	report.	Note	that	this	is	all	on	a	single	line,	no	line	breaks.

gramps	-O	'Family	Tree	1'	-a	report	-p	name=LastChangeReport,of=c:\output.txt,off=txt,what_types='True,True,True,True,False,True,True,True'

The	section	what_types=	represent	the	list	of	8	True/False	choices	is	for	the	eight	categories	(People,	Families,	Places,	Events,	Media,	Sources,
Notes,	Citations)	that	can	be	included	in	the	report,	at	least	one	of	which	must	be	included.

Issues
The	gramplet	is	found	under	the	"Add	a	gramplet"	context	menu	as	"Last	Change"	instead	of	"Latest	Changes"!
Last	Change	Report's	help	goes	to	[1]	instead	of	here.
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5.2	Addons

Life	Line	Chart	View

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

To	enable	SVG	file	export	use	the	minimum	requirement	of	Python	3.6	for	svgwrite
prerequisite

Life	Line	Chart	View	-	addon	-	Visualizing	an	ancestors	tree	(Gramps
5.1.x	version)

Life	Line	Chart	View	-	addon	-	Visualizing	a	descendant	tree	with
photos	(Gramps	5.1.x	version)

Life	Line	Chart	View	-	addon	-	Visualizing	a	larger	ancestor	tree
(Gramps	5.1.x	version)
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Life	Line	Chart	View	-	addon	-	Visualizing	a	ancestor	tree	with
photos	(Gramps	5.1.x	version)

Life	Line	Chart	View	-	addon	-	Visualizing	a	descendant	tree	in	cactus
shape	(Gramps	5.1.x	version)

Life	Line	Chart	View	is	an	interactive	 	 Charts 	category	view	addon	which	shows	individuals	as	lines	in	an	ancestor	or	descendant	chart.	The
length	and	position	of	the	line	depends	on	the	actual	life	span	and	the	marriages.	The	pedigree/ancestor	collapse	is	handled.	Labels	for	birth	/	names,
death,	and	marriages	can	be	added.

The	active	person	on	the	person	tab	is	starting	point	in	both	charts.	Birth/christening/baptism,	death/burial,	and	marriage	dates	need	to	be	available
to	properly	draw	this	chart.	If	they	are	incomplete	reasonable	guess	values	are	chosen	if	possible.	If	not,	then	these	individuals	are	not	shown

Usage

Two	new	chart	icons	will	appear	in	the	 	 Charts 	category	view	tool	bar	if	the	addon	was	loaded	successfully	and	the	prerequisites	have	been

installed:	

Life	Line	Ancestor	Chart	View	(left	icon)
Life	Line	Descendant	Chart	View	(right	icon)

The	charts	can	be	configured	using	the	Configure	the	active	view	dialog.

You	may	zoom	(if	the	chart	is	focused)	with
Ctrl + + 	and	 Ctrl + -
Ctrl + mouse	wheel
the	GUI	control	buttons	(+,	-,	fit	to	view,	reset	to	1)

Scrolling	is	possible	(if	the	chart	is	focused)	with
mouse	wheel ,	⇧	Shift + mouse	wheel
Ctrl + left	mouse	button 	(grabbing)

Context	menu	enables
Opening	the	edit	dialog
Change	active	person
Show	/	hide	persons	and	their	ancestors	/	descendants
Showing	siblings	in	the	ancestor	chart
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You	may	lock	 Ctrl 	with	the	GUI	control	button	"M"
You	may	also	use	the	filter	to	fade	out	individuals
A	tooltip	shows	the	name,	gramps	id,	birth	and	death	date	of	the	person.

Configure	Options

Life	Line	Chart	View	-	addon	-	Configure	dialog	(Gramps	5.1.x
version)

The	Configure	the	active	view	dialog	shows	two	tabs	of	option	that	you	can	configure	independently	for	the	charts.

General	Layout

number	of	generations.
relative	line	width.
vertical	and	horizontal	chart	size.
warping	of	the	whole	chart	(normal	grid,	sine,	triangle).
show	or	hide	pedigree	collapse.
unique	line	color	or	coloring	based	on	surname.
line	fading	represents	the	uncertainty	of	dates	or	the	age.
show	or	hide	lables	for	birth,	death,	marriages.
line	weighting	(only	descendant	diagram).
general	chart	layout	"parents	enclose	children"	or	"cactus"	(only	descendant	diagram).
optimizations	(only	ancestor	diagram):

flip	family	to	reduce	the	cross	chart	connection	lengths.
horizontal	chart	compression.

softness	of	the	family	shape.
vertical	flipping	of	the	whole	chart.
show	photos	of	the	person	on	the	line.
size	of	the	photos.

Label	Configuration

birth	and	death	label.
position.
rotation.
alignment.
word	wrapping.
font	name	and	size.

marriage	label	font	size	and	name.

Features

Photos	of	the	persons	can	be	displayed	along	the	line.	Their	position	is	either	based	on	the	date	that	is	set	in	the	media	object,	or	displayed	in
the	order	of	appearance	in	the	family	tree.
Overview	map	on	the	bottom	left.
The	diagram	can	be	exported	as	an	SVG	file	using	the	 Save	the	Life	Line	Chart	View 	button	(not	available	using	Python	3.5).
Layout	optimization	algorithms.
Dark	theme.
Handling	of	pedigree	collapse.

Prerequisites
If	the	requirements	for	this	addon	have	not	already	been	installed	you	will	be	prompted	to	download	them	semi-automatically	by	selecting
the	 Download	module 	button	for	each.

The	addon	is	based	on	the	Python	module	life_line_chart,	this	Python	module	is	required.
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To	enable	SVG	file	export,	the	module	(svgwrite)	is	required	(which	has	a	minimum	requirement	of	Python	3.6).

Issues
"smooth	scrolling"	is	supported	since	GTK	3.24	(GTK	documentation),	the	Windows	AIO	currently	uses	an	older	version.
Touch	screens	are	not	properly	supported	on	Windows.	This	is	an	unresolved	GTK	issue	(GTK	issue)

For	current	issues	see	the	related	tag	LifeLineChartView	on	the	bugtracker.
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5.2	Addons

Lines	of	Descendency	Report

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

All	sample	reports

that	are	shown	are	created	using	Gramps	Data.gramps	file

People	tab	options

Lines	of	Descendency	Report	-	example

The	 Lines	of	Descendency 	report	prints	out	all	lines	of	descendency	between	a	given	ancestor	and	a	given	descendent	one	after	the	other	in
the	format	shown	below	(using	the	Gramps	example	data).	People	on	the	left	build	the	continuous	ancestral	line	and	those	on	the	right	are	their
corresponding	spouses.

Usage
You	can	access	the	report	from	the	following	menu	Report	>	Text	Reports	>	Lines	of	Descendency	Report...

From	the	reports	 People 	tab	select	the	 Ancestor 	and	 Descendent 	using	the	 Select	a	different	person 	buttons.
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Example	output
																				'''Lines	of	Descendency	from	Smith,	Ingeman	to	Smith,	Craig	Peter'''

	'''1.	line:'''

	1.	Smith,	Ingeman	m.	Ericsdotter,	Marta
	2.	Smith,	Martin	m.	Jefferson,	Elna
	3.	Smith,	Martin	m.	Hansdotter,	Kerstina
	4.	Smith,	Gustaf	Sr.	m.	Hansdotter,	Anna
	5.	Smith,	Hans	Peter	m.	Jones,	Lillie	Harriet
	6.	Smith,	Lloyd	m.	Green,	Janis	Elaine
	7.	Smith,	Craig	Peter

	'''2.	line:'''

	(...)

Notice	that	even	though	the	example	data	of	Gramps	does	not	offer	a	possibility	to	display	this,	the	report	makes	no	distinction	between	the	male
and	female	line.	So	a	hypothetical	output	such	as	the	one	below	is	also	proper:

																				'''Lines	of	Descendency	from	Smith,	Ingeman	to	Nielsen,	Augusta'''

	'''1.	line:'''

	1.	Smith,	Ingeman	m.	Ericsdotter,	Marta
	2.	Smith,	Martin	m.	Jefferson,	Elna
	3.	Smith,	Martin	m.	Hansdotter,	Kerstina
	4.	Smith,	Margareth	m.	Green,	Hans	Gustaf
	5.	Green,	Peter	Lloyd	m.	Jones,	Elisabeth
	6.	Green,	Anna	Maria	m.	Nielsen,	Edwin
	7.	Nielsen,	Augusta

	'''2.	line:'''

	(...)

Development	ideas
Add	option	for	including	events,	birth,	death	and	marriage.
Add	option	to	include	sources.

Outdated	original	code	File:Lines-of-descendency.tar.gz	from	2009-10-23

Issues
Help	button	goes	to	https://gramps-project.org/wiki/index.php?title=Gramps_5.1_Wiki_Manual_-_Reports#Lines_of_Descendency_Report
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5.2	Addons

MapService-GoogleEarth

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

The	addon	does	not	recognize	if	Google	Earth	Pro	is	installed	and	cannot	be	used

see	11864

"GoogleEarth"	-	entry	showing	on	map	services	selection	dropdown
list

This	addon	adds	an	additional	 Map	Service ,	that	allows	you	to	use	Google	Earth	to	show	where	one	or	more	places	are	located	on	the	globe.

Google	Earth
From	the	Places	Category	view	toolbar	select	" GoogleEarth "	from	the	 Select	a	Map	Service 	drop	down	list.

Then	select	one	or	more	places	that	have	coordinates	(latitude/longitude)	in	the	Place	View	List	and	to	view	either	right-click	and	select	"Look	up
with	Map	Service"	or	press	the	 Attempt	to	see	selected	locations	with	a	Map	Service	(OpenstreetMap,	Google	Maps,
... 	button.

If	a	Place	does	not	have	a	set	of	coordinates	(latitude/longitude)

it	will	be	skipped	and	a	warning	can	be	found	in	the	log.

Prerequisites

"GoogleEarth	not	installed!"	-	dialog

You	must	have	Google	Earth	installed	to	show	the	result.

If	Google	Earth	is	not	installed	the	file	created	is	located	in	the	users	home	directory	called	GrampsPlacesForGoogleEarth	(with	file	extension
.kml	for	a	text	file	or	kmz	for	a	zipped	file)	contains	details	describing	the	places	to	be	viewed	with	coordinates,	this	file	can	be	copied	and	used	on
any	operating	system	that	has	Google	Earth	installed.
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The	addon	does	not	recognize	if	Google	Earth	Pro	is	installed	and	cannot	be	used

see	11864

Issue
This	Addon/Plugin	type	does	not	have	a	help	button

11864	[Map	Services	addon]Add	support	for	"Google	Earth	Pro"
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5.2	Addons

MediaBrowserGramplet

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Media	"Browser	Gramplet"	-	detached	-	example

The	Media	 Browser	Gramplet 	addon	shows	details	of	a	person	linked	media	objects.

Usage
Appears	and	under	the	name	"Browser"	Gramplet!	in	the	context	menu	to	add	a	gramplet
gramplet	can	be	added	to	the	following	categories:	People,	Relationships,	Charts,	Geography

Issues
help	button	goes	to	https://gramps-project.org/wiki/index.php?title=Gramps_5.1_Wiki_Manual_-_Gramplets#Media_Browser
Github	code	MediaBrowser
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5.2	Addons

MediaMerge

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Media	Merge	Tool's	"Number	of	merges	done"	Results	dialog	and
Before(top)	and	After(Bottom)	screenshots	of	the	Media	List	View

The	 Merge	Media 	tool	can	search	your	database	for	media	file	entries	that	are	pointing	to	the	same	actual	file	and	when	found,	they	can	be
merged	together.

Usage
Select	Tools	->Family	Tree	Processing	->	Merge	Media	from	the	menu.

The	tool	will	start	with	an	'Undo	history	warning'	that	suggest	that	you	back	up	your	work.

The	tool	then	scans	your	family	tree	and	depending	on	the	result	you	are	then	presented	with	the:

No	modifications	made 	dialog	-	if	no	media	needs	to	be	merged.
Number	of	merges	done 	dialog	with	the	result	of	the	automatic	merge

Number	of	merges	done

If	any	duplicate	media	is	found	and	merged	you	will	see	the	 Number	of	merges	done 	dialog	with	the	resulting	number	that	was	merged.

No	modifications	made

If	no	duplicate	media	is	found	or	remain	to	be	merged	you	will	see	the	 No	modifications	made 	dialog	with	the	result	that	"no	media	media
items	merged".

What	is	it	For?
The	 Merge	Media 	tool	searches	your	database	for	media	file	entries	that	are	pointing	to	the	same	actual	file.	This	can	occur	with	certain	import
types,	and	can	occur	if	the	user	adds	the	same	media	more	than	once.	When	found,	they	are	merged	together.

The	 Merge	Media 	tool:

Compares	all	the	media	'pathname'	values,	converting	them	internally	to	a	common	format	for	comparison.
For	Windows	users,	differences	in	capitalization	on	the	path	are	ignored,	as	are	differences	in	the	path	separators	"\"	vs.	"/".
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For	all	users	paths	that	are	relative	(using	Edit	->	Preferences	->	Base	path	for	relative	media	paths)	are	also	compared	to	absolute	paths	or
paths	relative	to	your	home	directory.
For	all	users,	paths	that	contain	"../"	forms	are	also	properly	collapsed	during	the	comparison.
All	of	the	above	allows	the	addon	to	find	variations	that	actually	point	to	the	same	file.
The	addon	will	NOT	find	variations	that	include	'links'.
The	addon	will	NOT	find	'UNC'	style	paths	that	have	been	assigned	to	drive	letters	(Windows	users).	For	example,	if	"\\MyPC\d"	is	assigned
to	the	drive	letter	"D:",	and	files	are	entered	each	way,	they	will	not	be	matched	and	merged.
When	merges	are	done,	the	media	with	the	shortest	pathname	is	kept.
If	pathnames	have	equal	length,	then	the	one	with	the	lowest	'ID'	is	kept.

See	also
The	builtin	 Media	Manager 	which	is	group	of	four	separate	tools	that	allows	you	to	do	the	following:

Replace	substrings	in	the	path
Convert	paths	from	relative	to	absolute
Convert	paths	from	absolute	to	relative
Add	images	not	included	in	database

The	Third-party	Addon	 Media	Verify	Tool 	is	used	verify	a	one-to-one	relationship	between	media	objects	and	files	in	the	media
directory.

Media	Management
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5.2	Addons

MediaReport

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Media	Report	-	example	output

The	 Media	Report 	is	a	text	report	for	images.	The	report	allows	custom	headings	and	custom	notes	as	well	as	the	image	data	like	notes,
citations,	tags,	attributes	and	people	references.

Usage
Once	this	addon	has	been	installed:

Select	Menu	Reports	>	Text	Reports	->	Media	Report...

Undo	history	warning

Proceeding	with	this	tool	will	erase	the	undo	history	for	this	session.	In	particular,	you	will	not	be	able	to
revert	the	changes	made	by	this	tool	or	any	changes	made	prior	to	it.	If	you	think	you	may	want	to	revert
running	this	tool,	please	stop	here	and	backup	your	database.

From	the	Undo	history	warning	dialogue	you	can	choose	 Stop 	or	 Proceed	with	the	tool .
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Media	Report	-	Option	dialog

The	 Options 	tab	is	displayed	with	the	following:
Heading: 	The	heading	for	the	report.
Media: 	The	media/image	file	for	the	report.
Custom	Note: 	A	custom	note	selector	for	this	report.
[	]	Include	custom	note: 	If	checked	the	selected	custom	note	will	be	added.
[	]	Include	referenced	people: 	If	checked	people	referenced	on	the	image	will	be	added	to	the	report.
[	]	Include	media	data: 	If	checked	the	media	data	(attributes,	tags,	citations)	will	be	added	to	the	report.

Once	you	have	made	your	choices,	you	can	either	choose	 Close 	or	 Execute 	to	apply	the	report	generation.

Issues
11492	Media	Report	reduces	image	quality

See	also
Photo	Tagging	Gramplet	addon
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5.2	Addons

Media	Verify	Tool

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Media	Verify	Tool	-	dialog	-	default

The	 Media	Verify	Tool 	is	used	verify	a	one-to-one	relationship	between	media	objects	and	files	in	the	media	directory.

The	main	purpose	of	the	tool	is	to	locate	files	that	have	been	moved	and	fix	the	paths.

Gramps	generates	MD5	checksums	when	adding	media	objects	to	the	Tree.	This	tool	uses	those	to	verify	the	integrity	of	files	under	the	media
directory.	It	also	allows	users	to	use	a	file	manager	of	their	choice	to	manage	media	objects.

Preparation

Preferences	-	General	tab	showing	the	"Base	path	for	relative	media
paths"	setting

The	 Media	Verify	Tool 	tool	assumes	that	you	store	all	your	media	files	under	a	media	directory.	You	can	specify	this	directory	by	setting	the
Base	path	for	relative	media	paths	in	the	 General 	tab,	under	the	Edit->Preferences	menu	option.	

Usage
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Media	Verify	Tool	-	dialog	-	default

You	can	access	the	tool	from	the	Tools	>	Utilities	>	Media	Verify...	menu.

The	 Media	Verify	Tool 	dialog	is	display	with	the	following	choices:

The	 Close 	button	when	selected	will	exit	the	tool.
The	 Generate 	button	will	generate	MD5	checksums	for	all	media	objects.
The	 Verify 	button	will	perform	various	checks	against	your	media	objects	in	Gramps	and	media	files	under	your	media	directory.
The	 Export 	button	when	selected	will	export	the	report	as	a	text	file.
The	 Fix 	button	will	fix	the	paths	in	the	media	objects	to	match	the	new	paths	listed	in	the	 Verify 	-	 Moved/Renamed	Files 	section
tab.

Generate

Clicking	the	 Generate 	button	will	generate	MD5	checksums	for	all	media	objects.	You	should	run	this	after	you	have	added	or	changed	any
media	files.	Media	objects	without	MD5	checksums	will	be	listed	as	part	of	the	media	verification.	Resulting	 Errors 	will	be	displayed	in	the	tab
if	any.	

Verify

Clicking	the	 Verify 	button	will	perform	various	checks	against	your	media	objects	in	Gramps	and	media	files	under	your	media	directory	and
display	the	following	section	tabs	only	if	that	type	of	issue	is	present	eg:

Moved/Renamed	Files 	-
Missing	Files 	-
Duplicate	Files 	-
Extra	Files	Files 	-
No	MD5	Generated 	-

Moved/Renamed	Files
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Files	that	have	moved	or	renamed	are	listed	in	the	 Moved/Renamed	Files 	tab.	Where	there	are	multiple	files	with	the	same	checksum	under	the
media	directory,	the	first	one	listed	with	the	same	name	as	the	original	will	be	displayed.

Double	clicking	on	a	row	will	edit	the	associated	media	object.	

Missing	Files

Media	objects	are	listed	in	the	 Missing	Files 	tab,	when	there	is	no	file	found	with	a	matching	checksum.

Double	clicking	on	a	row	will	edit	the	associated	media	object.	

Duplicate	Files

Files	with	duplicate	checksums	are	listed	in	the	 Duplicate	Files 	tab.

Double	clicking	on	a	row	will	display	the	image	in	the	default	viewer.	

Extra	Files
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Files	that	are	under	the	media	directory,	but	not	yet	in	Gramps	are	listed	in	the	 Extra	Files 	tab.

Double	clicking	on	a	row	will	display	the	image	in	the	default	viewer.	

No	MD5	Generated

Media	objects	with	no	checksum	are	listed	in	the	 No	MD5	Generated 	tab.

Double	clicking	on	a	row	will	edit	the	associated	media	object.	

Export

Clicking	the	 Export 	button	will	show	the	 Export	results	to	a	text	file 	dialog	so	you	can	save	the	report.

Example	results	text	file

The	results	text	file	when	viewed	will	show	each	type	of	issue	displayed	in	its	own	section.

Missing	Files
				1897_expeditionsmannschaft_rio_a.jpg
				Gunnlaugur_Larusson_-_Yawn.jpg
				654px-Aksel_Andersson.jpg
				Alimehemet.jpg
				E_W_Dahlgren.jpg
				AntoineClaudet.png
				scanned_microfilm.png

Fix

Clicking	the	 Fix 	button	will	fix	the	paths	in	the	media	objects	to	match	the	new	paths	listed	in	the	listed	in	the	 Verify 	-	 Moved/Renamed
Files 	section	tab.

See	also
Discourse	support	forum	discussion	about	strategies	when	using	this	tool
The	builtin	 Media	Manager 	which	is	group	of	four	separate	tools	that	allows	you	to	do	the	following:

Replace	substrings	in	the	path
Convert	paths	from	relative	to	absolute
Convert	paths	from	absolute	to	relative
Add	images	not	included	in	database

The	Third-party	Addon	 Merge	Media 	that	searches	your	database	for	media	file	entries	that	are	pointing	to	the	same	actual	file	and	when

Media	Verify	Tool 197

http://www.gramps-project.org/wiki/index.php/File:MediaVerifyTool4.png
http://www.gramps-project.org/wiki/index.php/File:MediaVerifyTool5.png
http://www.gramps-project.org/wiki/index.php/Addon:Media_Verify_Tool#Moved.2FRenamed_Files
https://gramps.discourse.group/t/gramps-4-2-8-linux-mint-restoring-connections/5168/25
http://www.gramps-project.org/wiki/index.php/Gramps_5.2_Wiki_Manual_-_Tools#Media_Manager
http://www.gramps-project.org/wiki/index.php/Gramps_5.2_Wiki_Manual_-_Tools#Replace_substrings_in_the_path
http://www.gramps-project.org/wiki/index.php/Gramps_5.2_Wiki_Manual_-_Tools#Convert_paths_from_relative_to_absolute
http://www.gramps-project.org/wiki/index.php/Gramps_5.2_Wiki_Manual_-_Tools#Convert_paths_from_absolute_to_relative
http://www.gramps-project.org/wiki/index.php/Gramps_5.2_Wiki_Manual_-_Tools#Add_images_not_included_in_database
http://www.gramps-project.org/wiki/index.php/Addon:MediaMerge


found,	they	can	be	merged	together.

Media	Management

Issues
Add	a	help	button	pointing	here
7144	Media	Verify:	wrong	handling	of	non-ascii	characters
6744	Add	Merge	for	Media	Verify	Plugin

Possible	future	enhancements

This	tool	could	be	enhanced	to	perform	other	tasks,	such	as:

Merging	media	objects	with	duplicate	files.
Updating	the	checksum	for	modified	files.
Removing	unused	duplicate	files.
Creating	media	objects	for	unused	files.
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5.2	Addons

MongoDB

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

For	Experts	only!	This	is	an	Experimental	Unreleased	addon.

Gramps	is	not	designed	to	be	used	by	multiple	users	at	the	same	time.	While	using	a	MongoDB	server
remotely	allows	multiple	users	to	connect	to	a	database,	doing	so	simultaneously	WILL	cause	database
corruption	and	loss	of	data.	If	you	chose	to	set	up	for	multiple	user	access,	please	backup	frequently,	and
set	up	a	system	of	your	own	to	make	sure	that	only	one	person	is	using	Gramps	at	one	time.	Gramps	or
the	family	tree	MUST	be	closed	before	allowing	another	user	to	access	the	database.

The	 MongoDB 	addon	provides	experimental	MongoDB	database	support	for	Gramps	5.x	or	greater.

MongoDB	is	an	open-source	document-oriented	NOSQL	database.

Prerequisites

Note	these	instruction	assume	you	are	using	Linux	or	development	environment.

As	the	Gramps	AIO	&	MacOS	installers	do	not	come	with	the	Prerequisites	and	can	not	be	installed
easily.	see	10491

Install	the	following	packages:

mongodb
python3-pymongo

Start	and	enable	the	database	service.

Windows	&	MacOS

As	the	Gramps	AIO	&	MacOS	installers	do	not	come	with	the	Prerequisites	and	can	not	be	installed	easily.	see	10491

Windows
If	you	really	want	to	experiment	with	mongodb,	(this	is	regarded	as	an	extremely	advanced	activity),	you	will	have	to	build	up	a	development
environment	for	Gramps	under	Windows	and	then	add	the	mongodb	prerequisites	there.	See	Gramps	for	Windows	with	MSYS2

MacOS
The	Mac	bundle	is	aimed	at	normal	users.	Tinkerers	can	use	MacPorts	and	have	more-or-less	the	same	environment	as	on	Linux.	Note	that
Homebrew	just	downloads	the	Gramps	bundle	dmg,	so	it	won't	help	in	this	case.	See:	Mac	OS	X:Build	from	source:MacPorts

Creating	a	family	tree
In	the	" Family	Tree "	tab	of	the	Preferences,	set	the	" Database	backend "	to	MongoDB.

Enter	the	 Host 	and	 Port 	if	using	anything	other	than	the	defaults.

In	the	 Family	Tree	Manager ,	click	 New 	and	enter	a	family	tree	name.

Click	the	 Load	Family	Tree 	button.

Create	or	import	some	data.

Viewing	a	database	using	mongo
From	the	command	line	type:

$	mongo

At	the	prompt	type:
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>	show	dbs

You	should	see	your	family	tree	listed.

>	use	Family_Tree_1

>	show	collections

>	db.person.find()

Now	you	should	see	some	data.

Some	query	examples
>	db.person.find({"gramps_id":	"I0044"})

>	db.person.find({"primary_name.surname_list.surname":	"Garner"}).count()

>	db.person.find({"primary_name.surname_list.surname":	"Garner",	"gender":	0}).count()

>	db.event.find({"type.string":	"Birth"})

See	also
PostgreSQL
DB-API	Database	Backend
https://www.mongodb.com/

Issues
10491	[Gramps	AIO	&	MacOS	installers]	Add	prerequistes	MongoDB	[Wontfix][Windows	use	:	MSYS2/	MacOS	use:	MacPorts]
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5.2	Addons

NetworkChart

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Long	chart	creation	times

Generating	a	chart	of	every	individual	in	a	very	large	database	can	lead	to	long	chart	generation	times
(See	Performance).	Of	course,	subsets	can	be	selected	greatly	reducing	the	chart	generation	times	(See
Trim	and	Highlight).

Slight	Variations	in	Graph	Layouts

Generated	Network	Chart	graphs	may	change	slightly	after	Gramps	restarts.	This	is	due	to	the
nondeterministic	nature	of	the	Graphviz	memory	allocation	method	used	in	the	dot	layout	engine.

Example	Default	Output

Network	Chart 	is	a	Web	Pages	Report	addon	for	Gramps	that	can:

Generate	a	single	graph	showing	connectivity	between	individuals
Has	clickable	nodes	(individuals)	that	contain	a	hyperlink	for	a	visual	index
Display	connectivity	paths	and	highlight	them

The	default	output	is	a	Scalable	Vector	Graphics	(SVG)	file	that	can	be	viewed	in	a	browser.	Network	Chart	requires	the	following	prerequisites;
the	python	networkx	module	to	assist	in	selecting	what	to	display	and	Graphviz	via	the	pygraphviz	module	to	generate	the	chart.

Usage
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To	Start	Network	Chart

To	start	the	Network	Chart	addon	use	the	following	menu	option	Reports	>	Web	Pages	>	Network	Chart...

Make	sure	you	have	installed	the	required	prerequisites.

Main

The	Shakespeare	database	used	for	the	examples	was	downloaded	from	the
http://genealogyoflife.com/	(Gone,	try	[1])	website.

Network	Chart	 Main 	preferences	tab

The	 Main 	preferences	tab	(see	image	on	left)	controls	the	output	Filename,	Folder,	File	Type	and	chart	title.	The	filename	defaults	to	the	database
name	+	'_network'	with	'.svg'(default)	added	automatically	on	output.	The	Chart	Title	defaults	to	the	database	name	and	the	folder	to	the	top	level
user	default	home.	Once	an	entry	is	changed	it	will	be	remembered	and	used	for	the	next	time	as	well.	Clearing	the	entry	will	set	it	back	to	default.
Additionally,	name	and	date	formats	for	the	chart	can	be	modified	using	the	Gramps	available	formatting.	The	output	File	Type	can	be	changed	to	a
PDF.	The	PDF	will	not	have	URL	links	but	everything	else	will	display	the	same	as	the	SVG.

Graph	style	menu	selects	the	type	of	connectors	with	choices	being	Orthogonal,	Straight,	and	Curved.	In	the	example	default	output	shown	on	the
right,	the	default	orthogonal	option	was	selected	resulting	in	straight	connectors	with	right	angles.	Graphs	with	over	1500	people	should	probably
use	the	Curved	or	Straight	options	with	noticeable	reduction	in	the	time	needed	for	graph	generation.

Graph	Direction	controls	which	of	the	four	different	orientations	to	use.

URL	Style	selects	one	of	Database,	Dynamic,	Static,	or	None	(Don't	include).	This	option	selects	what	hyperlink	will	be	used	for	individual	nodes
when	the	SVG	chart	is	viewed	from	a	browser.	The	Database	option	will	select	the	primary	URL	from	the	database	if	one	is	available	or	none	if	it
is	not.	Dynamic	will	use	the	URL	Prefix,	Suffix	from	the	next	line	in	the	Menu	and	the	GrampsID	of	the	node.	The	Example	Default	Output	chart
shown	includes	dynamic	URL's.	For	example,	Henry	Webb	in	the	database	has	GrampsID	=	I0125.	So	the	URL	for	that	node	will	have	the	prefix	of
'	https://mywebsite.com/home/	'	and	the	suffix	'.html'	yielding	a	node	with	a	link	to	'	https://mywebsite.com/home/I0125.html	'.	The	dynamic	URL
changes	for	every	node.	A	static	URL	will	use	only	the	URL	Prefix	and	the	Don't	Include	URL	or	None	will	not	place	any	link	in	the	nodes.

Example	Output	for	Left	to	Right	and	Static	URL's

The	font	selection	is	straightforward.	Obtain	the	name	of	the	font	that	you	wish	to	use	and	type	it	in	the	entry	box.	The	only	requirement	is	that	the
font	already	be	installed	on	your	system.	If	the	font	is	not	found	then	a	default	font	will	be	used.	This	is	a	silent	operation	and	will	not	warn	on	a	font
not	found.	When	the	SVG	graph	is	generated	that	font	will	be	identified	for	use,	however,	if	someone	viewing	the	chart	does	not	have	the	same	font
installed	they	will	see	their	default	font	instead.	(Embedding	fonts	in	SVGs	or	making	them	a	local	access	is	possible	but	not	available	in	this	addon.)
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The	default	font	is	White	Rabbit	by	Matthew	Welch	which	is	an	extremely	readable	font.	It	can	be	obtained	from
https://www.fontsquirrel.com/fonts/white-rabbit	and	the	license	found	at	http://www.squaregear.net/fonts/license.shtml	.

The	Spacing	option	controls	the	space	between	"generations"	of	nodes.	It	can	be	anywhere	from	0.1	-	5.0	inches.	Finally,	you	can	use	"Different
node	shape/edges	for	gender"	to	controls	the	box	shapes	and	makes	the	Male	and	Female	box	shapes	different,	by	default	this	selection	is	turned	off.

Color

Network	Chart	 Color 	preferences	tab

The	 Color 	preferences	tab	controls	most	of	the	colors	on	the	chart.	The	Network	Chart	SVG	background	is	transparent	so	the	background	color
you	see	will	be	the	default	background	color	of	your	browser	or	if	the	SVG	was	embedded	in	a	webpage	with	a	background	image	you	will	see	that
image	below	the	Network	Chart	SVG.	The	node	backgrounds	for	Male,	Female,	and	Other	can	be	changed.	An	alpha	transparency	is	used	for	the
individual	node	backgrounds.	Setting	this	to	0	will	make	the	node	background	completely	transparent.	Setting	it	to	255	will	make	it	completely	solid
(opaque).

Connector	lines	are	just	that,	the	connecting	lines	from	node	to	node	for	a	family	connection	or	marriage.	The	Highlight	connector	line	is	used	for	a
highlighted	path	as	discussed	in	the	Highlight	Menu	section.	The	Trim	box	edge	is	used	on	nodes	in	the	graph	that	have	been	"trimmed"	as	discussed
in	the	Trim	Menu	section.	Finally,	all	node	background	colors	can	be	set	to	none	with	the	Remove	Color	Backgrounds	option.

Privacy

Network	Chart	 Privacy 	preferences	tab

The	 Privacy 	preferences	tab	allows	dates	for	birth	and	marriage	to	be	made	vague.	All	individuals	that	have	a	valid	date	for	either	a	birth	or
marriage	can	have	that	date	rounded	to	the	nearest	decade	after	the	year	to	start	entered.	Additionally,	middle	names	can	be	changed	to	just	show
initials.	Finally,	private	records	for	individuals	can	be	included	or	not.	If	not,	the	individual	node	will	contain	the	words	"Private	Record"	for	all
those	individuals	marked	private	in	Gramps.

Trim
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Trim 	tab	Example	1

Trim	Example	1

The	 Trim 	preferences	tab	allows	"trimming"	of	the	database	to	display	less	individuals	in	the	Network	Chart.	The	Trim	Descendants	option	trims
all	descendants	"below"	the	selected	individuals.	The	Trim	Ancestors	option	attempts	to	trim	all	ancestors	"above"	the	selected	individuals.
Individuals	by	marriage	will	also	be	removed	depending	on	their	location	in	the	network	relative	to	the	person	trimmed.	Both	options	allow	entry	of
multiple	people.	The	Trim	Menu	image	shows	the	selection	of	individual	I0118	to	trim	descendants	and	I0111	to	trim	ancestors.	The	result	is	shown
on	the	right	in	the	Trim	Example	1.	Note	the	nodes	of	the	individuals	selected	on	the	trim	tab	are	bordered	with	a	red	dashed	trim.

Trim 	tab	Example	2

Trim	Example	2

Trim	Menu	Example	2	shows	the	selection	of	additional	individuals	to	trim.	However,	this	example	will	generate	"orphans"	or	individuals	with	no
connections	as	a	result	of	the	trimming	operation.	This	is	shown	in	Trim	Example	2.	Note	the	three	isolated	individuals	in	the	top	right	corner
including	one	of	the	individuals	selected	in	the	trim	menu.
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Trim 	tab	Example	3

Trim	Example	3

The	Trim	Groups	option	will	trim	smaller	groups/trees	or	individuals	that	are	disconnected.	You	must	enter	the	minimum	number	of	individuals	in	a
group/tree	to	display.	For	databases	with	more	than	1500	individuals	this	option	is	required	and	the	minimum	number	is	set	to	2.	This	will	force	all
disconnected	single	individuals	to	be	removed	from	the	graph.	Selecting	a	number	greater	than	the	largest	group/tree	will	return	only	the	largest	tree
or	those	trees	that	are	equal	in	size.	For	this	example	the	Trim	Groups	has	been	selected	with	a	size	of	2.	The	result	removes	the	isolated	individuals
from	the	graph	as	shown	in	the	Trim	Example	3	chart.

Highlight

Highlight 	tab	Example	1

Highlight	Example	1

The	 Highlight 	preferences	tab.	The	Highlight	Menu	highlights	paths	and	individuals	in	the	database.	The	Highlight	Path	option	choices	are
"Direct"	or	"Any".	The	Direct	option	will	attempt	to	find	a	direct	path	between	the	two	individuals	selected	and	highlight	that	path.	The	Any	option
will	attempt	to	find	any	path	between	the	two	selected	individuals	and	highlight	that	path.	The	example	shows	Highlight	Path	Direct	between	the
two	individuals	with	the	result	shown	in	Highlight	Example	1.	
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Highlight 	tab	Example	2

Highlight
Example	2

The	Show	Path	Only	will	display	only	the	path	found	and	remove	all	others	from	the	chart.	The	choices	are	"Direct"	or	"Any".	The	Direct	option
will	attempt	to	find	a	direct	path	between	the	two	individuals	selected	and	display	only	that	path.	The	Any	option	will	attempt	to	find	any	path
between	the	two	selected	individuals	and	display	only	that	path.	The	example	shows	the	Show	Only	Path	option	with	Direct	selected.	The	result	is
shown	in	Highlight	Example	2.	

Highlight 	tab	Example	3

Highlight
Example	3

The	Center	Person	option	allows	one	to	select	a	center	person	for	the	chart	and	radius	that	will	isolate	the	included	nodes	to	just	that	selected	person
and	anyone	within	the	radius.	The	radius	is	the	maximum	allowable	steps	or	edges	between	the	center	person	and	anyone	else	in	the	graph.	All
others	outside	of	the	maximum	steps	or	edges	will	not	be	shown.	Any	connection	via	parent,	child,	or	marriage	counts	as	a	step	or	edge.	

Config
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Config 	tab	Example

The	 Config 	preferences	tab	allows	modification	of	some	basic	functionality	of	the	Network	Chart	addon.

The	Name	format	can	be	changed.

The	GrampsID	in	a	database	can	change	for	an	individual,	however,	the	underlying	database	handle	for	an	individual	should	never	change.	Thus	the
Use	Database	Handle	option	can	be	used	for	the	Dynamic	URL	generation	on	the	main	menu	to	replace	the	GrampsID	with	the	database	handle.
This	is	typically	much	longer	than	the	GrampsID.

The	confirm	overwrite	option	allows	one	to	stop	the	overwrite	warnings	and	just	overwrite	the	file.

The	Translation	option	allows	the	selection	of	the	Language.

Finally	the	date	format	allows	you	to	change	the	format.	

Prerequisites
Network	Chart	requires	the	python	networkx	module	to	assist	in	selecting	what	to	display	and	Graphviz	via	the	pygraphviz	module	to	generate	the
chart.

Requires	the	following	to	be	installed	(type	pip3	if	system	default	is	still	python	2):

networkx	version	1.x	Note	that	Network	Graph	Report	Fails	when	used	with	with	networkx	v2.x	See:11471)

	pip	install	networkx

or

	pip3	install	networkx

To	get	"libcgraph"	for	pygraphviz	you	first	need	to	install	the	development	package	of	graphviz	eg:

	apt	install	graphviz-dev
												or
	dnf	install	graphviz-devel

then	run:

	pip	install	pygraphviz

or

	pip3	install	pygraphviz

Troubleshooting[2]

You	can	check	if	networkx	and	pygraphviz	installed	correctly	by	starting	python	(type	python3	if	system	default	is	still	python	2)	and	attempt	to
import	both	packages	eg:

			python3

			import	networkx

If	no	error	occurs	then	networkx	is	fine

then	try

			import	pygraphviz

If	no	error	occurs	then	pygraphviz	is	fine

If	you	receive	any	error,	correct	the	issue	and	test	again.
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Performance

Network	Chart	was	intended	for	smaller	databases	or	subsets	and	is	extremely	fast	for	charts	with	less	than	1500	nodes.	However,	it	can	generate
very	large	graphs	in	reasonable	time	and	should	be	adequate	for	those	large	databases	that	do	not	change	frequently.	Some	optimizations	for	large
databases	are	done	automatically.	The	Trim	Groups	selection	is	one.	Another	method	to	greatly	decrease	the	time	to	generate	a	chart	on	a	large
database	is	to	select	Straight	or	Curved	for	the	Graph	Style	on	the	 Main 	preferences	tab.	Reducing	the	number	of	nodes	to	graph	via	 Trim 	and
Highlight 	tabs	will	reduce	graph	generation	times.	For	example,	if	your	database	contains	65535	individuals	and	you	trim	or	highlight	to	plot
only	8191	individuals,	it	would	take	closer	to	20	seconds	to	generate	the	chart	(based	on	the	following	table).	Some	performance	data	is	shown
below	for	an	Intel(R)	Core(TM)	i7-2600K	CPU	@	3.40GHz	with	16GB	of	RAM	and	an	SSD	for	storage.

Network	Chart	Performance	(times	are	HH:MM:SS)

Data	File #	Individuals Graph	Style Trim	Groups SVG	File	Size Time	to	Generate
d03 124032 Curved 2 107.2MB 00:51:04

ENFAN16 65535 Curved 2 95.6MB 00:34:47
ENFAN15 32767 Curved 2 47.8MB 00:07:42
ENFAN14 16383 Curved 2 23.8MB 00:01:23
ENFAN13 8191 Curved 2 11.9MB 00:00:20
Royals	ged 3010 Orthogonal Not	Used 4.4MB 00:00:07

Issues
11900	[MacOS	installers]	Add	prerequistes	NetworkChart	[Wontfix]MacOS	use:	MacPorts
10197	Network	Chart	report	Running	report	on	second	Family	tree	shows	first	family	trees	chosen	Gramps	id.
11471	Network	Graph	Report	Fails	with	networkx	v2.x
Help	button	goes	incorrectly	to	[3]	instead	of	here.

See	Also
Web	Solutions	for	Gramps
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5.2	Addons

NoteCleanupTool

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Note	Cleanup	Tool	-	example	window

What	is	it	For?
The	Note	Cleanup	Tool	searches	your	database	for	notes	that	contain	"HTML	tags"	and	cleans	it	up.	"HTML	tags"	have	meaning	to	web	browsers
and	other	applications,	but	look	like	garbage	to	most	people.

The	cleanup	consists	of	converting	the	"HTML	tags"	to	what	the	Gramps	folks	call	"Styled	text"	which	displays	nicely	within	Gramps	and	in	the
various	reports	that	Gramps	can	generate.

The	tool	also	searches	for	"links"	to	web	sites	and	sets	them	to	"Styled	Text	Links",	so	that	they	work	properly	in	reports	such	as	the	Gramps
Narrative	Web	Site.

Examples	of	notes	that	needs	cleaning

	&lt;i&gt;Selected	U.S.	Naturalization	Records&lt;/i&gt;.	
	Washington	D.C.:	National	Archives	and	Records	Administration.	
	&lt;p&gt;&lt;a	href=&quot;/search/dbextra.aspx?dbid=1629&quot;&gt;
	View	Full	Source	Citations&lt;/a&gt;.&lt;/p&gt;

	United	States	of	America,	Bureau	of	the	Census.	<i>Fifteenth	Census	of	the	United	States,	1930</i>.	
	Washington,	D.C.:	National	Archives	and	Records	Administration,	1930.	T626,	2,667	rolls.

The	first	note	contains	some	text	with	italics	as	well	as	a	link	to	a	web	site.	The	cleaned	note	is	shown	in	the	lower	right	pane	of	the	image	on	the
cleanup	tool	above.	The	second	dirty	note	is	much	simpler,	it	only	contains	a	bit	of	italics	text;	the	tool	will	remove	the	<i>	and	</i>	and	convert	the
text	in	between	to	italics.

Where	do	the	"dirty"	notes	come	from?

The	author	of	this	plugin	has	a	lot	of	data	that	was	imported	from	http://ancestry.com	via	GEDCOM.	It	seems	that	the	ancestry.com	software	doesn't
always	do	a	great	job	of	converting	their	web	pages	to	notes	for	GEDCOM	export.	The	popular	Family	Tree	Maker	software,	in	conjunction	with
ancestry.com	also	seems	to	have	a	lot	of	these	"dirty"	notes	in	their	GEDCOM	exports.	There	are	probably	other	ways	that	dirty	notes	get	into	our
data,	but	this	tool	can	help	clean	it	up.

Usage
Once	this	plugin	has	been	installed
Select	Menu	Tools	->	Utilities	->	Note	Cleanup...

Warning

Proceeding	with	this	tool	may	make	unexpected	changes	to	your	data.	While	it	is	possible	to	Undo	the
changes	made	by	this	tool,	it	may	be	easier	to	recover	from	a	backup.

The	dialog	that	pops	up	when	you	start	the	tool	provides	a	warning	and	a	short	review	of	the	tool	usage.	Clicking	 Close 	will	dismiss	the
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dialog	but	does	nothing	else.
At	this	point	the	tool	window	with	three	main	panes	and	some	buttons	should	be	visible.
If	you	want	to	perform	a	quick	test	to	see	what	this	tool	does,	you	can	press	the	 Generate	Test	Notes 	button.	This	is	best	performed	on
a	test	database,	since	it	actually	adds	some	test	notes	to	the	active	database.
Otherwise	you	can	perform	a	scan	of	your	data	by	pressing	the	 Search 	button.	This	does	not	make	any	changes	to	your	data,	only	performs
the	search	and	fills	the	panes	if	any	dirty	notes	are	found.

The	left	pane	will	contain	lists	of	the	results	of	the	search.	If	nothing	appears	here,	then	none	of	your	data	is	dirty,	or	any	dirty	notes
already	have	been	edited	and	styled.	There	may	be	up	to	three	lists	in	the	left	pane.	A	list	will	only	be	present	if	there	are	notes	found	in
that	category.

The	Cleaned	Notes	list	contains	notes	that	have	been	edited	in	some	way,	and	may	have	styles	applied.	This	includes	converting
any	web	links	to	a	styled	link.
The	Links	Only	list	contains	notes	that	have	not	been	edited	(no	textual	changes	at	all)	but	have	had	links	converted	to	styled.
The	Issues	list	contains	notes	that	may	have	been	edited	in	some	way,	but	contain	HTML	tags	that	the	tool	does	not	recognize.

The	top	right	pane	will	show	the	original	unedited	text	of	a	note	that	is	selected	in	the	left	pane.	This	cannot	be	changed.
The	lower	right	pane	will	show	the	proposed	changes	to	the	note.	If	the	user	wants	to	make	additional	changes,	they	can	be	made
directly	in	the	pane.	The	editing	toolbar	directly	above	the	lower	left	pane	can	be	used	to	make	or	correct	style	changes	as	well.	This
toolbar	is	an	abbreviated	version	of	the	normal	Gramps	Note	editor	toolbar	and	each	icon	works	the	same.	Any	changes	made	here	are
preserved	within	the	tool,	but	will	not	affect	your	data	until	the	 Save	All 	button	is	pressed	(see	next	below).

When	you	have	reviewed	all	the	changes	made,	either	by	the	tool,	or	manually,	you	can	save	your	work	using	the	 Save	All 	button.	Your
data	is	not	changed	until	you	press	this	button,	but	when	you	do,	all	the	changes	are	committed	to	your	database.
If	you	do	not	want	any	changes	to	be	made	to	your	data,	or	you	are	done	with	the	tool,	you	can	simply	press	the	 Close 	button.
If	you	want	a	record	of	notes	that	have	been	found	in	the	search,	you	can	use	the	 Export 	button	to	save	a	listing	to	a	text	file.

Some	Notes
If	any	Issues	are	found,	the	unrecognized	"HTML	tag"	will	be	marked	up	with	a	yellow	highlight.	The	user	may	want	to	manually	edit	each
of	these	in	some	way.	When	done,	the	highlight	can	be	removed	by	selecting	the	highlighted	region	and	pressing	the	"Clear	Markup"	toolbar
button	(last	button	on	the	right).
Pressing	the	 Search 	button	at	any	time	will	scan	your	data	again,	discarding	any	proposed	automatic	or	manual	changes	and	producing
new	lists.
Double	Clicking	on	a	note	in	a	left	pane	list	will	bring	up	the	standard	Gramps	Note	Editor.	Any	changes	in	that	editor	followed	by	pressing
the	 OK 	button	will	update	your	database	immediately.	However,	if	you	later	press	the	 Save	All 	button	in	the	still	open	Note	Cleanup
Tool,	that	data	will	be	overwritten	by	the	Note	Cleanup	Tool.

Issues
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5.2	Addons

NoteGramplet

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Note	Gramplet	-	example

The	 Note	Gramplet 	is	for	data	entry,	similar	to	the	Data	Entry	Gramplet.	This	gramplet	will	edit	the	first	note	of	type	Person	Note	for	the
active	person.	Like	the	Data	Entry	Gramplet,	once	you	begin	editing	a	note,	it	won't	leave	the	current	person	until	you	save	or	abort.

You	must	save	your	changes	before	closing	Gramps,	or	your	changes	will	be	lost.

See	also
Gramps_5.2_Wiki_Manual_-_Gramplets#Notes	-	Builtin	Notes	Gramplet	showing	the	active	persons	notes.
Data	Entry	Gramplet	-	which	is	a	data	entry	gramplet,	that	allows	an	easy	method	of	editing	previously	added	people,	and	adding	new	and
related	people	in	your	family	tree.
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5.2	Addons

NumberOfAncestorsQuickView

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Number	of	Ancestors	Quick	View

The	Quick	View	 Number	of	Ancestors 	is	similar	to	the	text	report	Number	of	Ancestors.	For	each	generation	of	the	person's	ancestors	it	tells
you	the	number	of	ancestors	found,	the	theoretical	ancestor	number	and	how	many	percent	of	the	theoretical	ancestors	were	found.	The	Quick	View
only	counts	individual	ancestors,	therefore	duplicates	caused	by	pedigree	collapse	are	ignored	in	the	calculations.

Usage
You	can	activate	the	Quick	View	by	right-clicking	on	a	person's	name	in	the	 People	Category	View.	Then	select	Quick	View	>	Number	Of
Ancestors.

Tips
Quick	Views	can	also	be	used	as	Gramplets.	(more	information)
The	Third-party	Addon	Ancestor	Fill	Report	calculates	pedigree	collapse.

See	also
Pedigree	collapse	-	Wikipedia

NumberOfAncestorsQuickView 212

http://www.gramps-project.org/wiki/index.php/File:Gramps-notes.png
http://www.gramps-project.org/wiki/index.php/Third-party_Addons
http://www.gramps-project.org/wiki/index.php/How_to_make_a_backup
http://www.gramps-project.org/wiki/index.php/Using_the_bug_tracker
https://github.com/gramps-project/gramps/blob/master/README.md#the-following-packages-are-optional
http://www.gramps-project.org/wiki/index.php/Gramps_5.2_Wiki_Manual_-_Plugin_Manager
http://www.gramps-project.org/wiki/index.php/File:NumberOfAncestors-QuickView-example-51.png
http://www.gramps-project.org/wiki/index.php/Gramps_5.2_Wiki_Manual_-_Reports_-_part_6#Number_of_Ancestors_Report
http://www.gramps-project.org/wiki/index.php/Gramps_5.2_Wiki_Manual_-_Categories#People_Category
http://www.gramps-project.org/wiki/index.php/Gramps_5.2_Wiki_Manual_-_Gramplets#Quick_View
http://www.gramps-project.org/wiki/index.php/Addon:Ancestor_Fill_Report
https://en.wikipedia.org/wiki/Pedigree_collapse


5.2	Addons

Number	of	Descendants	Quickview

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Number	Of	Descendants	-	Quick	View	-	Sample	Output

The	Descendant	Count	Quick	View	shows:

The	number	of	descendants	of	the	current	active	person,	separately	counted	per	generation:	the	number	of	children,	the	number	of
grandchildren,	etc.
How	many	of	them	were	born	while	the	current	person	was	alive	(i.e.	how	many	of	his/her	descendants	did	the	current	person	live	to	see?)
How	many	of	them	died	while	the	current	person	was	alive	(i.e.	how	many	of	his/her	descendants	did	the	current	person	survive?)
How	many	of	them	are	alive	today?

Usage
You	can	activate	the	Number	Of	Descendants	Quick	View	by	the	context	menu	(right-clicking)	on	a	person's	name	in	the	 People
Category (Grouped	View	or	List	View),	and	selecting	Quick	View	>	Number	Of	Descendants

See	also
Other	Quick	Views

Issues
Quickview	on	dashboard,	no	help	page	link
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5.2	Addons

ParticipantsGramplet

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Participants	Gramplet	-	detached	-	example

The	 Participants	Gramplet 	addon	shows	the	participants	in	an	event.

Usage
You	can	only	add	the	Gramplet	from	the	Event	category	as	a	gramplet	option

Double-click	on	a	row	to	edit	the	selected	participant.

Issues
Github	code	Participants
help	button	goes	to	https://gramps-project.org/wiki/index.php?title=Gramps_5.1_Wiki_Manual_-_Gramplets#Participants
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5.2	Addons

PedigreeChart

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Pedigree	Chart	Report	-	Addon	-	example	output

This	version	of	the	 Pedigree	Chart 	(or	Ancestor	Tree)	was	designed	to	fit	a	single	sheet	of	paper	and	to	be	suitable	for	printing	or	distribution
as	a	PDF.	The	chart	is	laid	out	in	a	fixed	format	on	the	page	and	works	best	in	portrait	mode.	Up	to	four	generations	(counting	the	center	person)	are
printed	on	each	page	with	marks	indicating	the	next	page	where	the	ancestry	line	continues.

Usage
This	report	is	available	under	the	menu	Reports	>	Graphical	Reports	>	Pedigree	Chart...

Prerequisites
Optional	prerequisite	of	numpy
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5.2	Addons

PersonEverything	Report

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

PersonEverything	Report	-	Example	HTML	output

The	PersonEverything	Report	is	designed	to	show	absolutely	everything	about	one	person,	including	all	events,	notes,	citations,	sources,	attributes,
media	and	the	family	information	about	the	families	in	which	they	are	involved.	(E&OE)

Because	of	the	complicated	structure	of	the	data	in	Gramps,	the	data	is	output	in	a	very	structured	way,	so	it	may	not	be	in	an	elegant	narrative
format!	It	could	be	regarded	as	an	end-user	report	that	can	be	used	for	diagnostic	purposes,	or	as	a	debug	report	that	can	also	be	used	by	an	end-user!

Usage
This	report	is	available	under	the	menu	Reports	>	Text	Reports	>	PersonEverything	Report...

Options
See	also	common	options

Report	Options

Center	Person:	the	center	person	for	the	report.
Name	Format:	Select	the	format	to	display	the	names.	Choose	from	Default	/	Surname,	Given	Suffix	/	Given	Surname	Suffix	/	Given	/	Main
Surnames,	Given	Patronymic	Suffix	/	SURNAME,	Given	(Common)

Relation	to	other	reports
There	are	a	number	of	reports	that	output	information	about	individuals,	for	example:

The	Summary	Report	apparently	produced	a	detailed	summary	on	the	active	person.	The	report	apparently	included	all	the	facts	known	to	the
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database	about	that	person.	This	was	available	in	Gramps	2.2,	but	is	no	longer	available.
The	Complete	Individual	Report	provides	individual	summaries	similar	to	that	of	the	Individual	Summary	Report.
The	Descendant	Report	presents	the	descendants	of	the	Active	Person	with	a	brief	description	in	intended	style.
The	Detailed	Ancestral	Report	covers	in	detail	the	ancestors	of	the	Active	Person,	including	a	range	of	vital	data	as	well	as	marriages.
The	Detailed	Descendant	Report	covers	in	detail	the	descendants	of	the	Active	Person	by	generation,	following	the	genealogical	tradition	of
textual	descendant	reports	by	generation.	It	aims	to	provide	all	important	features	expected	to	be	found	in	these	classic	descendency	formats
and	has	received	influence	from	various	sources.
The	Ahnentafel	Report	lists	the	Active	Person	and	his	or	her	ancestors	along	with	their	vital	data.	The	people	are	numbered	in	an	establish
standard	called	'Ahnentafel'.
The	Family	Group	Report	creates	a	family	group	report,	showing	information	on	a	set	of	parents	and	their	children.
The	Narrated	Web	Site	report	generates	a	web	site	(that	is,	a	set	of	linked	web	pages),	for	a	set	of	selected	individuals.

Because	the	structure	of	the	data	stored	in	Gramps	is	complex,	there	is	a	necessary	trade-off	between	report	style	and	completeness.	All	the	above
reports	(with	the	possible	exception	of	the	obsolete	and	unavailable	Individual	Summary	Report)	are	selective	in	the	information	they	output	from
the	database,	in	order	to	present	it	in	a	way	that	the	report	designer	considers	helpful	to	the	user.

Report	implementation	design
The	report	is	designed	around	a	recursive	print_object	function.	This	uses	if	statements	to	determine	whether	the	object	to	be	printed	is	an	instance
or	subclass	of	the	class	which	the	if	statement	handles.	At	the	end	of	each	if	statement,	the	code	just	falls	through	to	execute	the	next	 if	statement.
The	if	statements	are	in	alphabetic	order	of	the	class,	and	this	ensures	that	the	different	objects	are	output	in	alphabetical	order.

The	report	output	is	started	by	functions	to	output	persons,	events	and	families.

As	an	example,	consider	the	Person	class.	print_person_summary	outputs	page	header	information	with	the	person's	name	and	birth	and	death
information	(all	of	which	are	repeated	later).	print_person_details	then	outputs	the	name	information	so	that	this	appears	at	the	start	of	the	output.
This	uses	print_object,	but	we	won't	describe	this	further	now.	print_person_details	then	calls	print_object	for	the	person.

The	person	class	is	defined	as:

	class	Person(CitationBase,	NoteBase,	AttributeBase,	MediaBase,
														AddressBase,	UrlBase,	LdsOrdBase,	TagBase,	PrimaryObject):

The	alphabetically	first	class	of	which	Person	is	a	subclass	is	AddressBase',	so	this	is	the	first	if	statement	to	be	true.	This	recurses,	calling
print_object	for	each	address.	On	return,	the	code	falls	through	to	the	next	if	statement.	The	next	if	statement	to	be	true	is	for	subclasses	of
AttributeBase.	This	loops	through	each	attribute	in	the	attribute	list,	outputting	a	header	containing	the	attribute	type,	value	and	privacy,	before
recursively	calling	print_object	for	the	attribute.	This	outputs	any	citations	and	notes	for	the	object	before	returning	and	falling	through	to	the	next
if	statement	that	is	true,	for	the	alphabetically	next	object	of	which	Person	is	a	sub-type.

The	code	is	not	as	simple	as	just	having	each	if	statement	output	the	data	for	that	class,	because	the	use	of	intermediate	'ref'	classes	would	result	in
the	main	information	about	each	class	being	separated	from	the	header	for	that	class.

A	new	Bibliography	class	is	needed	in	order	to	output	all	the	information	for	Citations	and	Sources.	The	number	in	the	text	and	the	notes	at	the
end	of	the	document	follow	the	Humanities	style	of	the	Chicago	manual	of	style	(see	[1],	but	without	the	bibliography).	Specifically	the	style	of
numbering	and	footnotes	is	based	on	[2].	This	format	has	the	properties	that:

the	superscript	numbers	for	the	citations	in	the	body	of	the	document	are	all	in	strict	numerical	order	in	the	document.
when	a	source	is	used	more	than	once	in	the	footnotes,

ibid.	is	used	when	the	footnote	refers	to	the	same	source	as	the	immediately	preceding	footnote,
op.	cit.	is	used	to	refer	a	previously	cited	source,	but	using	a	different	page	number,
loc.	cit.	is	used	to	refer	a	previously	cited	source	using	exactly	the	same	page	number.

The	style	of	the	notes	themselves	is	based	on	a	structured	presentation	of	the	data	that	is	stored	for	Citations	and	Sources,	rather	than	one	of	the
specific	document	types	in	the	Chicago	Manual	of	Style.	There	is	no	separate	bibliography	(i.e.	no	separate	summary	of	all	the	documents	that	are
references).

Known	issues
The	Gramps	report	document	infrastructure	may	not	always	generate	images	in	some	of	the	document	formats.	This	is	not	a	problem	with	the
addon,	but	rather	a	problem	with	the	infrastructure.	The	HTML	output	format	seems	to	be	the	most	reliable	in	outputting	images.
Images	are	not	displayed.
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5.2	Addons

Photo	Tagging	Gramplet

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

The	Gramplet	window	consists	of	the	toolbar,	the	selection	area	(center-left)
and	the	list	of	tagged	people	(center-right).

The	 Photo	Tagging	Gramplet 	facilitates	tagging	people	in	photographs,	i.e.	associating	regions	of	images	with	Gramps	persons.

Features
Image	preview	with	scrolling	and	zooming
List	of	persons	tagged	in	the	current	photograph
Adding	and	modifying	regions	and	associations
Supports	showing	XMP	Region	Name	if	there	are	no	regions	already	defined	in	Gramps	for	an	image.
Optionally	detect	faces	in	photo	automatically.*

Usage
Select	the	 Media 	Category	View	and	from	the	Sidebar	add	the	 Photo	Tagging	Gramplet .

The	Gramplet	window	consists	of:

the	toolbar
the	selection	area
the	list	of	tagged	people	in	the	image

Selection	area

The	selection	area	displays	the	image	and	highlights	the	regions	that	have	been	associated	with	person	in	the	Gramps	database.

The	mouse	wheel	can	be	used	to	zoom	in	and	out	of	the	image.	Alternatively,	you	can	use	the	corresponding	toolbar	buttons.

Left	click	inside	of	one	the	regions	makes	this	region	active.	Right-click	causes	the	context	menu	to	be	displayed.

To	tag	a	person,	select	a	region	of	the	image	by	pressing	the	left	mouse	button	in	one	of	its	corners	and	dragging	the	pointer	across	the	desired	area.
A	rectangular	frame	will	mark	the	selected	region.	Use	the	toolbar	to	select	an	existing	person	or	add	a	new	person	to	be	associated	with	the	region.

Drag'n'Drop	as	an	alternative	to	the	Person	Selection	dialog

The	most	obvious	option	for	selecting	a	Person	for	a	tag	is	the	Person	Selection	Dialog.	But	you	can	use
Drag'n'Drop	as	an	alternative	and	more	efficient	method.
Drag	a	Person	from	the	Clipboard	to	drop	on	the	selected	row	in	the	Gramplet	to	complete	a	Tag.	Or,
detach	(undock)	the	Photo	Tagging	Gramplet	and	use	the	Relationship	View	to	tag	multiple	members
from	a	Family	group.	Or	use	filtering	in	the	People	View	to	select	from	a	subset	of	the	family	tree.

It	is	important	to	select	the	target	row	before	beginning	any	drag.

To	modify	a	region,	first	make	it	active	by	clicking	inside	the	region.	Move	the	mouse	pointer	to	one	of	the	borders	or	corners	of	the	selection	box.
A	grabbing	handle	will	appear	that	you	can	drag	to	modify	the	shape	of	the	box.
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To	change	the	person	associated	with	the	region,	use	the	toolbar	buttons	or	the	context	menu.

To	associate	a	region	with	a	different	person,	click	within	the	region	and	use	the	toolbar	buttons	to	select	or	add	a	person.	In	this	case,	the	previous
association	is	discarded.

Toolbar

The	toolbar	contains	ten	buttons	that	are	made	active	in	accordance	with	the	current	state	of	selection.

Use	the	toolbar	to	modify	the	associations	of	the	current	image.

	Displays	the	Gramps	'Select	Person'	dialog.	Once	selection	is	made,	the	person	is	tagged	in	the	current	box.

	Creates	a	new	person	and	displays	the	Gramps	'Person'	dialog.

	Removes	the	tag	from	the	current	box.

	Removes	the	current	box	together	with	the	tag.

	Displays	the	Gramps	'Person'	dialog	for	the	person	tagged	in	the	current	box.

	Zooms	the	image	in.

	Zooms	the	image	out.

	Runs	the	face	detection	algorithm.	(Only	if	the	optional	prerequisites	have	been	installed)

	Displays	the	Gramplet	settings	dialog.

	Goes	to	this	help	page.

List	of	tagged	people

The	list	contains	the	people	tagged	in	the	current	image,	as	well	as	the	selection	boxes	that	have	not	yet	been	associated	with	a	particular	person.	A
thumbnail	image	of	the	corresponding	region	of	the	image	is	displayed	in	every	row.

By	default,	the	view	displays	the	 Row	Number (not	labeled),	 Preview ,	 Person ,	 Age ,	and	 XMP	Region	Name [1]	columns	for	each	tagged
image.

Left-clicking	on	a	row	in	the	list	selects	the	corresponding	region	in	the	image.	The	context	menu	allows	you	to	 Set	as	active ,	 Select ,
Add ,	 Clear 	or	 Remove 	the	image.

Double-click	on	a	row	with	a	person	opens	the	Gramps	'Person'	dialog	for	this	person.	This	is	equivalent	to	pressing	the	'Edit'	button	in	the	Gramplet
toolbar.

Settings

Photo	Tagging	Gramplet 219

http://www.gramps-project.org/wiki/index.php/File:Photo-Tagging-Toolbar-51.png
http://www.gramps-project.org/wiki/index.php/File:Photo-Tagging-Select-icon.gif
http://www.gramps-project.org/wiki/index.php/File:Photo-Tagging-New-icon.gif
http://www.gramps-project.org/wiki/index.php/File:Photo-Tagging-Clear-icon.gif
http://www.gramps-project.org/wiki/index.php/File:Photo-Tagging-Remove-icon.gif
http://www.gramps-project.org/wiki/index.php/File:Photo-Tagging-Edit-icon.gif
http://www.gramps-project.org/wiki/index.php/File:Photo-Tagging-Zoomin-icon.gif
http://www.gramps-project.org/wiki/index.php/File:Photo-Tagging-Zoomout-icon.gif
http://www.gramps-project.org/wiki/index.php/File:Photo-Tagging-Detect-icon.gif
http://www.gramps-project.org/wiki/index.php/Addon:Photo_Tagging_Gramplet#Installation_Prerequisites
http://www.gramps-project.org/wiki/index.php/File:Photo-Tagging-Settings-icon.gif
http://www.gramps-project.org/wiki/index.php/Addon:Photo_Tagging_Gramplet#Settings
http://www.gramps-project.org/wiki/index.php/File:Photo-Tagging-help-icon.png
https://gramps.discourse.group/t/suggested-update-to-phototagginggramplet-to-support-xmp-face-regions/1209/1


Selection 	tab
	 Replace	existing	references	to	the	person	being	assigned	without	asking	(checkbox	unchecked	by

default)

Face	detection 	tab
Minimum	face	width	(px): 	(50	default)	Size	in	pixels
Minimum	face	width	(px): 	(50	default)	Size	in	pixels
Sensitivity	(1	min	..	20	max): 	(50	default)	Size	in	pixels

	 Detect	faces	inside	existing	boxes 	(checkbox	unchecked	by	default)

Installation	Prerequisites
If	the	OpenCV	is	not	found,	the	automatic	face	detection	feature	will	be	unavailable,	but	the	Gramplet	should	otherwise	function	correctly.

Automatic	detection	of	faces	requires	the	following	to	be	installed:

OpenCV,	its	dependencies	and	Python	bindings.	This	library	should	be	available	in	common	Linux	distributions.	For	example,	Debian
package	python-opencv	provides	the	Python	bindings	for	the	library.	It	will	require	the	core	library	packages	(libopencv-*)	and	the
python-numpy	package.

Issues
10913	Face	detection	does	NOT	work	in	the[Microsoft	Windows]	AIO	bundle(s).	As	near	as	I	can	tell,	the	required	cv2	(OpenCV)	and	numpy
prerequisites	would	approximately	triple	the	size	of	the	AIO	download	and	installation.	So	they	are	not	included.

Feature	request

Some	of	the	ideas	to	be	implemented	in	future	versions	of	the	Gramplet:

Detection	of	faces	across	multiple	images	???
Integrate	with	Picasa	5674#c31715	(Moving	on	from	Picasa	-	Google	has	decided	to	retire	Picasa	in	order	to	focus	on	a	single	photo	service	in
Google	Photos)

Initial	announcement:

Face-Detection-Gramplet	-	2011
The	Face-Detection-Gramplet	[2]	was	redeveloped	into	this	Gramplet.

See	also

Media	Report	text	report	addon	(a	labeled	tag	region	report)
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5.2	Addons

PlaceCleanupGramplet

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Released	for	Gramps	5.x	+	versions

Place	Cleanup	Gramplet

The	 Place	Cleanup	Gramplet 	addon	uses	the	WebServices	feature	from	the	GeoNames.org	geographical	database	to	lookup	as	many	as	2,000
placenames	per	day.	(	See	GeoCodes.)	Selected	parts	of	the	validated	information	can	then	be	pushed	into	Gramps	to	correct	and	improve
incomplete	Place	records.

Purpose	of	this	Gramplet
This	was	written	to	assist	in	cleaning	up	already	existing	places.	You	can	use	it	while	adding	a	new	place,	but	the	place	must	be	created	with	the
normal	Gramps	Add	->	Place	and	select	the	new	place	in	the	top	window	prior	to	using	the	Gramplet.

When	starting	with	GEDCOM	imported	trees,	the	Places	that	are	created	are	often	incomplete	or	simply	don't	take	full	advantage	of	Gramps
features.	The	place	names	and/or	titles	are	often	left	with	strings	of	comma	separated	names.

Even	when	transcribing	events	from	census	or	other	sources,	Place	data	might	have	be	ambiguous	about	which	adminstrative	area	enclosed	a
locality	and	were,	in	turn,	enclosed.	Sometimes,	Places	may	have	been	entered	with	the	proper	enclosure	hierarchy...	but	without	the
Latitude/Longitude	coordinates	needed	to	plot	Events	on	the	maps	of	the	Gramps	Geography	view.

Rather	than	intefere	the	flow	of	data	or	research	workflow	to	validate	each	Place,	it	can	be	more	efficient	to	come	back	to	handle	these	deficiencies
collectively.

Cleaning	up	these	shortfalls	previously	required	a	lot	of	manual	work	to	clean	up.

The	Gramplet	assists	in	merging	new	places	with	already	present	places;	when	you	do	a	search,	if	the	Place	you	are	looking	for	is	located	elsewhere
in	your	Gramps	database,	and	is	completed,	then	you	can	merge	your	current	place	with	the	completed	place.

The	Gramplet	makes	use	of	the	GeoNames	database	via	the	web	to	get	information	to	fill	out	the	Places.

Warning:	Automated	records	updates	are	risky!

As	always,	back	up	your	current	tree	BEFORE	using	any	tool	that	automates	data	entry	or	editting.
While	it	is	usually	possible	to	Undo	changes	individually	within	a	session,	you	may	decide	that	you	need
to	restart	from	an	earlier	state.
See	make	a	Gramps	XML	backup

Usage

Installing	the	Place	Cleanup	Gramplet

The	Gramplet	can	be	installed	like	any	other	Addon;	see	 Installing	Addons	in	Gramps

Once	installed,	make	the	Gramplet	visible	in	the	 Places 	category	View	and	on	either	the	 Place	Tree 	or	 Places 	view	(which	ever	you
usually	use),	and	load	the	Gramplet	in	the	bottom	bar	by	clicking	the	 ∨ 	(Down	Arrowhead	button	also	known	as	the	Gramplet	Bar	Menu)	at	the
far	top	right	of	the	bottombar	titles,	and	then	using	the	 Add	a	gramplet 	menu	item.
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GeoNames	account	prerequisite

Add	free	WebServices	at	the	Login
screen

The	first	time	you	attempt	a	search,	you	will	be	reminded	to	obtain	and	set	a	GeoNames	user	ID,	which	is	required	for	use	of	their	data.	You	can
sign	up	for	the	ID	at	the	following	link:	http://www.geonames.org/login.

The	account	signup	requires	responding	to	a	confirmation	eMail.

Just	having	a	basic	GeoNames	account	isn't	quite	enough.	The	Gramplet	needs	to	access	to	the	Web	Services.	Return	to	the	login	screen	once	you've
validated	your	account,	then	enable	the	Free	Web	Services	by	clicking	the	link	in	the	section	of	their	login	screen.	It	is	shown	in	the	screen	capture
to	the	right.

Once	you've	logged	into	the	GeoNames	website,	requests	from	Gramps	on	the	same	machine	will	be	part	of	the	same	session.	If	the	session	log-in
expires	or	you	exceed	the	number	of	requests	allowed	in	a	day,	the	Gramplet	will	report	failing	to	find	matches	for	placenames	being	searched.	If	a
suspiciously	high	number	of	failures	occurs,	try	logging	in	again.

Once	you	have	an	ID,	you	should	set	it	into	the	Gramplet	via	the	Preferences	button,	see	below.	

Preferences

Place	Cleanup	Gramplet	-	Preferences

The	Gramplet	Preferences	is	accessed	via	the	Preferences	button	(located	in	the	top	right	of	the	main	view	of	the	Gramplet,	next	to	the	Title	field).
The	button	should	appear	in	the	far	upper	right	of	the	Gramplet.	

The	preferences	dialog	has	the	following	settings:

☑ Keep	Web	Links 	checkbox.	The	GeoNames	database	contains	various	URL	links	to	other	web	data,	associated	with	each	place.	For
example,	many	places	have	a	Wikipedia	link.	If	you	check	this	setting,	the	Gramplet	will	save	these	web	links	with	the	place	data.	They	will
appear	in	the	'Internet'	tab	of	the	Place	Edit	dialog.
☑ Add	citation	and	source	to	Place 	checkbox.	If	you	check	this	setting,	a	Citation	will	be	added	to	each	place,	citing	the
'GeoNames'	Source	and	Repository,	with	the	Citation	having	a	'Volume/Page:'	value	with	the	GeoNames	ID	number.	There	will	be	a	Citation
for	each	Place,	but	only	a	single	Source	and	Repository.
GeoNames	User	ID 	field.	This	contains	the	necessary	GeoNames	user	ID.	You	can	sign	up	for	the	ID	at	the	following	link:
http://www.geonames.org/login.
Alternative	Names	Languages	to	keep 	field.	This	contains	a	space	separated	list	of	the	ISO-639-1	2-letter	language	code:	en	de
fr	it	es,	et	cetera.	As	you	work	with	the	Gramplet,	you	will	see	a	list	of	alternate	names	available	for	most	places,	with	the	language	code
for	the	names.	If	you	want	these	names	automatically	checked	off	for	inclusion	in	your	Gramps	place,	add	the	code	to	this	field.
Currently	Enclosed	Places.	When	you	use	the	 Ok 	button	after	selecting	a	GeoNames	place,	the	Gramplet	may	have	to	deal	with	a	place
enclosure.	If	you	are	modifying	a	current	place,	and	your	place	is	already	'Enclosed	by'	another	place	the	Gramplet	has	two	choices	on	how	to
handle	changes	to	the	enclosure.

Keep	current	Enclosure 	radio	button	selector.	If	you	select	this	setting,	and	your	place	is	already	'Enclosed	by'	another	place,
then	no	changes	to	the	'Enclosed	by'	place	value	will	be	made,	even	if	your	current	enclosing	place	differs	from	that	provided	by	the
GeoNames	data.

If	there	is	no	'Enclosed	by'	place	value,	and	the	GeoNames	data	has	an	enclosing	place,	then	one	will	be	created,	and	selected	for
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approval.

Replace	with	GeoNames	Enclosure 	radio	button	selector.	If	you	select	this	setting,	and	your	place	is	already	'Enclosed	by'
another	place,	then	the	current	enclosure	is	replaced	by	the	enclosing	place	from	the	GeoNames	data.	If	it	did	not	exist	before	this,	it
will	then	be	created,	and	selected	for	approval.

While	this	ensures	that	the	enclosure	matches	GeoNames,	it	is	possible	that	the	previous	enclosing	place	will	no	longer	be	used,
and	will	remain	in	your	database.

Main	view

Use	extra	caution	when	changing	the	Title	field

The	place	data	found	and	pushed	to	update	the	Place	view	will	depend	on	the	contents	of	this	field.	If
you	change	it	in	inappropriate	ways,	you	could	end	up	with	mismatched	place	data.	
For	example,	if	the	originally	active	record	in	the	Place	view	is	"Berlín,	Usulután",	and	you	manually
type	in	a	Place	title	of	"Berlin,	Germany"	to	search,	when	you	find	and	accept	the	Berlin	place,	your
originally	selected	Place	view	record	for	the	municipality	in	El	Salvador	will	be	changed	to	Europe!

Place	Cleanup	-	finding	a	particular	place	title

The	Main	view	has	several	buttons,	a	'Title'	field,	a	small	'xx	Matches'	status,	and	a	'Choices'	or	match	results	list.

Title 	field.	This	field	shows	the	Place	that	is	currently	under	investigation.	It	provides	the	search	terms	that	are	used	for	finding	a	place.	It
changes	automatically	to	the	place	title	when	the	Gramps	Place	view	has	an	active	selection.	The	field	can	also	be	modified	by	the	user,	just
set	the	cursor	in	it	and	edit	as	normal.	This	is	generally	only	needed	when	trying	to	find	a	place	in	GeoNames	that	might	have	unexpected
abbreviations,	or	historical	hierarchy	or	other	issues	which	can	make	finding	a	match	in	the	GeoNames	database	difficult.	(As	an	example,
your	Gramps	place	hierarchy	has	"west	berliner,	west	germany".	There	are	no	matches	and	you	wonder	if	GeoNames	only	has	post-unification
names.	Then	you	notice	that	there	is	a	typographical	error	with	a	trailing	'er'.	So	you	change	it	to	successfully	search	for	"west	berlin,	west
germany"	instead	of	that	elusive	donut.)
Matches 	status.	This	small	status	block	is	located	on	the	left	side	of	the	Gramplet,	just	below	the	'Title'	label.	It	indicates	the	number	of
matching	places	found	when	searching	the	local	Places	list	or	the	GeoNames	database.	The	status	also	indicates	where	the	matches	were
found,	either	'Local',	or	'GeoNames'.
Search	result	places 	list.	This	area	lists	the	found	matches.	The	user	should	select	the	correct	match	for	the	place	under	investigation,
and	either	press	the	 Select 	or	double-click,	press	'Enter'	or	'Space'	to	move	to	the	result/edit	screen.

There	are	two	columns	in	this	list,	the	names,	and	the	'Types'	columns.	The	names	are	comma	separated	places	in	the	hierarchy,	as
found	in	the	local	database,	or	in	GeoNames.	The	'Type'	column	in	the	Places	view	shows	the	Gramps	Type,	when	showing	places	from
the	local	database,	and	shows	GeoNames	Feature	Codes	that	includes	a	Feature	class	letter	followed	by	a	colon,	then	a	type)	when
showing	results	from	the	GeoNames	search.

Avoiding	rework

If	you	search	GeoNames	for	a	place	in	that	is	already	in	your	database,	the	search	results	may	return
some	entries	annotated	with	a	red	strikethrough.	This	indicates	that	those	places	are	already	enclosed	by
the	current	place	and	cannot	be	selected.

The	Type	column	is	provide	for	informational	use	only,	to	help	the	user	determine	a	bit	more	about	the	found	place.	The	GeoNames
Feature	Codes	are	not	always	obvious;	the	type	type	format	starts	with	a	'class';	one	of	'A'	(Administrative	place),	'P'	(Populated	place),
or	'S'	(Spot).	(Of	the	9	GeoNames	classes,	searching	H,	L,	R,	T,	U,	V	is	not	supported.)	You	can	restrict	the	returned	search	matches	to
desired	categories	with	the	matching	Checkboxes	(see	below).	The	remaining	part	of	the	type	field	for	GeoNames	can	be	decoded	from
http://www.geonames.org/export/codes.html,	if	desired.

☑ Populated 	checkbox.	If	you	check	this	setting,	'Populated	Places'	(typically	cities,	towns,	villages	etc.)	will	be	returned	for	a	GeoNames
search.	This	setting	does	not	affect	a	local	database	search.	This	is	initially	enabled,	as	it	allows	the	search	to	return	what	most	people	expect
for	a	city	type	search.
☑ Admin 	checkbox.	If	you	check	this	setting,	'Administrative	Divisions'	(countries,	states,	regions	etc.)	will	be	returned	for	a	GeoNames
search.	This	setting	does	not	affect	a	local	database	search.	.	This	is	initially	enabled,	as	it	allows	the	search	to	return	what	most	people	expect
for	a	county,	state,	country	type	search.
❏ Spot 	checkbox.	If	you	check	this	setting,	'Spots'	(typically	farms,	buildings,	graveyards,	churches	etc.)	will	be	returned	for	a	GeoNames
search.	This	setting	does	not	affect	a	local	database	search.	This	is	initially	disabled,	as	most	place	searches	don't	go	to	this	level	of	detail.
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Help 	button.	This	brings	up	this	web	page.
Find 	button.	This	performs	a	search	for	the	placename	indicated	in	the	 Title 	field.	The	search	is	performed	in	two	stages:

Initially,	the	local	Gramps	place	list	is	examined	for	a	match.	The	local	match	is	only	searched	among	'Complete'	places,	those	with
Latitude/Longitude	coordinates	and	Place	Type	data	filled	in.	Only	the	initial	segment	of	the	place	is	used	for	searching.	For	example,	if
you	search	for	'Paris,	FR',	and	your	local	Gramps	Place	Tree	data	has	both	'Paris,	Lamar,	Texas,	United	States'	and	'Paris,	Paris,	Île-de-
France,	France',	both	will	be	shown.	Alternative	names	in	the	local	Gramps	places	are	also	searched.
The	second	stage	is	the	GeoNames	search.	It	is	performed	automatically	if	the	first	stage	doesn't	find	any	matches.	If	the	first	stage	did
find	one	or	more	matches,	but	none	of	them	were	correct,	the	user	can	press	the	 Find 	button	again	to	do	the	GeoNames	search.	Note
that	the	Web	Service	of	the	GeoNames	search	can	return	only	ten	results	at	a	time.	If	the	place	you	want	is	not	in	the	first	subset	of
results,	press	the	 Find 	button	again	to	see	the	next	ten.

Find	shops	locally	before	resorting	to	the	net

The	'Find'	button	changes	to	'Find	GeoNames'	after	a	local	database	search	where	something	was	found.
This	is	a	reminder	that	you	can	search	that	online	database	if	the	local	search	did	not	return	what	you
wanted.

Select 	button.	After	the	user	selects	one	of	the	matches	in	the	'Choices'	list,	this	causes	the	result/edit	screen	to	be	shown.
Edit 	button.	If	no	suitable	places	are	found,	the	user	can	use	this	to	advance	directly	to	the	result/edit	screen.	This	can	occur	if	the	place
you	are	searching	for	is	too	detailed,	for	example	'My	Estate,	Paris,	TX'	or	'123	Mains	St.,	Paris,	TX'.	Since	such	detailed	information	is	not
going	to	be	found	in	the	GeoNames	search,	you	have	to	edit	it	manually.
Next	Place 	button.	This	causes	the	Gramplet	to	advance	to	the	next	incomplete	Place	in	the	Gramps	Places	list.	Incomplete	places	are
missing	any	of	the	Latitude/Longitude	or	Place	Type	data.	If	a	place	is	found	that	is	not	used	by	any	Event	or	encloses	another	place,	you	will
get	a	dialog	popup	message	suggesting	that	the	place	be	deleted.

Result/Edit	view

Place	Cleanup	Result	View

This	view	presents	the	found	place	data	for	review	and	potential	editing.

At	the	top	of	this	view	is	the	full	title	of	the	Current	place,	in	bold	text.

Primary	Name 	field.	This	field	is	displayed	based	on	the	name	chosen	as	primary	from	the	list	of	available	names.	It	is	not	editable.
Postal	Code 	field.	This	field	displays	the	postal	code(s).	It	can	be	edited.	There	is	a	small	 Orig 	checkbox	just	above	this	field,	if
checked,	the	Original	postal	code	from	the	place	is	used	instead	of	the	found	postal	code.	Note	that	this	checkbox	is	disabled	if	there	is	no
original	postal	code.
Type 	field.	This	field	displays	the	place	type.	It	can	be	edited.	There	is	a	small	 Orig 	checkbox	just	above	this	field,	if	checked,	the
Original	place	type	from	the	place	is	used	instead	of	the	found	place	type.	Note	that	this	checkbox	is	disabled	if	there	is	an	'Unknown'	original
place	type.

NOTE

The	GeoNames	database	does	NOT	provide	Gramps	Place	Type	data.	This	Gramplet	uses	the	available
data	to	make	a	'best	guess'	at	the	correct	Place	Type.	You	should	always	check	and	make	sure	that	the
value	is	correct,	and	fix	it	if	necessary.

Latitude	and	Longitude 	fields.	These	fields	displays	the	Latitude	and	Longitude.	They	can	be	edited.	There	is	a	small	 Orig
checkbox	just	above	these	fields,	if	checked,	the	Original	Latitude	and	Longitude	from	the	place	is	used	instead	of	the	found	Latitude	and
Longitude.	Note	that	this	checkbox	is	disabled	if	there	is	no	original	Latitude	and	Longitude.
ID 	field.	This	field	displays	the	Gramps	ID.	It	cannot	be	edited.	There	is	a	small	 Orig 	checkbox	just	above	this	field,	if	checked,	the
Original	ID	from	the	place	is	used	instead	of	the	found	ID.	Note	that	this	checkbox	is	disabled	if	there	is	no	original	ID.
The	Names	list. 	This	list	contains	the	names	associated	with	the	found	place.	Each	name	has	an	associated	Language	and	Date.	There	is
also	an	'Inc'	column	which	displays	the	include	status	of	the	name	in	that	row.	If	there	is	a	'P'	in	the	'Inc'	column,	that	name	is	used	as	the
Primary	name.	If	the	column	has	a	checkmark	'✔'	the	name	will	be	included	in	the	final	Place	alternative	names	list.	If	you	double-click,
press	'Enter'	or	'Space'	on	a	selected	row,	that	will	toggle	the	include	status.
Keep 	button.	If	one	or	more	of	the	places	in	the	names	list	is	selected,	pressing	this	button	will	cause	the	associated	names	to	be	marked	for
inclusion	in	the	final	Place	alternative	names	list.
Primary 	button.	If	one	or	more	of	the	places	in	the	names	list	is	selected,	pressing	this	button	will	cause	the	topmost	associated	name	to	be
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marked	as	the	Primary	name.
Discard 	button.	If	one	or	more	of	the	places	in	the	names	list	is	selected,	pressing	this	button	will	cause	the	associated	names	to	be
unmarked	so	they	will	not	be	included	in	the	final	Place	alternative	names	list.
Cancel 	button.	Pressing	this	button	returns	the	view	to	the	main	search	view.	No	changes	are	saved.
Ok 	button.	Pressing	this	modifies	the	selected	place	with	the	new	values.	In	addition,	the	next	level	of	the	place	hierarchy	will	be	set	into	the
place.	If	that	next	level	is	already	present	in	the	local	Gramps	place	list,	and	has	a	matching	GeoNames	ID,	the	modifications	are	completed.
If	not,	the	next	level	in	the	place	hierarchy	is	shown	in	the	results	view.

FAQ
GeoNames	data	is	primarily	intended	for	present	day	usage.	It	contains	little	historical	information.	I	have	heard	that	it	is	pretty	complete	for
United	States,	Canada,	and	less	so	for	Europe,	although	it	seems	to	have	all	the	European	cities	I	have	tested	so	far.	If	you	find	an	error	or
omission	in	the	GeoNames	data,	you	may	want	to	tell	GeoNames	about	it	http://www.geonames.org/manual.html.
GeoNames	finds	multiple	places:	Example,	'Santa	Rosa,	CA'.	GeoNames	finds	both	'Santa	Rosa,	Sonoma,	California,	United	States'	and	'City
of	Santa	Rosa,	Sonoma,	California,	United	States'.	The	way	the	GeoNames	database	is	structured,	they	have	a	'Populated	Place',	which
generally	has	lots	of	Alternate	names	and	postal	codes,	and	an	'Administrative	subdivision'	for	the	same	place.	The	'City	of'	version	is	the
Administrative	subdivision,	which	generally	doesn't	have	postal	codes	and	alternate	names.	I	personally	prefer	the	first	version,	which	should
appear	first	in	the	'Choices'	list.
Timeouts:	When	using	the	GeoNames	web	database	with	a	free	account,	you	will	sometimes	get	a	timeout.	The	Timeout	is	set	to	20	seconds
for	each	request,	unfortunately	some	actions	take	several	requests,	so	the	user	may	see	unresponsive	Gramps	for	up	to	40	seconds.	You	can
always	try	the	request	again	by	pressing	the	last	used	button.	According	to	the	GeoNames	web	site,	if	you	pay	for	an	account,	you	may	get
better	performance,	as	the	paid	accounts	use	more	lightly	loaded	servers.
Not	Found:	While	the	GeoNames	database	contains	some	historical	names,	it	mostly	tries	to	be	up	to	date	with	the	current	times.	Many	places
in	a	typical	family	tree	are	described	as	of	the	time	the	event	occurred.	So	it	is	entirely	possible	that	the	described	place	no	longer	exists.	It
may	now	belong	to	a	different	country,	or	other	administrative	subdivision.	Or	it	may	have	been	subsumed	within	another	larger	place.
Initially	you	should	try	removing	the	intermediate	place	data,	leaving	only	the	initial	segment	and	the	country.	You	may	get	a	lot	of	matches,
but	that	may	give	you	a	better	clue	as	to	the	current	situation.	Or	you	may	have	to	do	some	research	outside	the	Gramplet	to	figure	out	what	it
might	be	called	now.
Place	Types:	Since	GeoNames	does	not	have	place	'type'	data,	the	same	way	that	Gramps	does,	this	addon	uses	an	algorithm	to	attempt	to
pick	an	appropriate	place	type.	If	a	country	is	known	to	have	a	rigid	administrative	place	type	structure,	such	as	the	United	States	with	its
City/County/State/Country,	then	the	various	parts	of	the	place	hierarchy	are	typed	accordingly.

If	the	structure	is	not	always	known	or	used,	then	the	algorithm	attempts	to	assign	place	types	by	looking	at	the	place	name.	For	example	if
the	place	name	includes	a	word	that	matches	a	place	type,	such	as	"Harris	County"	or	"Smith	Township",	then	the	place	type	is	set
accordingly.	To	do	this,	all	the	various	place	alternate	names	are	scanned,	in	case	the	primary	name	does	not	include	a	suitable	word.
If	you	know	that	a	particular	country	has	a	rigid	(or	even	mostly	rigid)	hierarchical	structure,	and	this	addon	seems	to	be	getting	it	wrong	a	lot,
please	let	the	author	know	at	paulr2787	at	gmail.com.	I	can	modify	the	code	to	make	it	work	better	if	I	understand	the	correct	country
structure.

IDs:	When	GeoNames	is	the	source	of	place	data,	the	normal	place	ID	('P0001')	is	replaced	by	a	GeoNames	specific	ID	('GEO12345').	The
number	portion	of	this	ID	is	the	GeoNames	identifier	for	the	place.	By	using	this	type	of	ID,	the	addon	can	easily	identify	when	enclosing
places	are	already	present	in	your	database,	which	means	that	the	user	doesn't	have	to	do	a	local	search	for	and	selection	of	each	level	of
enclosing	place.
GetGov,	how	does	this	interoperate	with	the	data	from	GetGov?	At	this	time	it	does	not	integrate	with	that	data.	If	you	already	have	places
loaded	from	the	GetGov	addon,	then	the	ID	field	will	have	a	GovID.	If	you	want	to	do	a	lookup	with	GeoNames	for	that	place,	you	should
probably	set	the	Place	Cleanup	preferences	for	the	enclosure	to	keep	the	current	values.	In	addition,	you	should	probably	use	the	'Orig'
checkbox	for	the	ID	to	keep	the	original	Gov	ID.

Issues
This	tool	is	fairly	complex.	Please	report	any	issues	or	desired	enhancements	to	paulr2787	at	gmail.com.

I	have	included	a	French	translation	of	the	tool,	mostly	as	a	test	of	the	internationalization	code.	Since	I	don't	speak	French	(USA	Texas	version	of
English	only),	please	excuse	my	French.

PlaceCleanupGramplet 225

http://www.geonames.org/manual.html%257C
http://www.gramps-project.org/wiki/index.php/Addon:GetGOV


5.2	Addons

PlaceCoordinatesGramplet

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Internet	Access	required

The	 Place	Coordinates 	Gramplet	reads	geolocations	from	the	internet.

Addon	Place	Coordinates	Gramplet	-	detached

The	 Place	Coordinates 	Gramplet	simplifies	setting	the	coordinates	of	a	place	and	also	provides	an	additional	geography	view.

Usage
Add	the	Gramplet	to	the	bottom	bar	of	the	Places	Category.

Options

Searching	geolocations	of	places	from	the	DB

Place	Coordinate	Gramplet

Searching	place	names	from	geolocations	from	the	DB
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Place	Coordinate	Gramplet

Additional	geography	view	with	a	context	menu

Place	Coordinate	Gramplet

It	also	provides	a	geography	view	 Place	Coordinate	Gramplet	View 	with	a	context	menu	that	enables:

1.	Adding	cities	as	new	places

2.	Adding	addresses	as	new	places

3.	Linking	existing	places	with	geolocations	

Prerequisites
Requires	GeocodeGlib	be	installed.

GeocodeGlib/geocode-glib	is	a	convenience	library	for	the	geocoding	(finding	longitude,	and	latitude	from	an	address)	and	reverse	geocoding
(finding	an	address	from	coordinates).	It	uses	Nominatim	service	(from	openstreetmap.org	)	to	achieve	that.	It	also	caches	(reverse-)geocoding
requests	for	faster	results	and	to	avoid	unnecessary	server	load.

Issues
On	linux	an	older	version	of	libgeocode-glib0	(3.18.2)	causes	segmentation	faults	when	pressing	the	search	button.

Please	update	to	a	newer	version	of	that	library.	For	example:

			wget	http://archive.ubuntu.com/ubuntu/pool/main/g/geocode-glib/libgeocode-glib0_3.25.4.1-4ubuntu0.18.04.1_amd64.deb
			apt-get	install	./libgeocode-glib0_3.25.4.1-4ubuntu0.18.04.1_amd64.deb

Help	button	goes	to	https://gramps-project.org/wiki/index.php?title=Gramps_5.1_Wiki_Manual_-_Gramplets#Place_Coordinates	instead	of
this	page
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5.2	Addons

PlaceUpdate	Gramplet

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

PlaceUpdate	Gramplet	-	Data	entry	-	detached	view

The	 PlaceUpdate 	Gramplet	allows	you	to	manipulate	and	change	properties	of	multiple	places	at	the	same	time.

The	properties	that	can	be	changed	are:

Place	Type
Tag
Enclosing	Place

Place	names	can	be	edited	by	substituting	sub-strings	with	new	values.

The	gramplet	can	also	generate	a	place	hierarchy	from	place	names	or	titles.

Usage
The	gramplet	should	be	installed	on	the	sidebar	gramplet	pane	of	the	Places	Category	view.

The	Place	list	is	then	used	to	select	which	places	are	affected.

Setting	enclosing	place

For	the	enclosing	place	first	select	the	place	that	should	enclose	the	other	places	and	click	the	 Select	enclosing	place 	button.	The	 Select
Place 	selector	will	be	displayed	and	you	can	select	your	place.	Then	select	any	number	of	places	that	should	be	enclosed	by	the	first	one	and	click
the	 Apply	to	selected	places 	button.

A	place	might	already	have	an	enclosing	place.	In	that	case	the	new	place	will	be	added	and	the	place	will	end	up	being	enclosed	by	multiple	places.
This	is	quite	ok	but	you	can	also	remove	the	previous	enclosing	places	by	checking	the	box	 Clear	original	enclosing	places .	This	can
e.g.	be	used	to	"move"	the	places	under	another	place.

Attempts	to	set	a	duplicate	enclosing	place	or	a	loop	(so	that	a	place	contains	itself)	are	quietly	bypassed.
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Setting	place	type	or	tag

You	can	also	set	the	type	of	the	selected	places	or	assign	any	tag	if	needed.	The	operations	can	be	combined	so	that	e.g.	the	place	type	and	enclosing
place	can	be	set	at	the	same	time.	Type	and	tag	can	be	selected	from	pre-existing	ones	or	you	can	type	a	new	name	if	needed.

Any	existing	tags	can	also	be	first	removed	if	the	 Clear	tags 	checkbox	is	marked.	Otherwise	the	new	tag	is	added	to	the	set	of	the	tags	for	the
places.

If	the	enclosing	place,	type	or	tag	is	not	specified,	then	the	corresponding	setting	is	not	changed.

Generating	a	place	hierarchy

If	a	place	name	contains	comma	separated	names	then	the	gramplet	can	change	this	to	a	place	hierarchy.	For	example	if	the	name	is	of	the	form
"place1,	place2,	place3"	then	two	new	places,	place2	and	place3	(with	type	"Unknown")	are	created,	the	name	of	the	original	place	is	changed	to
place1	and	the	places	are	put	in	the	hierarchy	"place1	<	place2	<	place3".

Duplicate	place	names	at	the	same	level	are	automatically	merged.	The	original	names	can	also	be	separated	by	spaces	instead	of	commas	-	but	then
you	must	be	careful	that	the	names	do	not	contain	spaces.

The	hierarchy	can	also	be	generated	in	reverse,	e.g.	the	result	can	also	be	"place3	<	place2	<	place1"	if	the	corresponding	checkbox	is	marked.

The	place	type	and	tag	setting	affects	only	the	original	place.

If	the	original	place	is	under	another	place	or	a	new	enclosing	place	is	specified	then	the	new	hierarchy	is	placed	under	the	enclosing	place.

Editing	place	names

The	 Replace	text 	function	allows	substituting	a	specified	text	string	in	the	place	names	with	another.	Regular	expressions	can	also	be	used.

Example

Select	"United	States"	as	the	new	enclosing	places	and	select	the	three	states.	Set	the	 Place	type: 	to	"State":

Setting	enclosing	place

Click	 Apply	to	selected	places .	The	result	is:

Setting	enclosing	place

Notes
The	 Clear	selections 	button	will	clear	the	form.

All	changes	are	done	under	a	transaction	and	they	can	be	undone	from	the	Gramps	menu	Edit	>	Undo	Setting	place	properties.

This	gramplet	does	not	have	direct	support	for	filters.	The	"Filter"	gramplet	can	be	used	to	search	for	the	places	that	need	changes.

This	gramplet	can	only	be	added	on	the	Places	view	and	it	requires	Gramps	5.x.

Author:	[email	protected]	(19	Jan	2020)

Issues
Help	button	goes	to	https://gramps-project.org/wiki/index.php?title=Gramps_5.1_Wiki_Manual_-_Gramplets#PlaceUpdate
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This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

5.2	Addons

Place	completion	tool

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

This	tool	is	of	limited	use	for	Gramps	5.x	series.

Please	read	the	Issues	section.	You	should	consider	using	the	Place	Cleanup	Gramplet	instead.

The	 PlaceCompletion 	tool	addon	can	import	places	into	your	Gramps	database	in	accordance	with	the	Gramps	requirements:	batch	add
country,	county;	look-up	latitude-longitude;	set	description	(title);	...

This	tool	helps	you	fill	in	the	place	attributes	like	county,	country,	...,	by	allowing	you	to	select	the	places	you	work	on,	and	do	changes	on	all	these
places	with	one	button	click.

The	general	aims	are:

Place/Location	is	a	newer	concept	in	Gramps.	Many	older	databases	only	have	a	Place	title	field	which	is	a	descriptive	text	containing	city,
state,	country.	This	should	be	parsed	to	insert	the	values	in	the	correct	attribute	fields.
Latitude	and	longitude	are	important	to	show	data	on	a	map.	However,	doing	a	look-up	of	this	data	on	the	internet	is	slow	and	time
consuming.	The	tool	allows	to	search	in	the	free	resources	on	the	net.
Setting	of	an	attribute	of	a	set	of	places	in	one	go.
Conversion	of	latitude	and	longitude	to	a	fixed	data	format.	On	import	one	might	obtain	latitude	and	longitude	in	several	different	formats.	A
conversion	tool	to	store	them	all	in	the	same	format	is	useful.
Construction	of	a	uniform	title/description	field,	from	the	data	in	the	place	object.

Follow	the	installation	details	in	the	Download	section	for	your	version	of	Gramp.

Usage	Instructions
The	place	completion	tool	provides	a	lot	of	functionality.	These	usage	instruction	should	help	you	to	understand	how	it	works.

Download	resources

The	place	completion	tool	can	look	up	for	you	latitude/longitude,	add	county	information	(USA),	...	.	For	some	of	this	functionality,	you	must
download	data	files	of	the	countries	you	are	interested	in.	Right	now	you	have	three	options:

1.	 Download	geonames	country	files.	You	can	do	this	here	freely.	Geonames	parses	fastest,	so	is	the	advised	format	to	use.
2.	 Download	geonames	USA	state	files.	You	can	do	this	here	freely.	This	is	advised	for	USA	searches,	as	the	data	in	the	USA	country	file
contains	many	doubles,	which	can	be	avoided	by	searching	state	per	state.	State	info	also	contains	county	information.

3.	 Download	GNS	Geonet	country	files	(not	available	for	usa).	You	can	do	this	 here	freely	with	ftp.

Watch	out,	some	of	these	downloads	are	VERY	large,	especially	USA	data.	Only	download	what	you	need!	If	the	download	is	a	compressed	zip
file,	you	will	need	to	extract	the	data	file	before	you	can	use	it.
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Note:

The	geonames	data	of	popular	places	is	in	English,	so	e.g.	municipalities	in	Italy	will	be	found,	but	Roma
not,	as	this	is	Rome	in	English.	To	find	data	with	these	you	need	to	search	in	the	localised	variants	of	the
name	(see	below)

Warning:

DO	NOT	USE	ON	YOUR	RESEARCH	DATA.	EXPORT	DATA	FIRST	TO	HAVE	A	BACKUP.
Before	use	backup	your	Family	Trees.

Starting	the	tool

You	will	find	the	plugin	under	Tools	>	Utilities	>	PlaceCompletion...

The	dialog	explained

The	Dialog	consists	of	4	parts:

Part	1.	Selection	of	places

First	you	need	to	choose	with	which	places	you	want	to	work.	You	can	use	several	methods	to	define	your	places:

1.	 Use	a	place	filter.	You	can	use	two	preset	filters:	All	places,	which	returns	all	places,	and	No	Latitude/Longitude	given,	which	returns	all
places	of	which	the	latitude	or	the	longitude	is	not	set.	You	can	also	created	a	custom	place	filter	in	the	place	view,	test	it	with	the	filter
sidebar,	and	then	use	it	in	this	tool.	All	custom	filters	you	made	will	be	available

2.	 To	prevent	the	need	to	make	a	filter	for	every	city,	...	in	your	data,	you	can	set	country,state,county,city	or	parish	of	the	places	you	want	to
search	on.	This	works	just	like	in	the	filter	sideview	in	the	places	view.

3.	 Use	a	latitude,	longitude	rectangle.	Eg,	suppose	you	have	the	latitude	and	longitude	of	all	places	in	the	UK,	and	now	want	to	add	in	the	state
attribute	Wales,	for	all	places	in	Wales.	You	can	look	on	a	map,	note	down	the	centre	of	Wales	in	latitude	and	longitude,	as	well	as	roughly
the	width	and	height	of	this	rectangle.	This	will	allow	you	to	obtain	all	places	in	Wales	(and	some	in	England),	allowing	to	much	faster	set	the
state	information.

Part	2.	Completion	of	places

1.	 The	first	possibility	is	to	look	up	in	a	datafile	the	latitude	and	longitude	of	your	places.	For	this	you	must	have	downloaded	the	necessary
resources,	see	section	above.	You	can	select	with	a	file	dialog	the	file	you	want	to	search,	and	set	how	this	data	must	be	parsed.	The	following
parsing	options	are	available:
1.	 GeoNames	country	file,	city	search:	use	the	city	attribute	to	look	for	lat/lon	in	a	GeoNames	country	file.	This	is	the	fastest	search.
2.	 GeoNames	country	file,	city	localized	variants	search:	use	the	city	attribute	to	look	for	lat/lon	in	a	GeoNames	country	file	using	the
localised	(non-English)	known	names	in	the	GeoNames	file.	Eg,	Roma	will	be	found	with	this	option	(as	Roma	is	the	Italian	local
variant	of	the	English	name	Rome)

3.	 GeoNames	country	file,	title	begin,	general	search:	Use	the	start	of	the	title	field	to	search	in	a	GeoNames	file.	With	start	it	is	meant
everything	before	a	comma:,	.	This	allows	to	find	landmarks,	squares,	...	.	Eg,	if	the	title	of	your	place	is:	Piazza	Navona,	Rome,	using
this	search	will	find	you	the	latitude	and	longitude	of	this	famous	square	in	Rome.

4.	 GeoNames	USA	state	file,	city	search:	Looking	for	places	in	the	USA	file	is	almost	worthless:	it	takes	a	long	time	and	every	name	exists
several	times.	Hence,	it	is	worthwhile	to	use	state	by	state.	If	a	USA	state	file	is	selected	for	doing	a	search,	you	must	select	this	option.
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The	city	attribute	is	used	for	the	search.
5.	 GNS	Geonet	country	file,	city	search:	use	the	city	attribute	to	search	in	a	GNS	file	(slower	than	GeoNames	search!).
6.	 GNS	Geonet	country	file,	title	begin	search:	use	the	start	of	the	title	of	a	place	to	search	in	a	GNS	file.	With	start	everything	appearing
before	the	first	comma	is	meant.

2.	 A	second	option	is	to	parse	some	existing	data	in	your	places.
1.	 You	can	parse	the	title	attribute	to	extract	information	from	it.	Eg	a	title	like	Albany,	NY	can	be	used	to	set	the	city	attribute	to	Albany
and	the	state	attribute	to	NY.

2.	 You	can	set	the	title	of	all	the	selected	places	to	a	uniform	way.	This	is	interesting	if	due	to	imports	you	have	different	styles	for	the	title
field,	which	can	be	annoying	in	reports.	At	the	moment	there	are	two	options:
1.	 Set	title	field	to	City[,	State]:	This	means	the	title	of	your	places	will	contain	the	city,	and	if	the	state	field	is	present,	the	state	will
be	appended	with	a	comma.

2.	 Set	title	field	to	Titlestart[,	City][,	State]:	This	means	the	present	start	of	your	title	will	be	kept.	If	this	start	is	not	the	city,	then
the	city	will	be	appended.	If	state	is	present,	also	state	will	be	appended.	An	example:	suppose	your	title	is	Piazza	Navona,	Italy,
the	city	is	Rome	and	the	State	is	Lazio.	Using	this	option	to	set	the	title	would	change	the	title	attribute	into	Piazza	Navona,
Rome,	Lazio.

3.	 Convert	latitude	and	longitude	to	a	uniform	way.	Again	due	to	import,	copy/paste,	you	might	have	latitude	and	longitude	entered	in
different	formats.	This	is	annoying	on	reports.	This	options	allows	you	to	set	for	all	selected	places	the	lat/lon	to	one	form.	The	options
are:
1.	 All	in	degree	notation:	use	the	classical	degree	notation	with	degree,	minutes	and	seconds.
2.	 All	in	decimal	notation:	use	the	decimal	system	to	denote	lat/lon.
3.	 Correct	-50°	in	50°S:	a	much	seen	error	is	to	use	-	for	the	classical	degree	notation,	which	is	wrong,	and	which	Gramps	will	not
be	able	to	interpret.	With	this	option	this	error	is	looked	for	and	corrected.

Part	3.	Overview	of	the	results

After	having	entered	all	data	in	Part	1	and	2,	you	click	find	for	Gramps	to	search	all	changes	that	will	occur.	This	part	of	the	dialog	shows	all
changes	that	will	occur.

All	selected	places	are	shown.	If	changes	will	be	done	all	changes	are	listed	as	subentries	of	the	place.	Every	change	will	be	a	subentry.

If	the	change	will	overwrite	an	existing	entry,	the	subentry	is	shown	in	orange.

Warning

TO	AVOID	PROBLEMS,	GO	OVER	ALL	CHANGES	QUICKLY,	AND	CHECK	ALL	ENTRIES	IN
ORANGE!

The	following	actions	are	possible	in	the	result	screen:

1.	 press	delete	to	delete	the	entry,	making	sure	that	this	change	will	not	occur.	You	can	delete	the	entry	to	delete	all	changes,	or	select	one
subentry,	to	only	delete	that	specific	chagne

2.	 double-click	on	an	entry	to	open	the	place	dialog.	If	you	double-click	on	the	entry,	all	changes	will	be	preentered.	If	you	double-click	on	a
subentry,	only	this	specific	change	will	be	preentered	in	the	place	dialog.

3.	 press	tab	to	open	in	a	browser	window	google	maps.	Pressing	tab	on	a	subentry	showing	a	new	lat/lon	entry	will	open	google	maps	on	this
new	lat/lon	position.	Pressing	tab	on	the	top	place	entry	will	give	open	google	maps	with	the	old	lat/lon	position,	or	if	that	is	not	known	the
title/city	field	is	used	for	the	search.

Part	4.	Actions

After	you	have	checked	the	changes	in	Part	3,	you	can	apply	them	by	clicking	the	 Apply 	button.

Selecting	 Help 	will	bring	you	to	this	page,	clicking	 Close 	will	close	the	Place	completion	tool	window	and	clicking	{{man	button|Google
Maps}	when	an	entry	is	selected	in	the	results	field	has	the	same	effect	as	pressing	tab	on	an	entry	(see	above).

Example
Open	the	example	file	from	the	examples	where	latitude	and	longitude	are	empty:	example.gramps.

We	will	now	show	how	the	places	in	this	file	can	be	completed.	The	best	thing	to	do	is	to	create	a	new	Family	Tree,	give	it	a	name,	and	import	the
example.gramps	file.	This	file	has	852	places,	which	would	mean	a	lot	of	manual	edits	if	you	do	not	use	this	tool!

Now,	open	the	place	view.	You	will	see	all	places	are	of	the	form:

Aberdeen,	WA
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This	value	is	the	Place	Name	attribute	(the	title	or	description	of	the	place).

Step	1:	City	and	State	data

Our	first	step	will	be	to	split	this	field	into	a	City	value	(here	Aberdeen),	and	a	State	value	(here	WA).

We	open	the	Place	completion	tool:

Here	we	have	selected	 All	Places ,	and	we	Change	the	title	into	as	 City	[,State] .	Click	on	 Find ,	quickly	scan	the	data	if	all	looks	ok,
and	then	click	on	 Apply .	You	are	notified	that	443	place	records	were	modified.	This	is	one	less	that	the	number	of	places.	Indeed,	one	place
does	have	a	different	type	of	title:	Puerto	Rico	has	no	state	information.

Step	2:	Look-up	latitude	and	longitude

We	have	downloaded	the	GeoNames	datafiles	for	the	USA	states,	and	will	now	use	that	to	complete	the	latitude	and	longitude	of	the	data.	At	the
same	time,	this	will	fill	up	the	county	field.

In	the	screenshot,	you	see	we	have	selected	All	Places	with	State=AK.	In	the	second	part	of	the	window	we	give	that	we	want	to	search	in	the
AK_DECI.txt	file	downloaded	from	GeoNames,	using	the	parsing	method:	GeoNames	USA	state	file,	city	search.	
Note	that	if	you	want	to	change	AK	into	Alaska,	this	would	be	possible.	Just	set	state=Alaska	in	the	set	attributes	section	of	the	window.
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Do	this	now	for	all	the	states.	Always	check	for	doubles.	Eg,	for	state	 AL,	going	over	the	changes,	we	encounter:

We	see	that	the	first	time	'Enterprise'	if	found,	it	is	in	county	Coffee	in	lat/lon:31.31/-85.85.	The	second	hit	is	for	county	Chilton	with	lat/lon:32.73/-
86.62.

You	can	now	use	the	Google	Maps	button	(or	press	TAB	key)	while	the	lat/lon	subentry	is	selected	to	see	where	this	city	is	in	both	cases.	From	this
it	will	be	clear	for	example	that	one	is	a	hamlet,	not	really	a	city,	while	the	first	is	a	real	city.	So	now,	select	the	second	lat/lon	entry,	and	delete	it	by
pressing	the	DEL	key.	Do	the	same	for	the	second	county	entry.

In	case	google	maps	did	not	allow	you	to	determine	which	is	the	correct	city,	you	can	double	click	on	the	city	to	open	the	Place	Dialog	(Warning:
this	will	preenter	the	data	of	the	Place	Completion	tool.	So	hit	cancel	here	if	you	want	to	exit	without	these	changes	done).	In	this	dialog	the
references	tab	allows	you	to	navigate	to	all	events	coupled	to	this	place.	This	will	give	you	extra	information	you	might	use	to	decide	which	of	the
two	found	places	is	the	correct	place.

Step	3:	Problem	entries

While	updating	all	places	in	step	2,	you	will	have	noticed	some	errors	in	the	state	information:	Some	places	have	a	dubious	state:	eg	OH-AL

You	can	obtain	these	states	by	choosing	All	Places	en	setting	the	state	search	box	to	-.	Clicking	Find	will	give	you	all	these	problem	places.	You
can	use	google	maps	or	the	place	dialog	to	sort	them	out.	You	can	also	use	the	USA	country	GeoNames	file	to	search	these	places	in	the	entire	USA.

Note:

You	will	need	sufficient	memory	for	this,	or	you	will	obtain	a	MemoryError	(see	below)!

Step	4:	Lat/Lon	not	found

After	the	above,	still	some	45	places	have	no	latitude/longitude	found.	You	can	now	select	these	places	by	setting	the	Place	filter	to	'No
Latitude/Longitude',	which	will	find	you	all	places	with	no	coordinates.

It	will	be	clear	that	many	of	those	can	be	quickly	corrected:	abbreviations,	eg	the	city	field	contains	St.George,	which	should	be	Saint	George;
double	names,	eg	Waterloo-Cedar	Falls,	IA	means	Waterloo	near	Cedar	Falls,	changing	the	city	to	Waterloo	and	redoing	the	search	using	Google
Maps	will	allow	to	quickly	find	which	coordinates	for	Waterloo	are	needed.

Advanced	usage
This	is	for	advanced	users	who	know	how	to	use	regular	expressions.

The	parsing	fields	have	entry	fields	allowing	you	to	give	your	own	parsing.	Parsing	uses	regular	expressions.	You	can	use	this	to	parse	your	title,
and	to	parse	a	lat/lon	file	in	your	own	way.	For	reference,	here	an	overview	of	the	parsing	codes	used	for	the	predefined	parses:

Parse	title	details

In	'Parsing	and	Conversion	of	existing	title	or	position',	'Parse	title'	and	'Change	title	into'	provide	some	pre-defined	options	for	extracting	location
values	from	a	Place	Title.	Otherwise	regex	parsing	is	needed.

Write	your	regex	in	'Parse	title:'.Click	on	'Find',	which	shows	the	proposed	changes.	Then	click	'Apply'.

Example	1

For	France,	some	practical	rules	could	be	useful	for	seizing	place.	It	needs	:

the	city	name	+	INSEE	code	(at	option).	This	code	is	unique	and	can	identify	with	certainty	a	common	(with	the	county,	district,	township
and	municipality).	It	can	identify	with	a	common	insurance	even	if	it	has	changed	its	name.	This	code	is	used	in	Archives.	Using	postal	code
is	not	advisable	...
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a	subdivision:	identifies	a	parish	or	a	place	called	within	a	municipality

the	state	(at	option)	or	county	but	is	already	on	INSEE	code

the	country	(at	option).	Ideally	it	should	still	take	the	country.	It	is	understandable	that	this	is	tedious.	Maybe	do	not	enter	the	country	if	the
genealogy	is	mostly	of	one	country	and	seize	enter	the	country	for	events	outside	the	country's	main.	Everyone	will	appreciate.

e.g.	Avignon,84000,Vaucluse,Provence-Cote-d'Azur,FRANCE,

where	some	fields	may	be	missing:

e.g.	Woerth,,,Alsace,FRANCE,

the	regex:

\s*(?P<city>[^,]+)[,]\s*(?P<zip>\d*)[,](?P<county>[^,]*)[,](?P<state>[^,]*)[,](?P<country>[^,]*)[,]*$

treating	the	comma	character	as	an	end-of-string	delimiter,	will	distribute	Avignon	to	City,	84000	to	ZIP,	Vaucluse	to	County,	Province-Cote-d'Azur
to	State	and	France	to	Country

and	in	the	case	of	missing	fields,	as	long	as	the	first	is	not	empty,	will	distribute	Woerth	to	City,	Alsace	to	State	and	FRANCE	to	Country.

It	allows	initial	whitespace	and	an	optional	comma	after	the	Country

Example	2

In	many	16th	and	17th	century	English	IGI	records	the	situation	is	more	complicated.

The	Place	Title	takes	the	form	of	3	strings	(Town,	County,	Country)	or	4	strings	(Parish,	District,	County,	Country)	for	example:

(a)	Chester	le	Street,	Durham,	England	-	3-string

(b)	Of	Middleton-in-Teesdale,	Durham,	England	-	3-string

(c)	Bishoply,Stanhope,	Durham,	England	-	4-string

(d)	Of	St.	Margaret's,	Stanhope,	Durham,	England	-	4-string

For	the	3-string	record	the	following	regex,	treating	the	comma	character	as	an	end-of-string	delimiter,	will	distribute	the	3	strings	correctly	to	City,
County,	Country	locations,	leaving	4-string	records	untouched.

Regex	A:

\s*(Of[,]*\s*)*(?P<city>[^,]+?)[,]\s*(?P<county>[^,]+?)[,]\s*((?P<country>[^,]+?)){1,1}$

For	4-string	records	the	following	regex	will	distribute	the	4	strings	correctly	to	Parish,	City,	County,	Country	locations,	leaving	3-string	records
untouched.

Regex	B:

\s*(Of[,]*\s*)*(?P<parish>[^,]+?)[,]\s*(?P<city>[^,]+?)[,]\s*(?P<county>[^,]+?)[,]\s*((?P<country>[^,]+?)){1,1}$

"Bogus"	4-string	records:	a	not	uncommon	error	in	these	old	records	is	for	'Of'	to	be	followed	by	a	comma,	e.g.

(e)	Of,	Houghton-le-Spring,	Durham,	England

Regex	A	will	parse	3-string	records	correctly	and	Regex	B	4-string	records.	However	Regex	B	will	attempt	to	treat	a	3-string	record	with	'Of,'	as	if	it
were	a	4-string	record.	This	would	give	the	3-string	record	a	non-existent	Parish	called	"Of"	!

To	avoid	this,	when	using	Regex	B	click	on	'Find'	to	display	the	records	proposed	for	change	and	delete	all	the	3-string	'Of,'	records	before	clicking
'Apply'.

take	care	when	pasting	a	Regex	(for	example,	after	testing	in	a	regex	editor)	into	the
Parse	title	details	field.	Pasting	adds	redundant	spaces	before	or	after	the	Regex	that	will
prevent	it	working	properly	in	the	Place	Completion	Tool

The	predefined	regex	expressions	are	as	follows,	where	for	brevity	we	use	some	variables	defined	lower.

Regex	Help

For	those	new	to	Python	and	Regex	please	review	the	HOWTO	here:
http://docs.python.org/dev/howto/regex.html

1.	 "City	[,|.]	State"	is	parsed	by	:	r'\s*(?P<'+city_translated	+r'>.+?)\s*[.,]\s*(?P<'+state_translated	+r'>.+?)\s*$'
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2.	 "City	[,|.]	Country"	is	parsed	by	:	r'\s*(?P<'+city_translated	+r'>.+?)\s*[.,]\s*(?P<'+country_translated	+r'>.+?)\s*$'
3.	 "City	(Country)"	is	parsed	by	:	r'\s*(?P<'+city_translated	+r'>.*?)\s*\(\s*(?P<'+country_translated	+r'>[^\)]+)\s*\)\s*$'
4.	 "City"	is	parsed	by	:	r'\s*(?P<'+city_translated	+r'>.*?)\s*$'

Here	the	variables	used	are:

lat_translated	=	_('lat')
lon_translated	=	_('lon')
city_translated	=	_('city')
county_translated	=	_('county')
state_translated	=	_('state')
country_translated	=	_('country')

You	can	use	one	of	these	variables	as	a	group,	and	the	tool	will	recognise	them,	and	use	as	values	for	the	corresponding	place	attributes.

Lat/Lon	lookup	parsing

For	the	regex	of	lat/lon	lookup,	you	need	to	indicate	which	data	must	be	replaced	with	existing	place	attributes	for	the	search,	as	well	as	indicate
which	regex	groups	must	be	extracted.

1.	 "GeoNames	country	file,	city	search"	is	parsed	with:	r'\t'+CITY_transl	+r'\t[^\t]*\t[^\t]*\t'	+latgr	+	r'[\d+-][^\t]*)\t'	+
longr	+	r'[\d+-][^\t]*)\tP'

2.	 "GeoNames	country	file,	city	localized	variants	search"	is	parsed	with:	r'[\t,]'+CITY_transl+r'[,\t][^\t\d]*\t?'	+latgr	+	r'[\d+-]
[^\t]*)\t'	+	longr	+	r'[\d+-][^\t]*)\tP'

3.	 "GeoNames	country	file,	title	begin,	general	search"	is	parsed	with:	r'\t'+TITLEBEGIN_transl	+r'\t[^\t]*\t[^\t]*\t'	+latgr	+
r'[\d+-][^\t]*)\t'	+	longr	+	r'[\d+-][^\t]*)\t[PSTV]'

4.	 "GeoNames	USA	state	file,	city	search"	is	parsed	with:	r'\t'+CITY_transl+r'\tPopulated	Place\t[^\t]*\t[^\t]*\t'	+	countygr	+
r'[^\t]*)'	+	r'\t[^\t]*\t[^\t]*\t[^\t]*\t'	+latgr	+	r'[\d+-][^\t]*)\t'	+	longr	+	r'[\d+-][^\t]*)'

5.	 "GNS	Geonet	country	file,	city	search"	is	parsed	with:	r'\t'+latgr+r'[\d+-][^\t]*)\t'+longr+r'[\d+-][^\t]*)'	+
r'\t[^\t]*\t[^\t]*\t[^\t]*\t[^\t]*\tP\t[^\t]*\t[^\t]*'	+	r'\t[^\t]*\t[^\t]*\t[^\t]*\t[^\t]*\t[^\t]*\t[^\t]*\t[^\t]*'
r'\t[^\t]*\t[^\t]*\t[^\t]*'	+	r'\t'+CITY_transl+r'\t[^\t]*\t[^\t\n]+$'

6.	 "GNS	Geonet	country	file,	title	begin	search"	is	parsed	with:	r'\t'+latgr+r'[\d+-][^\t]*)\t'+longr+r'[\d+-][^\t]*)'+
r'\t[^\t]*\t[^\t]*\t[^\t]*\t[^\t]*\t[PLSTV]\t[^\t]*\t[^\t]*'+
r'\t[^\t]*\t[^\t]*\t[^\t]*\t[^\t]*\t[^\t]*\t[^\t]*\t[^\t]*'	+	r'\t[^\t]*\t[^\t]*\t[^\t]*'	+
r'\t'+TITLEBEGIN_transl+r'\t[^\t]*\t[^\t\n]+$'

7.	 Read	of	mediawiki	CSV	dump.	This	reads	the	files	on	 [1](link	gone)	(for	more	information,	see
http://meta.wikimedia.org/wiki/WikiProjects_Geographical_coordinates)	(Contribution	by	nomeata)

For	extraction	of	data	you	can	use	the	same	groupnames	as	in	title	parsing,	so	eg	latgr	in	above	should	read:	r'(?P<'+lat_translated	+r'>'	.

The	syntax	for	the	values	that	need	to	be	used	for	searching	in	the	file,	eg	CITY_transl,	is	given	by	:	_('CITY').	You	can	use	as	substitution	values:
_('CITY'),	_('TITLE'),	_('TITLEBEGIN'),	_('STATE'),	_('PARISH').

The	tool	will	read	in	the	given	regex,	replace	the	substitution	strings	by	the	values	in	the	place	object,	do	the	search,	and	extract	the	regex	groups
given	from	the	result.

Resource:	GEOnet	Names	Server

Troubleshooting

Non	UTF-8	latitude/longitude	file

The	place	completion	tool	expects	the	input	files	for	location	lookup	to	be	in	unicode	(utf-8).	On	the	occasion	this	is	not	the	case,	you	will	get	the
error:

File	"/home/benny/programms/gramps/gramps2/src/plugins/PlaceCompletion.py",	line	851,	in	load_latlon_file
				self.latlonfile_datastr	=	infile.read()
		File	"/usr/lib/python2.4/codecs.py",	line	481,	in	read
				return	self.reader.read(size)
		File	"/usr/lib/python2.4/codecs.py",	line	293,	in	read
				newchars,	decodedbytes	=	self.decode(data,	self.errors)
	UnicodeDecodeError:	'utf8'	codec	can't	decode	bytes	in	position	1610092-1610094:	invalid	data

Note	that	the	Place	Completion	tool	catches	these	errors	and	shows	you	an	information	box.	After	this,	the	tool	will	attempt	to	read	the	file	with	utf-
8	(unicode),	ignoring	errors.	This	might	give	good	results,	but	will	of	course	fail	to	produce	results	on	non-unicode	encoded	files.

In	the	above	example	it	is	clear	the	problem	is	in	two	bytes,	so	you	can	correct	this	manually:	open	the	file	with	eg	KHexEdit	Binary	Editor,	go	to
the	specified	position	(offset	1610092),	and	change	the	two	bytes	with	a	space.

In	the	case	the	file	is	completely	non-unicode,	you	will	have	to	convert	it	to	unicode	with	a	tool,	before	using	it	in	the	placecompletion	tool.

Memory	Error

The	tool	might	fail	with	the	error:

self.latlonfile_datastr	=	infile.read()
		File	"/usr/lib/python2.4/codecs.py",	line	481,	in	read
				return	self.reader.read(size)
		File	"/usr/lib/python2.4/codecs.py",	line	293,	in	read
				newchars,	decodedbytes	=	self.decode(data,	self.errors)
	MemoryError

The	tool	has	to	load	the	datafile	for	latitude/longitude	searching	into	memory.	For	large	files	like	USA.txt,	this	might	be	impossible	if	you	have
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limited	memory.	You	can	try	to	close	as	many	programs	running	at	together	with	Gramps,	and	try	the	tool	again.

See	also
Addon:GetGOV	-	download	place	information	from	the	GOV	gazetteer.
Addon:GeoName	-	downloads	place	information	from	the	GeoNames	gazetteer.

GeoCodes

Design	specification

See	Place	completion	tool	specification

Place/Location	is	a	newer	concept	in	Gramps.	Many	older	databases	only	have	a	Place	title	field	which	is	a	descriptive	text	containing	city,	state,
country.	To	distribute	these	values	into	the	correct	attribute	fields,	see	Parse	Title	Details	below

Download
If	you	use	Gramps	5.0	,	then	use	the	automatic	installation.
If	you	use	Gramps	4.2	,	then	use	the	automatic	installation.
If	you	use	Gramps	4.1	,	then	use	the	automatic	installation.
If	you	use	Gramps	3.4	,	then	use	the	automatic	installation.
If	you	use	Gramps	3.3	,	then	use	the	automatic	installation.
If	you	use	Gramps	3.2	,	then	use	the	automatic	installation.

Manual	install

For	the	following	older	versions	of	Gramps	you	will	need	to	do	a	Manual	install	of	the	files.

Extract	the	three	files	that	are	in	the	download.	Put	the	.glade	and	.py	files	in	the	plugins	directory.	For	linux:

local	install:	place	in	~/.gramps/plugins

If	you	still	use	Gramps	3.1.x,	then	you	will	need	version	1.2	of	the	Place	Completion	Tool.	You	can	find	it	at	 placecompletion_1_2.tar.gz.

If	you	still	use	Gramps	3.0.x,	then	you	will	need	version	1.1	of	the	Place	Completion	Tool.	You	find	it	at	 placecompletion_1_1.tar.gz.

If	you	still	use	Gramps	2.2.5+,	then	you	will	need	version	1.0	of	the	Place	Completion	Tool.	You	find	it	at	 placecompletion_1_0.tar.gz.

Issues
None	of	the	Actions	in	the	tool	work	for	Apple	Mac	10004	in	4.2	release.	This	is	fixed	in	5.x	release.
For	Gramps	5.x	series	please	see	notes	here

The	most	concerning	is	that	this	tool	is	quite	outdated	in	our	current	place	structure	(for	Gramps	5.x).	While	it	works,	the	title	change
capability	is	of	little	utility	for	those	users	who	use	the	automatic	place	title	function.	The	new	place	hierarchy	largely	eliminates	the
need	for	this	tool.	Information	is	no	longer	duplicated,	so	we	no	longer	get	inconsistencies	which	need	fixing.	Also	changes	to	all	titles
lower	in	the	hierarchy	can	now	be	made	by	changing	the	name	of	a	single	place.
The	whole	tool	is	useless	unless	the	user	has	already	manually	enclosed	his	places.(for	Gramps	5.x)
The	user	can	still	use	it	for	Lat/Long	creation	and	update.(for	Gramps	5.x)

Maybe	replace	GoogleMaps	button	(eg,	http://open.mapquestapi.com/nominatim/)
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5.2	Addons

Plugin	Manager

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Warning	this	Replaces	the	standard	built-in	original	 Plugin	Manager

If	you	want	to	return	to	the	original	plugin	manager,	use	Plugin	Manager	Enhanced	to	uninstall	itself,
listed	as	"Plugin	Manager	Enhanced".

Plugin	Manager	Enhanced	-	showing	example	Addons	listing

The	 Plugin	Manager	Enhanced 	addon	provides	a	single	unified	dialog	that	combines	the	Registered	and	Loaded	plugins	with	all	the	available
3rd	party	plugins	replacing	the	original	plugin	manager

Usage

Replaces	the	built-in	"Help	>
Plugin	Manager"

Accessed	by	using	the	standard	menu	Help->Plugin	Manager.

Request	to	retrieve	the	current	3rd	party	addons	list	to	initialise	the
addon

The	first	time	you	use	the	addon,	it	will	request	permission	to	connect	to	the	internet	and	retrieve	the	current	3rd	party	addons	list	select	the	 Yes
button	to	confirm.

Features
Single	unified	dialog	combining	Registered	and	Loaded	plugins	with	all	the	available	3rd	party	plugin	addons.
Status	column	indicates	status	of	Addon,	Available,	Installed,	Built-in,	Update	Available,	and	hidden	(via	strike-through).	A	Failed	addon	also
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displays	'Failed'	status	in	red.
All	of	Available,	Installed,	and	Built-in	plugins	can	be	hidden	from	the	dialog	list,	and	if	installed,	hidden	from	the	normal	user	interface.
A	"Show	hidden	items"	checkbox	allows	the	user	to	see	addons	that	have	been	hidden.
A	"Show	built-in	items"	checkbox	allows	the	user	to	see	built-in	addons	if	desired.
'Available'	and	'Update	Available'	addons	can	be	installed	from	Addons	pane,	the	"Install"	button	becomes	active	when	this	is	possible.
Installed	addons	can	be	un-installed	from	Addons	pane;	the	"Uninstall"	appears	when	this	is	possible.
Info 	button	provides	information	on	all	addon	types;	includes	'Loaded'	and	failure	type	and	stack	traceback,	when	applicable.
In	'debug'	mode,	the	 Reload ,	 Load ,	and	 Edit 	buttons	appear;	load	and	edit	are	greyed	out	when	addon	is	not	installed.
After	updates	of	View	mode	plugins	or	Gramplets,	or	uninstalls,	the	user	is	reminded	to	restart	Gramps.
The	 Check	for	updated	addons	now 	button	will	refresh	the	list	of	addons	from	the	Gramps	repository	on	the	internet,	so	that	updates
and	new	addons	will	be	listed.	The	usual	Edit/Preferences	settings	for	updates	will	also	refresh	the	list.
A	Search	box	is	available	which	will	filter	the	dialog	to	only	those	addons	which	have	a	row	or	filename	which	include	all	the	search	terms.

Technical	details
The	 Plugin	Manager	Enhanced 	addon	uses	the	the	plugin	system	to	replace	the	original	plugin	manager.	It	installs	itself	as	a	"Plugin	lib"	early
in	the	Gramps	startup	sequence.	It	patches	itself	into	the	Gramps	Help	Menu	and	into	the	Addons	update	routine	so	that	any	addon	update,	via	its
own	button,	or	the	Edit->Preferences	General	tab	Third	party	addons	management	sections	 Check	for	updates 	button,	or	automatic	 Check
for	addon	updates: 	as	configured	in	the	same	section.
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5.2	Addons

PostgreSQL

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

For	Experts	only!

Gramps	is	not	designed	to	be	used	by	multiple	users	at	the	same	time.	While	using	a	PostgreSQL	server
remotely	allows	multiple	users	to	connect	to	a	db,	doing	so	simultaneously	WILL	cause	database
corruption	and	loss	of	data.	If	you	chose	to	set	up	for	multiple	user	access,	please	backup	frequently,	and
set	up	a	system	of	your	own	to	make	sure	that	only	one	person	is	using	Gramps	at	one	time.	Gramps	or
the	family	tree	MUST	be	closed	before	allowing	another	user	to	access	the	database.

Be	sure	to	backup	your	Family	Trees	frequently.

The	 PostgreSQL 	addon	provides	PostgreSQL	database	support	for	Gramps	5.x	or	greater.

PostgreSQL	is	a	powerful	open	source	relational	database	frequently	used	to	create,	read,	update	and	delete	Python	web	application	data.	Psycopg2
is	a	PostgreSQL	database	driver	that	serves	as	a	Python	client	for	access	to	the	PostgreSQL	server.

This	following	explains	how	to	install	and	use	PostgreSQL	on	Ubuntu.

Prerequisites

Note	these	instruction	assume	you	are	using	Linux	or	development	environment.

As	the	Gramps	AIO	&	MacOS	installers	do	not	come	with	the	Prerequisites	and	can	not	be	installed
easily.	see	10491

Install	the	following	packages:

	sudo	apt-get	install	postgresql	libpq-dev	postgresql-client	postgresql-client-common

Then	install	Psycopg	(the	PostgreSQL	adapter	for	the	Python	programming	language.	Which	fully	implements	the	Python	DB	API	2.0
specifications.)	on	Ubuntu	either	using:

	sudo	apt-get	install	python3-psycopg2

or	if	that	does	not	work	install	from	you	can	install	from	pip	using:

	sudo	apt	install	libpq-dev	python3-dev	python3-pip

and	then

	pip3	install	psycopg2

Setting	up	a	user	and	db
We	now	have	PostgreSQL	installed	and	the	PostgreSQL	service	is	running	in	the	background.	However,	we	need	to	create	a	user	and	a	database
instance	to	really	start	using	it.	Use	the	sudo	command	to	switch	to	the	new	"postgres"	account.

	sudo	-i	-u	postgres

Within	the	"postgres"	account,	create	a	user	from	the	command	line	with	the	createuser	command.	PostgreSQL	will	prompt	you	with	several
questions.	Answer	"n"	to	superuser	and	"y"	to	the	other	questions.

	createuser	yourname	-P	--interactive

Creating	a	database	for	Gramps	to	use
Create	a	new	database	for	your	family	tree.	You	can	name	it	"Family	Tree	1"	or	whatever	you	want.

	createdb	"Family	Tree	1"
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Now	we	can	interact	with	Gramps.

Using	PostgreSQL	on	Gramps

Menu:	Edit>Preferences...	-	"Family	Tree"	-	tab	-	example	-	defaults

Make	sure	that	you	have	installed	your	PostgreSQL	Addon.

In	Gramps	select	Edit	>	Preferences	from	the	menu	and	then	select	the	 Family	Tree 	tab,	select	the	 PostgreSQL 	entry	for	 Database
backend: .	That	should	allow	you	to	enter	the	 Host 	and	 Port 	settings.	If	you	have	the	PostgreSQL	server	installed	on	the	same	machine	as
Gramps,	you	use	localhost	or	127.0.0.1	as	your	host	name.	If	you	are	using	a	remote	server,	use	that	server's	ip	address	or	name.	The	default
"port"	for	PostgreSQL	is	5432,	use	that	or	the	port	configured	for	your	PostgreSQL	server.

Use	the	Gramps	Family	Tree	Manager	to	create	a	new	tree,	it	must	have	the	same	name	as	the	one	you	created	on	the	server.

PostgreSQL	addon	-	login	-	dialog	-
example

When	you	try	to	load	a	family	tree,	you	be	be	shown	the	 Login 	dialog	where	you	can	enter	the	user	name	and	password,	these	are	the	same
values	used	in	the	createuser	command	above.

At	this	point,	you	should	be	able	to	use	Gramps	normally.

Remote	Server:	Configure	PostgreSQL	to	allow	remote	connection
By	default	PostgreSQL	is	configured	to	be	bound	to	“localhost”.	We	have	to	make	a	few	changes	on	the	remote	server	to	allow	remote	access.

$	netstat	-nlt
Proto	Recv-Q	Send-Q	Local	Address											Foreign	Address									State
tcp								0						0	0.0.0.0:443													0.0.0.0:*															LISTEN
tcp								0						0	127.0.0.1:11211									0.0.0.0:*															LISTEN
tcp								0						0	0.0.0.0:80														0.0.0.0:*															LISTEN
tcp								0						0	0.0.0.0:22														0.0.0.0:*															LISTEN
tcp								0						0	127.0.0.1:5432										0.0.0.0:*															LISTEN
tcp								0						0	127.0.0.1:3737										0.0.0.0:*															LISTEN
tcp6							0						0	:::22																			:::*																				LISTEN

As	we	can	see	above	port	5432	is	bound	to	127.0.0.1.	It	means	any	attempt	to	connect	to	the	postgresql	server	from	outside	the	machine	will	be
refused.	We	can	try	hitting	the	port	5432	by	using	telnet.

Configuring	postgresql.conf
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In	order	to	fix	this	issue	we	need	to	find	postgresql.conf.	On	my	Ubuntu	it	was	located	at	/etc/postgresql/9.5/main/postgresql.conf

Open	postgresql.conf	file	and	replace	line	listen_addresses	=	'localhost'	with	listen_addresses	=	'*'

Configuring	pg_hba.conf

The	system	also	is	configured	to	limit	remote	logons	for	specific	user(s).	In	order	to	fix	it,	open	pg_hba.conf	and	add	following	entry	at	the	very
end.	On	my	Ubuntu	it	was	located	at	/etc/postgresql/9.5/main/pg_hba.conf	host	all	all	0.0.0.0/0	md5	host	all	all		::/0	md5	Now
restart	postgresql	server.

	sudo	/etc/init.d/postgresql	start

and	use	netstat	to	see	if	we	are	set	up	for	remote	access.

	netstat	-nlt

Proto	Recv-Q	Send-Q	Local	Address											Foreign	Address									State
tcp								0						0	127.0.0.1:11211									0.0.0.0:*															LISTEN
tcp								0						0	0.0.0.0:80														0.0.0.0:*															LISTEN
tcp								0						0	0.0.0.0:22														0.0.0.0:*															LISTEN
tcp								0						0	0.0.0.0:5432												0.0.0.0:*															LISTEN
tcp								0						0	127.0.0.1:25												0.0.0.0:*															LISTEN
tcp								0						0	127.0.0.1:2812										0.0.0.0:*															LISTEN
tcp6							0						0	::1:11211															:::*																				LISTEN
tcp6							0						0	:::22																			:::*																				LISTEN
tcp6							0						0	:::5432																	:::*																				LISTEN
tcp6							0						0	::1:25																		:::*																				LISTEN

Here	we	can	see	that	“Local	Address”	for	port	5432	has	changed	to	0.0.0.0.

On	a	remote	machine	it	should	be	possible	to	set	up	Gramps	with	the	IP	address	or	hostname	of	the	PostgreSQL	server	and	the	port	number	(default
value	is	5432).

Debugging
You	may	find	the	/var/log/postgresql/postgresql-9.5-main.log	file	to	be	useful.

See	also
DB-API	Database	Backend
MongoDB

Issues
See	issues	attached	to	the	PostgreSQL	tag.
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5.2	Addons

Prerequisites	Checker	Gramplet

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

The	 Prerequisites	Checker 	Gramplet	is	a	Dashboard	diagnostic	tool	to	help	work	out	if	instances	of	Gramps	have	the	required	prerequisites
installed	as	well	as	the	latest	version	of	core	software.

Also	helps	in	OS's	like	Windows	(Microsoft)	and	macOS	(Apple)	where	it	is	less	common	for	users	to	start	programs	via	the	command	line
interface.	The	gramplet	is	a	GUI	alternative	to	getting	information	on	Gramps	via	the	gramps	-v	version	option	from	the	Command	Line!

Usage

Load	your	Family	Tree	and	then	select	an	empty	area	on	the	Dashboard	and	from	the	Add	a	gramplet	menu	select	 Prerequisites
Checker 	Gramplet.

You	may	use	the	context	menu	(right	click)	and	 Select	All 	to	copy	the	text	to	be	added	to	a	bug	report	if	requested	by	a	developer.

Once	you	have	finished	with	the	Prerequisites	Checker	Gramplet,	remove	it	from	the	Dashboard.	Otherwise,	it	slows	down	Gramps	by	refreshing
every	time	you	change	views!

Prerequisites
None.	This	gramplet	tests	for	the	presence	of	them.

Issues
See	and	raise	issues	using	the	PrerequisitesCheckerGramplet	tag.

Development	details

Created	2018	for	Gramps	5.0.x
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PR109	Add	new	PreRequisites	Checker	Gramplet

See	also
Expanded	descriptions	of	listed	prequisites	are	available	in	the	Gramps	README.md	on	GitHub:

requirements
strong	recommendations
optional	prerequisites

Wiki	articles	describing	Gramps	logging	of	diagnostics,	Warnings	and	errors:

"gramps	-v”	version	option	of	the	Command	Line
Error	and	Warning	reference	:	Status	bar	warnings
Debugging	Gramps
Logging	System
GEPS	request	#38:	Enhanced	Transaction	Log
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5.2	Addons

Python	Shell	Gramplet

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Python	Shell	Gramplet	-	Interactive	shell	example
output

The	 Python	Shell 	Gramplet	brings	up	an	interactive	Python	Shell	for	interpreting	python	expressions.

Options
You	can	type	most	any	(single	line)	Python	expression.

In	addition,	the	environment	has	been	populated	with	some	useful	variables,	including

self	-	(this	Python	gramplet)
Date	-	a	date	object	constructor,	that	can	be	used	for	date	arithmetic.
db	-	Interact	with	the	Database
dbstate	-	Information	about	the	Database
gc	-	the	Python	"garbage	collector"	preloaded	with	the	same	flags	as	the	Debug	Tool.
uistate	-	Interact	with	the	GUI

When	the	 Python	Shell 	Gramplet	is	detached	you	can	select	the	 Help 	button	to	see	this	page.

Usage
Output	of	print()	commands	issued	in	the	Python	Shell	will	be	directed	to	the	Gramps	console	window,	so	be	sure	to	keep	that	window	open.

Use	the	database	API	to	retrieve	objects	and	use	object	library	to	find	the	information	you	require.	If	you	want	to	write	GUI	code,	then	knowledge
of	Gtk3	is	also	required.

Examples

Dates

The	Date	entry	is	a	date	object	constructor,	and	can	be	used	for	date	arithmetic.	For	example,	you	might	be	interested	in	questions	like:

What	was	the	date	56	years	before	a	given	date:

>	Date(2007,	12,	31)	-	56
1951-12-31

How	old	was	someone	on	Sept	3,	1955	who	was	born	on	June	7,	1922:
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This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

>	Date(1955,	9,	3)	-	Date(1922,	5,	7)	33	years,	3	months

When	did	they	turn	21	years	old?

>	Date(1922,	5,	7)	+	21
1943-05-07

You	can	also	add	years,	months,	and	days:

>	Date(1980)	+	(0,	0,	25)
1980-01-26

You	can	convert	one	date	into	another	calendar,	which	returns	a	new	date	object:

>	Date(1703,	6,	1).to_calendar("hebrew")
5463-10-17	(Hebrew)

Displayers

Use	utility	code	to	make	things	easier.	For	example,	you	will	probably	want	to	use	the	name,	date	and	place	displayers	rather	than	formatting	the
data	yourself.	To	print	the	name	of	the	default	person,	use	the	following	code:

>	from	gramps.gen.display.name	import	displayer	as	nd
>	person	=	self.dbstate.db.get_default_person()
>	print(nd.display(person))

To	find	the	type	of	a	variable	use:

>	type(person)

Developers

Another	use	for	this	Gramplet	is	for	debugging.	This	gramplet	makes	a	nice	interface	to	the	running	Gramps	system.	You	can	inspect,	and	alter	the
system	by	entering	Python	commands.	As	a	simple	example,	you	can:

>	self.clear_text()					#	clear	the	text	in	this	window
>	self.set_wrap(False)		#	turn	word	wrap	off
>	self.set_wrap(True)			#	turn	word	wrap	on

The	Python	Gramplet	also	has	the	Python	"garbage	collector"	preloaded	with	the	same	flags	as	the	Debug	Tool.	To	use:

>	gc.collect()
23
>	gc.garbage[0]
<cell	at	0x9f9089c:	function	object	at	0x9f89dbc>
>	gc.get_referents(self)
[...]
>	gc.get_referrers(self)
[...]

You	can	use	the	Python	Shell	to	interact	with	people	from	your	database	and	test	Gramps	functions:

Gramps	3.x
	>	person	=	db.get_person_from_gramps_id("I01284")
	>	from	Utils	import	probably_alive
	>	probably_alive(person,	db,	Date(1776,	7,	4))

Gramps	4.x
	>	person	=	db.get_person_from_gramps_id("I01284")
	>	from	gen.utils.alive	import	probably_alive
	>	probably_alive(person,	db,	Date(1776,	7,	4))

Gramps	5.x
	>	person	=	db.get_person_from_gramps_id("I01284")
	>	from	gramps.gen.utils.alive	import	probably_alive
	>	probably_alive(person,	db,	Date(1776,	7,	4))

You	can	also	interact	with	the	GUI:

This	following	returns	the	Gtk	Frame	of	the	first	Gramplet	in	the	first	column.
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Gramps
3.x

	>	uistate.viewmanager.pages
	[<DataViews.GrampletView.GrampletView	instance	at	0xa0bd0ac>,	
		<DataViews.PersonView.PersonView	instance	at	0xa8f542c>,	
		<DataViews.RelationView.RelationshipView	instance	at	0xa8f562c>,	
		<DataViews.FamilyList.FamilyListView	instance	at	0xa8f5f8c>,	
		<DataViews.PedigreeView.PedigreeView	instance	at	0xa8fc5cc>,	
		<DataViews.EventView.EventView	instance	at	0xa8fc88c>,	
		<DataViews.SourceView.SourceView	instance	at	0xa8fcdcc>,	
		<DataViews.PlaceView.PlaceView	instance	at	0xa9070ec>,	
		<DataViews.MediaView.MediaView	instance	at	0xa9074ac>,	
		<DataViews.RepositoryView.RepositoryView	instance	at	0xa9077ac>,	
		<DataViews.NoteView.NoteView	instance	at	0xa907d8c>,	
		<DataViews.GeoView.GeoView	instance	at	0xa90d0cc>]
	>	uistate.viewmanager.pages[0]
	<DataViews.GrampletView.GrampletView	instance	at	0xa0bd0ac>
	>	uistate.viewmanager.pages[0].columns[0].get_children()[0].get_children()[0]

Gramps
4.x

Gramps
5.x

	>	uistate.viewmanager.pages[:]
	[<dashboardview.DashboardView	object	at	0x0000000008c9f4e0>,	<persontreeview.PersonTreeView	object	at	0x0000000000a05748>,	<relview.RelationshipView	object	at	0x000000000b1b6358>]

This	following	returns	a	reference	to	a	loaded	Gramplet	object	on	the	Event	view	-	useful	when	developing	Gramplets.	Note	that	the	Events	view
must	be	navigated	first,	as	main	views	are	lazy	loading	in	Gramps	4.

Gramps	4.x

>	evtview	=	uistate.viewmanager.pages[uistate.viewmanager.page_lookup.get((5,0))]
>	#	list	all	TabGramplet	objects	loaded	for	Events	view
>	[child.get_title()	for	child	in	evtview.bottombar.get_children()]
['Gallery',	'Citations',	'Notes',	'Attributes',	'References',	'Event	PlaceTitle	Compare	Gramplet']
>	#	get	a	reference	to	my	custom	Gramplet	object
>	eptcGramplet	=	evtview.bottombar.get_children()[5].pui

See	also
Python	Evaluation	window	(debug	tool)
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5.2	Addons

QueryGramplet

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Advanced	use	only

Manually	install	only.	The	contributor	has	marked	this	preliminary	addon	as	"partially	working	with
some	functionality,	but	much	more	work	is	needed;	needs	testing"

Back	up	your	family	tree	or	use	on	a	copy	only.

Query	Gramplet	-	default	prompt

The	 Query	Gramplet 	takes	SQL-like	queries	and	shows	the	results	in	a	Quick	View.

Usage
Once	installed	manually,	you	can	access	the	 Query	Gramplet :

On	the	Dashboard	by	right	clicking	and	selecting	 Query	Gramplet
Any	of	the	categories	by	adding	a	Gramplet	and	selecting	 Query 	from	the	drop	down	list.

Enter	your	SQL-like	Query	and	a	Quick	View	result	window	should	be	displayed.

Example	result

Examples
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The	 Query	Gramplet Q	in	Gramps	5.0	can	SELECT,	UPDATE,	and	DELETE.	Some	examples	(keywords	are	shown	capitalized,	but	the	SQL
parser	is	case-insensitive;	fields	that	are	capitalized	are	macros	and	must	be	capitalized,	see	below	for	more	information):

DELETE	FROM	person	WHERE	GIVEN	==	"Travis";

SELECT	*	FROM	person	LIMIT	10;

SELECT	gramps_id,	GIVEN,	SURNAME	FROM	person;

SELECT	event_ref_list[0].ref	FROM	person;

UPDATE	person	SET	GIVEN="Gary"	WHERE	GIVEN	==	"Travis";

SELECT	gramps_id	FROM	person	where	ROWNUM	<	10;

SELECT	gramps_id	FROM	person	LIMIT	5;

SELECT	gramps_id	FROM	person	LIMIT	20,30;

SELECT	gramps_id,	father_handle.SURNAME,	mother_handle.SURNAME	from	family;	

UPDATE	gramps_id	SET	tag_list	=	Tag("Betty")	FROM	person	WHERE	"Betty"	in	primary_name.first_name;

Hints:

You	may	want	to	do	a	general	SELECT	first	("SELECT	*	FROM	table")---	that	will	show	you	the	names	of	fields
The	query	will	automatically	outer-join	tables	(use	FLAT	to	not	join)
Assigning	to	a	list	will	append	onto	it
Use	Tag("name")	to	lookup	or	create	a	new	tag
Use	Date(year[,	month[,	day]])	to	create	a	date
Use	TODAY	for	a	date	create	for	today
You	have	access	to	these	libraries/functions:	_	(for	translations),	re,	random,	db	(database)

Other	options:

FLAT	-	do	not	create	extra	rows	via	a	JOIN
EXPAND	-	do	automatic	JOINs
RAW	-	no	extra	processing
NORAW	-	follow	handles,	etc

This	API	is	made	possible	through	the	generic	struct/json	interface.	It	is	very	little	code,	because	it	relies	on	these	generic	structures.	It	should	be
able	to	be	made	solid	enough	to	expose	to	users	(say	as	a	generic	filter).	The	parser	can	be	made	more	user	friendly...	it	may	just	throw	an	error
currently.

I'd	be	interested	in	any	limitations	you	find,	or	enhancement	ideas.

SQL
Here	is	the	grammar	for	the	subset	of	SQL	supported.	The	SELECT,	UPDATE,	DELETE,	and	LIMIT	clauses	may	be	in	any	order.	The	WHERE
clause	(if	used)	must	be	last.

SELECT	expr1	[as	var1][,	expr2	[as	var2],	...]	FROM	table	[LIMIT	number1[,	number2]]	[WHERE	expression];

UPDATE	table	SET	field1=expr1[,	field2=expr2,	...]	[LIMIT	number1[,	number2]]	[WHERE	expression];

DELETE	FROM	table	[LIMIT	number1[,	number2]]	[WHERE	expression];

...	[FLAT	|	EXPAND]	...

...	[RAW	|	NORAW]	...

table	is	one	of:

person
place
repository
event
citation
source
tag
media
family

Other	items:

expr	is	a	field,	*,	or	expression
var	is	an	alias
number1	by	itself	is	maximum	number	of	rows	to	select
number1	with	number2	is	start,	stop	(first	row	is	zero)
expression	is	any	valid	Python	expression

expression	and	expr	may	use:

random.random()	(or	other	random	method)
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ROWNUM	(zero-based	counter)
col[N]	(alias	to	column)
aliases
object	-	the	primitive	gen.lib	object	(such	as	Person,	Family,	etc)

RAW/NORAW:	does	not	turn	the	results	into	strings,	but	leaves	the	selected	values	as	raw	Python.	The	default	is	NORAW.	Once	set,	the	new
setting	will	remain	the	default	for	this	session.

FLAT/EXPAND:	if	FLAT,	then	the	rows	are	not	cross-product	JOINED	with	other	multi-valued	columns,	but	rather	left	as	LISTS.	Default	is
EXPAND.	Once	set,	the	new	setting	will	remain	the	default	for	this	session.

The	following	shortcuts	(also	called	"macros")	can	be	used	in	expressions	and	as	a	field:

SURNAME,	short	for	"primary_name.surname_list[0].surname"
GIVEN,	short	for	"primary_name.first_name"

A	macro	is	a	low-level	text	replacement	system.	We	could	add	other	macros,	and	even	allow	users	to	define	their	own.

Pre-Defined	Functions	and	Libraries

The	following	are	defined	for	use	in	your	queries:

Tag(name)	-	Create	or	lookup	a	tag	by	its	name
re	-	The	Python	regular	expression	library
random	-	The	Python	random	library
db	-	the	current	Gramps	database
sdb	-	Simple	Database	API	to	the	database
Today()	-	a	Gramps	Date	object	set	to	today's	date
Date()	-	creates	a	Gramps	Date	object
lib	-	to	access	gramps.gen.lib	object	definitions
_(text)	-	for	translations

Examples:

SELECT	gramps_id,	primary_name.surname_list.surname	
FROM	person	
WHERE	any([re.match("Sm.*th",	name)	for	name	in	col[1]]);

Searches	all	primary_name	surnames	to	find	names	that	start	with	"Sm"	and	end	in	"th".	col[1]	is	primary_name.surname_list.surname,	which	is	a
list	of	surnames.

UPDATE	person	SET	tag_list=Tag("Smith")	WHERE	SURNAME	==	"Smith";

Lists

When	a	attribute	is	a	list,	you	can	select	elements	from	items	in	the	list,	and	also	filter	the	list.	For	example,	consider	a	person's	parent_family_list.
You	can	select	only	a	single	component,	say	private,	of	the	parent	family	like:

SELECT	parent_family_list("private")	FROM	person;

This	would	select	only	the	private	component	from	the	parent	families.

Likewise,	you	can	filter	the	list	to,	say,	only	show	those	families	that	are	private:

SELECT	parent_family_list(private=True)	FROM	person;

This	will	only	show	(in	the	finally	selected	people)	the	parent	families	that	are	private.

Finally,	you	can	both	limit,	and	select	from	a	list:

SELECT	parent_family_list("gramps_id",	private=True)	FROM	person;

That	will	limit	the	list	to	be	a	list	of	family	gramps_id	for	private	families.

You	can	delete	an	entire	list	by	assigning	None	to	it:

UPDATE	note_list=None	from	person;

You	can	delete	an	item	in	a	list	by	assigning	None	to	it:

UPDATE	note_list[0]=None	from	person;

Notes
Some	notes	on	use:

1)	Most	SQL	clauses	(UPDATE	table,	FROM	table,	SELECT	...,	SET	field=value,	...,	LIMIT	...)	can	appear	in	any	position,	any	order

2)	...except	the	WHERE	clause:	it	must	be	last;	this	is	because	the	WHERE	clause	is	not	parsed,	because:

3)	The	WHERE	clause	uses	any	valid	Python	expressions.	It	imports	some	libraries	(such	as	random),	to	have	ready	possible	expression	needed.

SELECT	*	from	person	WHERE	random.random()	<	.1;
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This	selects	records	where	each	has	a	10%	chance	of	being	selected.

4)	The	SELECT	fields	use	the	bracketed	notation	for	list	references.	Use	"event_ref_list[0]".

5)	JOINS	are	not	necessary,	because	it	automatically	looks	up	all	relations	through	the	handles.	In	a	SELECT,	columns	with	multiple	values	in	a	list
will	appear	as	an	outer-join	with	other	values	in	the	row.

6)	UPDATE	will	work	on	any	field,	through	a	joined	object	or	on	the	primary	object.	For	example,	you	can	update	the	birth	date	of	an	event	through
the	person's	referenced	events.

7)	Tables	are	lowercase,	single	(not	plural)	form	(eg,	person,	tag,	event).

8)	Implemented	"LIMIT	number",	"LIMIT	start,	stop",	and	"WHERE	ROWNUM	<	number"	(ROWNUM	can	be	used	in	any	expression).

9)	Field	names	are	the	actual	names	of	the	fields	of	the	gramps.gen.lib	objects,	verbatim,	no	differences.	You	might	need	to	look	up	what	you	need...
no	help	yet	from	this	interface	(although	I	am	working	on	defining	a	built-in	Schema	that	could	help)

10)	.handle	or	.ref	automatically	look	up	their	references.

11)	Shortcut:	you	can	use	col[N]	in	the	WHERE	clause	to	reference	a	column	selected.	N	is	zero-based.

SELECT	gramps_id,	private	FROM	person	WHERE	not	col[1];

That	will	select	all	people	where	private	is	not	True.	That	would	include	None	(non-existent	record)	and	False	values.	To	select	only	False	values,
use:

SELECT	gramps_id,	private	FROM	person	WHERE	col[1]	==	False;

That	will	not	select	None	values.

12)	If	an	object	doesn't	match	any	selected	field,	it	just	doesn't	show.	For	example,	to	find	all	of	the	people	with	at	least	two	surnames	on	their
primary	name,	use:

SELECT	primary_name.surname_list[1]	FROM	person;

or

SELECT	gramps_id,	primary_name.surname_list[1]	FROM	person	WHERE	col[1];

13)	You	do	not	need	to	reference	a	field	before	you	can	use	it	in	the	WHERE	clause.

14)	The	semicolon	is	optional.

15)	Be	careful	selecting	all	fields	from	all	records...	that	could	take	up	a	lot	of	memory,	and	bring	down	Gramps.

16)	This	should	be	fairly	fast,	but	it	does	call	eval().	This	might	make	things	a	little	slower,	but	made	the	code	much	easier	to	write.	And	it	does	use
the	full	power	of	python.

17)	You	can	use	parentheses	in	an	"UPDATE	table	SET	field=value"	value.	Something	like:

UPDATE	table	SET	field=(field	+	1);

but	that	hasn't	been	well-tested.	(Speaking	of	testing,	there	is	a	Vassilii-inspired	unittest	with	the	QueryQuickview...	will	add	more	there).

18)	The	primary_name...	stuff	is	really	long	and	verbose.	See	"shortcuts"	above.

19)	Fields	that	contain	other	objects,	or	lists	of	objects,	will	show	as	dictionaries	and	lists	of	dictionaries.	You	can	refine	those	fields	by	further
specifying	subparts.	Maybe	we	should	not	show	these,	or	show	in	another	form...

20)	If	a	selected	field	does	not	exist	in	a	record,	then	it	will	have	a	value	of	None.	For	example,	if	you	are	selecting	those	people	that	have	a	second
surname	on	their	primary	name,	and	there	are	some	people	who	do	not	have	a	second	surname,	it	will	appear	as	None.	If	all	columns	are	None,	then
the	item	will	not	be	selected	at	all.

21)	If	you	know	that	only	one	value	will	match,	then	a	"LIMIT	1"	may	be	a	way	to	speed	up	the	query.

Older	documentation	for	the	QueryGramplet	in	Gramps	3.4
This	has	different	table	names	(people	rather	than	person),	and	other	names	that	are	different	(surname	vs	primary_name.surname_list[0].surname).
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SQL-like:

select	FIELDS	from	TABLE	where	PYTHON-BOOLEAN-EXPRESSION;

TABLES:	FIELDS:

1.	 people:	given_name,	surname,	suffix,	title,	birth_date,	death_date,	gender,	birth_place,	death_place,	change,	marker
2.	 families:
3.	 sources:
4.	 events:

Examples:

$	select	*	from	people	where	surname.startswith("Smith")

$	select	given_name,	surname	from	people;
	
$	select	*	from	sources;

$	select	*	from	events;

$	select	*	from	families;

Issues
11671	QueryGramplet:	Plugin	error	(from	'QueryQuickview'):	No	module	named	'gramps.gen.lib.handle'

See	also:
Original	announcement	about	"Query	Gramplet"	from	developer	"Doug	Blank"(2013)

(Gramps-devel)	SQL-like	API	for	Gramps	gen.lib,	From:	Doug	Blank	-	2013-12-24	16:22:09
Which	mentions	feature	request	6513	tool	option	needed	to	edit	database

GRAMPS	-	Dev	-	query.py	2009

Because	Documentation	about	data	structures	becomes	quickly	outdated,	the	following	cross-references	have	a	parenthetical	notation	of	the	vintage
-	plus	the	most	recent	major	revision.

Gramps	Data	Model	(v4.1)	-	version	4.1	data	diagram	(2014)
GEPS	032:	Database	Backend	API	(proposed	2013,	implemented	2015)
GEPS	010:	SQL	Backend/Relational	Backend	(proposed	2008,	superseded	2013)
SQLite	Export	Import	-	a	third	party	addon	which	expands	the	Family	Trees	➡	Import…/Export…	menu	options	(2009,	revised	2019)
Gramps	SQL	Database	-	documents	the	format	of	a	SQL	database	version	of	the	Gramps	BSDDB	datastore.	(2009,	revised	2015)
SQL	Schema	-	(2016)
Pickle	Python	Tutorial	-	not	specific	to	Gramps	(2018)
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5.2	Addons

Quilt	Chart

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

The	larger	the	number	of	people	in	the	Family	Tree

The	longer	the	chart	will	take	to	appear.

The	 Quilt	View 	Chart	is	an	interactive	 	 Charts 	category	view	addon	that	presents	your	family	tree	in	the	form	of	a	grid.	Quilts	allow	the
visualization	of	large	genealogies	up	to	several	thousand	individuals,	by	using	a	diagonally-filled	matrix,	where	rows	are	individuals	and	columns
are	nuclear	families.

Quilt	Chart	view

Usage

From	the	 	 Charts 	category	view	select	the	Quilt	Chart	icon	or	select	View	>	Quilt	Chart	from	the	menu.

Available	actions

Move	the	mouse	hover	people

If	the	"Center	the	selected	person"	is	not	selected,	one	path	is	drawn	for	the	person	below	the	mouse.

Move	the	mouse	hover	families

If	the	"Center	the	selected	person"	is	not	selected,	one	tooltip	with	the	family	name	is	shown	below	the	mouse.

Click	on	one	person

With	the	left	button

The	popup	menu	for	the	person	selected	is	displayed.
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With	the	right	button

The	person	editor	is	called.

Click	on	one	family

With	the	left	button

The	popup	menu	for	the	family	selected	is	displayed.

With	the	right	button

The	family	editor	is	called.

The	search	bar

When	you	have	a	big	tree,	it	is	difficult	to	find	a	person.	This	bar	is	used	to	select	people	and	show	the	filtered	name(s)	in	a	drop	down	menu.

The	clear	button

This	button	is	used	to	clear	the	entry	filed	for	the	dropdown	menu.

The	message

On	the	label	string,	you	have	three	values	:

1.	 The	first	one	is	the	number	of	the	selected	persons.	The	lower	this	number	is,	the	smaller	will	be	the	list.
2.	 The	second	one	is	the	number	of	people	show	on	the	tree.	This	number	depends	on	the	active	person.
3.	 The	third	and	last	is	the	number	of	people	in	the	current	database.

The	results

Another	image	which	show	the	dropdown	menu.
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Configure	Options

Select	View	>	Configure...	from	the	menu	to	change	the	following:

General	options 	tab:

Center	the	selected	person. 	The	new	position	will	be	near	the	top	left	corner	(checkbox	selected	by	default).	If	this	option	is
selected,	you	don't	see	the	paths	and	you	have	no	tooltips	when	hover	families.
The	path	color: 	red(default)
The	selected	person	color: 	blue(default)
The	path	transparency: 	slider	that	defaults	to	6	out	(1	to	9).

See	also
Quilts	-	GEPS_030:	New	Visualization	Techniques
Based	on	GeneaQuilts
Anastasia	Bezerianos,	Pierre	Dragicevic,	Jean-Daniel	Fekete,	Juhee	Bae,	Ben	Watson.	GeneaQuilts:	A	System	for	Exploring	Large
Genealogies.	IEEE	Transactions	on	Visualization	and	Computer	Graphics,	2010,	16	(6),	pp.1073-1081.	10.1109/TVCG.2010.159.	inria-
00532939	[.pdf]

Quilt	Chart 255

http://www.gramps-project.org/wiki/index.php/File:Quiltview-search.gramps-50.png
http://www.gramps-project.org/wiki/index.php/File:QuiltView-Addon-ConfigureCharts-defaults-51.png
http://www.gramps-project.org/wiki/index.php/GEPS_030:_New_Visualization_Techniques#Quilts
http://www.aviz.fr/geneaquilts/
https://inria.hal.science/file/index/docid/532939/filename/geneaquilt.pdf


5.2	Addons

RelatedRelativesGramplet

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Hint

If	you	select	a	common	ancestor	for	a	relationship	with	a	relative	and	create	a	Hourglass	report	for	this
person	you	often	can	easily	spot	the	related	relatives	by	looking	for	lines	that	are	crossing	the	other	lines.

Related	Relatives	Gramplet	-	results	window	example

The	Related	Relatives	Gramplet	shows	all	persons	in	your	database	that	have	or	had	a	relationship	with	a	relative.

Usage
For	each	found	relationship	with	a	relative	the	relationship	is	named	and	the	common	ancestors	for	the	relationship	are	listed.	The	persons	in	the
relationship	and	the	common	ancestors	are	shown	as	links.	You	can	select	either	by	a	single	click.

RelatedRelativesGramplet 256

http://www.gramps-project.org/wiki/index.php/File:Gramps-notes.png
http://www.gramps-project.org/wiki/index.php/Third-party_Addons
http://www.gramps-project.org/wiki/index.php/How_to_make_a_backup
http://www.gramps-project.org/wiki/index.php/Using_the_bug_tracker
https://github.com/gramps-project/gramps/blob/master/README.md#the-following-packages-are-optional
http://www.gramps-project.org/wiki/index.php/Gramps_5.2_Wiki_Manual_-_Plugin_Manager
http://www.gramps-project.org/wiki/index.php/File:Gramps-notes.png
http://www.gramps-project.org/wiki/index.php/Gramps_5.2_Wiki_Manual_-_Reports_-_part_5#Hourglass_Graph
http://www.gramps-project.org/wiki/index.php/File:RelatedRelativesGramplet-addon-example-50.png


5.2	Addons

RepositoriesReport

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Example	output	from	the	Repositories	Report

This	is	a	set	of	Text	reports	to	list	repositories	and	their	related	sources	information,	such	as	the	call	number	or	the	type.	Repositories	stores	sources.
These	reports	are	useful	for	displaying	some	sources	information	before	going	to	a	repository	(like	an	archive).

Repositories	Report
Repositories	Report	Options

Repositories	Report
Once	installed,	you	can	access	this	report	via	menu	Reports	>	Text	Reports	>	Repositories	Report...

See	also	common	options	

Repositories	Report	Options

Example	output	from	the	Repositories	Report	Options

Once	installed,	you	can	access	this	report	via	menu	Reports	>	Text	Reports	>	Repositories	Report	Options...

See	also	common	options

This	report	extends	the	Repositories	Report,	and	provides	user-options	for	additional	source	information	(author,	publication	information,
abbreviation,	data),	pre-formatted	notes	for	source	or	repository,	primary	media	on	source,	also	allows	to	hide	private	records	(repository,	source,
note,	media)	and	supports	multi-language.
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Development

Limitations

As	this	is	a	textual	report,	there	is	no	changes	on	database.	It	just	retrieves	information	from	database.	No	need	to	make	a	backup	before	using
this	report.
As	code	is	not	very	complex,	it	should	not	introduce	mistakes	on	output.	If	there	is	an	error,	then	there	is	a	valid	email	address	at	the	end	of
the	plugin.

RepositoriesReport.py	(3.1.x)	was	inspired	by	Place	Report.

See	also	the	Repository	References	quick	view,	which	does	the	same	thing	on	active	repository	called.	Thanks	to	Alex	Roitman,	who	generated	the
"technical	part"	of	the	code	...

Generated	with	:

Coding	way	is	not	very	quick	or	standard	but	is	easy	to	understand	and	plugin	does	the	job.

It	has	been	generated	under	Geany
and	checked	with	Pylint.

Feel	free	to	improve	it	for	your	own	need	!

RepositoriesReport 258

http://www.gramps-project.org/wiki/index.php/Gramps_5.2_Wiki_Manual_-_Reports_-_part_6#Place_Report
http://www.gramps-project.org/wiki/index.php/Gramps_5.2_Wiki_Manual_-_Reports_-_part_8#Repository_References
http://www.gramps-project.org/wiki/index.php/Quick_Views
https://www.geany.org/
https://www.pylint.org/


5.2	Addons

SQLite	Export	Import

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

This	pair	of	addons	are	used	together	and	do	not	provide	generic	SQL	support	for
import	from	an	unknown	format.

See:	11447

A	Gramps	SQLite	exporter	and	SQLite	importer	that	can	export	most	of	the	Gramps	genealogical	data.

SQL	stands	for	"Structured	Query	Language"	and	is	pronounced	"sequel"	(it	is	a	joke:	as	it	came	after	QUEL,	it	is	its	sequel).	SQLite	is	a	common
local	database	format

Installation
Install	both	the	 SQLite	Export 	and	 SQLite	Import 	addons.

Usage

Export	SQLite

You	can	export	most	of	the	Gramps	genealogical	data	through	an	SQL	Export	using	the	Export	Assistant.	This	does	not	export	other	Gramps	data,
such	as	bookmarks,	researcher	information,	etc.

From	the	menu	select:	Family	Trees	>	Export...
From	the	Saving	your	data	wizard	dialog	select	 Next
From	the	Choose	the	output	format	wizard	dialog	select	the	 SQLite	Export 	option	and	then	select	 Next 	twice
From	the	Select	save	file	wizard	dialog	either	name	the	file	and	default	location	or	change	it	and	then	select	 Next
From	the	Final	confirmation	wizard	dialog	select	 Apply 	and	then	 Close

Import	SQLite

You	can	also	import	the	previously	exported	Gramps	genealogical	data	via	SQL	import.

It	is	recommended	that	you	create	an	new	Family	Tree	before	import.
From	the	menu	select:	Family	Trees	>	Import...
From	the	Import	Family	Tree	file	dialog	selector,	select	your	previously	created	SQL	file	(eg:	Untitled_1.sql)	and	then	select	the
Import 	button

Using	export	with	external	programs
After	you	use	the	SQLite	Exporter	to	export	your	Gramps	data	into	a	file	such	as	Untitled_1.sql,	you	can	then	use	SQL	queries	using	any	program
that	can	access	your	database	(postgresql,	sqlite,	etc).	For	example,	on	Linux	with	sqlite:
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$	sqlite3	Untitled_1.sql
SQLite	version	3.5.9
Enter	".help"	for	instructions

sqlite>	.tables
dates							family						names							people						repository
events						media							notes							places						sources			

sqlite>	.headers	on
.headers	on

sqlite>	select	*	from	people;
handle|gramps_id|gender|death_ref_index|birth_ref_index|change|marker0|marker1|private
b247d7186567ff472ef|I0000|1|-1|-1|1225135132|-1||0

sqlite>	select	*	from	names	where	surname	like	"%Smith%";
private|first_name|surname|suffix|title|name_type0|name_type1|prefix|patronymic|group_as|sort_as|display_as|call
0|Test|Smith|||2|||||0|0|

sqlite>	.exit
$

$	sqlite3	Untitled_1.sql
SQLite	version	3.6.12
Enter	".help"	for	instructions
Enter	SQL	statements	terminated	with	a	";"
sqlite>	.tables
address									event											location								note												repository_ref
attribute							event_ref							markup										person										source								
child_ref							family										media											person_ref						source_ref				
datamap									lds													media_ref							place											url											
date												link												name												repository				
sqlite>	.headers	on
sqlite>	.mode	columns
sqlite>	select	*	from	person;
handle														gid													gender	death_ref_handle				birth_ref_handle				change					marker0	marker1		private
------------------		--------------		------	-------------------	-------------------	----------	-------	--------	--------
b5dc6d9aa5766513709	I0010											0						b5dc6d9aa07279205ad	b5dc6d9aa3e7b41b0f1	1249739601	1							Complete	1
b5dc6d9add708e5ba9e	Amle	achba						0						b5dc6d9adc539e3085e																					1249739601	2							ToDo					0
b5dc6d9cd9c134a0c39	I0017											1																																														1249739602	-1															0
b5dc6d9dfd3719d4e00	imgoabim	Miulka	1						b5dc6d9dfca6a342e45																					1249739603	1							Complete	0
b5dc6d9f38779e2275b	I0024											0																										b5dc6d9f37b685b9607	1249739603	-1															0
...

If	you	change	the	data,	you	can	then	read	it	back	using	the	SQLite	importer	into	Gramps	to	see	the	changes.

NOTE

You	should	only	attempt	editing	textual	fields	or	fields	for	which	you	know	the	meaning.	For	example,	in
the	above,	do	not	change	the	handle	fields,	but	you	can	change	one's	gender.

Indexed	data

A	user	reported	that	their	experiments	with	the	SQLite	export	created	records	of	Events	where	the	Event	type	is	a	numeric	index.	There	was	no	text
label	of	the	Event	type.	They	were	unable	to	find	the	table	being	referenced.

The	events	type	are	referenced	in	gramps/gen/lib/eventtype.py

The	following	code	will	get	the	string	value	corresponding	to	the	index:

											event_type	=	[tup	for	tup	in	EventType._DATAMAP
																									if	tup[0]	==	index][0]
											evt_id	=	event_type[0]
											evt_name	=	event_type[1]

See	also

GEPS	010:	SQL	Backend	withdrawn	in	favor	of	GEPS	032
GEPS	032:	Database	Backend	API
Gramps_SQL_Database#Older_version

Gramps	bug	report	MantisBT	database:

11447	:	Sqlite3.DatabaseError:	file	is	not	a	database
9148	:	Sqlite	export	followed	by	re-import	not	idempotent
12620	:	Include	type	descriptions	in	SQLite	Export	addon
12765	:	Include	name_group	table	in	SQLite	Export
12766	:	Add	table	of	constants	to	SQLite	Export

Gramps	community	support	Discourse	forum:
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SQLite	export	clarification?	-	Dec	2022
Extracting	constants	from	python	code	-	Dec	2022
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5.2	Addons

SetAttributeTool

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Only	applies	Attributes	to	People	Attributes	only

(and	not	Families/Events/Sources/Citations/Media	Attributes)

The	 Set	Attribute 	Tool	allows	you	to	set/add	a	named	attribute	on	a	set	of	people	or	remove	them.	

Usage
Once	installed	select	the	menu	Tools->Family	Tree	Processing->Set	Attribute....	This	brings	up	the	 Undo	history	warning 	dialog	select
either	the	 Stop 	to	exit	or	the	 Proceed	with	the	tool 	button	which	will	show	the	 Set	Attribute 	window,	where	you	can	fill	in	the
required	information	to	either	add	or	remove	the	attribute	with	the	selected	value.

Person	Filter: 	-	Select	the	filter	to	restrict	people	to	eg:'Entire	Database	(default)
Filter	Person: 	-	The	center	person	for	the	filter

Select	a	different	person 	button
Attribute: 	-	Attribute	type	to	add	or	edit	(Will	remember	entry	between	use)
Value: 	-	Attribute	value	to	add	or	edit	(Will	remember	entry	between	use)

Remove 	-	(Unchecked	by	default)	If	checked	will	remove	attribute	value	to	add	or	edit	entered

To	exit	without	using	the	tool	use	 Close 	button.	Select	the	 Execute 	button	to	add	or	remove	the	Attribute.

Issues
3682	Set	Attribute	Tool	should	be	able	to	(add	and	remove)	attributes	for	Families/Events/Sources/Citations/Media	etc
No	help	url	to	here.
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5.2	Addons

SetPrivacyTool

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

The	 Set	Privacy	Tool 	allows	you	to	manage	the	privacy	status	of	people,	events	and	media	from	the	year	range	that	you	select.

Items	marked	as	private	can	be	hidden	in	Gramps	e.g.	in	report	generation	or	ignored	e.g.	when	exporting	the	database.	

Usage
Once	this	plugin	has	been	installed:

Select	Menu	Tools	>	Family	Tree	Processing	->	Set	Privacy	Tool...

Undo	history	warning

Proceeding	with	this	tool	will	erase	the	undo	history	for	this	session.	In	particular,	you	will	not	be	able	to
revert	the	changes	made	by	this	tool	or	any	changes	made	prior	to	it.	If	you	think	you	may	want	to	revert
running	this	tool,	please	stop	here	and	backup	your	database.

From	the	Undo	history	warning	dialogue	you	can	choose	 Stop 	or	 Proceed	with	the	tool .

Version	1.0.8
Available	through	the	Third	party	addons	management	section	of	the	General	Tab	in	Preferences.

The	 Option 	tab	is	displayed	with	the	following:
[	]	Persons: 	If	checked,	all	persons	with	a	birth	date	in	the	given	time	range	(Years)	will	be	set	private
[	]	Events: 	If	checked,	all	events	with	a	date	in	the	given	time	range	(Years)	will	be	set	private
[	]	Media: 	If	checked,	all	media	with	a	date	in	the	given	time	range	(Years)	will	be	set	private
[	]	Always	private	if	no	date: 	Checkbox	option,	if	checked	all	objects	without	a	valid	date	will	also	be	set	private
Years: 	The	number	of	years	back	from	today	which	should	be	considered	as	private

Once	you	have	made	your	choices,	you	can	either	choose	 Close 	or	 Execute 	to	apply	the	change.	

Version	1.0.9
Posted	6	July	2021	and	only	available	through	the	Pull	Request	system	on	GitHub.	Currently	queued	for	code	review	and	release	via	the	Plugin
Manager.

Ambiguity	is	subject	to	penalties	with	automated	mass	updates

This	tool	is	selective	but	not	intelligent.	It	does	exactly	what	it	is	told	to	do...	even	when	that	is	a	really
bad	choice.
Also	it	does	not	use	the	Probably	Alive	Proxy	calculation.	It	uses	the	Birth	year	when	filtering	Person
records.
So	the	dates	of	any	other	items	in	the	Person's	timeline	(other	Events,	defining	life	events	of	offspring,
siblings,	or	parents)	are	not	considered.	You	may	want	to	provide	some	better	direction	by	using	the
Calculate	Estimated	Dates	Tool	addon	to	estimate	a	Birth	year.]
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Set	Privacy	Tool	-	Option	dialog

The	 Option 	tab	is	displayed	with	the	following:

Years:
numeric	text	box	with	 - + 	buttons	
The	number	of	years	(counted	backwards	from	today)	which	should	be	excluded	from	being	updated.

Always	private	if	no	date.
If	selected,	any	objects	without	a	valid	date	will	also	be	updated.

Person	Filter:
Entire	Database	▼ 	(default)
Pull	down	menu	to	select	any	Person	custom	filter.

Persons
If	selected,	only	Person	objects	with	a	birth	date	in	the	given	time	range	(Years)	will	be	updated.

	 Event	Filter:
Entire	Database	▼ 	(default)
Pull	down	menu	to	select	any	Event	custom	filter.

Events
If	selected,	only	Event	objects	within	the	Years	range	will	be	updated.

Media	Filter:
Entire	Database	▼ 	(default)
Pull	down	menu	to	select	any	Media	custom	filter.

Media
If	selected,	only	Media	objects	within	the	Years	range	will	be	updated.

Internet	type	filter:
Entire	Database	▼ 	(default)
Pull	down	menu	to	select	a	specific	Type	of	Internet	record:

All 	(default)
Unknown
E-Mail
Web	Home
Web	Search
FTP

Internet
If	selected,	only	Internet	records	of	the	selected	Type	will	be	updated.

Addresses
Address

If	selected,	any	Address	records	within	the	Years	range	will	be	updated.

Once	you	have	made	your	choices,	you	can	either	choose	 Close 	or	 Execute 	to	apply	the	change.
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5.2	Addons

SourcesCitationsReport

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Sources	and	Citations	Report	-	Report	Options	-	tab	-	defaults

The	Sources	and	Citations	Report	addon	provides	a	source	and	citation	report	with	notes.

Usage
Select	Reports	>	Text	Reports	>	Sources	and	Citations	Report...	from	the	menu.

Issues
help	button	goes	to	https://gramps-project.org/wiki/index.php?title=Gramps_5.1_Wiki_Manual_-_Reports#Sources_and_Citations_Report
Github	code	SourcesCitationsReport
12506:	Improvement	to	the	existing	SourcesCitationsReport	-	New	report	has	an	improved	layout	with	no	tables	allowing	greater	User	control
via	Styles.	A	choice	of	three	Sorts	is	provided,	Source_id,	Author	and	Title.
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5.2	Addons

SyncAssociation

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

The	 Sync	Associations 	Tool	addon	is	designed	to	add	a	reciprocal	Association	if	it	is	missing.	For	instance,	if	you	create	a	GodFather
association	between	A	and	B,	this	tool	will	create	the	matching	Godchild	association	between	B	and	A.

Usage
The	 Sync	Associations 	tool	is	run	from	the	menu	Tools	>	Family	Tree	Processing	>	Sync	Associations....	It	will	scan	and	modify	your
family	tree	with	no	interaction	nor	feedback	of	the	changes	being	made.	(Although	the	Persons	receiving	a	reciprocal	association	will	have	a
freshened	Modify	Date.)	So	be	certain	to	make	a	backup	beforehand...	in	case	the	result	is	not	what	you	expected.

This	tool	is	designed	to	create	reciprocal	Associations	that	are	implied	by	explicit	Associations	records.	Any	Sources	or	Notes	referenced	by	the
original	Association	will	be	cross-referenced	to	the	new	reciprocal	relationship	Association.

Table	of	supported	Associations

The	following	Associations	imply	a	reciprocal	relationship:

Association	name Reciprocal	association	name
Godparent Godchild
Landlord Tenant
DNA DNA

See	below	to	Add	Types	to	the	Sync	Association	Gramplet

Example

Create	a	new	Family	Tree	and	import	the	Example.gramps	file.

View	the	Person	Association	information	for	example	person,	Fernandez	El	Fernandez,	Avis	III.	He	is	the	Godfather	of	Garner	von	Zielinski,	Lewis
Anderson	Sr.	
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Now	view	the	person	referenced	in	the	Godfather	association,	Garner	von	Zielinski,	Lewis	Anderson	Sr.	Note	that	he	is	the	Godfather	of	Garner,
Anderson	but	does	not	have	an	association	with	his	Godfather.	

After	running	the	 Sync	Associations 	tool,	a	window	describing	the	actions	taken	will	appear.	The	possible	actions	are

<N>	Reciprocal	associations	created
All	reciprocal	associations	exist,	none	created
No	existing	associations,	so	no	reciprocal	ones	needed

Now	view	the	person	again.	The	Godchild	association	has	been	added.	If	there	were	Notes	or	Citations	on	the	initial	Association,	they	would	also	be
referenced.	

Add	Types	to	the	Sync	Association	Gramplet
How	do	I	add	a	new	relationship	Type	to	the	Sync	Associations	tool?

Not	for	the	casual	user

The	list	of	Association	Types	was	not	designed	to	be	changed	via	the	interface.	(It	was	intended	for	a	specific	Association	and	does	not	have	any
interface.)	But	you	can	manually	change	the	Gramplet	code	as	a	temporary	hack.	Unfortunately,	the	next	time	that	Gramplet	is	updated,	any
temporary	hacks	will	be	wiped	out.

To	add	more	‘official’	reciprocal	relationship	will	take	time.	The	quickest	turnaround	would	be	for	users	to	manually	change	the	Association	Types
in	the	system	and,	once	they	have	verified	the	the	Types	as	functioning,	then	submit	the	patched	line	of	associations	as	an	Enhancement	Request.

What	variations	of	Syncs	can	be	added?

Associations	can	be	symmetrical	or	reciprocal.	That	is	to	say,	the	relationship	is	described	the	same	way	from	either	side	(co-workers)	or
inverse/mirror	of	one	another	(guardian	and	ward)

As	an	example,	perhaps	you	want	to	log	the	Association	of	a	Namesake	to	their	Eponym.	The	Junior-Senior	namesake	relationships	are	implied	via
the	Name	Suffix	and	loosely	refined	via	the	Family	relationship.	But	namesakes	that	skip	a	generation	(or	are	honoring	a	famous	person/thing)	are
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more	easily	tracked	via	Associations.	It	sure	would	be	nice	for	there	to	be	less	work	to	set	the	Reciprocal	Association.

When	considering	Associations,	note	that	they	do	not	have	a	datespan.	So	logged	Associations	should	probably	be	limited	to	those	that	are	expected
to	be	lifelong.

The	modification

If	you	go	to	line	57	of	syncAssociations.py	you	will	see:

ASSOC_LOOKUP	=	{
"cM":	"cM",
"DNA":	"DNA",
"Godfather":	"Godchild",
"Godmother":	"Godchild",
"Landlord":	"Tenant"
}

You	need	to	add	lines	with	a	similar	format	(quoted	string	then	colon	then	quoted	string	then	comma)

Once	the	new	Associations	Types	have	been	tested	and	work	as	expected,

submit	an	feature	request	to	included	it	in	the	addon.

Issues
Limited	list	of	association	currently	known.	Adding	additional	relationships	requires	adding	to	the	source	code	in	the	ASSOC_LOOKUP	table
No	help	link	to	here.

See	also
Gramps	5.2	Manual	-	Entering	and	Editing:	Associations
Roles,	Relationships	&	Associations
Add	a	godfather-godmother
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5.2	Addons

Themes

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

The	Themes	addon	adds	a	small	set	of	configuration	settings	to	the	Preferences	dialog.	A	new	tab	 Theme 	is	added	containing	a	few	new	settings
related	to	Gramps	appearance.

Settings
There	are	four	new	settings;

Theme: Adwaita 	setting	allows	the	user	to	select	from	the	installed	themes	on	their	machine.	A	few	of	the	themes	will	come	standard
with	the	system	library	Gtk.	Others	may	be	part	of	the	Operating	System,	particularly	in	Linux	based	systems.

Note	that	not	all	themes	are	fully	compatible	with	Gtk	and	Gramps;	if	the	theme	selected	doesn't	look	right,	with	missing	elements	or	other	issues,
select	another	theme.

	 Dark	Variant 	If	the	current	theme	includes	a	dark	version	of	the	theme	as	a	subset,	selecting	will	activate	the	dark	version.	(Also
called	Dark	Mode)	The	Dark	Mode	is	deselected	by	default.

Font: font	family			point	size 	Brings	up	a	selector	which	allows	the	user	to	pick	a	Font	family	to	be	used	throughout	the
Gramps	interface,	and/or	change	the	font	size.	The	fonts	presented	are	those	found	on	the	system.	After	making	a	font	change,	restart	Gramps.

	 Toolbar	Text 	Enables	text	below	the	main	Gramps	toolbar	icons.	Toolbar	labels	are	deselected	by	default.

	 Fixed	Scrollbar	(Requires	Restart) 	This	overrides	the	Gramps	scrollbars	to	be	a	bit	more	'classic'	in	behavior	and
appearance.	Fixed	Scrollbar	is	deselected	by	default.

This	option	toggles	between	the	default	and	these	overrides:

Scrollbars	remain	visible	rather	than	disappearing	when	not	in	focus
Arrow	button	(up/down)	are	shown	at	scrollbar	ends
clicking	in	the	empty	space	above	and	below	the	slider	acts	as	page	up	or	page	down	instead	of	'Warp	to	position'

Note	that	changing	the	scrollbars	setting	requires	restarting	Gramps,	and	may	require	restarting	your	session	(Log	off	and	log	back	on	to
Windows),	particularly	when	disabling	the	setting.

Restore	to	Defaults 	This	returns	Gramps	theme	settings	to	their	default	values,	as	if	no	changes	were	made	with	these	settings.
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Installing	your	own	theme
Themes	(correctly	copied	into	the	appropriate	OS	folder	and	with	the	correct	subfolders)	will	simply	appear	as	new	pull-down	menu	options	in	the
Themes	tab	that	appears	in	Preferences	after	the	Themes	addon	has	been	installed.

Windows

It	is	possible	to	change	the	Gramps	theme	on	the	Windows	AIO.

The	Gramps	AIO	version	5.0.x	uses	Gtk	3.18	or	higher,	so	a	theme	MUST	be	selected	that	supports	that	version	(themes	that	are	designed	for	a	later
version	may	not	work).	The	current	Gtk	version	is	reported	in	the	Addon:Prerequisites_Checker_Gramplet.

Suitable	alternate	themes	may	be	found	at	the	gnome-look.org	website.

Download	the	theme	file	(often	a	tar.gz)	and,	if	necessary,	decompress	it	using	7-zip	or	similar.

The	decompressed	files	should	be	stored	within	a	folder	in	"C:\Users\<username>\.themes"	(Substitute	<username>	with	your	login	name	under
Windows.	Less	ambiguously,	you	could	take	advantage	of	the	%USERPROFILE%	Windows	environment	variable	and	the	destination	folder	is:
%USERPROFILE%\.themes)

The	folder	.themes	can	be	manually	created	if	it	does	not	already	exist.

So,	the	final	directory	structure	for	a	theme	named	"MyAwesomeTheme"	looks	like:

	C:\Users\<username>\.themes\MyAwesomeTheme

or

	%USERPROFILE%\.themes\MyAwesomeTheme

Linux

You	should	follow	instructions	for	your	distribution.	Some	other	information	that	could	help	is	provided	GEPS_029:_GTK3-
GObject_introspection_Conversion#GTK_3_theme.

See	also
Themes	3rd	party	addon	(add-on	source	code	on	GitHub)
Windows	AIO	themes	:	Raleigh	and	High	Contrast	(not	pretty...	but	a	good	accessibility	theme)

Downloadable	themes	(screen	captures):
Greybird-Modv2	:	a	darker	gray	(no	dark	theme)
Crown	Blue	:	Similar	to	Adwaita.	Checking	the	Dark	Variant	makes	it	transparent	on	a	Win10	system.
Victory	:	Another	gray	with	no	dark	theme.

Some	might	find	Yaru	themes	more	to	their	liking.	There	are	many	other	colors	and	dark	themes.
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5.2	Addons

This	Day	In	Family	History

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Released	for	Gramps	5.x	and	greater

This	Day	In	Family	History	Addon	Output	Sample

The	 This	Day	In	Family	History 	Gramplet	provides	a	view	into	your	family	history	by	searching	through	your	family	tree's	events	and
presenting	you	with	a	concise	report	of	the	user	defined	list	of	events	that	happened	on	this	day	and	month.

More	than	a	novelty	this	gramplet	can	be	used	to	build	engagement	among	family	members	and	get	them	involved	with	filling	in	details.	Cut	and
paste	the	results	to	your	favourite	discussion	group	or	email	list,	however	you	keep	in	touch	with	the	family.

Features

This	Day	In	Family	History	Addon	Output	Sample

Choose	from	a	list	of	Gramps	events	to	report	on
Filter	the	list	between	living	and	deceased	members	of	your	family	tree
Sort	the	list	by	year,	participant	name,	event	location,	event	type,	gramps	ID
Click	through	on	the	individual	to	inspect	their	record

Usage
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This	Day	In	Family	History	Configuration	Dashboard	View

After	installing	the	gramplet	you	can	proceed	with	the	default	options	or	access	the	Configure	Dashboard	to	choose	your	preferred	options.	The
gramplet	will	appear	on	your	Dashboard,	no	further	learning	curve	required.

Definition	of	deceased	persons	for	filtering

For	the	purposes	of	this	gramplet	if	a	person	has	an	event	that	suggests	that	they	are	not	living	they	will	be	considered	deceased.	For	family	events
the	living	only	filter	will	be	applied	if	both	members	of	the	family	are	considered	deceased.

The	events	that	will	cause	a	person	to	be	considered	deceased	are:	burial,	cremation,	death,	cause	of	death,	and	will.

Installation	Prerequisites
Designed	and	tested	with	Gramps	5.0,	no	other	external	programs	required.

Issues
Output	for	family	events	where	the	partners	are	not	the	primary	participants	may	experience	odd	output.
If	the	only	record	of	an	event	that	would	indicate	a	person	is	deceased	is	recorded	as	a	family	event,	they	will	not	be	correctly	filtered	by	the
living	only	option.
Does	not	refresh	on	GEDCOM	import.
Does	not	refresh	if	person	is	accessed	through	right	click,	saved,	and	database	is	updated.

Feature	requests
Some	of	the	ideas	to	be	implemented	in	future	versions	of	the	gramplet:

Expand	the	location	to	include	the	full	hierarchical	name.
Detect	if	a	marriage	listed	under	multiple	People,	instead	of	as	a	Family	event,	refer	to	the	same	event	and	merge	the	notice	instead	of	listing
them	individually.
Sort	on	multiple	criteria,	e.g.	first	by	event	type	then	by	event	year.
Add	a	setting	to	consider	a	person	deceased	if	their	age	is	beyond	a	certain	threshold.

Other	information
Initially	developed	by	Stephen	Adams	for	Gramps	5.0

See	also
Builtin	-	 On	This	Day 	-	Quick	View
Builtin	-	Birthday	and	Anniversary	Report
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5.2	Addons

ThumbnailGenerator

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Thumbnail	Generator	Tool	in	progress

The	 Thumbnail	Generator	Tool 	regenerates	thumbnails	for	media	attached	to	objects.

The	thumbnail	images	are	fetched	from	the	Operating	System.	So,	if	your	OS	does	not	have	an	application	associated	with	the	file/MIME	type	of
the	media,	or	if	that	application	does	not	generate	thumbnails	from	the	content,	then	then	that	media	object	will	only	be	given	a	generic	thumbnail.	

Usage
Once	this	addon	has	been	installed:

Select	Menu	Tools	>	Utilities	->	Thumbnail	Generator	Tool...

There	is	no	confirmation	bailout

Despite	the	horizontal	ellipsis	("…")	at	the	end	of	this	menu	selection,	no	additional	dialog	appears
before	the	action	begins

No	confirmation	(preemptive	cancel)	opportunity.
No	options	are	offered.

The	thumbnails	will	be	regenerated	in	five	passes:

Generating	thumbnails	for	person	references
Generating	thumbnails	for	family	references
Generating	thumbnails	for	event	references
Generating	thumbnails	for	place	references
Generating	thumbnails	for	source	references

See	also
Avatar	Generator	tool
Feature	Request	9902:	[Thumbnail	Generator]	does	not	delete	old	Thumbnails	when	run	[Add	option	to	delete	old	Thumbnails]
Feature	Request	8161:	Gallery	does	not	generate	thumbnails	of	PDF	files.
Feature	Request	7390:	Gallery	tab	of	Source	view	does	not	display	.ods	files
Feature	Request	6183:	GraphView	docgen:	JPG/PNG	thumbnails	not	within	the	graph	nodes	at	large	DPI
Feature	Request	4120:	To	remove	last	[GNOME]	GCONF	references?	(function	attempts	to	generate	a	thumbnail	image	for	a	non-image)
Gramps	2.0.7	release	notes:	Thumbnail	generation	support	described	with	"evince"	installed,	thumbnails	for	PDF	files;	"totem"	installed,
thumbnails	for	video	files
ThumbnailGenerator.addon.tgz	download	page	on	GitHub
Gramps	Help	Discourse	forum	discussion:	Has	anybody	used	the	Thumbnail	Generator	tool?
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5.2	Addons

TimelinePedigreeView

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Marriage	missing	date.

When	a	marriage	does	not	have	a	date,	then	the	actual	marriage	will	not	show	as	connecting	lines	on	the
view.
Just	add	a	date	to	make	the	marriage	union	visible.

The	 Timeline	pedigree 	View	shows	a	pedigree	and	also	the	timeline	for	each	person's	life.	The	Timeline	Pedigree	View	displays	descendants
as	well	as	ancestors.

Usage
Select	the	Charts	Category
Select	the	 Timeline	pedigree 	icon	from	the	toolbar

The	following	keyboard	command	works	on	the	view
F2 	:	Display	home	person	if	set.

Context	Menus

Two	different	context	menus	(via	right-click)	are	available.	The	context	is	based	on	whether	a	Person	box	is	indicated	or	not.

Blank	section

Fig.	Addon.1	Blank	area	Context	Menu

Using	the	context	menu	on	a	blank	section	of	the	canvas	will	allow	you	to	adjust	and	change	various	options(	see	Fig.	.2)

Home	re-center	on	the	home	person
Show	images
Show	marriage	data
Order	by	timeline
Show	life	span

Mouse	Scroll	direction
Top<->Bottom	use	with	Shift	modifier	key
Left<->Right	default	-	no	modifier	key

Descendant	Generations
select	from	1	to	9	generations

Ancestor	Generations
select	from	1	to	9	generations

About	Timeline	Pedigree	View	(this	wiki	page)
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Person	box

Fig.	Addon.2	Timeline	pedigree	View	-	Addon	for	Chart	Category	-
display	example

Using	the	context	menu	on	a	person	box	will	show	additional	options	(see	Fig.	.1)

«name	of	indicated	person»	re-center	on	this	person
Edit
Copy
Spouses

list	of	spouses
Siblings

list	of	siblings
Children

list	of	children
Parents

«name	of	indicated	person's	father»
«name	of	indicated	person's	mother»

Related
list	of	family	members	where	person	is	a	child

repeat	of	the	Blank	Section	context	menu
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5.2	Addons

Timeline	Quickview

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Timeline	-	Quick	View	-	example	results	window	-	showing	context
menu

The	Timeline	Quick	View	shows:

all	of	the	events	of	the	current	active	person's	life
birth	events	of	parents
all	events	of	siblings
family	events	from	all	parents

These	events	are	sorted	by	date,	and	shows	the	age	of	the	center	person.	In	total,	the	columns	shown	for	each	event	are:

date
event	description
age	of	person
event	place
name	of	people	involved	in	event

Usage

You	can	activate	the	Timeline	Quick	View	by	the	context	menu	(right-clicking)	on	a	person's	name	in	the	 People	Category (Grouped	View	or
List	View),	and	selecting	Quick	View	>	Timeline

Timeline	Gramplet
You	can	also	use	the	Quick	View	as	a	Gramplet:

1.	 select	the	Dashboard	View
2.	 right-click	in	an	open	area,	and	select	"Add	a	gramplet"
3.	 left-click	on	 Quick	View 	Gramplet
4.	 Select	 Configure	the	active	view 	icon	from	the	toolbar
5.	 Select	the	"Quick	View"	tab:	from	"View	Type:"	select	"Person,	and	from	"Quick	Views:"	select	"Timeline",	and	press	"Save"
6.	 Close	the	Options

You	can	then	change	Gramps	Views,	and	select	different	people,	and	the	view	will	change	automatically.

Note

You	can	do	this	for	any	Quickview.

Functionality
Right-clicking	on	a	row	in	the	Timeline	Quickview	brings	up	a	dialog	that	allows	you	to	choose	between	showing	the	person	details	associated	with
the	event.
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Ages

Some	ages	will	appear	as	negative,	as	those	occurred	before	the	center	person	was	born.	Events	with
invalid	dates	will	appear	at	the	beginning	of	the	list.

Version	History
Version	1.0.1	refines	what	events	show	or	not,	and	adds	a	final	entry,	for	Today.
Version	1.0.2	updates	code	to	fix	a	missing	import.
Version	1.0.21	Gramps	4.x

See	also
Other	Quick	Views

Issues
Quickview	helplink	does	not	work	on	dashboard
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5.2	Addons

TinyTafel

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Tiny	Tafel	-	Report	Options	tab	-	with	custom	filter

The	 Tiny	Tafel 	report	(ListeEclair)	provides	a	compact	way	of	listing	the	main	surnames	found	in	a	place	and	showing	what	years	those
surnames	were	found	in	that	place.	It	helps	Genealogists	determine	if	they	might	have	overlapping	research	materials	that	could	be	shared	from	a
family	genealogy	database.

Usage

Tiny	Tafel	-	Report	Options
tab	-	with	Custom	Place	filter

Select	Reports	>	Text	Reports	>	Tiny	Tafel...	to	run	the	report.

Use	 Select	using	filter: 	to	choose	Entire	Database	or	an	existing	Places	category	custom	filter.	Place	custom	filters	can	be	defined	in	the
Place	category	view's	Filter	gramplet	or	from	the	Place	Filter	Editor	option	in	the	Edit	menu.

You	can	narrow	down	the	geographical	locations	of	the	list	by	using	 Select	places	individually:

From	the	 Type	of	list:

Tiny	Tafel	(default)

Place	Name:Surname:Begin	Year:End	Year

CousinGenWeb

Surname:Place	Name

You	can	 [x]	Include	private	data 	by	default.

Background
The	concept	was	to	catalog	areas	of	interest	in	genealogical	research	collections.	It	was	a	compromise	between	rows	which	can	be	read	by	humans
and	those	that	can	be	automatically	interpreted	by	computers	using	a	Tafel	Matching	System.

This	report	in	Gramps	is	not	in	the	classic	Tiny	Tafel	format.	Rather,	it	is	the	same	category	of	encouraging	research	collaboration.	Objectives	are
collated	in	a	form	intended	for	sharing	on	the	CousinsGenWeb,	a	French	genealogy	service	circa	2012.	The	Report	output	is	suitable	for	pasting
into	the	body	of	an	e-mail	or	posting	to	Social	Networking	Services.
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However,	the	filtering	has	limited	utility.	While	you	could	filter	to	just	the	Places	where	a	particular	group	of	Ancestor	resided,	the	report	still
returns	rows	with	ALL	surnames	logged	in	those	Places,	in	all	eras.	You	cannot	limit	to	all	surnames	you've	recorded	in	each	place	while	your
Ancestors	were	also	residents.	Nor	can	you	limit	it	to	listing	just	the	Surnames	in	one	branch	of	the	Tree.

The	defaults	(without	any	filters)	generated	a	report	running	over	24	pages	when	using	the	Example.gramps	sample	tree.	To	winnow	down	to	a
single	page	sample	report,	an	arbitrary	custom	filter	was	applied.	It	uses	a	 Places	with	a	reference	count	of	<11> 	rule.	This	is	a
completely	useless	custom	filter	for	any	collaboration	goal.	But	it	gave	a	predictably	small	report	length.

The	English	report	name	uses	Loan	words	from	German	and	French

The	term	"tafel"	is	a	German	word	meaning	"Table".	"Liste	Eclair"	is	a	French	phrase	meaning	"Lighting
List.

What	would	comprise	an	original	Tiny	Tafel?
The	following	is	summarized	from	the	2000	article	What	Is	A	Tiny	Tafel	Report?	published	on	RootsWeb.com	by	Jimmy	D.	Roberts	Sr.:

The	Tiny-Tafel	for	Database	Scope	Indexing	article	was	printed	in	the	April-May-June	1986	issue	(vol.5,	no.4)	of	Genealogical	Computing
magazine	(acquired	by	Ancestry	in	July	1886)	authored	by	Paul	Arthur	Andereck	1928-2007,	that	magazine's	editor.	The	Tiny	Tafel	text	file
specification	was	developed	by	Commsoft	in	1986.	Originally,	the	.tt	text	file	format	had	a	header	with	submitter	contact	identification	followed
by	a	simple	table	of	a	SoundEx	code	for	the	surname,	beginning	date,	end	date	and	the	locality.

One	of	the	driving	forces	in	developing	the	tiny	tafel	was	to	implement	a	very	standardized	database	that	could	compare	tiny	tafels	and	provide	a
report	on	matches.	The	Tafel	Matching	System	was	developed	to	do	this.	The	original	tiny	tafel	text	files	were	intended	for	sharing	with	early
online	services	and	Bulletin	Board	Systems	(BBSes).	The	format	evolved	as	the	technology	changed.	There	were	a	number	of	bulletin	boards
around	the	country	that	had	the	Tafel	Matching	System	installed.

		N	John	Smith
		A	123	Any	St.
		A	Anytown,	NY	12345
		T	212-555-1212
		S	[email	protected]
		S	www.example.com
		Z	3
		A160	1813*1850*AVERY\	Hampshire,	England/Hampshire,	England
		M635	1810*1850*MARTIN\	Armagh,	Ireland/Grey	County,	Ontario,	Canada
		S530	1920*1948*SMITH\	Brock,	Saskatchewan,	Canada/San	Jose,	CA,	USA
		W	24	May	1997

The	SoundEx	codes	above	are	described:	A160	M635	S530

The	format	began	with	header	lines.	Headers	contained	some	basic	identification:	the	researcher's	name	(N),	address	(A),	and	telephone	number	(T).
Following	these	required	lines	are	optional	lines.	They	can	include	(S)	giving	more	information	about	the	communication	system.	For	example,	it
could	include	an	e-mail	address	and/or	Web	page	address.

The	optional	lines	are	followed	by	a	required	line	(Z),	which	gives	the	count	of	data	lines.	Those	data	lines	follow	(described	below),	and	finally	a
closing	line	(W)	with	the	freshness	date	for	the	file.

The	data	lines	might	contain:

data	description • format
Soundex	code	for	surname • (4	characters)

Space	delimiter • (1	space)
Earliest	ancestor	birth	year • (4	numbers	yyyy)

Ancestor	interest	level • (1	character)
Latest	descendant	birth	year • (4	numbers	yyyy)
Descendant	interest	level • (1	character)

Surname • (variable	length)
\	Ancestor	birth	place • (variable	length)

/Descendant	birth	place • (variable	length)

Release	History
Announcement	Message	2012[1]	by	Eric	Doutreleau	<grocanar@gm...>
Github	code	ListeEclair

See	also
Tiny	Tafel	-	Wikipedia

Issues
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Need	to	swap	English	to	be	main	translation	language
help	button	goes	to	wrong	page
Warning	messages
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5.2	Addons

ToDoReport

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Sample	output	from	the	Todo	Report	Addon.

The	 Todo	Report 	prints	any	note	attached	to	person,	family,	place,	etc...	with	a	specific	tag.	Originally,	this	was	pre-set	to	find	Notes	with	the
ToDo	tag.	It	has	since	evolved	to	allow	any	tag	to	be	selected.

While	there	are	Todo	lists	built	into	Gramps	based	not	Notes	of	the	To	Do	type,	this	report	was	designed	around	the	idea	that	you	could	attached	a
note	to	a	person,	family,	place,	etc.	with	the	details	of	the	task	and	mark/tag	it	Todo.	That	would	also	save	time	from	having	to	duplicate
information	to	identify	the	record	you	were	working	on.

While	the	existing	builtin	Tag	report	already	does	list	any	notes	marked/tagged	ToDo,	this	report	allows	you	to	sort	by	the	referenced	person,	place,
etc.,	or	group	them.	Also	the	person's	information	is	printed	next	to	the	note	so	you	don't	lose	track	of	the	subject.

This	report	also	supports	any	custom	tags	you	might	have	created.	

Usage

Todo	Report	Addon	-	dialog.

Once	installed,	you	can	access	this	report	via	menu	Reports	>	Text	Reports	>	Todo	Report...	

See	also
Gramps	builtins:

To	Do	Gramplet
Tag	Report	(all	objects	with	a	selected	tag)

Addons

Addon:ToDoNotesGramplet

Issues

ToDoReport 281

http://www.gramps-project.org/wiki/index.php/File:Gramps-notes.png
http://www.gramps-project.org/wiki/index.php/Third-party_Addons
http://www.gramps-project.org/wiki/index.php/How_to_make_a_backup
http://www.gramps-project.org/wiki/index.php/Using_the_bug_tracker
https://github.com/gramps-project/gramps/blob/master/README.md#the-following-packages-are-optional
http://www.gramps-project.org/wiki/index.php/Gramps_5.2_Wiki_Manual_-_Plugin_Manager
http://www.gramps-project.org/wiki/index.php/File:Addon-TodoReport-report-example-50.png
http://www.gramps-project.org/wiki/index.php/Gramps_5.2_Wiki_Manual_-_Reports_-_part_6#Tag_Report
http://www.gramps-project.org/wiki/index.php/File:Addon-TodoReport-dialog-50.png
http://www.gramps-project.org/wiki/index.php/Gramps_5.2_Wiki_Manual_-_Gramplets#To_Do
http://www.gramps-project.org/wiki/index.php/Gramps_5.2_Wiki_Manual_-_Reports#Tag_Report
http://www.gramps-project.org/wiki/index.php/Addon:ToDoNotesGramplet


	??	-	Help	button	does	not	lead	here.
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5.2	Addons

Types	Cleanup	Tool

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Type	Cleanup	Tool	-	example	window

Type	Cleanup	Tool	-	progress	window

What	is	it	For?
The	Type	Cleanup	Tool	searches	your	database	for	records	that	contain	"custom"	Types,	provides	a	filtered	list	allowing	those	records	to	be	edited,
and	an	option	to	delete	or	rename	the	custom	type.	Custom	Types	are	recognized	by	Gramps	but	the	various	reports	that	Gramps	can	generate	and
other	applications	may	not	recognize	or	handle	them.

What	causes	the	extra	(Custom)	Types?
Custom	types	are	created	automatically	by	some	importers,	or	other	addons	(Forms	Gramplet,	for	example)	to	supplement	the	standard	Gramps
types.

They	are	also	created	manually	by	the	user.	Typing	directly	into	the	Type	 selector	combo	box	allows	the	pattern	matching	to	select	from	the	built-in
list.	But	entering	a	value	not	already	present	in	that	list	will	create	a	Custom	Type	and	insert	it	into	the	Custom	submenu.

Usage
Download	the	Check	for	addon	updates	feature	in	the	General	tab	of	the	Edit	->	Preferences...
Once	this	plugin	has	been	installed
Select	Menu	Tools	->	Utilities	->	Type	Cleanup...

Warning

Proceeding	with	this	tool	may	make	unexpected	changes	to	your	data.	While	it	is	possible	to	Undo	the
changes	made	by	this	tool,	it	may	be	easier	to	recover	from	a	backup.
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The	left	pane	has	the	list	of	various	groupings	of	Types.	Any	grouping	which	has	custom	values	will	also	have	the	 	expansion	button	at	the	left.
Clicking	the	button	will	 	expand	the	submenu	to	list	any	existing	Custom	types.	Select	one	of	those	custom	types	and	the	right	pane	will	show
the	list	of	references	that	utilize	the	custom	type.	If	the	list	is	empty,	the	Custom	Type	can	be	removed	without	affecting	any	records.

You	can	edit	any	of	the	references	in	the	right	pane	by	double-clicking,	using	the	enter	key,	et	cetera.	Use	this	feature	to	correct	the	Type	of	any
record	with	an	accidental	Custom	Type.	The	reference	will	continue	to	be	listed	even	if	the	Type	has	been	changed.	It	is	a	best	practice	to	re-run	the
Tool	to	verify	all	the	Custom	Types	have	been	resolved	before	Removing	that	Custom	Type.	

"Remove"	buttons	Warning	dialog

When	a	custom	type	is	selected	in	the	left	pane,	the	 Remove 	is	enabled.	If	you	want	to	remove	this	custom	type	from	your	drop-down	lists	in	the
type	selectors	when	editing,	you	can	use	this	button.	However,	if	there	are	references	using	the	type,	you	will	get	a	warning	that	the	references	will
not	be	changed.	If	you	elect	to	remove	the	custom	type	anyway,	it	will	disappear	from	your	drop-down	lists	in	the	type	selectors	when	editing.	But
if	you	ever	edit	and	save	an	object	that	still	uses	the	custom	type,	it	will	re-added	to	your	drop-down	lists	of	the	type	selectors.	
You	can	also	rename	a	custom	type	by	changing	its	value	in	the	combo	entry	at	the	bottom	of	the	tool.	You	can	select	a	standard	name,	or	just
modify	the	name	by	typing.	When	a	different	name	has	been	selected,	the	 Rename 	will	become	enabled.	Activating	this	button	will	actually	make
changes	to	your	database,	modifying	all	of	the	referenced	objects	at	once	to	the	new	name.	This	also	causes	the	tool	to	re-scan	the	database,	to	allow
the	changes	to	be	properly	reflected	in	the	panes.

It	is	possible	to	undo	changes	to	the	database	objects	via	the	usual	usual	Edit/Undo	menu	item.	But	note	that	undoing	a	rename	which	caused	a
custom	type	to	be	modified,	will	not	cause	that	custom	type	to	reappear	in	the	drop-down	lists	in	the	type	selectors	when	editing.	This	is	a	limitation
of	the	undo	function.

The	 Close 	simply	closes	the	tool.

The	 Help 	brings	up	this	web	page.

Issues

See	also
Renaming	Event	Types
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5.2	Addons

Web	Connect	Pack

This	is	a	Third-party	Addon.

Please	use	carefully	on	data	that	is	backed	up,	and	help	make	it	better	by	reporting	any	comments	or
problems	to	the	author,	or	issues	to	the	bug	tracker
Unless	otherwise	stated	on	this	page,	you	can	download	this	addon	by	following	 these
instructions .
Please	note	that	some	Addons	have	prerequisites	that	need	to	be	installed	before	they	can	be	used.
This	Addon/Plugin	system	is	controlled	by	the	Plugin	Manager.

Install	the	country	you	require	only

otherwise	many	websites	will	be	duplicated	in	the	"Web	Connection"	menu.

Web	Connect	Pack	-	UK	websites	menu

The	Web	Connect	Packs	contain	a	collection	of	Web	sites	for	various	countries.

Usage

From	the	 	People 	Category	view	select	a	person	then	right-click	and	from	the	context	menu	select	the	 Web	Connection 	entry	to	show	the
website	choices	that	you	can	search	on.	Selecting	a	website	will	send	the	selected	persons	following	data:

%(surname)s	:	Surname
%(given)s	:	Given	name
%(middle)s	:	Middle	name
%(birth)s	:	Birth	year
%(death)s	:	Death	year

to	be	queried	and	the	result	if	any	will	be	displayed.

Prerequisites
Before	using	you	must	install	libwebconnect	library	and	one	of	language	packs.

Requires	'libwebconnect'	be	installed.

'libwebconnect'	is	the	support	Library	for	web	site	collections.

Available	Web	connect	Packs

Install	the	country	you	require	only

otherwise	many	websites	will	be	duplicated	in	the	"Web	Connection"	menu.
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Available	Web	connect	Packs:

DEWebConnectPack
See	also	German	resources

FRWebConnectPack
See	also	French	resources

NLWebConnectPack
See	also	Netherlands	resources

RUWebConnectPack
See	also	Russian	resources

SVWebConnectPack
See	also	Swedish	resources

UKWebConnectPack
See	also	General	information	sites

USWebConnectPack
Includes	Australian	sources/French(selected)/Norway
See	also	US	resources

Issues
If	the	external	website	that	"Web	Connect	Pack"	queries	against	changes	its	query	method,	please	raise	an	issue	on	the	bug	tracker.

Updating	a	webpack

If	the	query	no	longer	works	because	the	website	updated	the	way	searches	happen	these	addons	will	need	updating	also.

So	a	Python	line	in	the	WEBSITES	section	of	WebPack.py	that	reads	like:

["Person",	"WikiTree",	"WikiTree",	"https://wikitree.sdms.si/function/WTWebProfileSearch/Profiles.htm?&Query=%(given)s+%(surname)s+B%(birth)s+D%(death)s&MaxProfiles=500&SortOrder=Default&PageSize=10"],

creates	a	WikiTree	submenu	line	to	the	contextual	pop-up	menu's	Web	Connection	group	in	the	People	category	view.

Selecting	that	a	WikiTree	submenu	line	for	a	Person	Gramps	records	as	being	named	Richard	Milhous	Nixon;	born	12	January	1913	in	Yorba
Linda,	California;	died	23	April	1994	in	Manhatten,	New	York;	would	send	the	following	query	line	to	your	default	browser:

	https://wikitree.sdms.si/function/WTWebProfileSearch/Profiles.htm?&Query=Richard+Nixon+B1913+D1994&MaxProfiles=500&SortOrder=Default&PageSize=10

See	Also
Web	Solutions	for	Gramps
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